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Reproduction, extraction, presentation, alteration, modification, or use, whether in whole or in part, of
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and more generally any act that has not been explicitly authorized by Lumiscaphe are strictly forbidden
and subject to prosecution.
Trademarks, brands, brand names, service marks, logos, and other distinctive symbols displayed in
this documentation are property of their respective owners and are protected by French and European
legislation, as well as by other applicable legislation. All unauthorized use or reproduction is strictly
prohibited.
This software uses NVIDIA® Iray® technology. Iray® 2021.0.1 - 344800.4174
This software uses X-Rite AxF™ technology.
This software uses components from Siemens Digital Industries Software. Copyright 2019-2021. All
Rights Reserved.
This software uses components from 3DS Spatial Corp. Copyright 1986-2021. All Rights Reserved.
This software uses libHaru 2.0.8. More info at libharu.org.
This software uses UMFPACK Version 5.1. Copyright 1994-2021 by Timothy A. Davis, University of
Florida. All Rights Reserved. More info at faculty.cse.tamu.edu/davis/suitesparse.html.
This software contains Autodesk™ FBX™ code developed by Autodesk, Inc. Copyright 2011 Autodesk,
Inc. All rights, reserved. Such code is provided "as is" and Autodesk, Inc. disclaims any and all warranties, whether express or implied, including without limitation the implied warranties of merchantability,
fitness for a particular purpose or non-infringement of third party rights. In no event shall Autodesk, Inc.
be liable for any direct, indirect, incidental, special, exemplary, or consequential damages (including, but
not limited to, procurement of substitute goods or services; loss of use, data, or profits; or business
interruption) however caused and on any theory of liability, whether in contract, strict liability, or tort
(including negligence or otherwise) arising in any way out of such code.
This software uses Little CMS 2.9.0-a. Copyright 1998-2021 Marti Maria Saguer. More info at www.littlecms.com. Little CMS is used under the MIT licence.
This software uses the FreeImage open source image library. More info at freeimage.sourceforge.io.
FreeImage is used under the FIPL, version 1.0.
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This software uses the GLEW open source library. More info at glew.sourceforge.net. GLEW is under the
Mesa 3-D License (MIT License)
This software uses libav 13 (see LGPL 2.1). More info at libav.org.
This software uses lib3ds 2.0.0 (see LGPL 2.1). More info at lib3ds.org.
The Libav library under Lesser General Public License (LGPL 2.1) and its source code can be downloaded here.
The lib3ds library under Lesser General Public License (LGPL 2.1) and its source code can be downloaded here.
This software uses FreeType library. More info at www.freetype.org. FreeType is under the FreeType
License (BSD-style License)
Information about the LGPL 2.1 license can be found in LGPL folder.
This software uses Embree. Copyright 2009-2021 Intel Corporation. More info at http://software.intel.com/en-us/articles/embree-photo-realistic-ray-tracing-kernels/. Embree is used under the Apache
v2.0 license.
This software uses Threading Building Blocks (TBB). Copyright 2005-2021 Intel Corporation. More info
at https://www.threadingbuildingblocks.org. TBB is used under the Apache v2.0 licence.
This product is licensed under the AVC patent portfolio license for the personal use of a consumer or
other uses in which it does not receive remuneration to (i) encode video in compliance with the AVC
standard ("AVC VIDEO") and/or (ii) decode AVC video that was encoded by a consumer engaged in a
personal activity and/or was obtained from a video provider licensed to provide AVC video. No license
is granted or shall be implied for any other use. Additional information may be obtained from MPEG LA,
L.L.C. See http://www.mpegla.com
This documentation is provided with the software Patchwork 3D Enterprise. It does not, however,
constitute a contractual agreement with regard to the features and functionality of the software.
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PRESENTATION

Lumiscaphe’s Patchwork 3D software suite enables organizations to convert their original CAD data
to Digital Aspect Mockups (DAMs) or to static images and dynamic renderings while maintaining
complete in-house control over the process. Permanent data access is assured through local storage.
Patchwork 3D Enterprise is a complete DAM production tool built to meet the needs of the design.
Used for product development during the design phases, Patchwork 3D Enterprise provides a range of
effective tools for working in real time on the style, colors and materials of the product.
The Patchwork 3D interface is divided into two modules:
• Shaper provides all the features required for importing, optimizing, and preparing 3D models.
• Matter provides the tools used to create a DAM through aspect dressing and the creation of a scene
around a model, including but not limited to the creation and modification of materials.

About Lumiscaphe
Lumiscaphe helps to strategically connect the design and engineering worlds with marketing and sales
support by developing and publishing innovative hybrid solutions employing the Digital Aspect Mockup
(DAM) and photorealistic, real-time 3D rendering.
Lumiscaphe provides 3D visualization solutions built on solid experience in real-time rendering technology. Lumiscaphe’s range of specialized products includes online and offline 3D product configurators,
applications and content created for the web and for mobile devices, as well as tools for publishing and
sharing. For creators, a software development integration kit is also available.
Lumiscaphe’s clients are found in the automotive, aerospace and luxury goods industries, as well as in
the architecture world and in the product design community.
Founded in Bordeaux in 2001, Lumiscaphe has become an innovative actor on the worldwide technology market. With offices today in Paris, Shanghai and Osaka, Lumiscaphe is proud to provide its
solutions to its clients directly or through a network of certified partners.
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About This Documentation
NOTE
This documentation describes the interface and the functionalities of Patchwork 3D
without distinction of version.
It begins with a presentation of the new features, the hardware requirements, and a short section on
how to get started with Patchwork 3D.
This document is organized by topic. It does not need to be read in order, and you do not need to read it
from cover to cover unless you want to. Instead, use the search function (Ctrl+F), the table of contents,
and the index to help you find what you are looking for. The chapter and first sub-heading are always
listed at the top of the page so that you will know where you are.

Interface Text
Text in the interface and shortcut keystrokes are written differently so that they will be easy to see.
They appear like this in the text.

Links
You will also see hyperlinks in the text. This is an example of a link to the New features [21]. If you
are reading on a screen-based support, you can click on these links to be taken to the related subject.
Likewise, the page numbers in the table of contents and the index are links to the pages they indicate.
You can click on them to go directly to that page.

Boxes
NOTICE
Boxes like this one are used to indicate novelties for the current software version.

WARNING
Boxes like this one are used to provide a warning.

NOTE
Boxes like this provide additional information. It may be an associated remark or additional explanation.
You may find this information interesting, but it is not essential for understanding the
operation or interface being described.

TIP
Boxes like this one give a tip to help you with a better understanding of the concept or
with the functionality concerned.
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Step-by-Step Instructions
When step-by-step instructions are given, they are formatted as a numbered list:
1.

This is the first step.

2.

This is the second step.

3.

This is the final step.

Images of the Interface
Unless otherwise indicated, all images in this text use the default interface theme, Dark. If you are
using a different interface theme, the colors on your screen will be different. However, the windows, the
interface text, and the symbols on the icons remain the same no matter what theme you choose.
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NEW FEATURES IN THE 2022 X5 VERSION
If you are viewing this document on a computer, clicking either on the page numbers in the index or on
the links in the main text will take you to the corresponding page.

General
• Addition of the possibility to change the Patchwork 3D User Interface according to your uses thanks
to workspaces [32].
• Addition of the possibility to automatically rename the configuration rule when renaming the target
aspect layer [365].
• It is now possible to change the state of several elements of a list by clicking and dragging [36].

Shaper
• Addition of the possibility to automatically create a scene (lighting, environment) after importing a
CAD file [222].

Matter
• Addition of the possibility to add one or more external libraries to Matter [82].
• It is now possible to take a color inside or outside of Patchwork 3D [206].
• Addition of the possibility to use the Live mode directly from the main toolbar [361].
• Live mode UI/UX improvements [361].
• Addition of the possibility to lock aspect layers to prevent accidental changes [123].
• Addition of the possibility export multi-layered images in Adobe® PSB format [141].
• It is now possible to cast soft shadows in Iray with the Real-Time Sun. [412]
• It is now possible to directly activate and open elements of the libraries (Materials [289], Textures [326], Backgrounds [330], Environments [322], Overlays [333], Post-processing [344], and Sensors [348]) by double-clicking.
• Patchwork 3D automatically renames the configuration symbol when renaming the configuration
rule. [365]
• It is now possible to adjust the animation range with the timeline content [118].
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REQUIRED HARDWARE
64-bit Architectures
Patchwork 3D Enterprise runs on 64-bit architectures.

Minimal Configuration
Operating system: Windows 10 ×64 or newer.
Processor: Intel Pentium Core i5 Sandy Bridge or higher, AMD Athlon II X4 or higher.
RAM: 8 GB, 16 GB for raytracing.
Workstation

Laptop

Quadro K4000 (3 GB)

Quadro K3000M (2 GB)

Quadro K2000 (2 GB)

Quadro K2100M (2 GB)

NOTE
Graphics cards must be used with the latest certified NVIDIA® drivers.

Recommended Configuration
TIP
Visit our website for the latest up-to-date configurations.
Operating system: Windows 10 ×64 or newer.
Processor: Intel Core i7 Haswell or higher, AMD Bulldozer or higher.
RAM: 16 GB, 24 GB for raytracing with large scenes and processor with at least 8 cores.
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Workstation

Laptop

Quadro RTX 8000 (48 Gb)

Quadro RTX 3000 (6 Gb)

Quadro RTX 6000 (24 Gb)

Quadro M5100M (8 Gb)

Quadro RTX 5000 (16 Gb)

Quadro M5000M (8 Gb)

Quadro RTX 4000 (8 Gb)

Quadro M4000M (4 Gb)

Quadro GV100 (32 Gb)

Quadro M2000M (4 Gb)

Quadro GP100 (16 Gb)

Quadro K5100M (8 Gb)

Quadro P4000 (8 Gb)

Quadro K5000M (4 Gb)

Quadro M6000 (12 Gb)

Quadro K4100M (4 Gb)

Quadro M5000 (8 Gb)

Quadro K4000M (4 Gb)

Quadro M4000 (8 Gb)

Quadro K3100M (4 Gb)

Quadro K6000 (12 Gb)
Quadro K5200 (8 Gb)
Quadro K5000 (4 Gb)
Quadro K4200 (4 Gb)
Quadro K2200 (4 Gb)

NOTE
Graphics cards must be used with the latest certified NVIDIA® drivers.
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GETTING STARTED
Installing Patchwork 3D on a Computer User
This process installs Patchwork 3D on a location of your choosing. It creates a listing in the Start menu
> Programs > Lumiscaphe folder and places a shortcut icon on the desktop.
You will need:
• Administrator privileges on the computer where you intend to install Patchwork 3D.
• The software’s .msi installation file.
We strongly advise running the .msi executable file locally, that is, saving it to the computer you wish to
install the software on before running it. You can place it on the desktop or in any other folder on your
computer.
1.

Run the .msi executable file for Patchwork 3D by double-clicking on it. Unless you have deactivated alerts, Windows will ask if you want to execute this file. Click the Execute button.

2.

A wizard will guide you through the following steps of the installation.
a. Computation of space requirements. The installer will verify that there is enough space on your
hard drive to install the software. Once this automated step is complete, you will be asked to
click Next in order to proceed.
b. Presentation of the end user license agreement. Read the end user license agreement carefully. You must accept the terms of this contract and check the box I accept the terms of the
license agreement in order to continue with the installation. At this point, you also have the
opportunity to print the license agreement. Click on Next to continue.
c. Choice of destination folder. By default, the installation wizard will install Patchwork 3D in the
following folder:

C:\Program Files\Lumiscaphe\Patchwork 3D 2022 X5 release 1\
If you would like to install it elsewhere on your computer, click the Change… button and select or create
a new folder for the installation. If you know the directory path of the folder you would like to use, you
may also type it in. Click Next to continue.
d. Validation. Click Install to continue or, if you want to make changes in the previous steps, click Back.
You can also cancel the installation by clicking on the Cancelbutton.
e. Installation. A status bar keeps you informed of the progress of the installation. When the installation is complete, click Finish to close the installation wizard.

Activating Patchwork 3D
Running Patchwork 3D for the First Time
The first time you run Patchwork 3D by selecting it from the Start menu > Programs > Lumiscaphe or
by double-clicking on the icon on your desktop, the activation wizard will open automatically. You are
required to activate Patchwork 3D before first use.
In order to complete the activation of your software, you will need a license. The following procedures
will walk you through the steps to activate your software, including the steps to obtain your license key.
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Follow the steps below or contact us at license@lumiscaphe.com (<license@lumiscaphe.com>) for
further assistance.
To purchase a license or to obtain an evaluation copy of Patchwork 3D, the sales team is at your
disposal. You can reach us at sales@lumiscaphe.com (<sales@lumiscaphe.com>).

License Activation Wizard
NOTE
The activation wizard will run when you open Patchwork 3D for the first time. You can
also run it yourself at any time from the Help menu > License Activation > Restart wizard...
button.
An activation wizard will guide you through the steps to activate Patchwork 3D.
First, choose your activation method. Four options are listed: two for nodelock licenses, and one for
floating licenses, and one for dongles with tokens.
Choose one of the following options:
• Create an activation request ;
• Activate the product with a license file ;
• Activate the product with a server on the network ;
• Activate the software with a token license (USB key).

Requesting a Nodelock Activation for Your Computer
Choose this method if you don’t have a license activation key yet but have already purchased your
license.
1.

Select I need activation for this computer on the first screen of the activation wizard, then click
Next>.>

2.

Provide the account information requested by the activation wizard on the next screen. You will
be asked for your name, your company, and your email address. You must provide your company
email. This allows us to identify you. We will send the license key you request to the company
email address you provide in this step.

3.

Click the Save File…button. Choose where this file will be saved. It is advisable to save it in an
easy to find place, for example, the office. By default, the name of the file is presented as follows:
"20150315_Votre Société_Request_disksn = WD-WMAYUM849339.lar". Do not change the name of
this file.

4.

Click on Finish to close the wizard.

5.

Email the file you have created to <license@lumiscaphe.com>.

6.

When we receive this file, we will send you your activation key. Once you have received your
activation key, you can run your P3D software again. This time choose I already have an activation
file for this computer when the activation wizard opens. (See paragraph below [25].)

Using an Existing Nodelock Activation Key for Your Computer
Choose this method if you have already received a license activation key. These are files ending with
extensions .lic or .klic. Choose the option I already have an activation file for this computer to use the
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license activation file you received attached to the email with the download links. This file must be
saved to your computer.
1.

Select I already have an activation file for this computer on the first screen of the activation wizard.
Then, click Next >.

2.

Click on Select a license file… A window in which you can navigate to find your license activation
key file opens. Select this file, then click Open.

3.

Click on Next> .

4.

Your activation is complete. Click Finish to launch Patchwork 3D.

We recommend moving your .lic or .klic file to the following directory for safekeeping:
C:\Users\[Your User]\Documents\Lumiscaphe\Patchwork 3D Design 2022 X5\
This file will be useful in the future if you need to reactivate Patchwork 3D. It can also be used to
provide us with information in the case of a problem with your activation, whether now or later on.

Using a Floating Activation from an RLM License Server on Your Network
Choose this method if you have purchased a floating license and have installed it on an RLM license
server. Your computer must be connected to this server by a network. Currently, this method should be
used for all floating licenses for Patchwork 3D.
1.

Select I want to use an activation from an RLM license server on my network on the first screen of the
activation wizard. Then, click Next >.

2.

Enter the name of the RLM license server in the text box. If you do not know the name of your RLM
license server, ask your system administrator. Click the Next > button.

3.

Your activation is complete. Click on Finish.

4.

On the next screen, all of the licenses available on your server will be listed.

Click on the license ID you want to use. If you only have one license ID available, or if you always want
to use the same license ID, you can also tick the checkbox for the option Always use selected license. If
you do not check this option, you will be asked to select your license ID every time you open Patchwork
3D.
Then click OK to start Patchwork 3D.

Using an activation with tokenslicense (dongle)
Choose this option if you have a UniKey dongle (USB key) to use Patchwork 3D occasionally. Indeed,
the activation of a license token per USB key is valid for 24 hours from the moment of acquisition of the
token

NOTE
Once the license token is activated, it is not necessary to let the USB key (dongle)
plugged into your computer. The token remains valid until the 24-hour period is over.
When the token is no longer valid, it is necessary to plug the USB key back in to use
another one token.
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1.

There are two possibilities of activation:
• Via the dongle which is connected to the computer,
• Via a server or via a network. In this case, it is possible to indicate the IP address of the server in
the dedicated field (speeds up the search for the server). If the specified server is not available, it
is possible to automatically search for a server on the local network by checking the box

2.

Once you have made your choice, click on Next > and the wizard will confirm that the activation has
been completed.

3.

Click on Finish.

4.

Patchwork 3D will prompt you to use a new token.

Overview
In the next pages, you will discover the structure of the user interface [29], the way Patchwork 3D organizes the data [37] and the preferences [47] of the software, including the default shortcuts [42].
This will help you orient yourself in Patchwork 3D.
You will also need to know how to manipulate objects [65] and how to navigate in a 3D view [57].
Manipulating objects and navigating in viewports in a nutshell
Manipulating objects in Shaper:
•

Translation gizmo: use this to move an object along an axis or on a plane.

•

Rotation Gizmo : use this to rotate an object in 3D space.

Viewport navigation:
•

Middle mouse button: hold and drag to pan.

•

Ctrl + middle mouse button: hold and drag to orbit (turn the view in all directions).

•

Shift + Ctrl + middle mouse button: keep pressed and move the mouse to zoom.

• Ctrl + Space: recenter the camera by placing the surface point under the cursor at the center of the
viewport.
Depending on how Patchwork 3D fits into your workflow, you might be starting from scratch with a CAD
file. Below there is an example of a process that you can use.
The Patchwork 3D Workflow in a nutshell
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In Shaper:
1.

Import a CAD file to obtain a model.

2.

Optimize the imported CAD data.

3.

Add mapping, kinematics, and lighting.

In Matter:
1.

Create and assign materials.

2.

Develop a rich setting.

3.

Add animation.

4.

Render high-definition, photorealistic images, videos, and viewer-readable files.

Importing Data
Here's a few suggestions on how to start:
• If you have a CAD file, import it [219] to create the first 3D Patchwork model.
• If you do not have a CAD file, it is possible to explore the functions of Patchwork 3D by creating a
simplified model with the geometric primitives [249] generated directly by the software.
• If you have a Patchwork 3D database, it will likely already contain a model.

Actions in Shaper
Here are some things to do in the Shaper module once you've imported your data:
• Move surfaces in the 3D [237] world to position or orient them differently,
• Duplicate a surface [237] or duplicate a surface with symmetry,
• Move a surface to a different geometry layer [237] ;
• Adjust the tessellation [238] of a surface,
• Modify a surface's UV mapping [254],
• Parent a surface to a kinematic object [260] for animation,
• Add lighting to your model [266].
Usually you'll have finished with the geometry-related tasks in the Shaper module before switching to
the Matter module to dress your model, but you may find yourself switching back and forth for certain
tasks.

Actions in Matter
In Matter, dressing a model can include tasks like the following:
• Create a product [286] and open it in a viewport [73],
• Create a material [174] and apply it to a surface [313] of your product,
• Import a texture [325] and use it as a background, as relief or as a pattern in a material,
• Use materials to create the shadow [305] of your product,
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• Use materials to create reflective or transparent surfaces [305],
• Add a lighting environment [316],
• Use a lighting environment as a visual on a skydome [303],
• Set up points of view using cameras [386],
• Add backgrounds [329], overlays [332], and 2D post-processing [337];
• Add configurability [362] to your product:
• Create geometry [351], position [353], lighting [354], environment [358], and aspect layers [360],
• Create configuration rules [366] that impose the conditions under which each layer should be
displayed,
• Save combinations of rule states (and, consequently, layer combinations) as configuration bookmarks [156].
• Add a real-time light [209] to your product,
• Animate [391] the product;
• Render with raytracing [182] for true-to-life distortions wherever light is reflected or refracted,
• Generate high-definition images [145] or videos [145];
• Export [233] a product for use in viewers and other Lumiscaphe satellite applications.

Going Further
These are just ideas that skim the surface of the functions of Patchwork 3D. As you explore, you'll find
additional functions and specific settings that allow you to obtain the exact results you are aiming for.
Most of these functions and controls are described in the rest of this documentation.

TIP
For additional help, you can also contact our support department at
<support@lumiscaphe.com> or set up a personalized training session through your
account manager at <sales@lumiscaphe.com>.

Interface Regions
The interface of Patchwork 3D is composed of several main regions where you can find tools and
information.

Modules
Patchwork 3D consists of two modules, each with its own interface: Shaper and Matter. Shaper combines all the tools for working on the 3D models. Matter combines all the tools for creating materials,
dressing the models interactively and calculating high-definition images.
Only one of the two modules is active at any given time. The toggle button Shaper / Matter , visible in
the toolbar under the menu File , allows you to switch from module Shaper to the module Matter and
vice versa.

The toggle button. You are currently working in Shaper. Click here to switch to the Matter interface.
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The toggle button. You are currently working in Matter. Click here to switch to the Shaper interface.

Menus

Menus allow you to handle the application: set your preferences, manage the operations stored in
memory, open, save, and close databases.
The menus are organized according to the element your actions will affect; in the corresponding menu,
you will find the main actions for each of these elements.

Shaper Menus
File: provides the options concerning the software or the database, including access to program
settings and to the set-up of the program shortcuts.
Edit: offers access to the undo / redo options and to the selection options.
Mode: gives access to the various interface interaction modes.
Model: collects the options regarding models, including the functions for creating surfaces that make
up a model, as well as imports and exports.
Layer: offers various actions to be performed on layers, for example, showing / hiding them or freezing /
unfreezing them.
Surface: groups together the functions concerning surfaces.
Visualization: offers access to the visualization options, including the head up display, antialiasing, grid
and axis orientation, as well as the visibility/non-visibility options for the current selection.
Viewport: allows the display windows called "viewports" to be manipulated.
Editors: gives access to the different editors available.
Scripting: gives access to the different scripting modes.
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Workspace: allows you to change the Patchwork 3D user interface by reordering the toolbars according
to your uses. Each reorders of toolbars can be saved in a workspace.
Help: gives access to the help and information files.

Matter Menus
File: provides the options concerning the software or the database, including access to program
settings and to the set-up of the program shortcuts.
Edit: offers access to the undo / redo options and to the options to purge resources currently stored in
memory.
Mode: gives access to the various interface interaction modes.
Product: groups together the options concerning products, including their export.
Camera: contains functions related to cameras and to sensors.
Snapshot: provides access to the snapshot tools.
Visualization: offers access to the visualization options, including the grid and axis orientation, as well
as the stereoscopy options and the full screen mode.
Viewport: allows the display zones, called "viewports," to be manipulated and reorganized.
Editors: gives access to the different editors available.
Scripting: gives access to the different scripting modes.
Workspace: allows you to change the Patchwork 3D user interface by reordering the toolbars according
to your uses. Each reorders of toolbars can be saved in a workspace.
Help: gives access to the help and information files.

Toolbars

In Shaper, the toolbars are located at the top and on the left of the screen.
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In Matter, the toolbars are located at the top and on the left of the screen. The editor toolbar is located at the bottom of the screen.

Toolbars provide quick access to the most common functions. You can move the toolbars around your
screen and anchor them to the top or the left edges of the main window.

Workspace
Available in: Shaper or Matter : Workspace

NOTICE
New Features in Patchwork 3D 2022 X5
A Workspace allows you to change the user interface of Patchwork 3D by reordering toolbars according
to your uses. Each reorders of toolbars can be saved in a different workspace.
Several workspaces come with Patchwork 3D. The workspace named Legacy is the historical user
interface of the software while the workspace named Default is an interface optimized for the uses of
CG Artists with a selection of dedicated editors necessary for the creation of a Digital Aspect Mockup.

Example of the Matter module with the workspace Default.

Example of the Matter workspace module Legacy.

Select the desired workspace in the menu to display it.
32

Patchwork 3D Enterprise 2022 X5

NOTE
For Shaper the top and left toolbars of the Patchwork 3D user interface are customizable.
For Matter the top, bottom and left toolbars of the Patchwork 3D user interface are
customizable.
You can also create your own workspaces from Python scripting. It is also possible to add new buttons
related to a Python script: you can launch software or a website from the toolbar, develop new custom
features using the P3D script API or automate routine operations. See the scripting documentation for
more information.

Example of adding buttons linked to a Python script that executes one or more applications. Here, in this case, it is Accel VR, Lumis
3D, and Adobe Photoshop®.

To create a new workspace, we recommend using one of the spaces delivered with Patchwork 3D, for
example, spaces named Default or Legacy. You will find them in the following location: C:\Program
Files\Lumiscaphe\Patchwork 3D 2022 X5 \workspaces.
Workspaces created by you should be stored in the following location: C:\ProgramData\Lumiscaphe\P3D\Workspaces so that Patchwork 3D can list them in the Workspace menu. Click on Open
workspaces folder to display the folder where workspaces are stored.

3D Viewport

Viewports in Shaper (left) and Matter (right).

A viewport is a display window within the workspace that is used to show a 3D representation of the
model or product being edited. Only one viewport can be active at a time.
The representation of the model or product is determined, in each viewport, by a viewpoint (the position
of the observer) and by a look-at point (the point being observed). Several types of representation exist,
depending on the active interface module. These render types are accessible via a right-click on the
name of the viewport type in order to display the viewport's context menu.
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Sidebar

The sidebar provides constant access to the most common tools and determines the editing mode.
The separator between the sidebar and the workspace is mobile, which provides a greater flexibility in
the organization and division of the application's surface area.
In the sidebar in Shaper, you will find the model, dressing, pivot, kinematics, and lighting tools.
In Matter, browse the products, Matter elements (materials, textures, backgrounds, overlays, post-processing effects, and sensors) and their libraries.

Information Bar

The space at the bottom of the main window is used to display additional information when you move
a mouse over an option or an element of your model or product.
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Editors

Editors are additional floating windows that give access to an element's settings. Most editors are
accessible from the Editors menu or the corresponding toolbar, or from context menus.

Context Menu

You can right-click on most elements in Patchwork 3D Design, whether that element is the upper-left
corner of the viewports or a part of your model or product. This action displays a context menu listing
options associated with the element in question.

Items of a list or hierarchy
Patchwork 3D offers features that make it easy to change the state of items in a list or reorganize them
in a hierarchy.
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Change the state of multiple items in a list by clicking and dragging
NOTICE
New Features in Patchwork 3D 2022 X5
Click and drag is very useful for changing, with a single click, the visibility, locking or selection state of
items in a list. Thanks to this functionality, it is no longer necessary to individually select each item of a
list to change their state.
The click and drag operation mode is easy to use. Select the first icon of the item in the list by
holding down the left mouse button and expand the selection to the other icons of the items by moving
vertically up or down, then release the left mouse button.

NOTE
When clicking and dragging, the visibility, locking or selection state of the first item in the
list is applied to the other items in the selection.

Example of changing the state of surfaces by clicking and dragging.

Rearranging items in a hierarchy
You can rearrange items in a list by a simply drag and drop.
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Data
P3D Database
In Patchwork 3D, the authoring data for a Digital Aspect Mockup is stored in a single file, a database
using the P3D format. This file contains all of the raw editing information and the directory information
for external resources, as well as all of the individual internal resources. Each element used to create
the final rendering is stored in the .pd3 database whether or not it is used in the Digital Aspect Mockup
that has been elaborated. For example, an image used to create relief in a texture, in turn used in a
material, is included in the P3D database.
Only one database may be open at a time.
Operations on the P3D database are available from the File menu:
• New;
• Open;
• Reload the last saved state of the database and discard any changes made since then,
• Recent: a list of recently opened databases. The number of databases listed can be set in the
application settings [47].
• Show Start Screen
More information below [39].
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• Save;
A database saved by a current version of Patchwork 3D may no longer be readable by earlier
versions of the software. When you attempt to save an older database with a newer version
of Patchwork 3D, the program will automatically ask you to confirm this action. Confirming the
save will change the database version. To maintain a copy of the original file, use the Save as
option instead.
• Save as;
• Save and clean up;
This feature allows you to save a version of your database free of unnecessary data such as
deleted data which you no longer need. Its benefit is to decrease the database size. But, on the
other hand, the time to save the database is lengthened.
By using Save As or Save and Clean functionalities you can:
• Do not save cache, Patchwork 3D will purge the cache to save the database. The result is a
significantly lighter database that will take a little longer to load the next time you open it.
• Save all, Patchwork 3D will keep the rendering cache. The next time the database is opened,
Patchwork 3D will load the data faster based on the existing renderings.

TIP
• Use Save (Ctrl + S) frequently during your work session.
• If you plan to work on the database again, at the end of your work session, use
Save and clean and Save all instead. In this way, the rendering cache will be saved.
• If you plan to share or archive the database you are working on, use instead Save
and Clean without keeping the rendering cache (Do not save cache).
• Import in a new database,
• Export
• In Shaper UI, it exports the current model. The following formats are supported: KSc, OBJ,
P3DXml, FBX.
• In Matter UI, it exports the current product. The following formats are supported: FBX, KDR,
LSD, and MI (Iray).
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• Settings, see details in the Settings (Editor) [47] chapter.
• Keyboard Map, see details in the Keyboard Map (Editor) [200] chapter.
• Edit Database Properties, see details in the Database Properties (Editor) [190] chapter.
• Print, see details in the Printing [423] chapter.
• Discard Patchwork 3D Operation History.
• Optimize Meshes.
• Quit.

Start Screen
Start Screen has been made to quickly give you an idea of what Patchwork 3D can do for you. Several
samples are available to guide you in a creation of a Digital Aspect Mockup (DAM).
Start Screen consists of two tabs:
• the Recent Files that lists last modified files.
• Sample files .

Start Screen window

Open... button allows you to open an existing DMA, while New... button lets you start a DMA from
scratch.
Lumiscaphe videos button links you to the Youtube channel of Lumiscaphe.
Uncheck Show this window at startup if you don't need this window shows up on the next launch of
Patchwork 3D. If you want to see it again, just click File and Show Start Screen.

Resources in a P3D File
The P3D file contains many resources, including:
39

Patchwork 3D Enterprise 2022 X5

• Lighting sets,
• Color palettes,
• Image and video files used as textures,
• Materials,
• Image files used as backgrounds,
• Gradients,
• Lighting environments,
• Camera hierarchies,
• Camera position lists (.kam file),
• Sensors,
• Overlays,
• Post-processing sets.
All of these resources are fully integrated in the P3D file. Even if they originally came from external
sources, once the database has been saved, Patchwork 3D will never require access to the original file.

NOTE
When transferring a P3D database from one computer to another, you will only need to
move the P3D file. All of the resources are contained in this one file.
Many of these resources can also be exported or imported, making them transferable between P3D
databases. They can, for example, be stored in a common library which can be specified in the
preferences and accessed via the explorer in the Matter sidebar.

Model
A model is a full set of 3D geometric and spatial information derived from an imported CAD file.
It is composed of Shaper objects such as surfaces, positions, and animation objects such as nulls,
vectors, and axes. The model also contains information regarding Shaper object properties, including
UV mapping coordinates, visibility settings, lightmaps, tessellation levels, and relationships with other
Shaper objects.
A P3D database may contain several models.

Product
A product is a 3D derivative of a model to which an aspect has been or can be assigned.
Multiple products may be produced for a single model.

Digital Aspect Mockup
In order to be used with the Lumiscaphe software suite of 3D visualization tools, the raw authoring
data must be exported as a Digital Aspect Mockup (DAM) in the format KDR. This format contains only
the data required by the rendering engine in order to display the product variants and configurations
created in Patchwork 3D. The image underlying the relief in a texture is no longer present; only the
resulting calculations needed to display a material using that texture are conserved. Consequently,
authoring is not supported in this format. The KDR is optimized to load more quickly: unlike the P3D
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format, in which the displayed images must be calculated when the file is opened, the data in the KDR
can be transmitted directly to the graphics card without further treatment.
The Digital Aspect Mockup may then be used as-is in any of the Lumiscaphe visualization solutions.

Undo/Redo Mechanism
The undo/redo level specified in the Settings (Editor) [47] defines the number of operations that
you can undo or redo at any moment and in a given context. The greater the number, the more information saved in memory by Patchwork 3D. It is possible to have an unlimited number of memorized
operations. However, each memorized operation may occupy a large amount of memory. A limit of 20
operations is generally sufficient.
The undo/redo operations are not saved in the P3D database: when you load a database, you cannot
undo any of the operations performed during a previous editing session.

• Edit >

Undo All or Edit >

Redo All: Undo all memorized operations at once.

• File > Discard P3D Operation History: Discard the memory of all information used to undo previous
operations in the application. This operation can free up a large amount of memory and significantly
reduce the side of the file during the next save.
• Edit > Discard Module Undo History: Discard only the undo operations in the current module (Shaper or
Matter).

Shaper
• Edit > Undo all or Edit > Redo all : Undo or redo all memorized operations at once.
The Shaper viewports also have their own undo/redo history:
• Viewport > Undo in Viewport: Undo the last operation performed in the active viewport.
• Viewport > Redo in Viewport: Redo the last operation undone in the active viewport.

Matter
In Matter, products have their own undo/redo history:
• Product > Undo: Undo the last operation performed on the active product.
• Product > Redo: Redo the last operation undone on the active product.
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Default Keyboard Shortcuts
Available in:
• Shaper or Matter: File > Keyboard Map > Show as HTML
• Help > Keyboard Shortcuts

Patchwork 3D includes the mechanism to assign operations to a keyboard or mouse shortcut. You can
keep the default configuration or define your own shortcuts.
The default keyboard shortcuts may be consulted or modified at any time. Custom shortcuts may also
be assigned to additional operations. These operations are listed in the Keyboard Map Editor.

NOTE
Matter's keyboard shortcuts are also accessible in the floating viewport of Matter, even if
you are in Shaper module. However, not all editor features are supported.

Application
Show Help

F1

Show Matter Module

Ctrl+2

Show Shaper Module

Ctrl+1

Save Database

Ctrl+S

Save Database As

Ctrl + Shift + S

Edit Keyboard Map

Ctrl+B

Print

Ctrl+P

New Database

Ctrl+N

Open Database

Ctrl+O

Surface Cutting Workshop
Pick Camera Look-At Point

Ctrl+Space

Unfolding Workshop
Pick Camera Look-At Point

Ctrl+Space

3D Selection Only

Space

Shaper
Show Edged Faces

(
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Shaper
Track Culling in Red in Active Viewport

]

Show Active Layer

Ctrl+T

Hide Frozen Surfaces

D

Show Selected Only

S

Show All Surfaces

Ctrl+Shift+R

Pick Camera Look-At Point

Ctrl+Space

Hide Unselected Surfaces

Shift+R

Hide Selected Surfaces

R

Paste surfaces to active layer

Ctrl+V

Copy Selected Surfaces

Ctrl+C

Cut Selected Surfaces

Ctrl+X

Move Selected Surfaces

Shift+C

Decrease Triangulation of Selected Surfaces

Ctrl+-

Undo Last

Ctrl+Z

Undo Last in Active Viewport

Maj+Z

Redo Last

Maj+T

Unfreeze All Surfaces

Ctrl+Shift+F

Split Selected Surfaces

Shift + G

Edit parameterization of surface unfolding

Shift + U

Edit Properties of Selected Surfaces

P

Tag Manager

Ctrl+M

Rotation Gizmo

F6

Translation Gizmo

F5

Increase Triangulation of Selected Surfaces

Ctrl++

Invert Selection

Ctrl+Shift+A

Stitch Selected Surfaces

G

Lock Selection

Space

Active Viewport Maximization

A

Set Interaction Mode to Pan.

X

Set Interaction Mode to Orbit.

C

Set Interaction Mode to Zoom Region.

V

Set Interaction Mode to Zoom.

Z

Select All Elements Enclosed by Region Mode

F4

Select All Elements Touched by Region Mode

F3

Select Mode

F2

New active layer

T

Set Active Viewport to Isometric

Shift+L

Set Active Viewport to Perspective

L
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Shaper
Set Active Viewport to Back View

Shift+O

Set Active Viewport to Bottom View

Shift+I

Set Active Viewport to Top View

I

Set Active Viewport to Right View

Shift+K

Set Active Viewport to Front View

O

Set Active Viewport to Left View

K

Shaper Active Viewport Maximization

Ctrl+Y

Redo Last in Active Viewport

Shift+Y

Restrict interaction to the XY plane

Shift+F7

Restrict interaction to the YZ plane

Shift+F8

Restrict interaction to the ZX plane

Shift+F9

Restrict interaction to the X axis

F7

Restrict interaction to the Y axis

F8

Restrict interaction to the Z axis

F9

Select None

Shift+A

Select All

Ctrl+A

Delete Selected Surfaces

Del

Dressing Component Interaction

F12

Surface Component Interaction

F11

Lock Active Layer

Ctrl+Shift+T

Freeze Unselected Surfaces

Shift+F

Freeze Selected Surfaces

F

Active Viewport: Enable Backface Cull

-

Render active viewport in bounding box mode

Shift+B

Render active viewport in wireframe mode

Shift+W

Render active viewport in smooth mode

Shift+S

Render active viewport in smooth and highlights mode

Shift+H

Zoom Active Viewport to View Full World

Q

Zoom Active Viewport to View Full Selected Surfaces

E

Zoom All to View Full Selected Surfaces

Shift+E

Zoom All to View Full World

Shift+Q

Text texture
No pre-defined shortcuts for this group.

Timelines
No pre-defined shortcuts for this group.
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Image viewer
No pre-defined shortcuts for this group.
Matter
Surface Depth Write under Cursor

,

Activate Full Screen Mode

Y

Assign Background under Cursor

F

Assign Active Material under Cursor

C

Modify backface visibility for surface under cursor

F6

Show Background Editor

Shift+F8

Show Material Editor

F5

Show product properties

F8

Show All Surfaces

Ctrl+Shift+R

Assign Environment to Surface under Cursor

G

Assign Environment to All Surfaces Using Material under Cursor

Shift+G

Pick Background under Cursor

R

Pick Environment under Cursor

T

Pick Material under Cursor

E

Set Camera Focus Plane from Picker

Shift+Space

Pick Camera Look-At Point

Ctrl+Space

Undo Last

Ctrl+Z

Undo Last for Active Product

Shift+Z

Tile Viewports

Ctrl+Shift+C

Edit Background under Cursor

Shift+R

Edit Material under Cursor

Shift+E

Store Bookmark 1

Ctrl+F9

Store Bookmark 2

Ctrl+F10

Store Bookmark 3

Ctrl+F11

Store Bookmark 4

Ctrl+F12

Pan Mode

X

Orbit Mode

C

Rotate Material Mode

F4

Select Mode

F2

Translate Material Mode

F3

Modify backface visibility for surface under cursor

N

Material Library

1

Texture Library

2

Background Library

3
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Matter
Environment Library

4

Overlay Library

5

Post-Processing Library

6

Previous Active Viewport Tab

Q

Next Active Viewport Tab

S

Set Active Viewport to Isometric

Shift+L

Set Active Viewport Mode to Walk

B

Set Active Viewport Mode to Fly

V

Set Active Viewport to Perspective

L

Set Active Viewport to view from Back

Shift+O

Set Active Viewport to Bottom View

Shift+I

Set Active Viewport to Top View

I

Set Active Viewport to Right View

Shift+K

Set Active Viewport to Front View

O

Set Active Viewport to Left View

K

Shaper Active Viewport Maximization

Ctrl+Y

Redo Last for Active Product

Shift+Y

Restore Bookmark 1

F9

Restore Bookmark 2

F10

Restore Bookmark 3

F11

Restore Bookmark 4

F12

Zoom to View Full Active Product

Z
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SETTINGS (EDITOR)
Available in: Shaper or Matter: File > Settings

The Settings editor covers application-wide settings.

General Tab
Patchwork 3D supports English, Japanese and Chinese. Choose your preferred language for the interface here.

The box Usage statistics informs the user about the behavior of Patchwork 3D on the collection of
usage statistics. At any time you can change this behavior by selecting the following options:
• I do not agree to the collection of usage statistics.
• I agree to the collection of anynomous usage statistics.
Information collected is as follows: the equipment used, the identifier of the anonymized user, the
duration of the session and the actions carried out in Patchwork 3D.
• I agree to the collection of usage statistics.
Information collected is as follows: the material used, the name of the license used (Enterprise
edition) or email (Community and Premium editions), the duration of the session and the actions
carried out in Patchwork 3D.
When the Remember size of windows option is checked, Patchwork 3D memorizes the size and position
of its window when you close the application. On the next startup, the main window of the application
resumes the size and position previously memorized.

The Undo/Redo zone combines all the options concerning the Undo/Redo system of the application. If
the Limit to box is not checked, then the number of memorized operations is infinite. When the box
is checked, the number of operations is limited to the value given on the right. You can change this
value by clicking in the editable field or by using the two arrowhead buttons on the right. A limit of
20 operations is generally sufficient. The changes made to the undo/redo system will not be taken
into account when the application is restarted. For more information, see the section on the Undo/Redo
Mechanism.
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The Controllers zone offers a selection of additional controllers. Check the box to the left of the
additional controller you wish to select. The name of the controller is a button that allows access to the
window for setting the speed and sensitivity for various actions. You can choose to add the following
additional controllers:
• SpaceMouse
• Xbox controller

Use the keyboard to enter numerical values in order to increase/decrease the speed/sensitivity of the
mouse.

File Tab
The recent Databases zone allows you to indicate the maximum number of files that will be available in
the File > Recent menu. The default value is 9; you can change it to any value from 0 to 99.
The Opening Behavior zone allows you to specify which objects should be loaded into memory when a
database is opened. If loading a database is very slow, it is often possible to speed up the initial loading
to be able to open your database more quickly.
The Reset loading warnings button enables the warnings for which you might have previously checked
Do not tell me again.

The Color Books zone allows you to specify the Adobe directory from which Patchwork 3D will be able
to find color books in Adobe Color Book file format (*.acb) that are used in Photoshop. It functions like a
standard file explorer.

The Exporters zone groups together required information for certain exporters such as the exporter for
P3DXml [225] that has an option to Export ACIS files in binary mode. This option is enabled by default.
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If Let Matter library elements have the same name is checked this allows resources (Material, Texture,
Background, etc...) in Matter libraries to have the same name. Conversely, if the parameter is unchecked,
you will be invited to change the name because two resources can have the same name.
Three choices are then possible:
• Keep asking: Patchwork 3D will suggest a new name each time, which you must then validate by
clicking on Rename button. If you tick Do not ask again, Patchwork 3D will remember your choice the
next time.
• Rename: Patchwork 3D will automatically rename the resource as Microsoft Windows does when you
have two files with the same name.
• Ignore Patchwork 3D will cancel the renaming if there is a conflict.

User Interface (UI) Tab
The UI tab provides controls for elements of the user interface.
In the 3D viewport in Shaper, you can:
• Force 3D Patchwork to Switch to isometric in orbit. This option is disabled by default. When enabled,
the 3D viewport switches automatically to isometric mode when the Orbit navigation mode (Mode >
Orbit or the Ckeyboard shortcut) is selected.
• Flip image vertically in all of the open viewports. This option, which is disabled by default, is not
compatible with the Head Up display (Visualization > Head Up).

In the main interface of Shaper, you can:
• Show head up display at startup. This option is enabled by default.
• Use same viewport configuration for all models, if your database includes several. This option is
disabled by default.
• Use custom interface color. This color is used for the background of the menu bar and for the
background of the information bar at the bottom of the interface. Click on the color thumbnail in
order to choose a different color.
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• Indicate the colors to use for the border around the active 3D viewport and for the background when
the option Show Selected Only is enabled. Click on the color thumbnail in order to choose a different
color.
• Indicate the colors to use for the border around the active 3D viewport and for the background when
the option Lock Selection is active. Click on the color thumbnail in order to choose a different color.

In the main interface of Matter, you can:
• Automatically update product thumbnail in the right-hand sidebar. This option is enabled by default.
• User multilayer material as default material. This option is disabled by default.
• Use stylized material thumbnail.
• Use custom interface color. This color is used for the background of the menu bar and for the
background of the information bar at the bottom of the interface. Click on the color thumbnail in
order to choose a different color.
• Set the product tab policy for the 3D viewports. In the Show product tabs drop-down menu, choose
one of the three options:
• Always: tabs will always be shown in viewports, even when there is only one product loaded in the
viewport.
• When needed: tabs will be visible when several products are assigned to the same 3D viewport.
Otherwise, tabs will not be show in viewports.
• Never: tabs in viewports will never be show. Several products may still be assigned to the same 3D
viewport, but the interface does not provide a clickable means of navigating among them.

You also have control over certain properties of the main monitor. You can correct the values calculated by default for the Width of the main screen and its Resolution.
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Geometry Tab
The Geometry tab provides general options for importers, as well as various options specific to the
importers for Parasolid (IGES), ACIS, and Alias Studio.
In the General Import Options, the Define default units button gives you access to the window for
configuring the units used by default during the importing of the 3D models.
The default measurement units for formats 3DS, DXF, WAVEFRONT OBJ, and STL can be defined by
using the associated drop-down menu. By choosing the User-defined entry of the scroll-down menu,
you have the possibility of entering an arbitrary value in the editable field on the right.

WARNING
Many of these imports are optional add-ons. Some may not be available depending on
your specific software license.
The Ignore files already imported zone allows you to optimize your imports by not repeating the import
of files that have already been imported. For example, if you regularly import all the files from a given
directory, you don’t need to worry about choosing only the new files the next time you import.

Access the options specific to the Parasolid (IGES), Alias Studio and, Catia importers that you wish to
set up.

Lighting Tab
The lighting engine powers the lighting in Patchwork 3D. Depending on the configuration of your
computer and the settings in this tab, the lighting engine may require a lot of resources. The default
values, however, are generally sufficient, though you have to option to disable the engine by unchecking
the box Enabled.
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By default, the Render configuration is limited to:
Option

Default value

Max shadowmap size

2048px

Max lightmap size

1024px

The Preview mode, available in the Lighting tab in the Shaper sidebar, can also be personalized. You can
set the length of time with no interaction before the incremental refinement begins (Start incremental
refinement after) and enable or disable the following options:
Option

Default value

Interactive degradation

enabled

Restrict refinement to shadow integrity

enabled

Also visible in Surface tab (when the Surface sidebar tab is active)

disabled

Activate on first created light

enabled

Preview in color

disabled

If you use Distributed Lightmap Rendering, you also have the choice to set the UDP port used to discover
units used for rendering.
To manage the memory resources required by the use of a real-time sun [209], provide the max size for
hard and soft shadow buffers. The values by default are sufficient in most cases.

Color Tab
Color Management is responsible for many of the strong points in the render quality.
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Color management profiles are a Shiftor technical tool in Patchwork 3D. They are responsible for
many improvements in render quality. These improvements have made it possible for Patchwork 3D to
make a considerable leap towards ultimate realism in rendering. The colorimetric profile defines the
interpretation of the color values (RVB, CMYK or LAB) by matching them with measurable physical
quantities (expressed in the space CIE XYZ or LAB). For the rendering and adjustment of materials
displayed on the screen to be consistent with the colors and the shades of the real materials, it is
essential to work in a defined colorimetric space. Patchwork 3D provides tools for defining, installing
and managing the colorimetric profiles of the workspace, of imported images and of images produced
by the software.

Rendering Tab
This tab gathers in two boxes the parameters for the options of the OpenGL engine and the raytracing
engine.

OpenGL Engine Options
The Hardware Antialiasing controls the behavior of the antialiasing system of the application used to
delete image aliasing effects. Depending on the video card used, it is also possible to disable the
hardware antialiasing, or to enable it with different qualities (2x, 4x, 8x, 16x, 32x, 64x).
The antialiasing is enabled in both interfaces, Matter and Shaper, by default. If you do not wish to view
the effects of the antialiasing, you can increase rendering speed in Shaper by deactivating antialiasing
for Shaper only. To do so, uncheck the box Available in Shaper.
The Default Depth Policy sets the depth buffer. If the default policy Frustrum based does not meet your
needs, you can choose between the options Look-At point based and Fixed depth range. This latter
option allows you to provide personalized values for the minimum (ZMin) and maximum (ZMax) depths.
The Display Zone sets the default maximum resolution for viewports. Three options are available: Main
screen, Maximum dimensions or Cover all screens. Respectively, these options apply the resolution for the
main screen, the greatest height and greatest width of the available screens, or allow for the creation
of a viewport spanning all screens. When a viewport is displayed in a zone larger than its maximum
resolution, black bars are added to compensate for the difference between the maximum resolution
and the larger display resolution.
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I have an Alioscopy display telling Patchwork 3D that you are using an alioscopy screen that displays 3D
in relief without using glasses 3D. This activates the alioscopy options in Matter to adjust the number
of renderings that Patchwork 3D must calculate per image to have the 3D in relief on the screen.

Raytracing Engine Options
This zone permits the CPU resources to be allocated to the raytracing engine to be defined. Three
options are available: Use all CPU cores, Use all CPU cores but one, and Manual thread count.
The Tile size in pixels can also be set. During the calculation of a rendering via raytracing, the image
is rendered and displayed tile by tile in the viewport. The smaller the blocks are, the more fluid the
display will be, but the rendering time will also be longer. The height and width of these square tiles
corresponds to the number of pixels provided in this field.

User Preset Tab
Patchwork 3D provides the ability to add your own preset values to certain lists in the interface.
Modifications to preset values are reflected in the list of presets as soon as they are entered. The
preset lists are then saved in the Windows registry when you click OK and close the Settings editor.

Fresnel Value Presets
Used as shortcuts to load Fresnel values when setting up standard or multilayer materials, these values
are listed by name in the preset list found in the Reflection tab of the Materials editor. You can access
this list by clicking on the

button next to the Fresnel values.
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To create a new preset, click on

.

To modify an existing preset, click on the corresponding line in the list of presets. Then, modify the
Name, Refraction index, and Extinction coefficient values, or delete the preset by clicking on

.

Deleting or modifying a Fresnel preset has no effect on the materials whose Fresnel values were
initialized using a preset.
For additional information on the use of the Fresnel effect, see:
• Standard Material

Snapshot Dimension Presets
Used to define the size of a snapshot created with the Snapshot editors, these presets appear at the
end of the list of available snapshot formats in any of the Snapshot editors.
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To create a new preset, click on

.

To modify an existing preset, click on the corresponding line in the list of presets. Then, modify the
Name, width, height, and units (available for modification if you have ticked the checkbox Defined with
units), or delete the preset by clicking on the

button.

Deleting or modifying a snapshot dimension preset has no effect on snapshots added to the Snapshot
Batcher whose dimensions were initialized using a preset. If the preset used was deleted or modified,
the original values of the preset will be applied using the format User-defined or the format User-defined
with units.
For additional information on snapshot dimensions, see:
• Dimensions of the Media Output [139]

Measurement Units
Patchwork 3D has numerical fields for physical lengths which show the unit the value is expressed in
and allow it to be modified.
These measurement units are contextual parameters, so it is possible to use a different unit for each of
the following categories:
• Geometry (shape of surfaces, placement in the scene, etc.),
• Geometric detail (various tolerances: stitching, etc.),
• Image (image size, screen size, etc.).

NOTE
The preferred unit for each category is recorded in the database.
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SHAPER
This chapter describes the overall operation of the Shaper module.

Shaper Graphical Interface

The Shaper interface is constructed around a system of interactive 3D views. By default, four views
are displayed: the top, front and left views, configured in wireframe display, and a perspective view,
configured as a solid display.
One of the four 3D views is active: it is surrounded by a zone displayed with highlighting (in the above
image, the perspective view is active). In Shaper, the view-configuration options are applied by default
to the active view.
Each view represents the 3D model that is being edited. Displaying a grid and the 3D view cube of the
model helps you understand the orientation of these views. Each view displays the projection mode
used in its upper left corner: front view, top view, back view, and perspective view.
Shaper provides you with several tools for modifying the point of observation and the viewing method
used to represent the model in a 3D view: orbital movement about the model, viewing in wireframe
mode or in solid mode, isometric or perspective projection, etc.
As in most of the applications, a menu and a toolbar located above the 3D views provide access to
most of the functions of the application. On the right, a system of tabs gives access to the editing
modes of Shaper: Surface, Mapping, Pivot, Kinematics and Lighting.
A vertical panel just below presents the tools available in each editing mode selected with the tabs. The
above image shows the Surface editing mode of Shaper with the model, layer, and surface selectors.

Shaper Viewports
A 3D viewport is a rectangular window used to draw a 3D representation of the model that is being
edited.
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The representation of the model is determined for each viewport by a viewpoint (the position of the
observer) and by a center of interest (the point being observed). Several types of representation exist: a
wireframe 3D rendering gives a schematic vision of the model, whereas a surface 3D rendering gives a
more real and more intuitive impression of the surfaces and volumes.
Shaper offers you four independent 3D viewports. The parameters of each viewport can be modified to
facilitate the observation and editing of the model. One of the four viewports has a highlighted frame:
this is the active viewport. The viewport configuration operations are applied by default to the active
viewport. To activate a viewport, click on it with the left button of the mouse. By activating the Viewport
> Maximize Viewport menu item, the active viewport is enlarged to fill the whole workspace. You can
return to the four-view mode by deactivating the Viewport > Maximize Viewport menu item. This can also
be done by pressing the A key.
In Shaper , you can work directly on the 3D viewports using the mouse. Several operating modes
determine how the user can interact with the 3D environment with the mouse.

Configuring 3D Viewports
Shaper offers nine types of view:
View

Description

Perspective
view

This type of view is similar to the objective lens of a photographic camera: the
perspective deforms the surfaces as a function of the distance. An object viewed
far away is represented smaller than an object that is close to the viewpoint.

Isometric
view

Isometric views are used in industrial drafting: there is no perspective and the
dimensions are not modified by the distance to the viewpoint.

Top view

This is an isometric view alined on the axes of the model, showing the model
viewed from the top. The camera is placed on the Y+ axis.

Bottom view

This is an isometric view alined on the axes of the model, showing the model
viewed from the bottom. The camera is placed on the Y- axis.

Left view

This is an isometric view alined on the axes of the model, showing the model
viewed from the left. The camera is placed on the X- axis.

Right view

This is an isometric view alined on the axes of the model. The camera is placed on
the X+ axis.

Front view

This is an isometric view alined on the axes of the model. The camera is placed on
the Z+ axis.

Back view

This is an isometric view alined on the axes of the model. The camera is placed on
the Z- axis.

UVW Mapping view

This view shows the mapping coordinates of the model.

Interacting with the 3D Viewports
Shaper offers several operating modes for navigating in the 3D views. These modes are accessible from
the Mode menu.
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Icon

Mode

Behavior

Shortcut

Pan

Clicking and dragging in a 3D view allows you to slide
the viewpoint in the plane of observation. The center of
interest moves with along with the viewpoint.

Middle mouse button + drag the
mouse

Orbit

Clicking and dragging in a 3D view allows you to rotate
the viewpoint about the center of interest. The position
of the center of interest remains unchanged.

Ctrl+Middle mouse
button + drag the
mouse

Zoom

Clicking and dragging in a 3D view brings the viewpoint
closer to the center of interest, which has the effect of
magnifying the objects located in the field of vision.

Shift+Ctrl+Middle
mouse button +
drag the mouse

Zoom
region

Clicking and dragging in a 3D view draws a rectangular
region. When the mouse button is released, the view is
centered on this region. The direction of observation is
unchanged, but the viewpoint and the center of interest
are moved in relation to the new centered view.

Fly
Mode

Can be used with a perspective view only.

Walk
mode

Once this mode is enabled, navigation is in fly mode,
and by simply moving the mouse (without clicking),
you can make the viewpoint rotate about the center
of interest. A (continuous) left-button click or a (continuous) right-button click allows you to move forwards
or backwards, which has the effect of magnifying the
objects located in the field of vision. Click and dragging
allows you to fly around the object.
Can be used with a perspective view only.
When you enable this button, you go into walk mode,
and moving the mouse allows you to rotate the viewpoint about the center of interest. Clicking and dragging gives you the illusion of walking (forwards or
backwards) next to the object. Unlike Fly mode, in Walk
mode, the altitude of the point of view remains constant.

The Model > Zoom to Fit menu offers several tools that facilitate centering of the views:
Zoom type

Description

Zoom selection to fit in active
viewport

This modifies the center of the active view to view the selection in its entirety.

Zoom world to fit in active viewport

This modifies the center of the active view to view the model
that is being edited, in its entirety.

Zoom selection to fit in all to
viewports

This modifies the center of each view to view the selection in
its entirety.

Zoom world to fit in all viewports

This modifies the center of each view to view the model in its
entirety.

59

Patchwork 3D Enterprise 2022 X5

Configuring the Rendering in a 3D Viewport
The 3D rendering of the active view can be configured to modify the representation of the model that is
being edited.
The Viewport > Render menu gives access to seven rendering modes:
Icon

Render Mode

Description

Wireframe

The surfaces are represented schematically with plotting following
the lattice structure of each surface. The surfaces are not mutually
masked.

Smooth

The surfaces are shown smoothed out with solid faces, lit by soft
lighting.

Smooth and
Highlights

The surfaces are shown smoothed out, as solid faces with a specular
reflection.
This is the default render mode.

Facets

The surfaces are represented by their lattice structure, not smoothed
out, as solid faces lit by soft lighting.

Facets and
Highlights

The surfaces are represented as a solid lattice structure, not smoothed out, as solid faces with a specular reflection.

Lit Wireframe

The surfaces are represented by an illuminated wireframe plot of their
lattice structure.

Bounding Box

Each surface is represented by the wireframe plot of its bounding box.
This rendering mode facilitates the handling of surfaces that have
lattice structures comprising a large number of triangles.

Wireframe view.

Smooth view.

Facets view.

Bounding Box view.
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Several options available from the Viewport menu modify the appearance of the rendering:
Option

Description

Edged Faces

The lattice structure of the surfaces is represented as a wireframe 3D rendering
overlaid on the surfaces.

Track Culling

The hidden faces (oriented away from the observer) are shown in bright red.
This mode facilitates the identification of the surfaces that are not properly
oriented.

Ignore Backface Cull

Enabled by default, this option enables the optimization of the rendering, which
removes the faces oriented away from the observer.

Other viewing aides are available from the Visualizationmenu:
Viewing Aide

Description

Head up display

Shows the number of surfaces, triangles, and points selected in the view.

Grid

Displays a reference grid that facilitates understanding of the 3D viewport. The
grid is enabled by default.

Axis orientation

Displays the indicator of the different axes for the model in the bottom left
corner of the window. This option is enabled by default.

Antialiasing

The anti-aliasing improves the visual quality of the 3D rendering by deleting the
aliasing effects caused by screen pixels. You have the possibility of modifying
the anti-aliasing configuration in the Patchwork 3D rendering settings [53].

Demonstration of the smoothing produced by the antialiasing algorithm.

Accessing the Viewport Context Menus
Each view contains a menu, accessible by right-click in the display on the name of the view type (i.e.
perspective, bottom, left) in the top left corner of each view. You can also access a second menu
with a right-click at the center of each view, that combines the most commonly used functions of the
application.

Selection Visibility Modes
Two options modify the behavior of Shaper for displaying a model that is being edited without affecting
the attributes of the surfaces:
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Icon

Option
Edit menu > Show Selected
Only

Description
When this option is enabled, only the selected surfaces
are visible. The selected surfaces are represented as unselected surfaces to facilitate viewing.
The selection is locked to prevent errors: you can no longer modify the selection with the mouse. This mode is
particularly helpful when it is necessary to isolate a subset of surfaces in a complex model: enable this option to
momentarily isolate the selected surfaces and check the
consistency of your selection. You can use the keyboard
shortcut associated with this menu entry to quickly enable and disable this option (S key by default).

Edit menu > Shade Selected

When this option is enabled, the selected surfaces are
represented with smooth rendering in the views where
you are using wireframe shading.

Manipulating Shaper Objects
Selection
A selection is a group of surfaces designated by a user in the model being edited.
Selected surfaces are represented in a 3D viewport with green highlighting. One of the surfaces is
designated as the leader. It is represented with white highlighting. The leader surface is used for
various operations that require the identification of a single surface within the selection.
The Shaper interface offers three methods to modify the selection of surfaces:
• By selecting surfaces with the mouse directly from the graphic representation in the 3D viewport.
This uses the Selection [64] mode.
• By enabling one of the operations affecting the selection from the menu or the toolbar.
• By using the surface selector that can be found in the layer selector in the Surfaces sidebar tab in
Shaper.

Actions available from the context menu
Once you have defined a selection, you can use
Freeze Selection, available from the context menu
that appears when you right-click in the viewport. The current selection will be locked. To keep you from
modifying it and to make it easier to manipulate this selection, the tools for selecting and deselecting
objects are deactivated until you unfreeze the current selection by selecting Freeze Selection again.
Still by right-clicking, the Select a surface under cursor lists the different types of selection:
• The Advanced Selection Under Cursor opens a window allowing you to select a surface under the
cursor. This option is useful when a product has several overlapping surfaces.
• The saved selections. You can find them in the Saved selections tab of the Selections (Editor) [204].
• The surfaces under the cursor.
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The context menu also allows you to resize the selected surface(s) with Scale Gizmo
how the scaling gizmo [67] works to apply the transformation.

. Please refer to

Modifying the Selection Using Menu Operations
Operations for modifying the selection are available in the Selection menu:
Icon

Function

Description

Select All

Select all the surfaces of the model.

Invert Selection

Invert the selection: select all unselected surfaces and deselect
the surfaces that were previously selected.

Select None

Deselect all surfaces.

Selection by type

Select surfaces by type.

Selection by lighting

Select surfaces with or without lightmaps.

Surface Selector
The surface selector is placed under the layer selector in the Surfaces panel of the Shaper sidebar. It
shows the list of surfaces associated with the current active layer. Each surface is represented by its
name and three boxes characterizing its state: visible, frozen, or selected.
The color of the first box corresponds to the color of a surface in the 3D viewport.
The second box corresponds to the visibility of the surface. An eye
surface. When the eye is barred and grayed out

represents the visibility of the

, the surface is not visible.

The third box indicates whether the surface is frozen or not. This condition is represented by a lock
. When the lock is closed and red
deselected.

, the surface's selection state is locked. It cannot be selected or

The fourth box corresponds to the surface selection. When the checkmark is highlighted in white, the
surface is selected. A green checkmark indicates that the tessellation for the selected NURBS surface
can be modified.
At any moment, you can modify the state of a surface by clicking on the boxes.
A few operations are directly accessible from the surface selector via the icons and the options menu.
To open the options menu, place the mouse pointer on the designated surface and right-click on it.
When an operation is called up directly from the surface selector, it applies to all the surfaces that are
highlighted in the surface selector.
You can mark or unmark a surface with a Ctrl-click on its name in the surface selector. You can extend
the marking to other surfaces by Shift-click on their names. You can cancel the marking by clicking in
the selector outside the surfaces.
Certain operations are available from the selector's context menu.
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At the bottom of the surfaces selector, tools allows you to duplicate the marked surfaces, to send the
marked surfaces to the active layer, to call up the properties box for the marked surfaces, or delete the
marked surfaces.
You can move the marked surfaces to another layer with a drag and drop of the marked surfaces to the
destination layer.
By clicking on one of the column headers of the surface selector, you can modify the sorting used for
displaying the surfaces: sorting by name or sorting by box.

Selection Mode

The Selection
operating mode (F2) allows you to interact directly with the 3D surfaces to modify
the selection. Please refer to the selection [62] for more information.
Function

Shortcut

Select a single surface

Click on the surface.

Add a surface to the selection

Shift + click on the surface.

Remove a surface from the selection

Ctrl + click on the surface.

Cancel a selection

Click anywhere in the background of a viewport.

By holding the mouse button down and moving the mouse cursor, you plot a rectangular region.
When you release the mouse button, all the surfaces that are visible in this region are included in the
selection operation.
Function

Shortcut

Select all surfaces in a region

Click and drag the mouse pointer in the viewport.

Add all surfaces in a region to the selection

Shift + click and drag the mouse pointer in the
viewport.

Remove all surfaces in a region from the
selection

Ctrl + click and drag the mouse pointer in the viewport.

Cancel a selection

Click anywhere in the background of a viewport.

The different selection methods are as follows:
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Icon

Function

Description

menu Selection > Touched
by Region ( F3 )

By default, the selection system is configured to designate
all the surfaces contained or partially contained in the
designated region during the click and drag.

Selection menu > Enclosed
by Region (F4)

Only the surfaces that are fully contained in the region are
designated during the click and drag. This operating mode
is particularly advantageous when you wish to designate
the surfaces of a more complex assembly.

Selection menu > Restrict
Region To Visible

Only visible surfaces contained in the region are selected
when clicking and dragging. This procedure is particularly
useful to avoid accidentally selecting surfaces hidden by
other surfaces.

NOTICE
This selection mode works in conjunction
with the other two selection modes Touched
by Region and Enclosed by Region.

Restrict Region to Visible enabled

Restrict Region to Visible disabled

Manipulating Surfaces
Gizmos
Patchwork 3D includes gizmos that make it easier to manipulate 3D objects in space. They appear
automatically as an overlay on the selected as soon as the gizmo of Translation
Scale is enabled.
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To move an element along an axis, click the part of the gizmo that represents the movement axis and
drag the mouse in the desired direction. To rotate an element, the movement axis is either up-down or
left-right. The farther you drag the mouse along this axis, the greater the angle of rotation will be.
The operation is the same for both types of movement (translation and rotation) and for scaling:
• If it is a single selection, the movement or scaling will be done in its transformation frame.
• If it is a multiple selection, two options are possible depending on the chosen mode:
• each modification (movement or scaling) will be done in the leader's frame,
• each modification (movement or scaling) will be done in its own frame.

TIP
When you hold down the Alt key, the selected element moves at a preset pitch. The value
of this pitch can be customized (see the section on setting step values in the chapter
Positioning Surfaces from the Main Interface [68].
A numerical indicator placed close to the gizmo shows the value applied to transformation in real-time.

Translation movement

Rotation movement

Scaling

Translation
The translation gizmo

lets you move surfaces by clicking + dragging on the selection.

Translation Gizmo.
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Rotation
allows the orientation of surfaces to be modified by clicking and dragging the
The rotation gizmo
selection. This operational mode works similarly to the translation gizmo: you can modify the selection
with the same mouse and keyboard combinations.
When the mouse is moved along an axis (up-down or left-right), the selected surfaces rotate around
one of the axes of their referential.

Rotation Gizmo.

Scaling
The scaling gizmo

allows you to resize the selected surfaces by clicking + dragging on:

• the axis of the gizmo, the resizing of the surfaces will then be constrained to the selected axis (X, Y,
or Z).
• the plane of the gizmo, the resizing of the surfaces will then be constrained to the selected plane
(horizontal, vertical, transverse).
• the central cube, the resizing of the surfaces will be uniform on the 3 axes at the same time.
A surface is moved in relation to its transformation referential. The center of the referential is placed
over the surface's pivot.

Translation Gizmo.
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Transformation Tools
The drop-down menu in the top toolbar establishes the transformation referential and contains four
options: Screen, View, World and Local.
Referential
option
Screen

Description
The transformation referential is aligned with that of the screen on the XY plane.
Moving a surface in XY occurs on a plane parallel to the screen and passing
through the surface's pivot.

View

For orthographic views (top, bottom, left, right, front, and back), the behavior is the
same as for the Screen orientation.
For isometric and perspective views, the behavior is the same as the World orientation.

World

The transformation referential is aligned with the axes of the model.

Local

The transformation referential is aligned with the local referential of the surface.
In this mode, the transformation referential is identical to the pivot [252].

Moving a surface occurs in three dimensions along the transformation referential, although the cursor
is moved on the plane of the screen in two dimensions. The movement of the mouse is therefore not
sufficient to determine the 3D movement of a surface. This is why moving a surface is limited to one or
two selected dimensions via the transformation referential.

Surface Visibility and Frozen States
Shaper provides three operating modes that allow you to quickly modify the visibility and the frozen
state of surfaces:
Icon

Function

Description

Click to Hide

Click on a surface to hide it.

Click to Freeze

Click on a surface to freeze it.

Click to Unfreeze

Click on a surface to unfreeze it.

Positioning Surfaces from the Main Interface
Patchwork 3D includes an area in its interface specifically for editing the positions of surfaces. This
editing area is beneath the 3D viewports in the workspace. It allows for directly entering numerical
values for the position of surfaces relative to axes X, Y and Z.

Editing area dedicated to surface positioning.
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The toggle button Enable user input for absolute coordinates
in the toolbar is for displaying or
hiding this editing area. Entering numerical values for these parameters is only possible when a surface
is selected.
The toggle button Keep Ratio of the Scale box affects the scaling behavior of selected surfaces. You
can indeed choose to keep the same dimensions on all axes (X, Y, and Z) and to have a uniform scaling
or on the contrary choose not to have a uniform scaling on the three axes (X, Y, and Z) . Here you
will find explanations on how the scaling [67] works.

Coordinates in World Reference Frame
The Translation and Rotation boxes are for specifying the surface’s translation coordinates (TX, TY, and
TZ) and the rotation orientation (RX, RY, and RZ) of the selected surface’s pivot relative to the World
frame. The selected surface remains fixed relative to its own pivot.

Initial position of the cube’s pivot.

Intermediate position of the cube’s
pivot after entering coordinates
TX=0.5 m and TZ=-0.3 m.

Final position of the cube’s pivot after
entering angular coordinate RZ=10°.

NOTE
In the Pivot mode, translation and rotation tools affect pivots only instead of affecting
surface-pivot couples, which they do in the other modes.

Coordinates in the World Reference Frame for the final position of the pivot shown in the previous figure.

Coordinates Relative to Parent's Pivot
The Translation and Rotation boxes are for specifying the position coordinates (TX, TY, and TZ) of the
pivot’s origin and the angular coordinates (RX, RY, and RZ) of the pivot for the surface selected relative
to the pivot of its parent in the kinematics chain.
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Positioning the blue cube's pivot relative to the parent surface's pivot, the green cube’s.

When no parent is defined for the surface selected, the values entered are considered to apply to
coordinates in the world frame reference like in the first box.

Relative Translation and Rotation
The function Enable user input for relative rotation or translation
may be accessed only when either
the Translation or Rotation gizmo is activated. It displays the Relative translation or rotation dialog box.
The value by which the surface selected is translated relative to the frame of the gizmo displayed is
entered in fields TX, TY, and TZ. The value by which the surface selected rotates relative to the axes of
the frame of the gizmo. The frame of the gizmo depends on the frame of reference selected.

The cube's translation gizmo origin is located at XX X=-0.4 m (on the left). A translation of 0.3 m in the direction of the World frame’s
X axis is applied to the cube (final position on the right).
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Applying a Transformation to a Selection of Surfaces
Two modes exist to apply a transformation to a selection of surfaces:
Transform selected surfaces regarding the pivot of the leader of the selection
: the transformation is
applied to all selected surfaces relative to the selection leader (displayed in white).
Transform selected surfaces regarding their own pivot
surface relative to its own pivot.

: the transformation is performed for each

A selection of surfaces. The selection leader is displayed in white.

Rotation applied to the surface selection presented in the previous figure relative to the selection leader's pivot (left) and relative to
the surfaces' individual pivot (right).

Defining the Step Values
The box on the right side of the area dedicated to positioning surfaces allows users to define fixed
increments of movement or rotation for using the gizmos while holding down the Alt key.

Steps box for specifying the step values (outlined in yellow).
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MATTER
This chapter describes the overall operation of the Matter module.

Matter Graphical Interface
Matter is designed on the multi-document application model. It manages the simultaneous editing of
several products. These products are accessible via tabs.

The graphic interface of Matter is organized into three functional zones:
• Menu/Toolbar: Visual regrouping of the various operations that are available according to the concepts handled.
• Workspace: Region receiving the various views.
• Sidebar: Organization of the tools in tabs.
• Product tab: This tab is specialized for managing geometry and data. It also contains the product
library.
• Library tab: This tab groups together the libraries containing the visual elements used in developing a product. These elements can be edited and managed from their respective libraries.
The Library tab consists of seven libraries presented as sub-tabs: material, texture, environment, background , overlay, post-processing and sensor.
This is the core of Matter: it is here that the textures and materials are created.
• Explorer tab: This tab allows you to explore external libraries and to import the materials, textures,
backgrounds, environments, overlays, post-processing blends and sensors saved on your computer
or in other locations external to the open P3D database.
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Collision Detection System
The collision detection system in Matter enhances the immersive experience when observing 3D
scenes. When a scene is explored using either Walk or Fly modes, the collision detection system
prevents the observer from passing through surfaces.
Collision detection includes two functions: Collisions and Prevent Collisions with Transparent Surfaces.
Icon

Function

Description

Collisions

This function disables the passing of the camera through the surfaces of the scene during its movement. The camera is deflected
along the surfaces.

Prevent Collisions with Transparent Surfaces

This function is available only if Collisions mode is enabled.
It modifies the effects of the Collisions function by allowing the
camera to pass through the transparent surfaces of the scene.

Matter Viewports
In Matter, a viewport is a movable window confined in the workspace. The number of viewports is not
set. You create them as needed by loading products in the workspace by drag-and-drop. A viewport
enables you to interact with the product or products that you are editing. Each viewport consists of a
list of tabs for rapidly selecting an open product, and a large interaction and viewing zone. Like in the
Shaper module, Matter viewports can be maximized. To do so, use the tools in the top right corner, as in
Windows.
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Importing an Object into the Active Viewport
The viewport is your means of editing a product. You can easily create viewports by:
• Dragging and dropping a model onto the workspace.
• Dragging and dropping a group of products onto the workspace.
• Double-clicking on a product.
• Ctrl + dragging and dropping a model onto a viewport.
• Ctrl + dragging and dropping a group of products onto a viewport.
They can also be created using the product tabs in an existing viewport by:
• Ctrl + dragging and dropping a tab onto another viewport.
• Dragging and dropping a tab onto the workspace.

TIP
Shift+Ctrl + dragging and dropping maximizes the new viewport in the workspace. Ctrl +
dragging and dropping cancels the maximization of the current viewport and creates a
new viewport.
Similarly, tabs in a viewport are created by:
• Double-clicking on a product in the Matter sidebar's product library.
• Dragging and dropping a model onto the interaction zone. The Matter module will automatically
create a new product.
• Dragging and dropping a product selection onto the interaction zone.
To select the product to be edited (active product), simply click on a tab, and to delete it, click on the
close tab

button.

When closing the last tab associated with the product (a product may be present in several viewports),
the Matter module captures a representation of the product and updates the product's thumbnail image
in the sidebar.

Interacting with the 3D Viewports
These interaction modes are available from the Mode menu.
Matter has several interaction modes:
Icon

Mode

Behavior

Shortcut

Pan

Clicking and dragging in a 3D view allows you to slide
the viewpoint in the plane of observation. The center of
interest moves with along with the viewpoint.

Middle mouse
button + drag
the mouse

Orbit

Clicking and dragging in a 3D view allows you to rotate the
viewpoint about the center of interest. The position of the
center of interest remains unchanged.

Ctrl + Middle
mouse button
+ drag the
mouse
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Icon

Mode

Behavior

Zoom

Clicking and dragging in a 3D view brings the viewpoint
closer to the center of interest, which has the effect of
magnifying the objects located in the field of vision.

Camera
Roll

This mode rotates the product relative to the center of the
screen.

Focal
Angle

This mode is similar to the zoom ring on a photo lens: it
changes the field of view. The more the lens is opened, the
smaller the product appears. If you approach too close to
an object, it disappears.

Fly
Mode

As soon as this mode is enabled, navigation is in fly mode,
and by simply moving the mouse (without clicking), you
can make the viewpoint rotate about the center of interest.
Clicking and holding down the left or right mouse buttons
allows you to move forwards or backwards, respectively,
which has the effect of magnifying the objects located in
the field of vision. Click and dragging allows you to fly
around the object.

Walk
mode

When this mode is enabled, moving the mouse allows
you to rotate the viewpoint about the center of interest.
Clicking and dragging gives you the illusion of walking (forwards or backwards) next to the object. Unlike Fly Mode,
in Walk Mode, the altitude of the point of view remains
constant.

Head
Mode

When this mode is enabled, moving the mouse (without
clicking) allows you to make the world turn around the
point of view.

Shortcut
Ctrl + Shift +
Middle mouse
button + drag
the mouse

Shift + Middle
mouse button
+ drag the
mouse

Some of these modes (Flight, Walk, Focal Angle) can only be used with a camera with a perspective
view.

TIP
The shortcut Ctrl + Spacebar centers the camera by positioning the point on the surface
below the cursor at the center of the viewport.

TIP
The reframing operation Zoom to fit (Z), in the Camera menu positions the point of observation in order to view the product as a whole while at the same time maintaining the
direction of observation.

Accessing the Viewport Context Menus
Each viewport offers a context menu accessible by right-clicking on the display of the type of view in
the upper left-hand corner of each viewport. This menu provides access to the render configuration
settings.
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Additionally, you can reach a second contextual menu by right-clicking on the center of the viewport.
This menu groups together the application operations that are most often used in viewports.

Configuring the Rendering in a Viewport
The viewport context menu allows you to choose the type of view in the View submenu.
In the submenu Render, you have access to the eight render modes.
The Render Presets allow you to activate one of the three default modes, Default, Fastest, and Nicest. If
you choose, you can also define a new render preset to have it added to this menu for easy access.

Linking the Updates of the 3D Viewports
Accessible from: Matter : Viewport > Link
To facilitate the comparison of products spread among separate viewports from the same viewpoint
(interactive comparison), the Matter module has a viewpoint synchronization mechanism. Thus, when
the viewpoint of the active viewport changes, the other views are informed and can update their
viewpoint under certain conditions:
Icon

Type of
link

Description

None

No updating of the point of view between viewports.

All

Update all viewports to correspond to the point of view in the active
viewport.

Model

Update all viewports containing products based on the same model. This
way, all of the products obtained from that model are observed at the
same angle.

Link Interactively

Enabled by default, this mode allows synchronized viewports to be updated while you are interacting with them.
However, for very heavy scenes, this interactive synchronization is detrimental to the smoothness of movement. When this option is disabled,
synchronization is possible only at the end of a phase of interactive manipulation.

Grid and Axis Orientation
A grid of a set size serves as a reference and can help improve the understanding of volumes within a
3D viewport. This grid is available under Visualization >

Grid.

Similarly, a reference icon illustrating the placement of the axes in the direction of observation is
available under Visualization >

Axis Orientation.

Render Statistics
The

Render Statistics are available from the Visualization menu.
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This option displays data related to rendering delays, the number of surfaces, summits and triangles
processed, and the GPU memory used.
The consumption of GPU memory is displayed as a gauge for the following elements:
• The images and videos used as textures and rendered in the active viewport,
• The meshes rendered in the active viewport,
• The textures used to calculate relief (bumpmaps) that are rendered in the active viewport,
• The lighting environments rendered in the active viewport,
• The lightmaps calculated in Shaper and used during the rendering in the active viewport,
• Other: other sources of GPU memory consumption, including database resources that are not used in
the active viewport, other open software, and the memory reserved by the graphics card's driver,
• Free: unused GPU memory.

Full Screen Mode
Accessible in: Matter : Visualization > Full Screen Mode

TIP
Keyboard shortcut Y
The Matter module has a Full Screen mode. In this mode, the viewing and interaction zone of the active
view occupies the maximum amount of space available for the Windows applications.
The interface of Patchwork 3D is no longer accessible, but the floating editors maintain their visibility
and their position.
As the tabs are no longer visible, product selection is performed via the Next tab in active viewport (S)
and Previous tab in active viewport (Q) operations.

Floating Viewport of Matter
Available in : Matter: Visualization > Floating Mode

In Matter, click on the Undock the viewport
button on the upper right corner of the viewport to detach
the viewport and use it as a floating window. All its interest lies in the fact that it stills visible in
Shaper. You could use Matter's viewport on a monitor and Shaper on another if you have, for example, a
two-display workstation.
The interest of Matter's floating viewport is multiple.
• Such as doing an unfolding with the Unfolding/Stitch Workshop from Shaper and checking, for example, that your unfolding in Matter meets your requirements.
• Create a scene by moving multiple geometries in Shaper and interactively checking in Matter the
result.
77

Patchwork 3D Enterprise 2022 X5

• Change the light sources of a scene from Shaper and interactively see the changes in a floating
viewport of Matter for an Iray rendering.
You will have understood that the limits of creation are only limited by your imagination.
Click the button again

to dock the floating viewport of Matter. The floating viewport of Matter will

automatically dock into Matter module accessible from this icon

.

TIP
Matter's keyboard shortcuts are also accessible in the floating viewport of Matter, even if
you are in Shaper module. However, not all editor features are supported.

Modifying Default Properties
Click on the Viewport Properties
button at the top right of a viewport to modify the viewport
properties. This opens the editor for Viewport Properties.
By default, clippings planes are visible in viewport according to the settings used in the Clipping
Planes [185] editor. This behavior corresponds to the No override property.
You can force clipping planes to be enabled or disabled in this viewport by selecting the desired option
from the drop-down list.

Unlinking from the Shaper Configuration
Click on the Link Configuration
button at the top right of a viewport to enable or disable the
configuration link to Shaper for this viewport.
By default, the configuration in each Matter viewport is linked to the configuration in Shaper. The
configuration in each viewport is not independent.
When linked to the Shaper configuration, this viewport will show the current configuration for geometry
layers, position layers, and lighting layers as set in Shaper. When this viewport is modified, it will
change the configuration in Shaper. Any modifications to the configuration displayed in Shaper will be
shown in this viewport when you return to Matter.
If multiple viewports are linked to the Shaper configuration, changing the configuration for geometry
layers, position layers, or lighting layers in one of the viewports will cause the same change in all other
viewports linked to the Shaper configuration.

Viewport Rendering Modes
Patchwork 3D offers eight rendering modes.
The first modes, Wireframe, Fill, UV and Lightmap, provide a view in Matter of certain Shaper elements:
tessellation, Shaper colors, mapping UV coordinates, and lightmaps textures, respectively.
The Material mode displays a rendering of the Matter materials.
The Mix mode displays a mix of all of the previous modes.
The Z-buffer and the G-buffer are used to view the Patchwork 3D scene by showing the positioning of
the objects relative to one another and the distinction of the elements by surface group.
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These rendering modes can be accessed from the Render submenu of View in the Matter viewport.
Right-click on the name of the viewport to access the contextual menu.

Z-buffer is a viewing method making it easier to understand a 3D scene by using the information
relating to the depth level of the objects.
This view shows the various elements of the scene with respect to the viewpoint, in grey scale. The
closest objects are shown darker than the distant objects.

Material rendering mode.

Z-buffer rendering mode.

G-buffer is a viewing method for quickly discerning the various elements of a 3D scene by representing
them as single-color tones.
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G-buffer rendering mode

NOTE
In the G-buffer rendering mode, the color used to represent an object is the color that has
been assigned to the group of surfaces of this object in Shaper.
By combining these rendering modes with the post-processing effects, you can obtain many interesting
visual effects.

G-buffer rendering + "Edge detector" post-processing.

Managing Matter Resources
Dragging and Dropping Matter Resources
You can add materials files (.kmt), environments (.hdr), images (.jpg, .png, etc.), to the Patchwork 3D
libraries by drag and drop.
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Purging Unused Matter Resources
Patchwork 3D includes tools for permanently deleting unused resources. This allows you to optimize
the size of your Patchwork 3D files.
These tools take the form of buttons in the toolbars of the various Matter resource libraries in the
sidebar.
Icon

Description
Permanently delete unused materials.
Permanently delete unused textures.
Permanently delete unused backgrounds.
Permanently delete unused environments.
Permanently delete unused overlays.
Permanently delete unused post-processing blends.
Permanently delete unused sensors.

Listing Matter Resources
This function will inform you of all of the products in which a resource is used.
This function is available via the context menu for each resource. In the corresponding sidebar library,
right-click on the resource (material, texture, background, etc.) and select Usage List to display the list
of products in which the resource is used.

Purging Unused GPU Resources
Accessible in: Matter : Edit > Purge Unused GPU Resources
When products are opened in Matter, each of them consumes GPU resources even if the product is not
currently being modified. Materials, textures, backgrounds, environments, overlays, and post-processes
are stored in the memory. Closing a product’s viewport will free up the GPU resources assigned to this
product.
Another means of freeing GPU resources while keeping multiple products open in viewports is to use
the Purge Unused GPU Resources option by simply clicking the corresponding button
the Edit menu in Matter .

located in

External Library Explorer
This sidebar tab allows you to load and filter materials, textures, backgrounds, environments, overlays
and post processes from your local hard drive or network drive.
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By default, the external library points to the C:\Program Files\Lumiscaphe\P3D 2022 X5 \Library directory where you will find samples of materials and environments for your use. This directory
is organized into several sub-folders: Backgrounds, Environments, Materials, Overlays, Postprocesses, and
Textures.

NOTE
Each file format is filed away in its category, i.e. the material files are filed under the
Material tab, etc.

NOTICE
New Features in Patchwork 3D 2022 X5
It is possible to add one or more external libraries to Matter by clicking on the following icon . For
example, you could add a personal library with your own content or add another shared on the network
with your collaborators.

Example of adding an external library hosted on a server.
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NOTE
When adding a new library, Patchwork 3D may ask you to create subfolders when the
software detects that they are missing. We recommend that you let Patchwork 3D create
them for you (cf. Create the missing subfolder(s)). A library is only recognized by Patchwork 3D if it contains the sub-folders mentioned earlier in this chapter.
If a subfolder is missing from the library, right click on the missing resource and select
Repair library path, then indicate to Patchwork 3D the root of the external library. The
software will then ask you to create the missing subfolder, click on Create the missing
subfolder (s) to correct the warning .
To facilitate their identification, you can give an alias to the name of each of your external libraries by
clicking on . The directory name will not be changed.

Example of adding an alias to an external library.

From the explorer you can drag and drop elements such as backgrounds onto a product in a viewport.
This background will be automatically added to the already-existing library of backgrounds in the open
P3D database.
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EDITORS
In this chapter, you will find below the list of Patchwork 3D editors.

List of Editors in Patchwork 3D
Editor

Shaper

Matter

Usage

✔

available via the Timelines editor,

✔

assembles settings associated with the aspect
of 2D backgrounds

Camera Animations [88]
Backgrounds [94]
✔

contains advanced surface cutting tools

✔

contains advanced surface flattening (unfolding) tools

Surface Cutting Workshop [110]
Unfolding
& Stitch Workshop [96]
✔

creates animation sequences called "timelines"

✔

manages layers containing color and material
information, as well as saved groups of aspect
layer visibility settings

✔

✔

manages layers containing modified positions
for the geometric objects in the model, as well
as their visibility; object positions in the layers
can only be modified in Shaper

✔

✔

manages the hierarchical camera list, the favorite cameras for each product, and the settings
of the camera currently being edited

✔

available via the Timelines editor; sets up an
animation of almost any parameter related to a
product's aspect

✔

contains the settings associated with sensors,
including the assignment of backgrounds, overlays, and post-processing

✔

prepares and creates image files from Patchwork 3D rendering

Timelines (Editor) [115]
Aspect Layers [123]
Position Layers [127]

Cameras [128]
Channels [132]

Sensors [138]

Snapshots
(Images) [139]
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Editor

Shaper

Matter

Usage

✔

available via the Timelines editor; sets up the
animation element allowing the visible configuration to be changed

✔

✔

allows animated meshes and geometry animations associated with translation vectors or rotation axes, as well as timeline clips, to be
played back manually, one by one

✔

✔

defines the display rules for layers and groups
them into product configurations

✔

✔

analyzes GPU consumption and detects ways it
can be reduced

✔

manages lighting environment layers and environment properties per product (orientation, setup for use with the real-time sun)

Configuration
Keys [153]
Animation
Sliders [154]

Configurations [155]
GPU Consumption [157]
Product Environments [161]

creates tags and assigns them to objects or
groups of objects

✔
[165]

Tag Manager
✔

✔

displays the status (events, warnings, and errors) of an import

✔

available via the Materials editor; creates or imports gradients

✔

creates or modifies a lighting environment with
HDR Light Studio

Import Log
Gradients [166]
HDR
Light Studio (plugin) [217]
Imported File History

lists files that have been imported into the model currently being edited

✔
✔

provides a history of snapshots that have been
rendered with Patchwork 3D

✔

creates an image based on text, which can then
be used as a texture

✔

contains settings associated with the aspect of
materials

Rendered
Views History [170]
Text Image [172]

[174]

Materials
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Editor

Shaper

Matter

Usage

✔

creates associations between a click on a specific surface and a channel animation clip or
a timeline, for playback when Live mode is enabled

✔

allows a user to explore configurations set up
for a product

✔

prepares and creates VR objects

✔

measures the distance between two points in
the 3D space

✔

prepares and creates 360-degree panoramic
videos from Patchwork 3D rendering

✔

prepares and creates VR cubic panoramas from
Patchwork 3D rendering

✔

establishes the settings used by the raytracing
engine

Live
Mode [175]
✔
Configuration
Browser [178]
VR Objects [139]
✔
Measuring
Tool [178]
Panoramas [148]
Cubic VR Panoramas [139]
Raytracing
Settings [182]

allows minimums and maximums to be applied
to the calculation of surface tessellation (a CAD
import license option is required)

✔
Advanced Triangulation Parameters
✔

positions, displays, and modifies the display
settings of the clipping planes that bisect a
product

✔

contains the settings for a series of 2D postprocessing effects, from effect-specific settings
to the order in which effects are applied

✔

contains information concerning the color profile and the origin of the file

✔

can require a specific display behavior for clipping planes in the corresponding viewport

✔

displays and can edit the name of the model
and the display size for nulls

Clipping
Planes [185]
Post-Processing [188]
✔
Database
Properties [190]
Viewport
Properties
✔
ties

Model Proper-
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Editor

Shaper

Matter

Usage
displays and can edit the name of the product,
the disassociation of Shaper and Matter visibility states, and the rendering policy for backfaces

✔
Product Properties [199]

provides information on the surface or object
and manages associated options

✔
Surface Properties [195]
✔

contains aspect properties (material, stickers,
specific lighting environment) for a surface, by
aspect layer and by environment layer

✔

contains settings associated with a lighting environment, including its orientation and its alternate background texture

✔

lists and can modify keyboard and mouse shortcuts used in Patchwork 3D

✔

defines render mode presets in the viewport
and contains tools to limit, if necessary, extensive calculations during interaction with the
scene

✔

assembles rendering tasks for creating videos,
images, VR objects and VR panoramas for
which immediate rendering was not selected,
and runs batched rendering

✔

available in any editor where a color choice is
possible; contains a color selection widget and
means of managing a color palette

Surface Properties [197]
Environment
Properties [191]
✔
Keyboard
Map [200]
Render Quality Settings [201]

Snapshot
Batcher [179]
Color Chooser [205]

✔

contains advanced selection tools, including selection by type, selection by search, and saved
selection groupings

✔
Selections [204]
✔

✔

saves and calls up visibility states for geometry
layers and for surfaces

✔

displays and can modify the visibility state of
each individual geometry and lighting layer

✔

adds a sun-type lighting that can be set up and
modified in real time

✔

modifies the basic stereoscopy settings when
the stereoscopy mode is enabled

✔

contains the settings associated with the aspect of overlays

Layer Visibility Bookmarks [208]
Layer Visibility [215]
Real-Time
Sun [209]
Stereo
Overlays [214]
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Editor

Shaper

Matter

Usage
manages image, resolution, and color properties
for textures

✔
Textures [215]

manages the interactive tessellation of a
NURBS surface or group of NURBS surfaces (a
CAD import license option is required)

✔
Triangulation

prepares and creates video files from a timeline

✔
Videos [139]

Camera Animations (Editor)
Available in: Matter : Timelines > Camera Animations library tab > double-click on an animation name
Timelines > Camera track > double-click on a clip

Camera Animations is an editor that allows you to set up a camera animation by defining a camera path.
You have a choice between three different types of camera path:
• Kam File type,
• Bookmark Animator type,
• Bézier Curve Path type.
When open, the Camera Animations editor will always show the information for the current active clip in
the Timelines editor. To change the clip shown in the Camera Animations editor, select a different clip in
the Timelines editor :
• Click on the name of a clip in the camera animations list,
• Click on the representation of a clip in the Camera track,
• Create a new camera animation using the button below the camera animations list in the library. This
will create a new clip and activate it.
Rename your animation in the text zone at the top of the editor. It is recommended that you give each
animation a different name.

Kam File Type
If you have selected Kam File as your camera path, the scene will be animated according to an
existing animation path, which might have been created, for example, by the export of a bookmark
animation [89] as a .kam file. The Kam Files options are displayed in the Camera Animations editor.
In the box File you have access to the tools to:
Icon

Function
Import Kam File
Update Kam File
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Icon

Function
Export Kam Animation
Delete Kam Animation

In the Parameters zone, the Filename and the number of Frames are displayed for your information. In
order to convert from a frame-based kam file to a real-time animation, you must provide the Frame rate
here.
You can indicate whether the Fov, or Field of view, is expressed as a vertical or a horizontal value. You
can also opt to Ignore Fov value supplied by the .kam file.

Bookmark Animator Type
The Bookmark Animator type allows you to define a camera path passing by one or more animation
bookmarks that you set up in the animator. You establish the order of the bookmarks, the time spent
at each point, and the type of animation used to move from one point to another. The corresponding
options are displayed in the Camera Animations editor.
The Time Parameters zone concerns the global duration of the animation. Define the pauses between
bookmarks and the duration of each bookmark. The Total Time of the animation is calculated based on
this information.
Tick the Close Path checkbox to animate the transition between the last and the first bookmarks when
the animation playback is looped. This option is checked by default.
The Bookmark Sequence zone summarizes the animation bookmarks according to their order in your
animation list. It also provides the information concerning each bookmark as a step in the animation.
This zone offers multiple buttons to modify the list of bookmarks:
Icon

Function

Description

New Animation Bookmark

Adds the current viewport's view of the product to your list as
a new animation bookmark.

Update Animation
Bookmark

Replaces the selected bookmark with the current view of the
product.

Duplicate Animation
Bookmark

Creates a bookmark identical to the selected bookmark and
adds it to the end of the list.

Insert Active Camera
Set

Inserts the Cameras from the last active group in the Cameras
editor. The position and orientation of the cameras are imported as bookmarks and placed below the current selected
bookmark .

Import Bookmark Animation

Opens and loads bookmark animations previously saved
in .kba or .kam formats.

Export Bookmark Animation

Saves the current bookmark animation in KBA or KAM format.

Move Bookmark Up in
List

Moves the selected bookmark to position it higher in the list.
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Icon

Function

Description

Move Bookmark Down
in List

Moves the selected bookmark to position it lower in the list.

Convert to Bézier path

Creates a Bézier path for the camera animation described by
the bookmarks in the list.

Delete Animation Bookmark

Removes the bookmark from the list. Its settings will not be
saved.

The Bookmark zone concerns the set-up of the selected bookmark:
Parameter

Description

Checkbox

Includes the bookmark in the animation (checked) or excludes it (unchecked).

Label

Allows you to set or modify the name of the bookmark.

Sleep

Defines the duration of the pause of the bookmarked image.

Duration

Defines the duration of the animated transition to the next bookmark.

Smoothness

Sets the fluidity of the camera behavior.

Type

Type of path:
• Linear: sets a straight path (the rotation parameter fields are grayed out),
• Jump: moves from one stage to the next with no transition,
• Orbit: sets a circular path (the rotation parameter fields are accessible),
• Head: pivots the camera (the rotation parameter fields are accessible),
• Spline: smooths the transitions when the camera moves from bookmark to
bookmark.

Orbit/Head

Provides rotation parameters, which are modifiable if you have selected Orbit or
Head as the type):
• During... of step: percentage of the step dedicated to the rotation,
• turn…times: number of 360-degree turns to carry out.

Bézier Curve Path Type
For a Bézier Path animation, Camera Animations defines the behavior of the camera's position and
orientation as well as that of the camera target's position.
For the purposes of this editor, the camera is the position of observation, along with properties such
as zoom and camera angle. The target, or the point being observed, is the center of the viewport when
the scene is viewed using this camera. The center of the current active viewport at the time the clip is
created is used as the initial target position for the clip. However, you can set a different initial target in
this editor.
The camera's position, its target, or both can be animated by Bézier curve [396] path. Selecting an
option for each element allows you to set its behavior for this clip.
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TIP
To find the name of a curve, hover over it with your cursor. Its name is displayed in the
information bar at the bottom of the screen.
Position path options:
Position

Use

Settings

Follow Bézier
path

Choose this option to enable the drop-down menu. This
menu lists all of the Bézier curves created in your product. Select the curve you wish to use as the path for the
camera's position. The camera will move along the Bézier
path at a constant speed.

The button

Follow null

beside this option reverses
the direction of
the path.

Choose this option to enable the drop-down menu. This
menu lists all of the null objects in the product and is
available only if you have at least one null. A null constrained by Follow path to a Bézier path and animated by
channel animation serves as a moving tripod for the camera. The camera will move with the null object, respecting
the easing established by the channel animation.
The camera animation and the path constraint animation
must start and end at the same time in the timeline.
For more information see:
• Channels (Editor) [132]
• Animation Constraints [263]

Stationary

Choose this option in order not to animate the camera's
position.

The button

beside this option sets the
fixed camera
position using
the camera position in the active viewport.

Target path options:
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Target

Use

Follow Bézier
path

Choose this option to enable the drop-down menu.
This menu lists all of the
Bézier curves created in
your product. Select the
curve you wish to use as
the path for the camera's
target

Enabling Enhanced Transparency

Settings
The button

beside this option reverses
the direction of
the path.

Follow position
path

Choose this option to
have the target's position
be calculated automatically in order to precede
the camera along the
camera's position path.

Only available if you have
selected Follow Bézier
path as the Position path.

Follow null

Choose this option to enable the drop-down menu.
This menu lists all of the
null objects in your product. Select the object you
wish to use as the camera's target.

Only available if you have
at least one null. A null
constrained by Follow path
to a Bézier path and animated by channel animation serves as a moving
base for the camera's target.
The camera animation
and the path constraint
animation must start and
end at the same time in
the timeline.

Fixed direction

Choose this option to lock
the target's position in
relation to the camera
and prevent the modification of the camera's orientation. As the camera
moves along its path, the
target moves in exactly
the same way.

Only available if you have
selected Follow Bézier
path as the Position path.

The button

beside this option sets the relative target and
camera positions based on
the current relationship in the
active viewport.
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Target

Use

Stationary

Choose this option in order not to animate the target's position.

Enabling Enhanced Transparency

Settings
The button

beside this option modifies
the initial target
position by replacing the previous initial position with the
current center
of the active
viewport.
In the Duration field, provide the clip length in seconds.

NOTE
A camera animation by Bézier path provides a linear development of the camera and
target positions over time, and takes into account all of the curve as the path.

TIP
The start point along the curve is defined on the Bézier path itself. Right-click on the
curve where you would like to place the start point and select

Place start here.

Example: Creating a Rotor Animation
The "rotor" camera path with a ping-pong effect simulates the rotation of a product as if it had been
placed on a rotating pedestal whose center corresponds to the point at the center of the active
viewport. In other words, a rotor animation is a rotation around the Y axis at the coordinates of the ZX
plane at the center of the active viewport.
A rotor animation can be easily created using a bookmark animation camera path.
1.

Open Timelines and create a new camera animation.

2.

In the Camera Animations editor, give your animation a meaningful name, such as "Rotor Animation

3.

Choose the bookmark animator camera path [89] type.

4.

Position your product. The point at the center of the viewport will provide the ZX coordinates to
use as the central point of the rotating plane.

5.

Create a bookmark in the Camera Animations editor by using the New Animation Bookmark button
.
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6.

In the Bookmark zone, provide the following information:
• Duration : Enter the desired duration of the rotation in seconds.
• Type: Choose the value Orbit. This will create a rotor movement.
• Orbit/Head > During… % of step: Enter 100 to have the rotor movement occupy the full duration of
the bookmark.
• Orbit/Head > Turn… times: Supply the number of times to turn. For a rotor movement, this value
is usually between 0 and 1. 1 corresponds to a full rotation around the center point; 0.5, for
example, corresponds to half of a rotation around this point.

To implement a ping-pong effect:
1.

Place your animation clip in the timeline.

2.

Place a second instance of the same clip in the timeline, positioned so that it begins exactly when
the previous instance ends.

3.

Select the second clip by clicking on it.

4.

Using the mouse, right-click on your selection to open the context menu and select the option
Reverse playback.

TIP
To make the transition from one bookmark to the next during a ping-pong effect appear
more fluid, increase the Smoothness in the Camera Animations editor.

Backgrounds (Editor)
Available in: Matter: Editors > Backgrounds

Backgrounds
is a floating editor that allows you to create backgrounds and to change the
parameters of the active background.
The interface is organized into three zones:
• Operations bar and name of the active background: Displays operations available in the Matter
sidebar's background library.
• Gradient: Displays the controls and parameters of a color gradient background.
• ImageMap: Regrouping of the parameters concerning the superposition pattern.
The following buttons are present in the operations bar:
Icon

Description
Start point for dragging and dropping the background to assign it to a sensor or to a
viewport.
Enables an eyedropper for selecting the background used in a viewport in order to edit it.
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Icon

Description
Assigns the background being edited to the sensor in the active viewport.
Creates a new background.
Duplicates the background currently being edited.

In the Gradient zone, the gradient type of background can be enabled and the beginning and end colors
for the gradient can be defined. You can also.
• Lock the color

to force a solid color to be used as the background,

• Modify the Orientation of the gradient.
In the Map zone, you can edit the properties for an image type of background:
• The check-box next to the Map image allows use of the texture to be enabled or disabled.
• Drag and drop a texture from the Matter sidebar's texture library. This field accepts video textures.
Clicking on the name of the Map in use takes you to the current texture group in the Matter sidebar's
texture library.
• Check the Preserve texture aspect box to prevent the image scale defined in this editor from being
modified when the viewport is resized.
• Provide the Offset (position of the texture in the viewport), the Scale and the degrees to Rotate the
background texture.
• Lock the transformation scale
axes.

to apply uniform scaling of the texture's vertical and horizontal

You can combine an image with the gradient and configure the image's transformation to shift it using
the Offset values, repeat it with the Scale values, and rotate it.

95

Patchwork 3D Enterprise 2022 X5

First row: Solid background, gradient background. Second row: Using different values of rotation (left: 90 degrees; right: 180 degrees) to
orient the gradient.

Unfolding & Stitch Workshop
Available in:
Shaper:
• Via the upper toolbar

>

Display all visible surfaces or

Display selected surfaces

• Via the Edit unfolding/stitch for the selected surfaces menu for a multiple selection.
• Right click on a surface Edit unfolding/stitch for for a surface under the cursor or Edit unfolding/
stitch for the selected surfaces for a multiple selection.
Matter:
• Via the lower toolbar

>

Display all visible surfaces

• Via the menu Editors > Edit unfolding/stitch for the selected surfaces >
surfaces
• Via a right click on a surface Edit unfolding/stitch for

The Unfolding tab of the Unfolding/stitch Workshop is a tool that allows you to:
• set the UV mapping of complex surfaces by unfolding,
• cut the UV mapping of complex surfaces that need to be cut to flatten.

96

Display selected

Patchwork 3D Enterprise 2022 X5

The Stitches tab of the Unfolding/stitch Workshop is a tool that allows you to create and edit geometry
bands that support seams.

NOTE
The Unfolding/stitch Workshop is now non-modal, which means you can use it in Matter
as well. Any modification of a surface will be directly applied in Shaper and Matter. Unless
the checkbox Disable automatic update in Shaper and Matter is checked, in which case the
update is no longer done automatically. In this case, click on this icon
update the unfolding.

to manually

The unfolding workshop interface consists of four zones:
• The main toolbar,
• The 2D UV zone,
• The 3D Geometry zone,
• The edition zone that contains the following tabs: Unfolding and Stitches.

Main Toolbar
The main toolbar contains two buttons to display the selected or visible surfaces, as well as six
background texture options to make it visually easier to understand the unfold procedure that has
taken place.
: The Display selected surfaces button adds all selected surfaces in Shaper.
: The Display all visible surfaces button adds all visible surfaces in Shaper.
: The texture options change the background and surface texture for the
selected unfolded surfaces.
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: Checker

: Grid

: Frame

: Letters

: Rules

+

+

+

+

: The User-defined texture toggle is for enabling/disabling the background texture of your choice.
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: User-Defined
The procedure for loading a texture file of your choice is explained below in the User Texture [107]
subsection of the Surfaces section.

2D UV Zone
In the unfolding workshop interface, the UV-mappings obtained are displayed in the 2D UV zone. The
user can now adjust the unfolding of the surface directly from the 2D view by defining additional
constraints, or by modifying or releasing existing constraints. The position of the texture on the surface
is updated simultaneously, which allows the user to view the effects of the adjustments.

Icon

Operation
2D Translation Gizmo

Description
Adjust manually the unfolding in relation to the UV.
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Icon

Operation

Description

Pan

Pan in the 2D view.

Zoom

Zoom in the 2D view.

Edit control points

Adjust manually the unfolding in relation to the UV.

Background

Enable/disable the display of the background textures (see the
Main Toolbar [97] subsection).

Zoom Selection to Fit

Reframe the 2D view and center it on the selected unfolded
surface.

Auto Zoom Selection
to Fit

Enable/disable the automatic reframing of the view on the unfolded surfaces when they are selected.

Edit parametrization
margin

Open an editor for defining margins around the unfolding so
that it will be easier to use after export.

Show bounding-box

Enable/disable the display of the previously defined margins.

Export parameterization

Open an editor for configuring and then exporting the 2D image
of the unfold that has taken place. In this way you can use
your surface-unfolding work with graphic creation tools to edit
textures that are perfectly suited to the programming of your
surfaces.

Defining a Constraint
The user can convert the markers previously set on the surface in the 3D view into constraints either by
simply left-clicking in the UVW Mapping window or by using the Convert Markers to Constraints option
accessed by right-clicking in the 2D view.
• For a surface unfolded using the One-click option in the Hit Mode tab of the Surfaces panel, the three
vertices of the triangle the marker is set on will be converted into constraints.
• For a surface unfolded with the Multi-constraints option, the vertices of all triangles containing a
marker will be transformed into constraints.
• When a surface was unfolded with the Follow Boundary option, all vertices on the corresponding
boundary are converted into constraints.
These constraints are represented by green dots in the UVW mapping. Any point thus highlighted
represents a constraint.
Any point in the UVW mapping may be moved to create a deformation using the Select and Translate
tool from the 2D UV toolbar. The parameterization is updated in real time. Moving a point with no
constraint assigned to it defines a new constraint. The point is then highlighted.

Modifying a Constraint
To modify a constraint, the Select and translate tool must be activated. The highlighted point may be set
to another position by dragging it, thus modifying the constraint.
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UV mapping of a surface unfolded using the one-click method and corresponding 3D view.

UV mapping of the surface after an additional constraint was added and corresponding 3D view.

Releasing a Constraint
To release the constraint set on a point, the option Release Constraint on Selected Point must be chosen.
This option is accessible by right-clicking on the corresponding highlighted point.
All the constraints set on the UV mapping can be released at the same time by using the option Delete
all markers accessible by right-clicking in the UVW mapping view.

TIP
Right-clicking inside the UVW mapping window gives access to the two options Delete
All Markers and Convert Markers to Constraints. The third option, Release Constraint on
Selected Point, is only displayed by right-clicking on a highlighted point.

3D Geometry Zone
The 3D Geometry zone contains an interactive 3D view in which the surfaces to be unfolded and several
tools for unfolding and manipulating the surfaces are displayed.

101

Patchwork 3D Enterprise 2022 X5

The 3D Geometry toolbar changes its look depending on the following operation modes: Unfolding or
Stitch.
Icon

Operation

Unfolding

Sew

Description

Selection

✔

Select surfaces.

Move Marker

✔

Select and move a marker on the unfolded surface.

Zoom

✔

✔

Zoom in the 3D view.

Pan

✔

✔

Move around in the 3D view.

Orbit

✔

✔

Control the rotation of the 3D view in order to observe the surfaces from different points of view.

Set Render to
Texture

✔

View the background textures of an unfolded surface.

Set Render to
Deformation

✔

View a highlighted distribution of the physical
forces associated with the deformation of the unfolded surfaces.

Show Wireframe

✔

✔

Enable/disable the display of the surfaces' wireframe.

Zoom to Fit

✔

✔

Reframe and center the 3D view on of the surfaces
in the unfolding workshop.

102

Patchwork 3D Enterprise 2022 X5

Icon

Operation

Unfolding

Sew

Description

Zoom Selection to Fit

✔

✔

Reframe and center the 3D view on a selection.

Auto Zoom to
Selection to
Fit

✔

✔

Enable/disable the automatic reframing of the
view on the unfolded surfaces when they are selected.

3D Selection
Only

✔

✔

Limits the display of the 3D view to the surface
being unfolded. To return to a view of all selected
surfaces, click on this button again.

Show/Hide
seam curve
point for selected seam

✔

Show the seam curve points.

Show/Hide
seam mesh

✔

NOTE
By default, the seam curve points are
displayed.
Show the mesh of the seam.

NOTE
By default, the geometry band mesh
is displayed.

In the Unfolding tab, a right click on 3D Geometry Zone you can:
• Delete a marker,
• Insert New Marker After,
• Delete All Markers,
• Convert Markers to Constraints.

Edition zone
Unfolding tab
The Surfaces box contains an area for exploring the surfaces involved, and three menu tabs for configuring the methods for unfolds and viewing them.
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The area for exploring the surfaces lets you select the surfaces by their name and view the unfolding
method used. (The selected surface is highlighted).
Each surface can combine up to 32 separate unfolding sets. At the bottom of the box, Displayed UV
channel allows you to choose the set of UV targeted by the unfolding.
This zone is followed by several tabs which give access to the workshop settings.

Click Mode
The Click Mode tab provides access to the fast unfold general options.
Preprocess provides access to three types of preparation: None, Sew and Weld & Sew.
Preparation

Description

None

Uses the current topology of the surface.

Sew

Carries out a sewing operation on the edges.

Weld & Sew

Carries out a sewing and joining operation on the edges.

Find the description of the Surface Cutting Workshop
in a dedicated chapter. See the Surface
Cutting Workshop [110] for more information on how it works.
Welding Tolerance assigns a numerical value to the tolerance of the CV's when the Weld & Sew mode of
preprocess is selected.
Method provides access to three types of unfolding methods: None, Copy and Unfolding.
Method

Description

None

Remove and cancel the previous unfolding work.

Copy

Is used to retrieve an existing unfolding method. In Copy mode, the unfolding workshop offers the choice of currently-defined UV sets. A drop-down menu allows you
to browse the UV sets and select the most suitable set for unfolding the selected
surfaces.

Unfolding

Create an unfolding of the surface using the 3D view. Unfolding Properties: Technique
provides access to three different unfolding techniques: One click, Multi constraints
and Follow boundary. These techniques are described below.

TIP
The Quick Assignment mode must be enabled in order to execute an unfold operation and
view its representation (see "3D Geometry Zone [101]" above).
One click: is for creating a new unfold with just one click on the surface to be unfolded. The origin of the
unfold is on the surface at the precise location where the click has been made. With this technique, the
orientation of the texture is always positioned so that the y axis of the texture is parallel to the vertical
edges of the 3D view.
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Multi constraints: is for assigning several markers to the unfold so that it precisely follows the form of
the surface.

One click method.

Multi-constraints method.

TIP
It is possible to change the position of the markers at any time using the Move marker
tool (see "3D Geometry Zone [101]" above).
Follow boundary: is for constraining the unfold to a specific edge of a surface. Two markers are
necessary for this unfolding technique.
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One click method.

Follow boundary method.

The Auto centered option is for positioning the origin of the texture in the center of the surface,
regardless of where the click has been performed.

Auto-centered disabled.

Auto-center enabled.

Surface Properties
The Surface Properties tab provides access to the unfold options depending on the selected unfolded
surface.
: The Reset button is for re-establishing the initial unfold assigned to the surface.
The Parametrization frame provides the same unfolding options as in the Hit mode tab (see the Hit
Mode [104] Tab section).
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When the unfolding methods Multi constraints or Follow boundary are chosen, the placement of markers
that define the constraints are handled using the following buttons:
Icon

Function

Description

Place marker

Place a new marker at the clicked location on the selected surface

Delete all markers

Delete the markers created with the Multi constraints unfolding
technique.

Swap boundary
markers

Reverse the direction of the markers created with the Follow boundary unfolding technique.

Set

Confirm the adjustments made on the selected surface.

The UV Transformation frame is for positioning the texture using numerical values.
The Automatic centering option is for positioning the origin of the texture in the center of the surface.

User Texture
The User Texture tab provides access to the properties of a user texture.
: The Open texture button is for loading a texture from your documents.
: The Reload texture button is for updating the loaded image.
The Dimensions frame is for assigning metric values to the texture dimensions.
: The Reset texture dimensions button is for canceling the values assigned to the texture dimensions and for returning to the initial values.
The Preview frame is for viewing the image loaded for the texture.

Stitches tab
The stitch workshop creates geometry bands that support sewing materials to create realistic seams.

NOTE
Surfaces must be unfolded first if you want to use the stitch workshop. The following
icon helps you to identify unfolded surfaces. The UV column lists the channel on
which one or more seams were made. The Seams column gives the number of seams the
surface has.
Like the Unfolding tab, you can select the UV channel (Displayed UV) in which you want to stitch a seam.
The parameter For all surfaces allows changing the displayed UV channel for all surfaces.
Two stitching method are available:
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•

Free Draw Seam freely stitches the seam on the surface without constraints.

•

Follow Surface Boundary constraints the stitch to the surface boundaries.

You can adjust the Width of the geometry band which will serve as a support for the seam and set the
Offset from surface to move the seam just over the surface.
You can also set the Offset from boundary. This parameter is only available with the Follow Surface
Boundary stitching method.
The Precision in length parameter increases the number of points between the markers in the geometry
strip. Conversely, the lower the number of stitches, the more the seam will be straight. A straight seam,
for example, requires very few stitches (simple mesh), while a sinuous seam that hugs curved surfaces
generally requires a high number of stitches (complex mesh).
The Precision in width parameter increases the number of points between the markers in the geometry
strip. The higher the number of points, the more detailed the geometry strip will be. Conversely, the
lower the number of stitches, the more the seam will be straight. This parameter is very useful for
making concave or convex a strip of geometry that simulates a seam at the border of a material
(leather, fabric, etc ...).

Example a geometry strip with a width of 0.3 cm with the value of 20 for the precision in length and a value of 3 for the precision in
width.

TIP
It is possible to use the 2D UV and 3D Geometry zones whatever the stitching method
used to create the seams. The drawn of the seam points is done in the UV Mapping (2D
view). The drawn is automatically transferred to the 3D view. If some artifacts appear in
the 3D view, check the place points and move them in the 2D view accordingly.

Free Draw Seam
Add as many points as necessary to create your seam. It can be open or closed. If you need to make a
closed seam, right-click on the last stitch of the seam and select Close Selected Seam.
By a right-click you can change the shape of your seam using the following options:
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Icon

Function
Finish editing selected seam
Delete selected seam point
Delete selected seam
Open selected seam
Close selected seam
Join selected seams for two open seams.
Split selected seams into two separate seams. To do so, select two points of the seam to
identify the segment to be split.

TIP
For more realism, you can also add curves to the seam with the following keyboard
shortcuts:
Alt + click adds a tangent to the selected point.
Ctrl + click on a tangent endpoint breaks the angle of the tangent.
Ctrl + Shift + click you can change the length of one side of the tangent while keeping the
same axis for both sides. The tangents of the geometry band are handled in the same
way as the Bézier curves [399].

Free draw seam with a width of 0.6 cm and a precision of 10.
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Follow the surface boundary
Two markers are needed to create a seam: one at the start of the border and the other at the end. The
seam can be opened or closed.
For a closed seam to be made correctly, the start marker and the end marker must be as close as
possible or even joined (see. Close selected seam).
When flying over the surface, the nearest point on the border is displayed with the green arrow. It
indicates the direction that the seam will follow. The blue arrow indicates the offset of the geometry
strip from the border.

NOTE
You can manually move a curve control point at any time. You must return to free mode
to do so.

WARNING
Warning: manually modified points will be ignored when modifying the Offset from boundary.

Seam following the surface boundary with a band width of 0.6 cm and an offset from the boundary of 2 cm.

Surface Cutting Workshop
Available in: Shaper: Surface > Unfolding > Edit unfolding/stitch for selected surfaces >
Workshop

The Surface Cutting Workshop is a tool available from the Unfolding/Stitch Workshop.
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The Unfolding Workshop enables users to define the UV mapping of complex surfaces. However, for
some surfaces, the UV mapping obtained is not always relevant. This is especially true for surfaces
that can’t be unfolded onto a plane without being cut in places. In such cases, the surface cutting
workshop can be used to manually work out a cutting line that will ensure a quality UV mapping.
Cutting paths are defined using control points that are positioned manually.

Surface Cutting Workshop Interface
The surface cutting workshop has a dedicated interface that can be accessed from the standard
unfolding workshop once a surface has been selected.

Open the surface cutting workshop by clicking on the
cutting workshop consists of four zones:

icon in the panel on the right. The surface

• Validation commands toolbar.
• 3D view.
• 3D geometry toolbar.
• Cut Properties Panel.

Surface Cutting Workshop interface.

Validation Commands Toolbar

The validation commands toolbar in the top left corner of the surface cutting workshop interface.

The validation toolbar has three options:
• The green checkmark validates the defined cutting path and returns to the unfolding workshop.
• The red cross discards the cutting path and returns to the unfolding workshop.
• The red cross discards the cutting path and returns to the unfolding workshop.
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3D Geometry Toolbar

3D geometry toolbar above the 3D view in the surface cutting workshop interface.

The 3D geometry toolbar gives access to tools for managing control points and observing surfaces.
The four operating modes for navigating in the 3D view are Zoom, Pan, Orbit, and Zoom by extent.
The two tools for managing control points are:

for selecting an existing control point and moving it to another position.

• Select and Move tool
• Quick Assignment

mode for inserting a new control point.

3D View
This window is an interactive view in which the surfaces to unfold are displayed. It possesses the same
functions as all other 3D views in Patchwork 3D.
In this 3D view, the control points are marked in green and the delimited cutting path is displayed in red.

Cut Properties Panel
The Cut Properties panel is divided into two boxes, the Preprocess box and the Cut Points box.
The Preprocess box provides access to three modes for preparing surfaces before defining a cutting
path: None, Sew, Weld and Sew. The Cut Points box allows the user to keep track of the number of control
points defined. The Cut! button performs a defined cut based upon control points.

Defining a Cutting Path
Preprocessing Boundaries
Depending on the surface topology, the user may wish to prepare before defining a cutting line. The
preparation tools available in the Preprocess box of the Cut Properties panel are Sew and Weld and Sew.
They have the same effects as the preprocess options in the Unfolding workshop.

Defining Control Points
Control points are set using the Quick Assignment mode in the 3D geometry toolbar. They may be
placed on any triangle vertex. Control points define cutting path segments. Users need to set at least
two control points and may set more.
To set a control point, users click on the matching vertex.
Control points are displayed in green. The cutting path segment defined by two control points is the
shortest path between them. It is displayed in red.

NOTE
If a control point is behind the surface from the user’s standpoint, the green dot will not
be visible.
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A cutting path defined by four control points: the cutting path is displayed in red and the control points in green.

Modifying Existing Control Points
The Select and Move tool is for dragging any of the points belonging to the red line, control points
included, and assigning them to another triangle vertex.
Right-clicking on a control point opens a box containing three options. The user may then.
• Delete current control point.
• Continue to insert markers using the Insert New Marker After option. When this option is activated, the
next triangle vertex selected becomes a control point.
• Delete All Markers.

The three options available when right-clicking on a marker.

113

Patchwork 3D Enterprise 2022 X5

Applying the Cutting Path

The final cutting path is displayed in yellow. No markers exist any longer.

Once the cut path is defined, cutting is performed by pressing the Cut! button. It is displayed in yellow
afterward. Users may define additional cutting paths if needed.
In order to unfold a surface, users validate the cut from the validation commands toolbar and return to
the unfolding workshop to get the proper UV-mapping of the surface.
In the case of a sphere, the surface cannot be unfolded onto a plane without being cut in places: use of
the surface cutting workshop is recommended.

UV-mapping obtained when defining a cutting path in the surface cutting workshop.
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UV-mapping obtained without using the surface cutting workshop.

Timelines (Editor)
Available in: Matter: Editors > Timelines

Timelines
is an editor used to develop animation sequences, called "timelines." From this editor,
you can create, duplicate, rename, and delete timelines. You can also add, remove, and modify elements in the different animation tracks of each timeline. When played back, the animated result will be
displayed in the current active viewport in the main interface of Patchwork 3D.
The Timelines editor is divided into two sections: the timeline editing area to the left, and the libraries to
the right. The Timeline box is the editing area. It contains the playback and time controls, as well as the
animation tracks and their content. The libraries are organized into tabs for each type of item:
Tab

Type of animatable element
Timelines [118]
Products [119]
Camera Animations [119]
Configuration Keys [120]
Channel Animations [121]
Textures [122]

Use the arrows in the upper right corner of the library zone to scroll through the tabs.
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Timeline Controls

Verify that the timeline shown is the timeline you wish to play back. The current timeline’s name is
displayed in the Name zone. This zone contains a drop-down list that provides direct access to a list of
all the existing timelines.

TIP
To modify a timeline’s name or to create a new timeline, use the controls available in the
Timeline library tab [118] to the right.
From the Camera drop-down menu, choose the camera to be used to initialize the timeline. If your timeline contains camera clips, these will be applied to the selected camera and will modify its settings.
The free camera is selected by default.

NOTE
The chosen camera is modified by camera clips during timeline playback. The original
camera settings will be overwritten.

Timeline Playback Controls

The playback is controlled using the set of playback buttons at the top of the Timeline Zone:
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Icon

Function

Description

Timeline range start

Returns the time cursor to the beginning of the animation
range.

Play / Pause

Start the playback if it is stopped, or pause it if it is currently
running.

Timeline range end

Move the time cursor to the end of the animation range.

Loop timeline playback

Loop the playback of the animation range. This mode is active
by default.

TIP
You can also control playback with optional keyboard shortcuts that can be set up in File
> Keyboard Map editor for the following actions:
• Timeline Range Start returns the time cursor to the beginning of the animation range.
• Timeline Range End moves the time cursor to the end of the animation range.
• Play/Pause Timeline Playback starts the playback if it is stopped, or pauses it if it is
currently running.

Navigation Controls for Timeline Tracks

To move within the timeline tracks:
• Use the scroll wheel of the mouse to zoom in on and out from the mouse cursor position.
• Click on the buttons at the top of the Timelines editor corresponding to the mouse modes, then move
the mouse while holding down the left mouse button:
• Select and move
• Pan
• Zoom

an item.

the track display zone.
.
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• Use the shortcuts configured in the Keyboard Map editor. By default, you can:
• Pan: by holding down the middle mouse button and moving the mouse,
• Zoom: by holding down Ctrl + Shift + the middle mouse button and moving the mouse.
button in the upper right-hand corner resets the level of zoom to fit the width of the entire
The
playback range in the display zone.

NOTICE
New Features in Patchwork 3D 2022 X5
in the upper right corner adjusts the animation range with the timeline content from 0
The button
seconds until the last channel.
The button
in the upper right corner adjusts the animation range with the content of the timeline
from the start of the first channel to the last.

Precise Positioning Controls

This bottom of this zone also allows you to:
• Position the time cursor as precisely as possible by providing its temporal position in seconds in the
Cursor Time box. You can also drag the cursor with the mouse.
• Position the selected item or group of items in the animation tracks as precisely as possible by
providing its activation time in seconds in theItem time box.
• Define the animation range, or the playback start and end times in seconds, by specifying values in
the Range:From and To boxes.

Timeline Library
The libraries on the right-hand side of the Timelines editor include a tab for the list of Timelines
.
From this list you can select the timeline animation to edit by clicking on its name. The selected
timeline’s contents and settings are shown in the Timeline editing zone on the left of the Timelines
editor. Only one timeline can be selected at a time.
Use the buttons to manage the list:
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Icon

Function

Description

New

Create a new timeline.

Duplicate

Duplicate the selected timeline.

Rename

Rename the selected timeline. Give each timeline a unique name.

Delete

Delete the selected timeline.

NOTE
You must have at least one timeline in the Timelines editor. The Remove button will be
grayed out if the selected timeline is the only timeline in the list.

Product Library
The products in your database can be loaded into any timeline as product keys. For quick access from
within the Timelines editor, the libraries on the right-hand side include a Products
of the products in the open database.

tab that lists all

From the Products library, you can load database products as product keys by dragging products from
the library and dropping them onto the Product track.

TIP
Products can also be dragged directly from the Matter sidebar's product library.
The first product key will be used to determine the initial product shown in your timeline. If you have
not added any product keys, the product in the active viewport will be displayed instead.

Camera Animations Library
Camera animations provide the source content for clips in the Camera track of a timeline. The Camera
tab in the library on the right-hand side of the Timelines editor consists of a list of
Animations
defined camera animations. It provides buttons allowing you to create new ones and duplicate, rename,
or delete the current ones.
From the list in this library tab, you can:
• Load camera clips by dragging animations from the library and dropping them onto the Camera track.
Dropping a camera animation onto the Camera track creates a solid-colored clip whose length corresponds to the duration of the clip. In a bookmark animation clip, the positions of the bookmarks are
visible. Each bookmark is displayed as a vertical bar within the clip.
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NOTE
The initial camera position of the first clip will be used from the beginning of the
timeline. If no clips exist in your timeline, the camera position in the active viewport will
be used instead.
• Modify an existing animation by double-clicking on its name in the list.
Use the buttons to manage the list:
Icon

Function

Description

New

Create a new camera animation. You will be asked to provide a name
for the new animation and to select the type of camera path (Kam file,
bookmark animation or Bézier path) from the drop-down list.

Duplicate

Duplicate the selected camera animation.

Rename

Rename the selected camera animation.

Import

Import a camera animation in the following formats: KBA (bookmark animator), BZA (Bézier paths) and KAM (KAM file).

Export

Export a camera animation in the following formats: KBA, BZA and KAM.

Delete

Delete the selected camera animation.

Configuration Keys Library
NOTE
If you are working with a multi-product database, please note that configurations will
apply to the first product in your product list only. If a different product is animated in the
Product track, the configuration keys activated during that period will appear to have no
effect.
Configurations set up in your database with the Configuration system can be animated on the Configuration track in any timeline.
library
To animate configurations, configuration keys need to be created in the Configuration Keys
tab on the right-hand side of the Timelines editor. This tab contains a list of existing configuration keys
and buttons allowing you to create new ones and duplicate, rename, or delete the current ones.
From the list in this library tab, you can:
• Add a configuration key to the Configuration track by dragging it from the library and dropping it onto
the track.
• Modify an existing key by double-clicking on its name in the list.
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Use the buttons to manage the list:
Icon

Function

Description

New

Create a new configuration key. This will open the Configuration Key editor,
where you can provide a name for the key and set the configuration it
corresponds to.

Duplicate

Duplicate the selected configuration key.

Rename

Rename the selected configuration key.

Delete

Delete the selected configuration key.

NOTE
If you do not have a configuration key or its colored influence zone at the beginning of
your timeline range, the initial configuration will be adopted from the global configuration
set in the Configuration Browser. During the playback, the Configuration Browser will be
updated with the configuration changes imposed by the configuration keys.
This allows the initial configuration in your timeline to vary. Consequently, looped playback and configuration manipulations done in the Configuration Browser can be used to
create variations in the playback at the beginning of your timeline.
If this is not the desired behavior, initialize your timeline with a configuration key placed
at the beginning of the playback range. In the Configuration Key Editor [153], make sure
that this configuration key imposes a value other than the default Keep previous value for
each of the symbol selections.

Channel Clip Library
Channels allow diverse elements of your Digital Aspect Mockup to be animated. Channels exist for.
• Animated geometries set up in the Kinematics tab of the Shaper sidebar.
For freely transformable parts, six different channels control the animation of a part: the angles of
rotation around the three axes (X, Y, and Z) and the distances of translation along the three axes (X, Y,
and Z).
For rotating and translatable parts, a single channel controls the animation of the part: the angle
around the rotation axis in the case of a rotation, or the distance along the vector in the case of a
translation.
• The intensity and color of the lighting layers,
• Animated meshes,
• Most modifiable options for any type of material,
• Lighting environments,
• Real-time sun settings,
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• Overlays,
• Post-processing.
A material, environment, overlay, or post-processing effect must be used in the active product for its
channels to be available for animation.
To add channel-based animations to a timeline, create channel animation clips in the Channel Animalibrary tab on the right of the Timeline editor. This tab is made up of a list of existing channel
tions
animation clips and buttons to create, duplicate, rename and delete clips.
From the list in this library tab, you can:
• Add a channel animation clip to any Channel track by dragging it from the library and dropping it onto
the track.
• Modify an existing clip by double-clicking on its name in the list.
Use the buttons to manage the list:
Icon

Function

Description

New

Create a new channel animation clip. This will open the New Channel Selector window, where you can provide a name for the clip, select the channel
or channels that will be animated in the clip, and select the desired type
of control over the animation: Standard (basic, single-channel animation) or
Advanced (custom, multi-channel animation).

Duplicate

Duplicate the selected channel animation clip.

Rename

Rename the selected channel animation clip.

Delete

Delete the selected channel animation clip.

Texture Library
The video textures in your database can be added to any timeline as texture clips. For quick access
from within the Timelines editor, the libraries on the right-hand side include a Texture tab that lists all of
the video textures in the open database.
From the Textures library
you can load a texture as a clip by dragging and dropping from the
library. Drop the clip on a Textures track.

TIP
Textures can also be dragged directly from the Matter sidebar's texture library.
When the timeline is played, the video will be animated simultaneously in all materials using it that are
assigned to surfaces in the active viewport.
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Aspect Layers (Editor)
Available in: Matter: Editors > Aspect layers

Aspect Layers is an editor that organizes the aspect of a product in layers. Different materials and their
UV mapping projections can be assigned to the same surface in different layers. Using aspect layers
will allow you to create configurations for the materials used to dress your product.
This editor consists of three tabs that can be used to manage the aspect layers, the visibility bookmarks and the material assignment method.
The Product field identifies the active product.
The Layer tab is for configuring the aspect layers.
The Bookmark tab is for creating bookmarks associated with the aspect layers.
The Assignment tab is for defining the method for assigning materials, specifying which aspect layer
and affectation mode should be used when materials are applied.

Layer Tab
Layers: List of aspect layers that have been created.
: The visibility toggle button is for enabling/disabling visibility of the aspect layer. When the visibility
button is disabled for a group of aspect layers, none of the layers in the group are visible, but layers
keep their own state.

NOTICE
New Features in Patchwork 3D 2022 X5
: The lock toggle button is used to lock/unlock one or more aspect layers or a group of aspect layers.
Once locked, the aspect layers are protected from any change. This prevents you from accidentally
modifying a finalized appearance layer configuration that does not require further modification. A
locked layer can no longer be activated until it has been unlocked.
: This icon indicates the active aspect layer(s).
Icon

Function

Description

Pick active aspect layer

Select the aspect layer associated with the material of the surface
you click in the viewport.

New aspect layer

Create a new aspect layer in the list of layers.

Duplicate the selected item

Create a copy of the selected element: aspect layer (s) or group of
aspect layers.

New group

Create a new group of aspect layers.
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Icon

Function

Description

Merge Layer Selection

Combine the selected layers into a single layer.

Flatten all layers

Combine all layers into a single layer.

Delete aspect
layer

Delete the selected layer.

Split layer by
picked material

Assign a new aspect layer to the picked material.

Split layer by
stickers

Assign a new aspect layer to the picked sticker.

Split layer by
visibility

Create an aspect layer, skipping the surfaces hidden in Shaper. Only
the surfaces that are visible will be taken into account. (Switch to
Evaluate active layer only to enable this function.)

Explode layer
selection by assignment

Partition products in layers that have common material assignments.

Explode layer
selection by material

Divide an aspect layer by the number of materials constituting it.
The names assigned by default to these new layers are those of the
materials.

Import aspect
layer

Import aspect layers from another product.

Flatten all layers
in new product

Create a new product using all aspect layers.

Evaluate all layers in stack

View the product by taking all aspect layers into account.

Evaluate layers
stack until active layer

View the product by taking into account the lowest level of aspect
layers up through the active layer only. A red border around the
viewport indicates that the view is restricted to a limited selection
of layers.

Evaluate active
layer only

View the active aspect layer only.

Highlight active
layer assignments

Enable/disable highlighting of surfaces with a material in the active
aspect layer.

Hide surfaces
without assignment

Hide/show surfaces that have no material assigned to them.
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Icon

Function

Description

Mask labels with
materials

This button allows you to enable or disable the display of aspect
layers containing labels on top of all layers containing materials
in the list. When a list of aspect layers is displayed on a product,
the layers are applied above those located under them in the list.
Thus, when a layer containing a material is applied above a layer
containing a label, the label should probably be hidden. However,
you can choose to force the label to be visible on the material.
indicates that labels are currently visible even if
• The icon
materials were applied above them. Clicking this icon disables
label visibility.
• The icon
indicates that labels are currently hidden by materials applied above them. Clicking the icon makes labels visible.

Replace String

Rename a selection of layers and assign a prefix and/or suffix to
them.

The Layer field is for renaming the active aspect layer.
Right-clicking on an aspect layer opens a context menu with the following functions:
Icon

Function

Description

-

Select visible
layers

Select visible layers.

-

Invert layer selection

Invert layer selection.

-

Hide selected
layers

Hide layer selection.

-

Show selected
layers

Show layer selection.

Lock the selected layer(s)

Lock layer selection.

Unlock the selected layer(s)

Unlock the layer selection.

Merge Layer Selection

Combine the selected layers into a single layer.

Split layer by
picked material

Assign a new aspect layer to the picked material.

Split layer by
visibility

Create an aspect layer, skipping the surfaces hidden in Shaper. Only
the surfaces that are visible will be taken into account. (Switch to
Evaluate active layer only to enable this function.)

Split layer by
stickers

Assign a new aspect layer to the picked sticker.
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Icon

-

Function

Description

Explode layer
selection by material

Divide an aspect layer by the number of materials constituting it.
The names assigned by default to these new layers are those of the
materials.

Explode layer
selection by assignment

Partition products in layers that have common material assignments.

Flatten all layers

Combine all layers into a single layer.

Flatten all layers
in new product

Create a new product using all aspect layers.

Copy Selected
Layers To Active
Layer

Copy the selected layers to the active layer.

Bookmark Tab
The Bookmark tab is for creating bookmarks according to the visibility state of the aspect layers.
Layer Visibility Bookmarks: Lists the bookmarks of layer visibility configurations that have been created.
Double-click on a bookmark to enable it.
Icon

Function

Description

New aspect layer
bookmark

Create a new bookmark in the list of aspect layer visibility
bookmarks. A bookmark is a saved set of the elements visible
in the current configuration of layers.

Store aspect layer
bookmark

Update the active bookmark by storing the current aspect layer
configuration.

Restore aspect layer
bookmark

Display the configuration saved in the active bookmark. his
function can also be accessed by double-clicking on the bookmark in the list.

Delete aspect layer
bookmark

Delete a bookmark from the list of visibility bookmarks.

The Bookmark field is for renaming the active visibility bookmark.

Assignment Tab
The Assignment tab is for configuring the mode of assignment of the aspect layers.
Parameter
Target

Description
Set whether a material being assigned should be applied to the active aspect layer
or to the layer to which the current visible material belongs.
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Parameter
Assign as

Description
Sets the default assignment mode for the layer. This determines whether a material should be assigned by default as a material or as a sticker.

NOTE
For an aspect layer dedicated to stickers, setting the default assignment mode to Sticker will prevent you from applying material types
(matte, mirror) that cannot be used as stickers.
UV reset

Indicate whether the UVs should be reset to 0.0 (yes) or used as-is (no) during
assignment.

Affectation
mode

Choose whether to use the assignment mode Assign or the mode Replace.

The Reset to default button is used to restore the default parameters.

Position Layers (Editor)
Available in: Shaper or Matter > Editors > Position layers

Position Layers is an editor used to create layers in which the position of Shaper objects can vary.
Position layers can then be used by the configuration system to create variants of models or products
in which the position of certain objects is modified.
The Position Layers editor consists of a Layer tab in which there is a list of existing position layers. The
position layer named Base layer is present by default.
Each position layer in this list has a visibility toggle button for enabling and disabling visibility. The
symbol

indicates which position layer is visible. When a layer is hidden, the symbol

is displayed.

The
icon indicates the active position layer. In order to make a position layer active, click within the
check-mark column beside the layer you want to make active.
The following operations can be performed on position layers:
Icon

Function

Description

Pick Active Position
Layer Mode

This command is for selecting the position layer associated
with the position of the clicked surface from the viewport.

New Position Layer

A new position layer is created and added to the list of layers.

Duplicate Position
Layer

This command creates a copy of the selected position layer.
The base layer cannot be duplicated.

Merge Layer Selection

This command merges selected position layers.

Delete Position Layer

The selected position layer is deleted. The base layer cannot
be deleted.
127

Patchwork 3D Enterprise 2022 X5

Icon

Function

Description

Evaluate all layers in
stack

This command displays the product taking all position layers
in the list into account.

Evaluate Layer Stack
Until Active Layer

This command displays the product taking into account the
selected position layer and the layers lower in the hierarchy
only. A red border around the viewport indicates that the view
is displayed with a restricted list of position layers.

Evaluate Active Layer
Only

This command is for restricting the visibility of the position
layers to the selected layer.

Highlight active layer
assignments

This command enables/disables highlighting of surfaces that
have an assignment in the active position layer.

Hide Surfaces Without
Assignments

This command enables/disables the displaying of the surfaces without an assignment.

The Layer field of the Layer box at the bottom of the editor is for renaming selected position layers. It
should be noted that the Base Layer cannot be renamed.

Cameras (Editor)
Available in: Matter or Shaper: Editors > Cameras

Cameras is an editor that contains two parts: the list of cameras that are available in your
database, and the zone that displays the properties of the camera being edited.

Camera List
The camera list is organized in a hierarchy composed of groups and cameras. Each group can contain
both cameras and other groups. The elements in the hierarchy — cameras and groups of cameras —
can be moved within the hierarchy by drag-and-drop.
You can select a camera from the camera list to edit or to activate in the current viewport.
Icon

Operation

Description

-

Activate a camera

Click on a camera to recall its settings in the current
viewport.

-

Edit current camera

Double-click on a camera from the list or click on the icon
just below the camera list to view and edit the camera
settings in the right part of the editor. In this mode, navigating in the viewport changes the camera settings.

Show/Hide cameras

Shows or hides cameras in the viewport of Matter or
Shaper.
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Icon

Operation

Description

Unlock/Lock the position
of the cameras

Unlock or lock the position of the cameras in the viewport.

NOTE
By locking the position of one or more cameras you will no longer be able to change its
parameters such as the Depth of field or the
Motion blur.

Use the buttons below to manage the cameras in the hierarchy. You can.
Icon

Operation

Description

Add a new camera

The camera is initialized using the settings in the current
viewport.

Add a camera group
Rename a camera or a
group of cameras
Duplicate a camera or a
group of cameras
Delete a camera or a
group of cameras

If you attempt to delete a camera currently assigned
to a viewport, an alert will appear informing you of the
camera's current use. If you confirm that you would like
to delete the camera, the viewport will return to its free
camera.

Import a camera or group
of cameras in the KCH or
KBE format

This option also allows you to generate cameras
from a .kam file. See Generating cameras from a .kam
file [389].

Export a camera or group
of cameras in the KCH format
Enable or disable the Edit
current camera mode

The camera currently being edited is marked with this
in the Camera List. If no camera is marked
icon
with this icon, the viewport's free camera information is
shown and can be edited on the right-hand side of the
editor.

Update camera settings
with the settings used in
the active viewport
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Icon

Operation

Description

Assign selected camera
as one of the product's favorite cameras

The selected camera is assigned to the favorite camera
you select for the product in the active viewport. Cameras marked as favorites for the product in the active
viewport are displayed in the Camera List with the icon
.

A right-click on a camera or a group of cameras opens a context menu. In addition, to list the operations above, this menu has one more. You can assign the same sensor to your selection with
Assign sensor parameter.
You can also assign a sensor to a multiple selection of cameras by dragging and dropping a sensor
from the Sensor Library to the Cameras editor.

NOTE
If you assign a sensor to a group of cameras, the sensor will be automatically applied
recursively to all its cameras and subgroups.

Editing Camera Properties
The right-hand side of the editor displays the settings of the camera being edited. Select a camera from
the list on the left by clicking on it and enabling the
Edit current camera mode to view or edit the
camera settings in the right-hand side of the editor. You can also double-click on the camera.

WARNING
In this mode, navigation in the viewport will also modify the camera's settings.
If no camera is selected for editing, the settings for the active viewport's free camera are displayed.
You can click in the field you would like to modify and provide a new value.

Renaming the Camera
The name of the camera being edited is shown. You can modify it by clicking within this zone. It is also
possible to use the button below the camera list to rename the camera.

Choosing a Sensor
To modify the associated sensor, drag a sensor from the Matter sidebar's sensor library and drop it on
the Sensor field.
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To remove a sensor from the camera, click on the
Remove current sensor button. This will not
delete the sensor. When you remove a sensor, the camera will automatically return the default sensor
settings instead.

Lens
The basic camera parameters can be set in the Photo tab or the CG (Computer Graphics) tab. The Photo
tab displays the parameters in analog form, using the vocabulary associated with a physical camera as
a metaphor. The CG tab allows you to provide the same information.
Photo

CG

Focal length: provide the focal length. The sensor size
is displayed below this field for reference. Sensor size
influences the interpretation of this value.

Field of view (FOV): provide the angle
corresponding to the field of view.

Portrait mode: tick this box to impose a portrait orientation. Lenses have a landscape orientation by default.

Field of view axis: from the drop-down
menu, choose the axis to which the
angle of the field of view should be applied.

Depth of Field

NOTE
The Depth of Field zone brings together settings that were previously available in the
Depth of Field Editor for versions up to and including v5.7.
Depth of field is an effect by which objects at the focal distance from the camera appear clearly.
Objects at other distances appear progressively blurrier as their distance from the zone in focus
increases. This effect can be activated by checking the option Active.
By default, the depth of field is also active during navigation within a scene or when playing an
animation.

TIP
For the depth of field to be displayed in the 3D viewport, antialiasing must be activated
under the Render Quality Settings menu accessible from the viewport context menu. See
Render Quality Settings (Editor) [201].
For an image snapshot, the option Antialiasing must be activated in the Snapshot Images
editor.
The value provided in the Aperture field sets the diameter of the aperture of the lens shutter. The
aperture is expressed in millimeters.
The focal distance can be provided here in numerical form. If you prefer to defined the focal distance
interactively, activate the camera.
Once the camera is active in a 3D viewport, you can define the focal distance by placing the cursor over
the zone where the focal point should be positioned and using one of the following keyboard shortcuts:
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Shortcut

Action

Ctrl+Spacebar

Places the point indicated by the cursor at the center of the focal plane. This
manipulation may change the direction in which the camera is facing.

Shift+Spacebar

Places the point indicated by the cursor at the center of the focal plane. This
manipulation may change the direction in which the camera is facing.

The smoothness of the blurriness, or quality, can be modified by moving the slider. A higher value
increases the quality but requires a longer calculation time.

Motion Blur
The motion blur effect simulates the streaking effect of moving objects or a moving camera when the
object or camera is moving during the time of exposure.
When the Motion Blur option is enabled, modifying the camera orientation and position produces a
motion blur effect. This simulates the effect of a physical camera with the capture speed (framerate)
provided in the Frames per second field.
To limit the effects on rendering speed, this effect is applied only to the camera motion by default. To
apply it to animated objects as well, check the Apply to moving objects option. When applied to moving
objects, place the cursor at the appropriate time in the Timelines editor to see the effects on a static
image.
The motion blur effect is visible in video captures, but is not available in renders by raytracing.

Depth Range
The Depth Range box shows the automatically-calculated placement of the two Z planes between which
the camera's view is in focus. You can force a different position for the Z-near and the Z-far planes by
providing new values.

Point of View
A camera position: the position and the orientation of the camera.
Mode

Description

From-To-Up

Provide the point (X, Y, Z) for the position of the camera, a point along the
camera’s viewing vector, and a point along the vector indicating the upward
vertical axis of the camera.

Position-Orientation

Provide the point (X, Y, Z) for the position of the camera and its orientation in
Euler angles.

Channels (Editor)
Available in: Matter: Timelines > Channel Animation Clips library tab > double-click on a clip name
Timelines > Channel Animation tracks > double-click on a clip

Channels is an editor that allows you to set up and rename channel animation clips. The editor will open
when you create a new channel animation clip or when you double-click on an existing clip in order to
modify it.
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Once open, the Channels editor will always show the information for the current active clip in the
Timelines editor. To change the clip shown in the editor, select a different clip in the Timelines editor
using one of the following methods:
• Click on the name of a clip in the Channel Animation library tab,
• Click on the representation of a channel animation clip in one of the Channel track,
• Create a new channel animation clip using the button below the list of existing clips in the Channel
Animation library tab. This will create a new clip and activate it. It will also open the New Channel
Selector window, where you can provide a name for the clip, select the channel or channels that will
be animated in the clip, and select the desired type of control over the animation: Standard (basic,
single-channel animation) or Advanced (custom, multi-channel animation). Validating this choice will
open the Channels editor.
The editor will display different controls depending on which configuration mode you have chosen.

Channel Selector
Available in: Matter: Timelines > Channel Animation Clips library tab > New channel animation
Timelines > Channels > Channel Selector
The Channel Selector determines which channels will be available for animation in a clip. When creating
a channel animation clip, you must first select the channel or channels to include in the clip. The
Channel Selector therefore appears automatically when you create a new clip.
When using advanced configuration, you can also modify the channels in the clip at a later time. To add
or remove channels from the clip, open the Channel Selector from the toolbar of the Channels editor.
The main body of the Channel Selector is the hierarchy of channels available for the active product.
There are four ways to find a channel:
• Expand the entries in the hierarchy until you reach the channel you want to use. Channels are
grouped by type, then by option. If, for example, you want to modify the orientation of an environment
called "Studio_Default", expand the nodes Environment, Studio_Default, and Orientation. Select the axis
or axes you want to modify.
• Use the animated mesh eyedropper
to pick the animated mesh you want to use. Click the
eyedropper, then click the surface in the 3D viewport. This selects the mesh in the Channel selector.
Expand the mesh to select the Frame channel.
• By using the material eyedropper
to pick the material in which the channel you want to use is
found. Click on the eyedropper, then click on the material in the 3D viewport. This selects the material
in the Channel Selector. Expand the material in order to view its channels and select the pertinent
ones.
• By using the transformation eyedropper
to pick the part that will undergo the transformation
you want to use. Click on the eyedropper, then click on one of the surfaces of the part in the 3D
viewport. This selects the first parent of that surface in the Kinematics tab in Shaper.
To add a channel, click within the selection column next to the name of the channel, or right-click on
the channel and select Add channel from the context menu that appears. The same actions will remove
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a channel that has already been added: to remove a channel, click in the selection column of a selected
channel or right-click and select Remove channel from the context menu that appears. The selection
column lists the status of each channel:
Icon

Description
Channel included in the clip.
Channel excluded from the clip.

Multiple channels can be added to the clip at once. Highlight the channels you want to add by clicking
on their names while holding down Shift to select a range of channels or Ctrl to select separate individual channels. Right-click to open the context menu and select Add channel to select these channels, or
Remove channel to deselect them.
Once you have selected the channel or channels to add to the clip, choose the configuration mode.
If you have selected only one channel, you will be able to select Standard configuration if you prefer.
Multi-channel clips, however, must be configured in Advanced mode.

Standard Configuration
The standard configuration of an animation clip is a single-channel mode that gives you access to all
of the parameters needed to animate a channel. The speed of the animation is calculated automatically
based on the range of the change and the duration of the clip. Both the interval of values for this
channel (the range) and the duration are set in this editor.
At the top of the editor, a text field displays the name of the clip. It can be edited directly in this field.
Use the Enter key to validate your changes.
Below the name of the clip, the following settings are available:
• Initial value of the animated parameter,
• Final value of the animated parameter,
• Duration of the clip in seconds,
• Easing. The value of this option smooths the animation so that the beginning, the end, or both appear
less abrupt. Choose from the following options:
• Linear
• Ease in
• Ease out

: The development of the animation will be linear. No easing is added.
: Easing is added at the beginning of the animation.
: Easing is added at the end of the animation.

• Ease in and out

: Easing is added at the beginning and at the end of the animation.

Depending on the channel select, the initial and final positions are expressed:
• in the Patchwork 3D default units [56] for translation and other distances,
• in degrees for rotation and other angles,
• in whole numbers from 0 to 255 for colors,
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• in decimal numbers between the minimum and maximum values for other parameters such as
intensity,
• in 0 (disabled) or 1 (enabled) for the state of a binary parameter.

Using Preset Values for an Animated Mesh
Choosing an animated mesh and the standard configuration mode allows you to automatically replicate the animation exactly as it was prepared in Autodesk Maya or Autodesk 3ds Max.
1.

In the Timelines editor's Channel Animation Library, create a new channel animation.

2.

The Channel Selector will appear. Select the animated mesh you want to use. You can use the mesh
eyedropper

3.

to pick the mesh directly from the viewport. Do not select any other channels.

Select Standard configuration.

The animation parameters for the mesh are initialized with the values taken directly from the imported
settings that were established in Autodesk Maya or Autodesk 3ds Max:
• Initial value: frame 0, the first frame of the animation,
• Final value: frame N, the last frame of the animation,
• Duration: the original length of the animation, expressed in seconds,
• Easing: linear.

Advanced Configuration
Advanced configuration of a channel animation clip handles the animation of multiple channels at
once. It also gives you direct control over the temporal development of the animation using points
placed along a graph representing time on the X axis and the range of animation of the part on the Y
axis. This produces a curve representing the development of a given channel over time. Each channel
has its own curve.
The Y-axis is expressed in the default units for the selected channel:
• in the Patchwork 3D default units [56] for translation and other distances,
• in degrees for rotation and other angles,
• in whole numbers from 0 to 255 for colors,
• in decimal numbers between the minimum and maximum values for other parameters such as
intensity,
• in 0 (disabled) or 1 (enabled) for the state of a binary parameter.
At the top of the editor, a text field displays the name of the clip. It can be edited directly in this field.
Use the Enter key to validate your changes.
The operations toolbar above the graph provides the following tools:
Icon

Function
Selection

Description
Use this mode to select points placed along the curve.
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Icon

Function

Description

Pan

In this mode, the mouse is used to move the curve so as to display
the section you are interested in. This does not change the scale of the
graph.

Zoom

In this mode, the mouse is used to zoom in or out on the curve, changing the scale of the graph.

New key
frame

In this mode, clicking places a new key frame along the curve.

TIP
A new key frame can also be added by holding down Alt
and clicking when using any of the modes to select and
move key frames (see below).
Select and
change value

Dragging a key frame changes the value, but not the time. You can also
provide a exact value in the Value field.

Select and
change time

Dragging a key frame changes the time of the point, but not the value
that has been set. You can also provide a exact value in the Time field.

Select and
move

Dragging a key frame changes the time and the value. You can also
provide its exact time and value in the corresponding fields.

NOTE
For any two key frames, increasing the time (horizontal
distance) between them will make the animation slower.
Increasing the difference in values (vertical distance) will
make the change more pronounced.
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Icon

Function

Description

Key Frames
editor

Provides access to the key frame options:
• Current key frame,
•

Previous key frame,

•

Next key frame,

• Key frame Time (horizontal position),
• Key frame Value (vertical position),
• The variations of a channel's value between two successive key
points over time are represented by curves. The forms of the curves
to the Left and to the Right of a key frame can be one of the following
types:
• Curve type
• Linear
• Step type

(default),

type,
.

The form chosen at a key point for the curve to the left of the point is
applied to all of the curve starting from the previous key frame. Likewise,
the form chosen at a key point for the curve to the right of the point
is applied to all of the curve until the next key frame. If another form
was previously applied at a different key point for the same segment of
curve, it will be overridden by the current choice.
Capture current values

Places new key frames at the time cursor position for each of the selected channels. Each key frame is positioned at the current value for its
channel in the active viewport.

Capture
RGB values

When the curves for the R, G, and B channels of a color parameter are
selected, this button appears. It can be used to open the color picker,
in which you can select a color for the parameter. Once the choice of a
new color has been validated, the new R, G, and B values are placed at
the time cursor's position on the corresponding curves. If key points do
not already exist at this location, they will be created for the new values.

Channel Selector

Allows you to modify the channels used in this clip.

Zoom to fit

Zoom to adjust the scale to fill the display area with the curve, vertically
and horizontally.

Zoom to fit
(selection)

Zoom to adjust the scale so that the selected key frame and curve
segments fill the display area.

Zoom to fit
(horizontal)

Zoom to adjust the scale so that length (time) of the curve fills the
display area.

Zoom to fit
(vertical)

Zoom to adjust the scale so that the height (changes in position or
orientation) of the curve fills the display area.
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To the left of the graph, the list of all of the available curves is displayed. By default, all of the curves
are selected. Modify the selection by clicking on the names of the curves. Only the selected curves are
visible on the graph.
The color of a curve can be customized. Right-click on name of the curve and choose Change curve
color to open the color chooser.

TIP
To check the name of a curve on the graph, hover over it with the mouse cursor. Its name
will be displayed in the information bar at the bottom of the main window.
Below the graph, you have options to provide the maximum duration in seconds of the animation, and
an indicator of the cursor's current position in the Mouse at field.

Sensors (Editor)
Available in: Matter:
• Sidebar sensor library > New Sensor
• Sidebar sensor library > Edit the Selected Sensor
• Editors > Sensors

The interface is organized into two functional zones:
• Operations toolbar and sensor name,
• Sensor settings.
The operations toolbar contains the basic operators for sensors:
Icon

Description
Drag the sensor that is currently being edited from this point and drop it onto a 3D
viewport to use it.
Select the eyedropper, then click on a 3D viewport. This sets the sensor used in that
viewport as the current active sensor and allows it to be edited.
Click on this button to create a new sensor.
Click on this button to duplicate the sensor currently being edited, whose settings are
shown in the editor. The new sensor is activated as soon as it is created.

Text field

The text field indicates the name of the active sensor. Click in the text field to modify
the sensor's name and validate your changes with the Enter key when you have
finished.

Choose the projection type. By default, a sensor is created in perspective mode, but you can activate
the isometric mode instead by ticking the Isometric projection checkbox. Isometric projections are used
in industrial drafting: there is no perspective and the dimensions are not modified by the distance to
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the viewpoint. When the isometric mode is active, the options in the Aspect Ratio zone are grayed out.
This zone contains settings that are not applicable to an isometric projection.
If you set up a camera in perspective mode, you can set the sensor size in the Aspect Ratio zone:
• Aspect preset: Select an option from the drop-down list. You can choose from among common
formats (such as 16:9) or select the option to define your own format. To the left, the Sensor size field
displays the equivalent size in terms of a sensor of a physical camera (such as 36x24).
• If you have chosen a custom ratio in the list of presets, provide the ratio you would like to use as a
ratio in the Aspect ratio field or in camera sensor sizes in the Sensor size field. Some sensor sizes
are preset for you; you can choose one of these in the Preset drop-down menu if you have chosen a
preset aspect ratio.
Overlays, backgrounds, and post-processing effects are applied to the sensor. To apply an effect, drag it
from its library in the Matter sidebar and drop it in the corresponding field in this editor. You can remove
the application of an effect to a sensor by clicking on the Remove button beside the effect.

Snapshots (Editors)
Available in: Matter: Snapshot > Snapshot Image / Snapshot Videos / Snapshot Cubic VR Objects /
Snapshot Cubic VR Panoramas

The five snapshot editors capture the rendering in a viewport and use it to generate a high-definition
image, video or 3D environment. Each editor is adapted to its specific media format: images, videos,
360-degree videos, 3D virtual reality objects, or virtual reality cubic panoramas of 3D spaces.
All five editors, however, have the same structure and many shared settings.
Once all of the settings have been defined, click on the Render button to start the generation of each
snapshot used to compose the required output.
In this section:

Shared Settings
Dimensions of the Media Output
The dimensions and resolution for the image to be rendered are provided in the Dimensions zone.
The Format drop-down list, available for all types of snapshot except cubic VR panoramas, provides
access to the most commonly-used sizes and formats. Certain formats, such as User Defined or User
Defined in Units allow the dimensions to be provided directly as values. By default, Patchwork 3D
proposes the format Defined by Viewport.
Custom formats can be added to this list from the User Presets tab in the Patchwork 3D Settings.

Rendering Engine
Each editor offers the choice of rendering engine to use: OpenGL, Raytracing or Iray.

OpenGL
The Configure button next to the OpenGL radio button opens the OpenGL Settings window.
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Choose whether or not to apply:
• Antialiasing;
• the Mipmap,
• Mirrors reflections,
• Alpha background.
Choose the level of Super Sampling from the drop-down list.
Use the slider to define the level of Specular anisotropic filtering.
Click on OK to save your changes.

Raytracing
The Configure button next to the Raytracing radio button opens the Raytracing Settings window. For
more information on these settings, see the chapter Raytracing Settings (Editor) [182].

Iray
The button Configure next to the Iray radio button opens the window Iray settings. For more information
on the parameters of this editor, refer to the chapter of Iray [404].

Files
The Files zone contains the controls for the creation of an image file.
In this zone you can set:
• The output directory where the image file will be saved, as well as the name of the file and its
extension,
• Whether to Open File Selector or not when rendering. When Open File Selector is selected, clicking on
the Render button will show the dialogue box offering the choice of file name and type. This option is
selected by default.

NOTE
Image rendered for VR objects and for cubic VR panoramas are saved in the Snapshots
directory by default.
The following file formats are supported for video output:
• .jpg
• .png
• .bmp
• .tif
• .exr
• .hdf
• .psd
• .psb
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The following file formats are supported for video output:
• .avi
• .png
• .jpg
• .bmp
• .tif
• Whether to Confirm Overwrite or not when rendering. When Confirm Overwrite is selected, if a file with
an identical name is detected, P3D Conf Explorer requests your confirmation before replacing it with
the file being created. This option is selected by default.
• The configuration of the compression according to the file type,
• The configuration of the layered export for .psd files.

NOTE
Images with an alpha layer must be saved as .png files to keep their transparency. In
these cases, the format PNG is automatically proposed by default.

Compression
Click on the Configure Compression button to open the Compression window.
The compression is adjustable for each type of file to export. For each type of file, the higher the value,
the better the quality.
• JPEG: slide the cursor to define the compression.
• PNG: slide the cursor to define the compression. Tick the Export as 16 bits checkbox if you want to
activate this option.
• Image Compression for Animations: slide the cursor to define the compression.
• Image Compression for VR Objects and Cubic VR Panoramas: slide the cursor to define the compression.
If you are configuring compression for a multilayer image, use the PSD or PSB options. The options
available for multilayer image compression are:
• No compression: the output file will not compressed,
• RLE: RLE compression mode is used,
• ZIP: output file is compressed using the ZIP format.
To export as a file using 16 integer bits, check Export as 16 bits. By default, export is performed using 8
integer bits. Floating point formats (with 16 or 32 bits) are not available.

Layered Image Options
The functionality of exporting captures in PSD or PSB file format allows you to export different layers of
a view. Each of the exported layers is saved to a layer in the PSD or PSB file.
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Snapshot with OpenGL or Raytracing rendering engine
To export a multilayered image, click the button Configure Layered Export to open the Layered Images
Options window, then choose the layers to add to the PSD or PSB file from the following layers:
• Composable Image containing three layers: a background, a multiplicative layer, and a layer of the
product’s opaque surfaces,
• Composited Image,
• G-Buffer,
• Wireframe,
• Z-Buffer,
• Lightmaps.

NOTE
The settings defined in this window apply to images exported as PSD or PSB file formats
only.
The maximum size supported by the PSD file format is 30,000 pixels in any dimension
with a maximum weight of 2 GB.
The maximum size supported by the PSB file format is 300,000 pixels in any dimension.
You can choose to export a layer for each of the following options:
• Export only PSD or PSB file. The editor exports the selected layers to a PSD or PSB file format. In
Photoshop, layers will be represented as layers.
• Export only layers as images. The editor exports the selected layers to individual images. The destination directory will receive all the images of the layers in their respective folders.
• Export PSD or PSB file and layers as images. The editor exports both the selected layers to a PSD or
PSB file format and to individual images. The destination directory will receive all the images of the
layers in their respective folders.

Example of exporting a video using the option Export PSD or PSB file and layers as images.

Once the settings have been made click on the button OK to save the settings and then press Render at
the bottom of the editor. In the window that appears name the image and change its file extension to
*.psd or *.psb.
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Samples of layers from an exported PSD file: lightmap, wireframe and G-buffer views.

Samples of composable layers and composited image generated using Composable Image and Composited Image options respectively.

Using Composable Layers
The following composable layers can be obtained using the Composable Image option:
• A layer with the background of the snapshot,
• A multiplicative layer. When applied to the previous layer, areas corresponding to transparent surfaces are colored,
• An additive layer which adds opaque areas and reflections on transparent surfaces to the final
image.

Example of view reconstruction: over the background layer (left) the multiplicative layer (result of the process shown in the middle) is
applied. Then the additive layer is applied on the resulting view to reconstruct the final image (right).

The compositing technique described above allows the substitution of the background while maintaining a correct filtering by semi-transparent surfaces. This would be impossible to achieve with a
transparency based on an alpha layer.
However, this technique is not compatible with the use of post-processes. Therefore, post-processes
are disabled for rendering of composable layers.
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Snapshot with Iray rendering engine
If you have selected Iray as Rendering engine the Iray only layers zone will be available for you to select
from the following layers:
• Alpha
• Normal. The rendered image displays a texture of normals.
• Object id works like the G-Buffer. The rendered image displays a different color for each surface used
by the product.
• Material id. The rendered image displays a different color for each material used by the product.

Example of a snapshot with Iray rendering engine and the parameter Material id activated.

Once the settings have been made click on the button OK to save the settings and then press Render at
the bottom of the editor. In the window that appears name the image and change its file extension to
*.psd or *.psb.

Internal Render Info
The Internal Render Info zone summarizes various settings. The applicable elements from among
following information are displayed:
• Width of the image in pixels,
• Height of the image in pixels,
• Pass, the number of passes to render the image,
• The number of Frames to render,
• Sampling,
• Memory.

Snapshot Process
Various options are available in the Snapshot zone, depending on the type of output:
• Show Info: displays, along the bottom border of the active viewport, a summary of the dimensions
settings of the snapshot.
• Viewer: sets the image viewing window to open automatically during rendering.
• Background: to open the color chooser. The selected color will be used as a background in the
rendering where the view is not entirely enclosed by geometric elements.
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Rendering Buttons
Once all of the settings have been defined, click on the Render button to start the generation of each
snapshot used to compose the required output.
You can also Add to Snapshot Batcher to delay rendering until later, or Replace current Snapshot Batcher
item with the current settings of the open snapshot editor.

Specific Settings for Images
Available in: Matter: Snapshot > Snapshot Video

From the Snapshot editor, you can modify the rendering parameters and render a view of a product in
an image file. This editor uses the material abilities of the interactive viewport to calculate an image
whose size can be significantly larger than the screen resolution. The maximum size of the image
depends only on your computer’s memory.
Once the desired settings have been indicated, the Render button initiates the creation of the image file.

Dimensions Zone
The
button next to the Resolution box is a shortcut to standard resolutions expressed in dpi (dots
per inch). If the resolution is provided in units other than dpi, the chosen standard resolution will be
converted to the selected units.
In the Orientation zone, select one of the radio buttons for Portrait or Landscape. This choice is not
available if you have selected one of the predefined formats: Defined by Viewport, Defined by Product, or
Fill Viewport.

Specific Settings for Videos
Available in: Matter: Snapshot > Snapshot Video

Videos exports a timeline as a sequence of frames in a video file. This editor allows you to specify all of
the parameters for the conversion of your real-time animation to a frame-based video format that can
be saved to your computer and read by common video players.
From Videos, you can set the parameters for the conversion from real-time to video file:
• The dimensions,
• The video format, including file name, file extension, codec, and compression,
• The rendering engine to use,
• The timeline that will provide the animation, and the frame rate to apply,
• The frames to include in the video file,
• A preview of the frames that will be created.
Once all of the parameters have been defined, click the Render button to launch the rendering of each
frame and the production of the video file.
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TIP
During rendering, a dialogue box is displayed to show the progression of the creation of
the video file. The Viewer button at the bottom of this dialogue box opens a frame viewing
window.
At any time, you can pause the progression by clicking the Pause button, or cancel it by
clicking the Cancel button. If you have paused the rendering, start it again by clicking on
Resume.

Dimensions Zone
The dimensions of the animation to be rendered are filled out in the Dimensions box.
The Format drop-down lists the most common sizes and formats. Some, such as User-Defined, allow
you to directly set the dimension values. By default, the format Defined by Viewport is proposed.

Files Zone
Video formats are defined by three parameters:
• Container (file format),
• Codec (encoding algorithm),
• Bitrate (encoding quality).

Access to video format settings.

When the container is changed, the codecs available in the drop-down list are updated according to the
codecs supported by the format.

Video format settings.

The available containers (formats) are the following:
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• AVI (Audio / Video Interleaved) ;
• MKV (Matrovska Video) ;
• FLV (Flash Video).
Each video format can embed different encoding algorithms called codecs. Some of them are specific
to a format. For example, only Sorenson codec is available for FLV format. Check the documentation of
your movie processing software to known which format and codec best fit your needs.
The bitrate defines the amount of data stored to represent the frames. A low value will generate a
small-sized file, but visual quality will be low. Conversely, a high value will generate a good quality video
but the file will be larger.

Frame samples from videos generated using respectively a low bitrate (on the left) and a high bitrate (on the right).

Timeline Zone
The Timeline zone provides the Timeline drop-down list from which you can choose the timeline to be
rendered as a video.
Next to the timeline selection, specify the frame rate for the conversion from real-time animation to
frame-based video.

Frame Output Zone
You have the option to render only a portion of the timeline range by providing the numbers of the
desired frames:
• Current Frame,
• All Frames,
• A Range of frames.
It is also possible to indicate the initial number for the index appended to the filename of each frame in
the Output Filename zone. By default, the value of this option is "0."
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Preview
The Preview zone provides a preview of each of the frames that will be rendered.
You can move within the preview sequence:
• By using the buttons to step backwards (<) and forwards (>) one frame at a time in the sequence,
• By providing a frame number,
• By sliding the cursor along the bar.
You can also visualize the sequence by using the Play and Stop buttons. The frame sequence playback
is displayed in the current active viewport.
Tick the Loop checkbox to play the video preview in a loop.

NOTE
The editors Videos and Timelines both use the active viewport to display playback. Consequently, you cannot view playback from both editors at the same time.
If the real-time playback in Timelines is playing, you will not be able to play the video
preview. Use the controls in the Timelines to pause the real-time playback before playing
the video preview.
Conversely, if the video preview is playing, you must stop it in Videos before running
real-time playback from Timelines.

Specific Settings for Panoramas
Available in: Matter: Snapshot > Snapshot Panorama

Panoramas editor exports a timeline [393] as a sequence of frames in a 360-degree panoramic video
file. This editor allows you to specify all of the parameters for the conversion of your real-time animation to a frame-based video format that can be saved to your computer and read by interactive video
players including YouTube, as well as virtual reality displays.
360-degree panoramic videos differ from standard videos in that the viewer is able to change the
direction of view during playback by interacting with the video using a mouse, by changing the position
of a mobile device, or by turning her head when using a VR set-up.
From the Panoramas editor, you can set the parameters for the conversion from real-time to a 360-degree panoramic video file:
• The dimensions,
• The panoramic settings, including the dimensions in angles of the slices used to compose the 360
degrees of the scene and the choice of mono or stereo feeds,
• The video format, including file name, file extension, codec, and compression,
• The settings for the OpenGL rendering engine,
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• The timeline that will provide the animation, and the frame rate to apply,
• The frames to include in the video file,
• A on-screen view of the frames as they are generated.
Once all of the parameters have been defined, click the Render button to launch the rendering of each
frame and the production of the video file.

NOTE
During rendering, a dialogue box is displayed to show the progression of the creation of
the video file. The Viewer button at the bottom of this dialogue box opens a frame viewing
window.
At any time, you can pause the progression by clicking the Pause button, or cancel it by
clicking the Cancel button. If you have paused the rendering, start it again by clicking on
Resume.

Dimensions Box
The dimensions of the animation to be rendered are filled out in the Dimensions box.
The Format drop-down lists the most common sizes and formats. Some, such as User-Defined, allow
you to directly set the dimension values. By default, the format Defined by Viewport is proposed.

Panorama Settings
Panoramas are composed of a number of slices, which are then assembled around the camera position
to create the 360-degree visual environment. You will need to determine the width and the height of the
slices required by your video. These dimensions are given in angle degrees.
The smaller the angle, the more slices your video will require. Each slice requires a separate pass. As
there is a direct relationship between rendering time and the number of passes required, videos using
smaller slice angles will require longer rendering times. It is recommended that you choose the widest
angle with no rendering artifacts in order to reduce rendering time.
• Horizontal degrees/slice: In stereo mode, separate feeds for the left and the right eyes are produced
in order to provide depth perception. This increases the sensitivity to slight differences in horizontal
points of view, particularly for objects in the foreground, which in turn requires more slices. When
rendering in stereo mode, horizontal slices of a maximum of 3 degrees are recommended. In mono
mode, most scenes will support a horizontal slice width of up to 45 degrees.
• Vertical degrees/slice: Most environments will support a vertical slice height of up to 45 degrees.
• Interpupillary distance: When stereo mode is enabled, the interpupillary distance can be personalized.
This distance measures the space between the left and the right pupils of the viewer and is given in
meters. If the Stereo mode is not enabled, the value in the Interpupillary distance field is not taken into
account.

Configuring the Codec
Video formats are defined by three parameters:
• Container (file format),
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• Codec (encoding algorithm),
• Bitrate (encoding quality).

Access to video format settings.

When the container is changed, the codecs available in the drop-down list are updated according to the
codecs supported by the format.

Video format settings.

The available containers (formats) are the following:
• AVI (Audio / Video Interleaved) ;
• MKV (Matrovska Video) ;
• FLV (Flash Video).
Each video format can embed different encoding algorithms called codecs. Some of them are specific
to a format. For example, only Sorenson codec is available for FLV format. Check the documentation of
your movie processing software to known which format and codec best fit your needs.
The bitrate defines the amount of data stored to represent the frames. A low value will generate a
small-sized file, but visual quality will be low. Conversely, a high value will generate a good quality video
but the file will be larger.
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Frame samples from videos generated using respectively a low bitrate (on the left) and a high bitrate (on the right).

Timeline Zone
The Timeline Zone provides the Timeline drop-down list from which you can choose the timeline to be
rendered as a video.
Next to the timeline selection, specify the frame rate for the conversion from real-time animation to
frame-based video.

Frame Output Zone
You have the option to render only a portion of the timeline range by providing the numbers of the
desired frames:
• Current Frame,
• All Frames,
• A Range of frames.
It is also possible to indicate the initial number for the index appended to the filename of each frame in
the Output Filename zone. By default, the value of this option is "0."

Preview
The Preview zone provides a preview of each of the frames that will be rendered.
You can move within the preview sequence:
• By using the buttons to step backwards (<) and forwards (>) one frame at a time in the sequence,
• By providing a frame number,
• By sliding the cursor along the bar.
You can also visualize the sequence by using the Play and Stop buttons. The frame sequence playback
is displayed in the current active viewport.
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Tick the Loop checkbox to play the video preview in a loop.

NOTE
The editors Videos and Timelines both use the active viewport to display playback. Consequently, you cannot view playback from both editors at the same time.
If the real-time playback in Timelines is playing, you will not be able to play the video
preview. Use the controls in the Timelines to pause the real-time playback before playing
the video preview.
Conversely, if video preview is playing, you must stop it in the Videos editor before starting
real-time playback from Timelines.

Specific Settings for VR Objects
Available in: Matter: Snapshot > Snapshot VR Object
VR Objects produces a 3D image of the product. In this 3D image, the camera is stationary. The object
is posed on a plane that turns at regular intervals of time. This allows you to view the object from every
angle, with the ability to examine every detail.
Once the desired settings have been indicated, the Render button initiates the creation of the image
files that constitute the VR object.

TIP
During rendering, a dialogue box is displayed to show the progression of the creation of
the VR object files. At any time, you can pause the progression by clicking the Pause
button, or cancel it by clicking on the Cancel button. If you have paused the rendering,
start it again by clicking on Resume.
The Viewer button at the bottom of this dialogue box opens a frame viewing window.

Preview Frame Zone
The Preview Frame zone allows you to preview each frame of the camera’s path around the object by
moving the slider along the bar.
This preview allows you to check the point of observation. By default, the product is observed with
a very large field of view. You can modify the point of observation at any time, either in the active
viewport or with the tools in the Camera Path [152] zone. To apply a modification to the point of
observation, click the Acquire button in the Camera Path zone.

Camera Path Zone
The Camera Path Zone defines the camera’s position and its path.
To create a VR object, a series of images is generated, in which each image is taken from a point
on a circle around a central point. Center values are used to position this central point relative to the
origin of the coordinate system. The Radius value establishes the distance between the camera and
this central point.
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The value FovY in degrees provides the vertical field of view.
If you have made changes, click on the Acquire button in order to validate and apply these settings.

VR Object Settings
The VR object settings establish:
• The Pan Range: frames can be created either for a complete circle on a horizontal plane (the checkbox Complete Loop is ticked by default) or for a limited arc only. In this latter case, you must supply
the angles between which your product will be observed.
• The Tilt Range: frames can be created to form a circle on a horizontal plane around the camera path’s
central point or to form a sphere or portion of a sphere around this same point. In these latter cases,
you must supply the angles between which your product can be viewed. By default, the camera
angles cover a full sphere. The viewing angles range from -90 degrees (the negative Y axis) to +90
degrees (the positive Y axis).
• The Number of Frames: frames can be created closer together or farther apart along the camera path.
Pan provides the number of frames along the circle on the horizontal plane. Tilt provides the number
of frames between the top and bottom angles, if you have defined a vertical plane.

Specific Settings for Cubic VR Panoramas
Available in: Matter: Snapshot > Snapshot VR Panorama

Cubic VR Panorama produces a 3D image of the product in a 3D space. It creates a cubic viewing space
that gives the observer the impression to be in the product’s 3D space.
Once the desired settings have been indicated, the Render button initiates the creation of the image
files that constitute the cubic VR panorama.

TIP
During rendering, a dialogue box is displayed to show the progression of the creation of
the video file. At any time, you can pause the progression by clicking the Pause button, or
cancel it by clicking on the Cancel button. If you have paused the rendering, start it again
by clicking on Resume.
The Viewer button at the bottom of this dialogue box opens a frame viewing window.

Configuration Keys (Editor)
Available in: Matter: Timelines > Configuration Keys library tab > double-click on a key name
Timelines > Configuration track > double-click on a key

Configuration Keys is an editor that allows you to set up and rename configuration keys used to change
the configuration in an animation. The editor will open when you create a new configuration key or
when you double-click on an existing key to modify it.
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When creating or modifying a configuration key, the Configuration Key editor will open. Once open, it will
always show the information for the current active key in the Timelines editor. To change the key shown
in the editor, select a different key in the Timelines editor:
• Click on the name of a key in the Configuration Key library tab,
• Click on the representation of a configuration key in the Configuration track,
• Create a new configuration key using the button below the list of existing keys in the Configuration
Key library tab. This will create a new key and activate it.
In the text zone at the top of the Configuration Keys editor, provide a name for the configuration key or
change the key’s current name. It is recommended that you give each key a different name.
In the Configuration zone, all of the configuration symbols are listed. Each symbol is paired with a
drop-down menu of the possible values. Choose a value for each symbol.
You can choose to impose a new value for each of the symbols, or you can use the default value, Keep
previous value, for certain symbols. As a general rule, it is best to impose a new value only for the
symbol(s) that should be modified by the configuration key.
Choosing symbol values will determine the animation behavior when the playback reaches the activation point of the key in a timeline:
• If you set a new value, the configuration will be modified.
• If you leave the default Keep previous value for a symbol, the value of the symbol will not change
during playback. Use Keep previous to create keys that can be used in multiple situations. This is
particularly useful if you have configuration elements that are independent of one another.

Animation Sliders (Editor)
Available in: Editors > Animation Sliders

This editor allows you to test the effect of certain animations. It presents the different parts that can
be animated by rotation or by translation, the animated meshes, and any animation clips that you have
dragged and dropped from the libraries in the Timelines editor.
For existing translatable or rotatable parts to appear in this editor, the Show in Animation Sliders editor
option must be checked for that part in the Kinematics sidebar tab in Shaper.
For each part, use the slider to manually animate the part. The animations are displayed in the active
viewport. This allows you to view one animation in one viewport and another animation in a different
viewport.

Animated Meshes
Using the slider for animated meshes allows you to move through the frames of the animation. The
frame number is displayed to the right. You can also position the slider by typing a different frame
number in this field.
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Translations
The translation is limited by the distance set for the directional vector of the part. The value of
the cursor position is displayed to the right and is expressed in the preferred units of measure for
distances. You can also position the cursor by providing a new value in this field.

Rotations
The rotation is limited by the values set as min and max angles for the part. The value of the cursor
position is displayed to the right and is expressed in degrees. You can also position the cursor by
providing a new value in this field.

Clips
You can add clips that you want to manipulate in the Animation Slider. In Matter, from the libraries on
the right of the Timelines editor, drag and drop clips you would like to manipulate onto the Animation
Slider editor. This adds the clip to the editor. Clips are only visible in the editor while in the Matter
module.
The slider allows you to scan through the clip. The value of the cursor position is displayed to the right
and expressed in seconds. You can also position the cursor by providing a new value in this field.

Configurations (Editor)
Accessible in: Matter or Shaper: Editors > Create Configurations

The main tool of the configuration system [362] is the Configurations editor.
Configurations is an editor used to create configuration rules that establish the behavior of configurable
layers for each product in your database. You can also associate rules together as sets to create
configurations, or complex product variants.
Configurations is organized into tabs:
• Rule Tab [155]
• Browser Tab [156]
• Library tab [156]
• Inspection tab [157]

Rule Tab
Configuration rules are created in the Rule tab.
The Rule tab has two boxes. In the Rules box appears the list of rules already defined.
The following functions are available:
Icon

Function

Description

New Simple Rule

This function opens the Simple Rules editor. In this dialog box, users create
rules that have the following expression: (defined "symbol"). Simple rule
creation is detailed in the section Creating Simple Rules [366].
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Icon

Function

Description

New Complex Rule

This function is for creating a rule with the Complex Rules editor. Complex
rules involve the function "defined" as well as the logical operators "and",
"or", "not" and "xor". Complex rule creation is described in the section
Creating Complex Rules [372]. Information on complex rule syntax can be
found in the chapter Rule Syntax [374].

Replace
String

This function is for replacing the name of a symbol with a new string of
text. It is particularly helpful for changing the prefixes ("partition.") of several "partition.value_n" symbols simultaneously. The name of the symbol will
be replaced simultaneously in all of the rules where it is used, as well as in
the Configuration Browser.

Delete
Rule

This function is for deleting the rule selected in the list.

Rule expressions are entered directly inside the Expression box. The Insert Tool is for inserting a string
corresponding to a simple rule for a defined symbol.
The Compiler Output box allows for checking rule syntax. If syntax problems are detected during rule
validation, an error message is displayed in this box.
The second box in the Rule tab shows the properties for the selected rule.
It includes the Rule field which allows the selected rule in the list to be renamed.

Edit Rule Expression opens the Complex Rules editor for modifying rule expressions directly.
The Targets box indicates the target layer(s) of the selected rule.
When a geometry, aspect, position, overlay, or environment layer is defined as a target for a configuration rule, the icon
is displayed next to that layer in the corresponding layer editor. Clicking on this
icon selects the rule in the Configurations editor.

Browser Tab
This tab is the Configuration Browser. It can also be accessed from Editors > Configuration Browser.
The Configuration Browser is for testing and exploring product derivatives. The Configuration Browser
interface is updated automatically according to the configuration rules [365] created: all symbols used
in rules pertaining to the active product are gathered and displayed in it. The browser lists all available
symbols for the product displayed in the active viewport.
The browser allows you to select which symbols among those available should be defined for rule evaluation. The selection is made either with checkboxes or from drop-down lists. All product derivatives
may thus be explored.

Library Tab
The Library is for managing and editing configuration sets, that is, set of defined symbols and groupings identified in the Configuration Browser. It includes the following functions:
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Icon

Function

Description

New Configuration

Creates a configuration.

Store Configuration

Saves changes made to an existing configuration .The current
set of defined symbols is saved, replacing the previous set of
defined symbols.

Restore Configuration

Deletes the configuration selected in the list.

Delete Configuration

Deletes the configuration selected in the list.

The second box includes a field for renaming configurations.

Edit Configuration opens the Symbol Sets editor. This editor lists all available and defined symbols.
In the Available Symbols list, defined symbols are grayed-out.
Icon

Function

Description

Define Symbol

Adds the symbol selected in the Available Symbols list to the
Defined Symbols list.

Delete Defined Symbol

Deletes the selected symbol from the Defined Symbols list.

Inspection Tab
In the Rules Value box, the list of existing rules is displayed. Rules evaluated as true with the current
defined symbols are highlighted in green, and highlighted in red otherwise. The expression of the rule
selected is displayed in the Rule Evaluation Trace box. The parts of the rule’s expression displayed in
green are true and the parts displayed in red are false. This tool allows for quick determination of the
reason why a rule is evaluated as false.

GPU Consumption (Editor)
Available in: Shaper or Matter: Editors > Advanced > GPU Consumption

In order to render the content of a database, Patchwork 3D consumes GPU resources. The elements
to be rendered are stored in the graphics card. The amount of resources required varies depending on
the complexity, size and level of detail of the item to be rendered, while the total amount of resources
available depends on the graphics card used.
The analysis tools provided in GPU Consumption help to find anomalies or user practices that contribute
to an overconsumption of GPU resources.

Running an Analysis
Before moving forward, you run an analysis of the GPU resources that are used.
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TIP
This analysis must be run from Matter.
1.

Choose what you would like to analyze from the drop-down menu. The analysis can be limited to
what is currently displayed in the active viewport, or it can reflect all of the products, along with
their configurations, that are part of your database. An analysis of the current viewport will take
less time to run than an analysis of the full database.

2.

Start the analysis by clicking on

. This may take some time.

Once the analysis has finished, you have access to the two tabs that provide two different overviews of
the results: the summary of consumption and the detection of overconsumption.

Summary of Consumption
The Summary tab provides a global overview of the GPU consumption.
The consumption is organized by tab based on the type of Patchwork 3D resource. The label for each
table shows the type of Patchwork 3D resource, followed by the total consumption for this type of
resource. The unused Patchwork 3D resources that are still present in the database are not taken into
account in the total consumption.
The following categories of resources are analyzed:
Type of resource
Textures

Definition

Additional information provided

Images and videos used as textures, including backgrounds

Lightmaps

Resolution in pixels, color profile format
Resolution in pixels, lightmap format

Bumpmaps

Textures used as bumpmaps

Resolution in pixels

Environments

Resolution in pixels

Meshes

Number of vertices, number of triangles

The summary presents the analysis results as a table:
• Resource: the name of the Patchwork 3D resource,

TIP
Environments created by Patchwork 3D to display specular reflections are listed under
the name "Cube map."
• Size: amount of GPU memory allocated,
• Information,
• Activation: This column is only present for textures and bumpmaps. A comment is displayed if the
resource is inactive. A texture will be classified as inactive, for example, if it is used as a Color map in
a material applied to a surface in the active viewport but for which the checkbox enabling use of a
color map is not checked in the Materials editor.
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Several operations to manage this information are available:
• Click on a column header to sort by that column.
• Double-click on an item to expand the list of elements using this resource.
• Right-click, then choose Activate to select the element in the interface.

TIP
The Show only selected surfaces mode displays only the elements concerned by an operation. In Shaper, activate the mode Show only selected surfaces with the S key. When you
choose the option Activate for a group of surfaces, they are displayed. The rest of the
model is hidden. In Matter, when the Activate option opens the Materials editor, use the
Only show active material button to display only the surfaces using this material.
A total consumption of GPU resources is indicated at the bottom of the editor. This total is the sum of
the subtotals listed for each resource tab. The total consumption corresponds to the analyzed context
only: if the analysis covers only the current viewport, other viewports are ignored. If the analysis covers
all products in the database, other databases that might be open in another instance of Patchwork 3D
and other sources of GPU consumption are not included.
From this tab you can

Export the summary in CSV format.

NOTE
The GPU memory consumption gauge, which is available in the render statistics, shows
total GPU consumption, including consumption sources external to Patchwork 3D. By
contrast, the summary of consumption only shows elements created directly or indirectly
by a user in Patchwork 3D. Consequently, slight differences may exist between the totals
reported by the two tools. See Render Statistics [76].

NOTE
The GPU resource purge wipes the resources used for inactive viewports from the graphics card. This operation has no impact on the summary of consumption, which provides
information regarding either the active viewport or all products in the database, regardless of their presence or absence in a viewport. For more information on this function,
see Purging Unused GPU Resources [81].

Detection of Overconsumption
The Detection tab offers customizable detection rules that can be used to find the elements that use
significantly more resources than others without contributing to an improved overall rendering.

Rules
Each rule is based on a limit that can be set based on your requirements. The limits that you indicate
are saved by Patchwork 3D and will be available in all databases that you open on the same computer.
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The default values are given for demonstration purposes only and may not be appropriate for your
usage of Patchwork 3D.
The following rules are available:
• Size of the texture in pixels,
• Number of layers in a multilayer material,
• Number of triangles in a surface,
• Average area of a triangle for a surface in mm2.
Check the boxes next to the rules you would like to use in your detection.
Verify the value of the limits. If necessary, modify them by typing a new value directly in the field, by
clicking on the field and using the up and down arrows on the keyboard, or by clicking on the arrows
beside the field.
Obtain the results by clicking on one of the buttons at the bottom right of the editor.

Colored Display
displays the results of the detection in the viewport by coloring each surface.
Color

Magnitude of noncompliance

Gray

This surface was not included in the analysis that was run.

Green

No over-consumption was detected for this surface.

Yellow

This surface exceeds a detection rule by up to 50%.

Orange

This surface exceeds a detection rule by 50-100%.

Red

This surface exceeds a detection rule by 100% or more.

When the false color mode is activated, the view is surrounded by a white frame. To exit this display
mode:
• Press the Esc key.
• Click the button again

.

List of Results for All Surfaces
opens a window containing the diagnostic results for all surfaces. The results are presented in
the same format as the statement. However, only cases where the threshold is exceeded are listed.
The color of each line indicates the magnitude of noncompliance with the provided rule limits:
Color

Magnitude of noncompliance

Yellow

Between 100% and 150% of the limit

Orange

Between 150% and 200% of the limit

Red

Greater than 200% of the limit
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Various operations allow you to manage the results of the detection:
• Sort: Click on the column header to sort the list.
• Find an element: Right-click on an entry, then choose Activate to find the element in the interface.
Close this window by clicking OK.

Results for a Picked Surface
allows you to pick a specific surface to analyze. The cursor will change to an eyedropper.
Click on the desired surface in the viewport. A new window will open.
This window contains the detection results for the selected surface only. The results are presented in
the same format as the summary. However, only the cases exceeding the rules' limits are listed.
The color of each line indicates the magnitude of noncompliance with the provided rule limits:
Color

Magnitude of noncompliance

Yellow

Between 100% and 150% of the limit

Orange

Between 150% and 200% of the limit

Red

Greater than 200% of the limit

Various operations allow you to manage the results of the detection:
• Sort: Click on the column header to sort the list.
• Find an element: Right-click on an entry, then choose Activate to find the element in the interface.
Close this window by clicking OK.

Product Environments (Editor)
Available in: Matter: Editors >

Product Environments

Product Environments provides the tools to prepare your environments for displaying your products. It also manages environment layers. Environment layers allow for the creation of several product
variants with different environments. These layers can then be used in the configuration system.

Environment Layers Tab
Environment layers are created in the Environment Layers tab.
The name of the product in the active viewport is displayed at the top of this tab. The rest of the tab is
composed of the Environment Layers, Environments, and Surfaces using environment boxes.

Environment Layers Box
This box contains a list of the existing environment layers. Each layer has a toggle button to activate
or deactivate its visibility. The symbol

means that the layer is visible. When a layer is hidden,
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this symbol is barred. The
environment allocations.

icon is used to pinpoint the active layer, which will receive all the new

The following operations can be performed on the environment layers:
Icon

Function

Description

New Environment Layer

A new environment layer is created and added to the list of
existing layers.

Duplicate Environment
Layer

Creates a copy of the selected environment layer. The mention "Copy" is added to the name of the created layer.

Rename Environment
Layer

This operation opens a dialog box which allows the selected
layer to be renamed.

Solo Environment Layer

This operation displays the surfaces affected by an environment contained in the selected layer only.

Delete Environment
Layer

The selected environment layer is deleted. The minimum number of environment layers is one.

When the Product Environments editor is opened, it already contains a layer called Default. When
opening a database created with a version of Patchwork 3D prior to version 5.5, the environments
assigned to the product are automatically imported in this layer.

NOTE
When no environment layer is selected, the name of the default environment is displayed
in the Environments box. When all environment layers are hidden, the default environment
is used.
As with aspect and position layers, the position of environment layers in the layer list is taken into
account when displaying environments on the product. The layer hierarchy is assessed from the top to
the bottom of the list:
• The first allocation of a global environment found in a layer is displayed in the product.
• If, for a given surface, any environments are specifically assigned, the highest-ranking of these
environments is applied, even if a higher-ranking global environment is defined.

Environments Box
This box displays the list of environments contained in the selected layer of the Environment layers box.
A global and several surface-specific environments can be present in the same layer.
Selecting an environment in this box displays the list of Surfaces affected by this environment in the
Surfaces using environment box.
The following actions can be performed on a selected environment:
Icon

Function
Solo Environment

Description
Restricts the rendering to the surfaces affected by the environment selected in the list.
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Icon

Function

Description

Set Active Environment

Defines the selected environment as the one considered active
in the Matter sidebar's environment library.

Find Environment

Selects the corresponding environment in the Matter sidebar's
environment library.

Remove Environment

Removes the assignment of the selected environment from the
surfaces using it in the current layer.

To set an environment as a global environment in the active layer, drag and drop it onto the product.
To assign a local environment, drag and drop it onto the targeted surfaces by holding down Shift key
and by selecting Apply To Surface in the opening context menu.
To replace an environment in the active layer, drag and drop the desired environment from the Matter
sidebar's environment library onto the name of the environment to be replaced in the list of the
Environments box. It is also possible to drag and drop the desired environment onto a selection of
surfaces in the Surfaces using environment box to assign it to the selection.

Surfaces Using Environment Box
This box lists the surfaces affected by the environment selected in the Environments box.
The following actions can be performed on the selected environment(s):
Icon

Function

Description

Solo Surfaces

Restricts rendering to the selected surfaces.

Reset Orientation

Resets the orientation of the environment affecting the selected
surfaces. This feature applies only to surfaces for which the environment has been specifically reoriented. These surfaces are tagged with the icon

Remove Environment

.

Removes the assignment of the environment specific to the selected surfaces.

Surface names displayed in italics and crossed out correspond to surfaces which possess an unused
environment allocation. For a global environment allocation this occurs either when another global
environment allocation is listed higher in the layer hierarchy, or when a surface-specific environment
exists. For a surface-specific environment, this occurs when another surface-specific environment
allocation is listed higher in the layer hierarchy.

Product Environment Properties Tab
The Product Environment Properties tab presents the functions used to prepare environments by adjusting their orientation or by defining the specific settings for the use of a real-time sun.
It contains four boxes: Environments, Orientation , Real-Time Sun and Environment’s Brightest Point.

Environments Box
This box lists the environments that are globally allocated in the product or specifically allocated
to certain product surfaces. Selecting an environment from this list gives access to its orientation
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settings, to the real-time sun settings, and to the settings for the definition of its brightest point. The
settings for the selected environment are modifiable when the environment is the product’s active
environment. Otherwise, they are visible as read-only.

Orientation Box
The Orientation box is designed to modify the two following types of orientation:
• Environment orientation in the product. This orientation can also be modified by activating the
and moving the environment directly using the mouse. The global
Environment Orientation mode
orientation of the visible environment under the mouse is modified, even when the environment is a
surface-specific environment affected to multiple surfaces.
• Surface-specific orientation, typically used to reorient reflections on a given surface. This operation
is also performed by activating the Environment Orientation mode
and moving the environment
by using the mouse to click and drag while holding the Shift key, or from the Surface Properties.
This orientation feature does not impact the environment’s default orientation stored in the environment properties, which is used for initializing the environment orientation in the product upon allocation.
In order to change the selected environment’s orientation from the Environments box, enter the desired
value for the orientation with regard to the X, Y, and Z axis in the corresponding fields.
You can reload the default orientation at any time by clicking the Use default orientation button.
In order to save an environment orientation as the default, click on the Set as default orientation button.

Real-Time Sun Box
The settings in this box are used to adjust the real-time sun specific to the selected environment.
Parameters defined in the editor Real-time sun can be ignored in favor of the parameters defined
specifically for the selected environment by checking the box Use the following sun settings when using
this environment . These correspond to those in the box Sun setting from the editor Real-time sun .
If no real-time sun is active for the product as a whole, it is still possible to use a specific real-time sun
in an environment by ticking the checkboxes Apply the following sun settings when using this environment
and On.

Environment’s Brightest Point Box
This box is used to specify the brightest point of an environment in order to position the real-time sun
with the help of the positioning option Extracted from Environment. This can be set up either manually or
by an automatically search.
To run the automatic identification of the position of the brightest point in the environment, select the
environment in the Environments box, then click Find automatically. The brightest point of the current
environment is then identified by a square on the displayed environment.
It is also possible to click directly on the displayed environment to pinpoint the desired direction of the
real-time sun.
The sun remains fixed relative to the environment when the environment Orientation feature is used.
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Tag Manager
Available in: Shaper: Surface > Tag Manager (Ctrl+M)

The Tag Manager uses buttons to manage the list of tags, to create tags, to add tags to a selection, and
to manage a selection using tags.
Tags are used in Shaper and in Matter to manage the selection and to:
• apply a material to several surfaces at the same time [313],
• exclude surfaces from a local environment [194],
• indicate the surface that are not affected by clipping planes [185],
• indicate the surfaces that function as configuration triggers in Live Mode [400].
Managing the list of displayed tags:
Icon

Function
Remove all tags from the display list. This does not delete the tags.
Recover the tags from all surfaces and display them in the list.
Recover only the tags from the selected surfaces and add them to the list.

Creating tags:
Icon

Function
Add the edited tag to the selection.
Create a tag with the name in the text box and add it to the list.

Applying or removing tags from a selection:
Icon

Function
Delete the tag highlighted in the list from the selected surfaces.
Add the tag highlighted in the list to the selected surfaces.

Managing the selection:
165

Patchwork 3D Enterprise 2022 X5

Icon

Function
Select the surfaces using the tag highlighted in the list.
When some surfaces are already selected, add the surface using this tag to the selection.
When some surface are already selected, deselect only the surfaces using this tag.

Using Tags to Create Configuration Triggers
Tags can be used to create configuration triggers for the Live Mode.
When a properly tagged surface is clicked during Live Mode, the next configuration value is displayed. If
the configuration property is displayed in the Configuration Browser as a check-box, successive clicks
will enable and disable the option. If the configuration property contains a set of values, such as a
series of colors, successive clicks will cycle through the colors one by one.
To do so, you will need to create specific tags for the surfaces that will act as triggers. The tag must
correspond to the partition of the configuration that you want to cycle through. To add rules associated
with the partition type, use the tag partition. To add rules associated with the partition.value type, use
the tag partition.
Examples:
Type

Configuration symbol

Tag to apply

Result

partition

armrest

armrest

show/hides an armrest

partition.value

material.wood

material

shows the different values (wood,
marble...) one after the other

partition.value

material.marble

material

shows the different values (wood,
marble...) one after the other

You may be interested in the following topics:
• Product configurations [362]
• Live Mode [400]

Gradients (Editor)
Available in: Matter: Editors > Materials >

in the Gradient zone

The editor Materials gives access to Gradients, an editor that allows you to create your own gradients or
to modify pre-existing gradients in Patchwork 3D. These gradients are used to display a different color
depending on the angle at which a surface is viewed.
This parameter is available for the following types of material:
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• Standard Material: Diffuse and Diffuse and Reflection types,
• Multilayer material: Diffuse, Illumination and Flakes,
• Stickers using the same types or layers as above.
You will find the same configuration of operations in the Gradients editor, namely operations to Create,
Import, Save, or Delete a gradient, as in the other types of editor.

NOTE
The new gradient created appears in the Gradient palette and is named by default gradient
0, gradient 1, etc. You can rename it directly in the input field relating thereto.
Icon

Function

Description

Delete

Delete a gradient from the palette

Import

Load a gradient. The imported gradient is saved in the Gradients directory
by default.

Save

Save a gradient. The modifications are saved in the Gradients directory by
default.

• In the Gradient zone, slide one of the two squares under the Gradient banner head to modify the
gradient, or enter a value directly in the Angle field.
• Modify the color using the Color Chooser, accessible by clicking on the Color square.

TIP
To open the Color Chooser, click on one of the two squares of the Gradient banner head.
The gradient created is displayed in the banner head. For more information on modifying
colors, see Color Chooser [205].
Icon

Function

Description

Create a new
gradient

Create your gradient directly using the Color Chooser, then click this
button.

Assign

To assign a new gradient to an element in the palette, select the
gradient you want to assign the new colors to, then click this button.

To modify a gradient of the Gradient Palette, select it and double-click on it. The gradient is displayed in
the viewer.
The Position as Ramp Access Angle parameter allows you to specify a gradient angle.

Importing Gradient Ramps in .csv Format
Gradient ramp files in CSV format are supported.
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With the Import gradient
editor, or CSV gradient files.

button, you can import KGR gradient files generated by the Gradients

• Select the gradient file in KGR or CSV format that you would like to import from your workstation.
• Click on Open to validate.
The imported gradient is added to the gradient palette.
For a CSV file, the name of the CSV file is used as the name of the new gradient.
Valid .csv files begin with a header line, followed by lines listing the gradient angle and the colors to
apply at that angle. The colors are expressed in one of the following encodings:
• RGB [168]
• CIE Lab Profile [169]
The values contained in each line must be separated by a comma (,); if the line contains decimal
numbers, they must use a point (.) as the decimal separator.
Parameter

Accepted Values

Header as first line

Required

Value separator

,

Decimal separator

.

End of line

No special character

If the file structure is not respected, the importer will stop. The error message that is show will indicate
the line in your file where the first structural error was found.

RGB Profile
Parameter

Accepted Values

Required header line

angle,R,G,B

Angle

Whole numbers from 0 to 90 inclusive

R

Whole numbers from 0 to 255 inclusive

G

Whole numbers from 0 to 255 inclusive

B

Whole numbers from 0 to 255 inclusive

If the accepted values are not respected, the importer will replace any value that is out of range with
the minimum or maximum accepted value, whichever is closer. For example, an angle value of 100
degrees will be replaced by the maximum accepted value, that is, 90.
Example
angle,R,G,B 0,255,255,255 1,255,255,255 2,255,255,255 3,255,255,255 … 90,255,204,0
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CIE Lab Profile
Parameter

Accepted Values

Required header line

angle,L,a,b

Angle

Whole numbers from 0 to 90 inclusive

L

Decimals from -128.0 to 128.0 inclusive

a

Decimals from 0.0 to 100.0 inclusive

b

Decimals from 0.0 to 100.0 inclusive

If the accepted values are not respected, the importer will replace any value that is out of range with
the minimum or maximum accepted value, whichever is closer. For example, a L value of -130 will be
replaced by the minimum accepted value, that is, -128.
Example
angle,L,a,b 0,100.0,0.0,0.0 1,100.0,0.0,-0.000001 2,100.0,0.0,-0.000001 3,100.0,0.0,-0.000001 …
90,88.122,1.933,50.797

Flakes Color Editor
Available in: Matter:
• Materials (Editor) in Layers tab of a multilayer material,
• Right click on a multilayer material: Material > Edit material: [your material] in the Layers tab of the
material.

The Flakes Color Editor interface is composed of two functional zones:
• the Color Palettes box that lists the available color palettes,
• the Palettes Editor box that allows you to create color palettes.
The Color palettes box gathers the following operations:
Icon

Description
Saves a color palette
Updates the selected palette of color.

TIP
This feature is useful for updating the color palette with colors you just
added.
Imports one or more color palettes in CSV format.
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Icon

Description
Exports the selected color palette in CSV format.
Deletes the selected color palette.

The Palettes Editor box contains the following operations:
Icon

Description
Adds one color to the selected color palette.
Deletes selected color of the palette.

How to create a color palette?
1.

In the Palette Editor of flakes, click on the color area to choose the color you want to assign at the
palette.

2.

If necessary, click on this icon

3.

Click then on this icon

4.

Repeat steps 1 to 3 to add as many color palettes as you want to the list.

to add one or more color. Click this

to delete a color.

to add a color palette to the list of palettes.

How to import a color palette in CSV format?
The process of importing a color palette in CSV format works as the same as the gradients editor.
Please refer to the following chapter Importing Gradient Ramps in .csv Format [167] for more information.

Rendered Views History
Available in: Matter: Editors >

Rendered Views History

The Rendered Views History is a tool available to compare several views of products in Patchwork 3D.
It saves rendered views, displays them as miniature images, and restores their original size. It shows
views taken of any of the products in a database.
The views are saved as soon as they are added to the Rendered Views History.
To select a view in the Rendered Views History, click on the corresponding miniature. Several views can
be selected at once.
• By holding down the Shift key (for a continuous selection) or the Ctrl key (for a discontinuous
selection).
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• By holding down the left mouse button and drawing a rectangle over the desired views.

NOTE
The Rendered Views History in Patchwork 3D also loads the views rendered with the
Raytracing editor from versions 5.2 to 5.4.

Operations Toolbar
This toolbar located at the bottom of the Rendered Views History provides the tools to manage the
views in the history.
Icon

Function

Description

Add rendered
view

Saves the view in the active viewport to the history.

Export views

Allows the selected views to be exported by saving each view as a
separate image file. When this button is clicked, it opens the Export
images dialogue box.

Reload view
bookmark

Repositions the camera in the active viewport to the position that
was used to create the selected view.

Rename rendered view

Allows the view to be renamed. Each view must have a unique name.
If the user enters a name that has already been assigned to another
view in the history, the Rename rendered view function will add a
number to the end of the duplicate name: Product (1).

Delete selected
views

Deletes the selected views.

The Export images dialogue box shows a list of the selected views, the choice of the directory where
the files will be saved, and the choice of file format to be generated.
Some of these operations are available in the context menu that is accessed by right-clicking on a view.
The actions chosen from the context menu affect only one view at a time.
From the context menu, you can Export view, Reload view bookmark, Rename view or Delete view.

Engines Used for Rendering
The view image is rendered by the engine used to calculate it in the active viewport. If any part of the
active view is calculated by raytracing, the image will be rendered by the raytracing engine. However, if
the view is calculated by the OpenGL engine, the image will be rendered by this engine.
The engine used to render the view (OpenGL or Raytracing) is indicated on the upper part of the
thumbnail.
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Indication of rendering engine on thumbnails (OpenGL engine on the left; raytracing engine on the right).

NOTE
The raytracing engine can be set up to automatically add views rendered by raytracing to
the Rendered Views History.

Raytracing settings on the toolbar Editors or navigate in Editors >
Click on the button
Raytracing settings. An option in the Viewport Raytracing box allows the Automatically add
to Rendered Views History on render option to be activated or deactivated. This option is
disabled by default.

Recalling a View
Double-clicking on a view will recall it in the active viewport. The size of the original image is restored
and the viewport is resized accordingly.

Text Image (Editor)
Available in: Matter: Textures Library (right-hand sidebar) > Edit or Create a new text texture

The Text Image editor creates, based on a provided text, an image that can be used as a texture. This
text texture can be used in all of the same contexts as a standard texture.
The interface is divided into four zones:
• Operations toolbar and name of the active text image: shortcuts to the operations of the texture
library.
• Settings for Geometry , Colors , and Font: management of the look of the text to be displayed.
• Text: input field for the text to be displayed.
• Preview: full-size preview of the text to be displayed.
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Operations Toolbar
The following operations are available from the operations bar:
Icon

Description
Drag-and-drop start point for assigning the texture to the appropriate field in a material,
an overlay...
Create a new text texture.
Duplicate the current text texture.

You can also rename this texture by modifying the name in this zone and saving your changes by
pressing Enter.

Display Settings
Geometry Settings

Description

Size

Dimensions of the image text box in which the text will appear, in pixels.

Anchor

Placement of the upper left-hand corner of the text with regard to the upper
left-hand corner of the text box in which the text appears.

Color Settings

Description

Background

Color and level of opacity of the image background.
Opacity is given as a value between 0 (fully transparent) and 1 (fully opaque).

Font

Color and level of opacity of the text.
Opacity is given as a value between 0 (fully transparent) and 1 (fully opaque).

Font Settings

Description

Font

Drop-down menu offering a choice of fonts from among the fonts installed on
the current computer.

WARNING
Fonts used in text images are not embedded in the database.
If this database will be handled on another machine, make sure
that the chosen fonts are also installed on the other machine.
The texture created by this editor will remain usable as-is on any
machine, regardless of the availability of the original fonts, until
it is modified.
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Font Settings

Description

Style

Drop-down menu offering the choice of styles available for the chosen font.
Common styles include bold or italics.

Size

Size of the font's characters in points (pt).

Text
Insert your Text in the Text zone.
Supported text includes all characters rendered in the UTF-8 encoding, as long as these characters can
be displayed in the selected font.
Text is displayed with no styling. Text wrapping is not applied, but new lines inserted manually are
taken into account.
No character limit is imposed, but only the text that fits in the image text box will be displayed. This
is determined by the size of the text box as set in the geometry settings as well as by the font size
provided.

Preview
The
button updates the text preview, which is displayed in full-size. This action also saves the
current settings.
button undoes any modifications to the settings that have been applied after the last save
The
and update of the preview. The display settings are reset to the state displayed in the preview zone.

Materials (Editor)
Available in: Matter: Editors > Materials (F5)

Materials

is an editor that provides access to the parameters of the active material.

The interface is organized into two functional zones:
• Operations bar and material name.
• Settings for a given type of material, usually organized in tabs, followed by global options applied
to all tabs. You can find more information on the options specific to each type of material in the
corresponding sections.
The operations bar provides access to basic material operations:
Icon

Function
Drag-and-drop
start point

Description
Drag the material being edited from this point and drop it on a
surface in a 3D viewport to assign it.
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Icon

Text
field

Function

Description

Selection eyedropper

Select the eyedropper, then click on a material assigned to a
surface in a 3D viewport. This will make the selected material
active and allows it to be edited.

Solo Material

The Solo Material mode hides all surfaces except the ones to
which the current material is assigned. This visualization mode
applies in all of the open viewports. This button both enables
and disables the Solo Material mode.

Select all the
surfaces

Click on this button to select in Shaper all the surfaces that have
the same material.

Create a new
material

Click on this button to open the window to choose a type of
material. When you validate your choice, a new material of that
type will be created.

Duplicate the
material

Click on this button to duplicate the active material whose settings are shown in the editor. The new material is made active
when it is created.

Convert to multilayer material

Convert the selected material(s) into equivalent multilayer materials.

Name of the
material

The text field shows the name of the active material. Tho change
it, click within the text field and use the Enter key to validate your
changes once you have finished.

The specific settings for each material class make up the rest of this editor. They are described in the
chapter Materials [288].

Live Mode (Editor)
Accessible in: Matter: Editors >

Live mode

Live Mode is an editor that associates a chosen surface with one or more chosen animations. These
associations are then used in Live mode, a navigation mode in which clicking on designated surfaces or
pressing preset keys triggers animations.

Defining Triggers
The editor that sets up Live mode is composed of two main sections: the list of animations associated
with a trigger, followed by the operations toolbar where the buttons are located.
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Live Mode Editor

The list of triggers contains all of the animations with a trigger. For each animation, the following
information is displayed:
Title

Information

Trigger

The name of the surface or Shaper object that acts as a trigger when clicked to start
the animation.

Play Mode

The name of the playback mode. This mode defines what happens when a trigger is
clicked again after the playback of an animation has been started.

Animation

The name of the channel clip or the timeline that will be played.

This list can be sorted. Click on the column header by which you want to sort the list.

TIP
You can double click on a trigger in the list to edit it.
The operations toolbar contains the following buttons:
Icon

Function
Add a trigger.
Switch to Live mode in the main window.
To exit the Live Mode, click the button

in the main toolbar of Matter.

Delete the selected triggered animation. This disassociates the trigger and the clip or
timeline, and removes the animation from the list in this editor. The clip or timeline is not
deleted from the database.

Creating a new triggered animation requires two steps: creating a trigger, then associating it with a clip
or a timeline.
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TIP
You must have created at least one clip or timeline in the Timelines editor.

Creating a Trigger
Use the button

to add a trigger. Two types of trigger are available:

Type

Function

Mouse

This type of trigger plays a clip or a timeline when you click on a specific surface in
the scene.

Keyboard

This type of trigger plays a clip or a timeline when you press a specific key on the
keyboard.

1.

First, select the type of trigger.

2.

For a mouse trigger, select the surface, or kinematics node. You can do so using the list or by
clicking on the button
to use an eyedropper to pick a surface, a null, a vector or a rotation
axis. When using a null, a vector, or a rotation axis, all of its child surfaces will function as triggers.

3.

For a keyboard trigger, click on the button to record the keystroke that will function as a trigger.

Associating a Clip or a Timeline
Once the trigger has been saved, a window opens.
1.

Select the clip or timeline to associate with the trigger.

TIP
A single trigger can trigger multiple clips or activate multiple keys. Each action taken
will be listed separately. Multiple selection of clips or keys with keys Shift or Ctrl is
possible ; this allows multiple lines to be created simultaneously with the same
trigger.
2.

Validate with the button OK or click on the button Cancel to close this window without saving an
association.

Choosing a Play Mode
1.

Choose one of the four modes from the Play Mode drop-down list. This mode defines the behavior
of the playback if the trigger is clicked again while the animation is playing.
Mode
Continue

Description
Click on the trigger for a playing animation to pause it.
Click on the trigger for a paused animation to resume playback from where it
left off.
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Mode

Description

Reset

Click on the trigger for a playing animation to restart it from the beginning.

Reverse with
pause

Click on the trigger for a playing animation to pause it.

Reverse
without
pause

Click on the trigger for a playing animation to reverse the direction of playback: the animation will play backward from the current point.

Click on the trigger for a paused animation to resume playback from where it
left off, playing the animation backwards.

TIP
If you do not choose a mode, the Continue mode is used by default.
2.

Click OK to save this triggered animation or click Cancel to close this window without saving.

Configuration Browser
Available in: Matter or Shaper: Editors > Configuration Browser

The Configuration Browser is for testing and exploring product derivatives. The Configuration Browser
interface is updated automatically according to the configuration rules [365] created: all symbols used
in rules pertaining to the active product are gathered and displayed in it. The browser lists all available
symbols for the product displayed in the active viewport.
The browser allows you to select which symbols among those available should be defined for rule evaluation. The selection is made either with checkboxes or from drop-down lists. All product derivatives
may thus be explored.
In Shaper , the Configuration browser displays only the parameters of the geometry, illumination and
position layers. Aspect and environment layers that have no application in Shaper , the associated parameters are hidden. If rules based on appearance, overlay or environment layers have been configured
for your product, you will find the associated parameters as soon as you return to the interface Matter .
In Shaper and Matter, the Configuration Browser displays the configured Cameras in the Camera editor.

Measuring Tool
Available in: Shaper or Matter: Editors > Advanced > Measuring tool>

The Measuring Tool shows the distance between two points that you have chosen. This distance
between these two points may thus be represented visually in the active view.

TIP
The Show the gizmos option must be checked to use the eyedroppers.
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• Click on the green eyedropper and select your starting point in the viewing window.
• Click on the yellow eyedropper and designate the end point in the scene.
The result is displayed in the Distance field of the Measure zone at the bottom of the editor.

TIP
The distance is represented visually.
The Enable Depth Test function allows you to show the gizmos measuring the distance between measuring points in the scene without them being obscured by surfaces. Uncheck this parameter to display
the points and the measurement above all the surfaces.

Snapshot Batcher
Available in: Matter: Snapshot >

Snapshot Batcher

The Snapshot Batcher is used to delay the rendering of a list of snapshots. It improves the fluidity of the
workflow by allowing a user to batch snapshots in order to launch the rendering operations at a more
convenient time.
Snapshots batched for delayed rendering are automatically saved when the database is saved.

Snapshots Box
The box Snapshots contains the list of all the captures awaiting rendering. It is fed from the various
capture editors ( Snapshot Image, Snapshot Video, Snapshot VR object, or Snapshot Cubic VR Panorama ).

TIP
The list of captures is associated with the active viewport. When the active viewport
is changed, the snapshots corresponding to that viewport or product are no longer
shown, though they remain in memory. Reactivate the original viewport to recover the
corresponding snapshots.
The Snapshots box contains a list organized into four columns. Each row of the list represents a
snapshot.
• The selection column shows an icon of a checked box when the snapshot is selected. Selected
snapshots will be rendered by the batcher when the rendering is launched.
• The Name column shows the name of the snapshot. This name is either provided by the user or
automatically assigned by the batcher. During rendering, this name will become the filename.
• The image column displays a miniature image of the snapshot to be rendered. The rendering engine
that will be used (OpenGL or Raytracing) is indicated on the upper part of the miniature. In the lower
right-hand corner, a symbol represents the type of snapshot.
• The Parameters column provides the following information:
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• image size,
• file format,
• snapshot type,
• render engine used for the snapshot (OpenGL or Raytracing) and engine specific options,
The list of snapshots can be ordered alphabetically by column by clicking on the column header.
Double-clicking on a snapshot in the Snapshots box restores the snapshot in the active viewport with
that of the snapshot and opens the editor that produced the snapshot. According to the type of
snapshot created, the following information, saved at the moment the snapshot was taken, is restored.
Type of
snapshot
Image
snapshot

Information
• image size,
• render engine used for the snapshot (OpenGL or Raytracing) and engine specific
options,
• point of view, camera specific parameters and depth of field,
• product’s aspect, position, environment, overlay, and geometry layer visibility,
• clipping planes and real-time sun settings.

Video snapshot

• image size,
• render engine used for the snapshot (OpenGL or Raytracing) and engine specific
options,
• animation frame rate,
• camera path and specific options,
• product’s aspect, position, environment, overlay, and geometry layer visibility,
• clipping planes and real-time sun settings.

Cubic VR
panorama
snapshot

• render size,
• render engine used for the snapshot (OpenGL or Raytracing) and engine specific
options,
• cubic VR panorama specific options,
• product’s aspect, position, environment, overlay, and geometry layer visibility,
• clipping planes and real-time sun settings.

Snapshot
VR Object

• image size,
• render engine used for the snapshot (OpenGL or Raytracing) and engine specific
options,
• camera path,
• VR Object specific options,
• product’s aspect, position, environment, overlay, and geometry layer visibility,
• clipping planes and real-time sun settings.
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Selecting Snapshots
The Snapshot Batcher differentiates between the current active snapshot and the captures selected for
rendering.
The current active snapshot is designated by clicking on it. It is shown with a light gray background or
surrounded by a dotted border.
The selected snapshots are marked with the

selection icon in the Snapshots box.

To select or deselect a snapshot, click within the space of the first column to show or hide the
selection icon.

Snapshot Context Menu
Right-clicking on one of the snapshots brings up the Snapshot context menu.
This menu, which affects the current active snapshot, allows the user to:
Operation

Description

Render current snapshot item

Clicking on this option opens the Save options dialogue box containing
the save settings. This rendering operation does not delete the snapshot from the Snapshot Batcher.

Duplicate snapshot

The text "Copy" is added to the name of the duplicate snapshots.

Rename snapshot

You cannot have multiple snapshots with the same name.

Delete snapshot

The programmed capture will be deleted.

Operations Toolbar
This toolbar provides the tools to lance rendering and to manage the selected captures in the Snapshots box.
Icon

Function

Description

Render snapshots

Launches the rendering for all of the selected snapshots. Clicking on
this button opens the Save options dialogue box. This dialogue box
contains the save settings for the snapshots to be rendered.

Select none

Unchecks the selection boxes for all of the snapshots in the Snapshots box.

Select All

Checks the selection boxes for all of the snapshots in the Snapshots
box.

Rename snapshot

Renames the current active snapshot in the Snapshots box. You cannot have multiple snapshots with the same name.

Duplicate snapshot

Duplicates the current active snapshot in the Snapshots box. The text
"Copy" is added to the end of the name of the duplicate snapshots.

Delete snapshot

Deletes the current active snapshot.
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Adding and Modifying Snapshots Using the Snapshot Editors
Snapshots are added to the Snapshot Batcher using the various snapshot editors: Snapshot Image,
Snapshot Video, Snapshot VR Object, or Snapshot Cubic VR Panorama. These editors can be accessed via
the Snapshot menu.
The validations buttons are located at the bottom of each of the editors.

Validation buttons in the snapshot editors

The Replace Current Snapshot Batcher Item button replaces the active snapshot in the Snapshot Batcher
with the snapshot created by the open snapshot editor.
The Add to Snapshot Batcher places the current capture parameters from the Snapshots box of any
snapshot editor in the Snapshot Batcher for rendering at a later time.

Rendering from the Snapshot Batcher
Launch the rendering of the selected snapshots by clicking on the Render snapshots button
Save options dialogue box will open.

. The

The Output directory sets the directory in which the snapshots are saved. The image files for the
snapshots are named after the corresponding view.
When Confirm overwrite is not checked, all files with conflicting names in the output directory automatically are overwritten. If Confirm overwrite is checked, you are asked confirmation for each conflicting
file before rendering. If you choose not to overwrite a file, the rendering for the corresponding view is
skipped.
Once the saving options are set, click OK to start rendering. Clicking on Cancel closes the Save options
dialogue box and brings you back to the Snapshot Batcher.
During the rendering, a dialogue box displays the operations performed, along with any potential errors
and warnings.

Raytracing Settings (Editor)
Available in: Matter: Editors > Raytracing Settings

Rendering Tab
The Raytracing Settings window contains all parameters needed to configure the rendering.
The image quality is determined by the activation of various options:
Parameter
Adaptive
antialiasing

Description
Enables the adaptive sampling of the scene: more rays are sent on pixels representing a zone with high color variations, thus strongly reducing aliasing. This
option is enabled by default.
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Parameter

Description

Use surface
environments

Instructs the raytracing motor to use the lighting environment assigned to surfaces rather than the global environment when reflecting zones outside of the scene.
Disable this option to use the global environment instead. This option is enabled
by default.

TIP
If the surface is dressed with a material that has a roughness value
greater than zero, by default the surface will not be rendered by the
raytracer. To render a material with roughness using the raytracing
engine, make sure that the Raytrace roughness option is selected in
the Raytracing tab of the Materials editor.
You may adjust the Ray rebounds parameters to obtain a rendered view with the desired quality, by first
adjusting the Maximum Recursion Level (maximum number of rebounds) reached during calculation.
In the Reflections box, the adjustable parameters are:
Parameter

Description

Max Reflections

Maximum number of reflections allowed during calculation.

Max Rough Reflections

Maximum number of rough reflections
allowed during calculation.

Similarly, the following parameters can be set in the Transmissions box:
Parameter

Description

Max Transmissions

Maximum number of transmissions allowed during calculation.

Max Rough Transmissions

Maximum number of rough transmissions allowed during calculation.

When a pixel is rendered, reflections and transmissions are computed until Max Recursion level, Max
Reflections, or Max Transmissions is reached. The End of course color parameter from the last material
hit is then used to determine if either a predefined color or the environment should be used to compute
the render. The End of course color parameter is set in the Raytracing tab of the Material editor.
It should be noted that setting the maximum number of rough reflections and transmissions to a high
value will drastically increase computation time. Rough reflections and transmissions exponentially
increase the number of traced rays. If a ray is sent through a ground glass with a transmission
roughness value set to 100, 100 rays will be generated for the first hit, and then 100 other rays will
be generated when each of these rays will touch the rear face of the glass. More than 10000 rays will
be therefore used to compute a single pixel. The Max Rough Reflections and Max Rough Transmissions
parameters should thus be used with caution to reduce computation time.
The Raytrace roughness for all materials option in the Reflections and Transmissions boxes overrides
roughness raytracing for all materials without considering parameters from the Raytracingtab of the
Material editor.
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The Override roughness sampling option is also available in these two boxes. It allows the roughness
sampling value from the Raytracing tab of the Material editor to be disregarded. This override applies to
all materials.
The option Use environment instead of background for refracted rays determines the behavior taken into
account when rays pass through a transparent surface. When this option is enabled, the refraction of
rays passing through a transparent surface redirects them towards the lighting environment instead
of the background. If a significant difference, such as a difference in color, exists between the lighting
environment and the background, this can produce unexpected effects. Consequently, it is possible to
ignore the refraction of rays passing through transparent surfaces by unchecking this box. This option
is enabled by default but is never taken into account when rendering multilayer images in a PSD or PSB
format.
The Viewport Raytracing box provides the option to automatically add views rendered by raytracing to
the Rendered Views History. To activate this option, tick the Automatically add to Rendered Views History
on render checkbox. This option is deactivated by default.

Viewport Raytracing Box

Remote tab
Patchwork 3D allows you to configure and use remote CPU from units (cluster) to generate a snapshot
with raytracing rendering engine.
For hardware requirements (main PC and calculation units) please, see the Required Hardware [22] chapter for details.
In the Remote tab, parameter are:
Parameter
Use remote
raytracing

Description
Enables raytracing calculation on remote units (PC) running a specific software :
Check the Use remote rendering checkbox to enable remote raytracing feature.

Units to be
used for rendering

Allows you to add remote rendering units for raytracing calculation.

IP

IP from each remote rendering unit.

Port

Port of each remote rendering unit.

NOTE
This port can be changed.
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Parameter
Status

Description
Status of each remote rendering unit.
• Offline (remote rendering unit is not ready for raytracing calculation)
• Available (remote rendering unit is ready for raytracing calculation)
• Uploading (send data to a remote rendering unit)
• Rendering (sending data to the remote rendering unit)

This box contains a list of configured remote rendering units. You can also select or unselect separately units with this symbol

.

The following operations can be performed on this box:
Icon

Function

Description

Add remote rendering unit

Add a remote rendering unit.

Remove remote rendering unit

Remove highlighted remote rendering unit.

Load remote rendering units file

Import a list of IP units from a text file.

Select all remote rendering units

Select all remote rendering units.

Disable all rendering units

Disable all remote rendering units

Clipping Planes (Editor)
Available in: Matter: Editors > Advanced > Clipping Planes

Clipping Planes is an editor that allows you to section the object of the scene in a pre-designated plane
in order to see its interior.
Active clipping planes are visible in all open viewports and will clip through all products.

NOTE
Clipping planes are positioned in the world. Consequently, modifying the position of a
geometry in the world will not move the plane. The position at which the plane clips the
element will be modified.

General Settings for Clipping Planes
The General Options zone provides render settings with the Face Elimination Policy function, which
allows you to show or to hide the backfaces of the surfaces.
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In the Face Elimination Policy drop-down list, the option Surfaces displays backfaces according to the
settings provided in the Surface Properties [195] in Shaper.

The Show Gizmo option displays a translation gizmo that can be manipulated to quickly move the plane of the active section.

The Tags section can be used to prevent surfaces from being clipped by the plane. Use the button to
open a list of tags; select the tag that marks the surfaces that should not be clipped. Tags are assigned
to surfaces using the Tag Manager [165] in Shaper.
Patchwork 3D Design allows the management and display of several Clipping planes simultaneously.
Each plane is listed separately, followed by indicators for the clipping plane's state (enabled or disabled), the visibility of its contour, and the visibility of its grid. Clicking on the indicators modifies the
state of the associated property.

Settings for the Selected Plane
The Enabled function in the Clipping Plane zone must be checked to view the clipping plane.
The Clipping Plane zone provides the planar equation used to define the clipping plane. You can modify
it by providing new numerical values.
Alternatively, you can choose a cross-section plane in the Select the Plane zone:
• Select the desired cross-section plane in the drop-down list.
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• Via the function Pick Plane, you can perform a cross-section starting with a plane directly selected
in the active viewport, using the eyedropper tool, or alternatively a precise cross-section point by
checking the Position option.

NOTE
The cross sections are represented automatically in the interactive view each time the
eyedropper tool is used.

Creating a Contour

The contour of the clipped surface edges can be visually represented by enabling the Show option
within the Contour zone. The color of the contour can be modified by clicking on the colored square to
open the color selector. You can also modify the thickness of the line by entering a numerical value, or
by using the up and down arrows of the keyboard.

Additional Display Options
The Plane box proposes a set of display options for the active cross-section plane.

Thus the display of a plane can be activated (Plane zone > Show checkbox) and the value of its
transparency (Alpha field), size (Width and Height fields), orientation, and Color of its representation
(Color1 and Color2) can all be modified. Alternatively, just a metric Grid is displayed (Grid and Step
options).
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Post-Processing (Editor)
Available in: Matter: Editors > Post-Processing

Post-Processing
is an editor used to create, enable/disable, combine, program and assign 2D
post-processing effects interactively. It creates and modifies a blend of effects, their properties, and the
way they are combined.
Once post-processing blend is assigned to the Patchwork 3D scene, viewing of the created effects is
instantaneous; adjustment of the various effects is done in real time.
Function

Description
Start point for assignment by drag-and-drop.

TIP
Assignment of a post-process is also possible from Matter sidebar's post-processing library. See Post-Processing Library [344]
for more information.
Allows an post-processing blend to be selected with a click on the viewport in
which it is active.
Creates a new post-processing blend.
Duplicates the active post-processing blend.
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Function

Description

Text field

The text field is for renaming the active post-processing blend.

Apply to background

Enables or disables the application of the post-processing effects to the background in the Patchwork 3D scene.

Apply to overlays

Enables or disables the application of the post-processing effects to the overlays in the Patchwork 3D scene.

In the Post-Processing Effects box:
Function

Description
This toggle button is for enabling/disabling a specified post-processing effect.
This icon indicates that the effect is enabled.
This icon indicates that the effect is disabled.
The New effect button is for adding a new effect to the post-processing currently being edited. Many effects are available. See the chapter Post-Processing Effects [337].
The Solo effect toggle button is for momentarily isolating the selected effect. A
green frame around the 3D view indicates that only the isolated effect is displayed.
The Delete effect button is for deleting the selected effect from the list of post-processing effects in the blend being edited.

Effect properties zone

The effect properties frame is for precisely defining the various parameters contained in a post-process, by assigning precise numerical value.

TIP
For post-processing that require settings on the size of the effect, it is possible to
adjust the effect relative to the size of the image with % width, % height, and % default
parameters. % default uses height or width based on the default orientation of the current
camera.

Advanced Menu
The Advanced sub-menu gives access to the various tools and options for combining several effects
with one another.
The rendering possibilities are numerous and the effects obtained can be extremely variable depending
on the parameters used for combining the effects.

Typical effect obtained by combining effects: Film grain + Edge detector + Tone Mapping + Hand drawing + Get 3D image.

Get 3D image is for restoring the initial 3D image (without post-processing).
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Store current result is for saving the image with the combination of activated effects.
Restore saved result is for restoring the image with the previously saved combination of effects.
Combine with saved result is for combining the image obtained by the latest activated post-processing
effect with the previously stored image.

The associated parameters are for precisely adjusting the influence of one image relative to the other.
Multiply/Add is for adding or multiplying the image by a factor.

Grain generator is for generating grain (simple filter used in the photo grain advanced filter).

Database Properties (Editor)
Available in: Shaper or Matter. File > Edit Database Properties

Each database possesses a set of properties concerning the displayed rendering, the color management, and the database format and creation. This information can be viewed or modified in the
Database Properties.

Rendering Tab
A database's rendering options are used to optimize Patchwork 3D's performance with certain less
powerful hardware configurations. In the Rendering tab, the options Force texture dimensions in powers
of two and Reduce Lightmap Size work to limit the resources required for rendering.
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WARNING
These options are intended for advanced users. Enabling these options can affect your
rendering in unexpected ways, particularly where smaller databases are concerned.

Color Management Tab
The colorimetric profile defines the interpretation of the color values (RVB, CMYK or LAB) by matching
them with measurable physical quantities (expressed in the space CIE XYZ or LAB). For the rendering
and adjustment of materials displayed on the screen to be consistent with the colors and the shades of
the real materials, it is essential to work in a defined colorimetric space. Patchwork 3D provides tools
for defining, installing and managing the colorimetric profiles of the workspace, of imported images
and of images produced by the software.
In this tab, you can consult and modify the profiles used by the open database.
To set the behavior concerning Color [52] management profiles for new databases, refer to the settings
available in the Color tab of the File > Settings menu item.

Application Tab
This tab contains information on the origins of the open database. The name and version of the
application with which it was last saved are displayed.

Environment Properties (Editor)
Available in: Matter: sidebar environment library > Edit

The Environment Properties
environment.

is an editor used to modify the properties of the active lighting

Certain HDR environment properties are updated in real time as they are modified. These properties are
indicated below.

General Properties
General Properties can be applied to all global or local environments.
General Properties:
Property

Description

Name

Displays the name of the environment. This name can be changed by providing a new name in this field. Use the Enter key to validate any changes.

Gamma

Allows you to change the gamma value of your image. Useful in some cases
for correcting the gamma value of the imported HDRI image.

Saturation

Allows you to adjust the color saturation of the environment image. Its value
varies from 0 (environment image in black and white) to 1 (environment image
in saturated colors). This property can be adjusted in real time.

Mapping Type

Allows you to define the projection method for the type of HDRI image.
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Property

Description

Invert

Allows you to invert the projection of the environment image.

Default Orientation

Initializes the orientation of the environment in order to position it correctly
with regard to the product.

Diffuse:
Property

Description

Exposure Correction

Allows you to adjust the influence of the exposure of the environment on the
diffuse layer of a material. It is a coefficient applied to this contribution. This
property can be adjusted in real time.

Lightmap Coloration

Allows you to adjust the influence of the environment color on the diffusion of
the materials using lighting textures.

Specular:
Property

Description

Exposure Correction

Allows you to adjust the influence of the exposure of the environment on the
specular or reflection layer of a material. It is a coefficient applied to this
contribution. This property can be adjusted in real time.

Resolution

Allows you to define the resolution of the image used for adjusting the mirroring.

High Quality Filtering

Eliminates whitening and aliasing effects environment reflections on sharp
geometries in scenes with very intense areas.

Reflection of an environment featuring a high intensity area
in a specular material without the High quality filtering option.

Reflection of an environment featuring a high intensity area
in a specular material with the High quality filtering option.
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Background:
Property

Description

Alternative
background map

Allows a high resolution texture in a low dynamic range format (JPG, PNG...)
to be used instead of the HDR environment for environment materials.

Exposure

Allows you to adjust the influence of the exposure of the environment on
the background. Its value is a coefficient applied to this contribution. This
property can be adjusted in real time.

Altitude

Allows you to adjust the altitude of the background.

Resolution

Allows you to define the resolution of the image used for the background.

The image below illustrates the impact of the general properties on the render:

Here the red light source is placed out of the viewport, to the right of the image. This red component can be seen bleeding across the
white bodywork.

Parallax Correction
Reflections generated by a local environment are calculated from the environment's position. However,
the observer's position is often different from the environment's position. This may produce a visible
difference between the physically realistic reflection of the environment and the reflection actually
observed in the scene.
Parallax correction uses proxy surfaces in order to correct for the shift due to the use of different
reference points for the observer and the environment.

193

Patchwork 3D Enterprise 2022 X5

Property

Description

Type

The type of proxy surface to use:
• None: no correction,
• Box: a cube,
• Hemisphere: a hemisphere,
The settings for each type of proxy surface are discussed below.

Automatic
adjustment
(...)

When a box or hemisphere proxy surface is used, Patchwork 3D Design can
estimate its required volume in order to match the environment zone as closely
as possible. Run this operation using the ... button. It may be necessary to
fine-tune the results.

Gizmo

Show or hide the highlighting of the proxy surfaces.

Box
Use a box as a proxy when the space that should be used for the environment is mostly box-like.
Boxes are always aligned on the grid. They are defined by their minimum and maximum values along
the X, Y and Z axes.
In the corresponding fields, enter the minimum and maximum coordinates along the X, Y and Z axes.

Hemisphere
Use a hemisphere as a proxy when the space that will be used for the environment is similar to a
hemisphere shape.
A hemisphere is defined by the length of its radius and by the position of the hemisphere's central
point.
Provide the coordinates for the central point, and indicate the length of the radius.

Local Environment Properties
Local environment properties set the capture zone for a local environment.
Icon

Property

Description

Product

Associate the environment with an existing product. Drag and drop
the product onto this field.

Dynamically rebuild when configuration
changes

Activate automatic updating for the local environment when changing configurations. This insures visual coherence in the reflections
of geometries, colors and lighting in the scene when the displayed
configuration is modified.

Position

Set the origin point at which the local environment will be captured
by providing the origin's XYZ coordinates.

Display and move
the capture box

The capture box makes it easier to visualize the zones from which
the local environment images are going to be captured. It can repositioned with the mouse.
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Icon

Property

Description

Pick the capture
origin

Set the origin point of the local environment capture in the viewport
using the eyedropper. The X, Y, and Z values of the clicked point are
automatically entered in the Position fields.

Refresh environment

Update the environment by recalculating the images captured by
the local environment box.

Radius

Adjust the size of the capture box.

Resolution

Block the resolution of the environment texture at a chosen resolution. Select the desired resolution from the list.

Exclude surfaces
with tags

If the surfaces of an object around which an environment local
is assigned have been tagged, they can be ignored by the local
environment. Provide the tags of these surfaces here.
For more information on tags, see Tag Manager [165].

Surface Properties (Shaper Editor)
Available in: Shaper: Surface > Properties (P)

Surface Properties displays and edits the properties of the selected surfaces. This editor is composed
of three tabs and an information zone.
Each surface has several properties listed in the zone labeled Information:
• Its name,
The name allows for rapid identification of a surface, both in Shaper and in Matter.
• Its drawing color in Shaper,
• A comment (initially, the name of the import file), The comment contains, once a surface has been
imported, the path to the source file.
• The layer to which it belongs,
• The type of surface.
Its name and comment can be modified by clicking in the text field and typing a new value.
To change the Shaper drawing color, you have access to a color chooser:
1.

Select a color, either by clicking on it in a color palette or in a color book, or by setting it in the color
picker on the left.

2.

To validate the selection and close the color chooser, click on the OK button.

The button Reset allows you to return at any time to the original color.

Lighting
In this tab, set the default behavior of this surface when lit.
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By default, all surfaces created cast shadows and receive shadows unless these values are overridden
for a given surface. This behavior can be modified by unchecking the boxes here.
Default lightmap format and size options are also available. The lightmap size is determined by Patchwork 3D based on the size of the surface.
The Factor option allows the calculated size to be increased or decreased. The values available are
multiplicative values applied to the length and to the width of the lightmap. Consequently, a factor of 2
will double the length and the width of the lightmap, for a total size increase of four. A factor of 0.25 will
divide the total lightmap size by four.
Increasing the size makes a lightmap more precise but requires more computational time and takes
up more disk space. Maximum size for lightmaps is set in the application settings. However, you can
impose a different limit for this surface in the Max size field.

Geometry
The Geometry properties of the surface:
• Its scale initially defined on importing,
The scale of a surface is the same used in the CAD tool used to model the surface. The scale of a
surface is generally detected automatically during the CAD import. However, it can be subsequently
modified.
• The number of points and triangles used to represent it.
The number of points and the number of triangles give information regarding the fineness of the lattice
structure used to represent the surface.
The Symmetry properties of the surface:
• Whether the symmetry is enabled or not,
• The plane of symmetry (XY, YZ, ZX),
• The position of the plane of symmetry.
The Animated Mesh properties of the surface:
• The default frame to display, if the surface is an animated mesh. The frame corresponding to the
slider position is used as the default visual for the surface. The frame number is also displayed to the
left.

Display
Surface State properties:
• Hidden,
• Frozen.
Just like the layers, the surfaces can be frozen or hidden individually. Each surface has two boxes: the
first encodes the visibility, the second the freezing. In order to be visible, a surface must belong to a
visible layer. It is editable if it is not frozen and if the layer to which it belongs is not frozen either.
The Optimization properties:
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• Removal of the hidden faces (backface-culling),
Surfaces use global default settings of the model for the backface-culling (disabled by default). However, you can enable or disable this optimization for one or more surfaces by changing the Force to show
backface or Force to hide default backface respectively.
• Simplified display: drawing of the bounding box.
When the lattice structure of a surface comprises a high number of triangles and points, its display
may become overloaded. You can simplify the representation of a surface in Shaper by enabling the
Display as Box option: the surface is no longer represented by its lattice structure but by its bounding
box.
Billboard properties:
• None, Rotate Y, or Rotate XY

Properties of a Selection of Several Surfaces
If several surfaces are selected, you can modify their color, their scale, their state and their display
properties.

Surface Properties (Matter Editor)
Available in: Matter: right-click on a surface > Edit properties

When you right-click on a surface and choose Edit properties, an editor appears. From this editor, you
can edit the surface's properties.

Visibility
This property indicates whether the surface is visible. It is taken into account only if the property of the
Visibility of the different surfaces product is enabled.
You can modify this property by:
• Visibility in the viewport context menu (right-click on a surface),
• Using the Click to Hide mode.
• Running the Show All operation available in the Visualization menu or the viewport context menu.
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Backface Culling
This property enables the removal of the faces that are not oriented toward the observer. This removal
of the rear faces consequently improves rendering speed.

Open volume: Only front (outer) faces are visible.

Open volume: The transparent top surface's front face is visible, and the bottom surfaces front (outer) and back (inner)
faces are visible.

A rear face is generally obscured by one or more front faces in a closed volume. If a face becomes
transparent (application of a transparent material), it no longer performs its occlusion function. It is
then essential to make the front and rear faces visible in order to close the volume.
Backfaces use the default global settings. See Use product global setting.
This parameter can be changed for each surface with the Backface Culling available in the viewport
context menu:
• Hide backfaces
• Show backfaces

Depth Writing (Transparent Materials Only)
This property, which is available from the viewport context menu, indicates that the surface leaves its
imprint in the depth buffer. It is most importantly used for solving transparency conflicts. This property
is modified by the Write depth option in the viewport context menu.

Transforming a Material
The Transformation zone allows you to manually position a material on a surface, by directly modifying
the numerical values U and V and also the rotation values in the Surface Properties.
With this, you have the capability of rotating and moving a material precisely and interactively by
means of the keyboard.
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Product Properties (Editor)
Available in: Matter: Editors > Advanced > Product Properties (F8)

Product Properties is an advanced editor used to override surface property settings from Shaper when
viewing the product.
The product name displayed at the top of the editor indicates which product is being edited. The
product name can be modified from this field.
Property

Description

Has its own
surface visibility

When this option is checked, surface visibility states in Shaper are ignored. This enables you to hide a surface in Shaper, but still view the surface in Matter, allowing
you to work on your model simultaneously in Shaper and in Matter.

TIP
When this option is enabled, a surface may also be hidden in Matter
but visible in Shaper. Set the visibility of a surface in Matter by
right-clicking on it and selecting Visibility to change its state.

Baked lightmaps reach their limits when certain objects casting shadows are animated, or may appear
or disappear according to the configuration. We implemented SSAO to break through these limits in
addition to lightmaps.
The SSAO (Screen Space Ambient Occlusion) measures the amount of ambient light that is blocked
by surrounding objects. If a surface is obscured by another object, less light will come to it and it
will be darker. The SSAO, therefore, measures the obstruction or occlusion of indirect light on an
object in order to reduce its amount of ambient light. Usually, corners, cavities, or edges of objects are
geometries with a lot of ambient occlusions.
More exactly the SSAO approximates the ambient occlusion using the Z-Buffer, it evaluates the depth
of the pixels around an area and then applies the occlusion to these pixels according to the samples
taken from the surrounding area.
Depending on the approximation of the ambient occlusion you wish to make, enter a value for the
Radius, number of Steps, and the Bias.
• The Radius is adjusted according to the area to be evaluated.
• The number of Steps is adjusted according to the proximity of the blackout object. A large number of
steps results in a better quality of the SSAO but has an impact on performance.
• The Bias is an arbitrary parameter allowing to adjust the result of the SSAO.
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Product without SSAO on the left and with SSAO on the right.

NOTE
You also have the possibility to add to the SSAO, the rendering of lightmaps by checking
the dedicated box.

Keyboard Map (Editor)
Available in: Shaper or Matter: File > Keyboard Map

The Keyboard Map is an editor used to verify the default keyboard and mouse shortcuts and to modify
them. By default, shortcuts are assigned to a small portion of the available actions. This editor can
be used to assign shortcuts to any available operations or to remove shortcuts from actions you don't
often use.
The Keyboard Map is divided into two tabs: Actions and Navigation.

Actions
In the Actions tab, on the left of this window is the list of operations used in Patchwork 3D. These
operations are combined into several groups: Application, Matter, Shaper, Surface Cutting Workshop,
Unfolding Workshop, and Timelines. The group selector allows you to display the operations of a group
in the list of operations. By selecting an operation, its description, the associated icon and the assigned
shortcut if there is one will appear on the right.
To assign a new shortcut to the selected operation, click the Enter... button and then press the desired
key on your keyboard that you wish to use. The shortcut entered then appears in the New shortcut
zone. If an operation is currently assigned to this shortcut, it is displayed in the Currently assigned to
zone. By clicking the Assign button, this shortcut is assigned to the selected operation. An operation
previously assigned to this shortcut is no longer assigned to it. You can remove the shortcut assigned
to an operation at any moment by clicking the Remove button.
The system of predefined configurations allows you to easily load one of the keyboard configurations
supplied by default with Patchwork 3D. The user configuration corresponds to the keyboard configuration that is currently being used in Patchwork 3D. Use the OK button to assign your new configuration
to the keyboard. Use the Cancel button to cancel any changes you have made. It is also possible to
display the keyboard shortcuts in an HTML file by clicking the Show as HTML button.
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Navigation
The Navigation tab displays the navigation modes that are accessible via shortcuts. The profiles in
the list Presets list offer default choices among the shortcut navigation configurations used in 3ds
Max, Alias, Maya, and Solidworks, as well as those used by default in the Patchwork 3D universe. The
buttons New, Rename and Delete on the right manage the list of presets. Each preset configuration is
fully editable.
Modifications are made in the same manner as in the Actions tab. To assign a new shortcut to a
camera action, select the action from the list on the left. Select the mouse button, and, if necessary,
the modifier keys for the navigation shortcut. If a camera action is currently assigned to this shortcut,
it is shown in the Currently assigned to zone. By clicking the Assign button, shortcut is assigned to the
selected camera action. A camera action previously assigned to this shortcut is no longer assigned to
it. You can remove the shortcut assigned to a camera action at any moment by clicking the Remove
button.

Render Quality Settings (Editor)
Available in: Matter: viewport context menu (right click on the name of the current camera) >
Render Presets > Edit Render Quality Settings

The render quality settings establish the rendering strategy in the 3D viewport. These are advanced
settings. Three preset profiles are available in the Render Presets submenu to simplify modification of
the render quality settings:
• Default,
• Fastest,
• Nicest.
The presets cannot be modified or deleted. To use a similar profile, first copy the preset, then modify
the new profile.

The top of the editor is dedicated to a preset profile management section:
• Drop-down menu: all of the existing profiles are listed,
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• New: create a new profile,
• Delete: delete the selected profile. Preset profiles cannot be deleted.
• Rename: rename the selected profile,
• Copy: create a copy of the selected profile,
• Make default: set the selected profile as the default profile to use when opening a new viewport. This
profile is saved in your application preferences and is also applied when you open a new editing
session in Patchwork 3D.
The render settings in this editor are applied or disabled depending on the phase of your interaction
with the 3D viewport. The current interaction or inactivity with the viewport constitutes the context,
shown in the drop-down menu:
Context

Description

All

The settings displayed when the context All is selected are applied to all contexts. That is, they are always applied.

During interaction

The settings displayed when the context During interaction is selected are applied while you navigate or work in the 3D viewport.

At end of interaction

The settings displayed when the context At the end of the interaction is chosen
are applied immediately when you stop navigating or working in the 3D view.

While idle

The settings displayed when the context While idle is selected are applied only
when the viewport is inactive.

Each context is associated with a set of parameters:
Parameter
Render
Mode

Description
Imposes a rendering style. In addition to the Material mode, which is the standard
rendering mode in Matter, all of the Shaper rendering options are also available:
• Wireframe: surfaces are represented schematically with plotting following the
lattice structure of each surface. The surfaces are not mutually masked.
• Smooth: the surfaces are shown smoothed out with solid faces, lit by soft lighting.
• Smooth and Highlights: the surfaces are shown smoothed out, as solid faces with
a specular reflection.
• Facets: the surfaces are represented by their lattice structure, not smoothed out,
as solid faces lit by soft lighting.
• Facets and Highlights: the surfaces are represented as a solid lattice structure, not
smoothed out, as solid faces with a specular reflection.
• Lit Wireframe: the surfaces are represented by an illuminated wireframe plot of
their lattice structure.
• Bounding Box: each surface is represented by the wireframe plot of its bounding
box. This rendering mode facilitates the handling of surfaces that have lattice
structures comprising a large number of triangles.
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Parameter

Description

Mirror reflections

Displays reflections in mirror materials when this option is checked.

Mipmaps

Allows the use of texture mipmaps. This option, which may use a significant
amount of GPU memory depending on the capacities of your graphics card, improves the render of textures when they are displayed on the screen on a scale
much smaller than their natural size. This is the case, for example, when they are
applied to objects that are positioned far from the camera.

Post-Processing

Allows post-processing effects to be displayed.

Real-time
depth of
field

Activates the real-time depth of field, which applies to navigation and to the playback of animations.

TIP
For the depth of field to be displayed in the 3D viewport, the software
antialiasing must be activated (see below). For an image snapshot,
the option Antialiasing must be activated in the Snapshot Images
editor.
FXAA

Enables or disables the fast approximate GPU antialiasing filter. It is best to use
either the software antialiasing or the GPU's fast approximate antialiasing, but not
both at the same time.

Specular
anisotropic filtering

The slider's position set the level of samples for the specular anisotropic filtering.
This filter is enabled when its value is greater than 1. It provides improved rendering
for textures viewed and an oblique angle.

The parameter for the software antialiasing [415] is composed of multiple options:
Option

Description

Enabled

Enables software antialiasing when the checkbox is ticked.

Progressive
depth of
field

Displays the various stages of progressive render refinement during the calculation of depth of field (except real-time depth of field).

Samples

Sets the level of definition via the number of renders per pixel of the final image.

Wait time

Sets the wait time before passing from the context At end of interaction to the
context While idle. This delay does not include the time required by the refinement
to the rendering, which can be consequential with certain configurations.

This option is not recommended if you are also using Real-time depth of field.

It is also possible to exclude certain types of materials from the render in a given context. By default, all
material types are rendered. Untick the checkboxes of the materials to exclude:
• Error: the render when an error prevents the material from being displayed,
• Null opaque: the render when no material is applied to the surface,
• Standard [291] opaque,
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• Standard [291] transparent,
• Seam [311],
• Matte [305],
• Environment [303],
• Opaque mirror [305],
• Transparent mirror [305],
• Multilayer [306],
• Stickers [312].

Selections (Editor)
Available in: Shaper: Editors > Selections

Selections is an editor used to save sets of selected Shaper objects.
This editor's interface consists of three tabs.

Saved Selections
The Saved Selections tab provides access to the operations on simple selections.
Operation element

Description
This zone provides a list of the saved selections.

The Create a saved selection button is for saving the currently-selected surfaces as a new selection set.
This button allows you to update the active selection based on additions or
deletions of surfaces you want to make.
This button allows you to rename the active selection.
The Delete a saved selection button is for deleting the active saved selection.

TIP
To activate one of these saved selections, double-click on its name in the list.

Selection by type
Surfaces can be selected by type.
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Selection by lighting
Select here the surfaces that have lightmaps (Select Surfaces with Lightmaps) and the surfaces that do
not have lightmaps (Select Surfaces without Lightmaps).

Regular Expression Selections
The Regular Expression Selections tab provides access to the operations on advanced selections by
regular expressions.
Icon

Function

Description

Save all the regular expressions

Saves all expressions of complex selections in a file.
This allows the same expressions to be used in several
databases.

Open regular expressions file

Import and recall a saved file of complex selections.

Create regular expressions
group

Creates a new group of regular expressions.

Delete regular expressions
group

Deletes the selected group of regular expressions.

Create regular expressions
based selection

Creates a new regular expression to use as a selection
criterion.

Delete regular expressions

Deletes the selected regular selection expression.

Example
A selection of all the objects named box will have the following regular expression: box*.
A group of regular expressions containing the following regular expressions: box* and cyl* will select in
one go all the objects named box and all the objects named cylinder.

TIP
To activate a selection group by regular expression, double-click on its name in the list of
regular expression groups.

Color Chooser (Editor)
Available in: Matter or Shaper: click on a modifiable color square

Modifiable colors can be clicked on in order to open a color chooser and to set a new color to be used
for the element in question.

Modifiable color squares. Click to open the color chooser.
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The interface of the color chooser is divided into two parts:
• On the left, the Color from Picker and Color from Temperature tabs provide tools for choosing a color.
Below them, a zone listing the color management profiles used by the database.
• On the right, two tabs help you manage the groups of colors used in your database as color palettes
or Adobe color books.
The buttons at the bottom allow you to save or ignore modifications:
Button

Description

OK

To validate your color selection, which appears in the rectangle to the left, and to close
the color chooser, click on OK. This updates the color of the element that you are
currently modifying.

Reset

The Reset button allows you to return at any moment to the initial color of the element,
shown in the rectangle on the right.

Cancel

The Cancel button closes the color chooser without saving any changes.

Color from Picker
The Color from Picker tab provides multiple ways of setting a color:

NOTICE
New Features in Patchwork 3D 2022 X5
• Select a color hue, shade, and tint by clicking on the selector.
• Enter color values. Color values can be entered in the following formats:
• HSV
• RGB
• LAB
• CMYK
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• Hexadecimal
You can pick a color anywhere on your screen inside or outside Patchwork 3D with the eyedropper .
To pick a color, just click on the eyedropper to activate it and then pick the desired color. A hexadecimal
code appears under the pointer to facilitate color picking.

Color from Temperature
The Color from Temperature tab provides an alternative method of setting a color by choosing the
temperature of a light source and applying the corresponding color.

Use the slider or enter a temperature value in Kelvin. The button beside the Temperature field provides
shortcuts to values for common color temperatures.

Color Palettes
Color palettes group together colors and can save them as an external resource. A saved palette can be
loaded later in another database.
Clicking on a color in the palette will load it in the color picker for use.
The buttons below the list of colors in the open palette allow you to manage the palette:
Button
New

Description
This button allows a new color to be added to the palette. The new color will appear
in the Color Palette list.

TIP
The color appears in the color palette. Each newly-created color is
named by default: Color 1. You can rename each color in the text zone
situated below the color palette.
Assign

This button allows you to update the selected color in the color palette with the hue
you have set in the color picker to the left.

Delete

This button deletes the selected color from the list of colors in your palette.
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Button

Description

Save to
file

This button saves color palettes in the KPL format.

Load
from file

This button loads KPL files.

TIP
KPL files can also be directly loaded by drag and drop from Windows
Explorer in the Color Palette tab.

Loading a KPL file in the Color Palette by drag-and-drop replaces the colors that are currently listed with
those from the KPL file. To add the list of colors in a KPL file to the list of colors already present in the
tab, hold down the Shift key during the drag-and-drop.

Adobe Color Books
Patchwork 3D supports color books used by Photoshop in the Adobe Color Book format (ACB). In the
File Tab of the Patchwork 3D Settings [48], you can set the access path to the Adobe directory where
these color books can be found.
Color books present in this directory are accessible via the Color Books tab in the color chooser. Select
your color book from the drop-down list in order to access the colors.

Layer Visibility Bookmarks (Editor)
Available in: Editors > Layer Visibility Bookmarks

Layer Visibility Bookmarks is an editor that stores sets of visibility states of geometry layers.
This editor's interface consists of an area for exploring layer visibility bookmarks and includes some
simple tools for editing and enabling these bookmarks.
In the exploration zone, Bookmarks, the bookmarks are listed by name and can be selected. This zone
contains the list of all existing layer visibility bookmarks.
Icon

Function
New

Description
Creates a new bookmark. This button saves the current set of visibility
states.

TIP
To create layer visibility bookmarks, set each layer's desired
visibility option directly in the Layers zone in the Shaper sidebar, then create a new bookmark.
Rename

Modifies the name of the selected bookmark.
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Icon

Function

Description

Sort

Sorts the list of saved bookmarks in alphabetical order by name.

Activate

Loads the layer visible states saved in the selected bookmark.

Refresh

Updates the selected bookmark by replacing the saved state with the current visibility states in the active viewport.

Delete

Deletes the selected bookmark.

Real-Time Sun (Editor)
Available in: Matter: Editors >

Real-Time Sun

Real-Time Sun is an editor used to set up and display a sun that can be modified in real time in your
products.

Example of real-time sun usage.

To spare memory usage, decrease the maximum size of lighting and shadow textures in File > Settings
> Lighting tab. Default values are nevertheless desirable.
This editor is composed of five boxes: Sun Settings, Shadow Settings, North Setting, Position, and Raytracing.
This editor state is saved individually for each product. Data related to the Real-Time Sun is included in
databases exported in KDR format.

Sun Settings Box
The Sun Settings box provides a set of adjustable parameters for creating a real-time sun.
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Parameter

Description

On

Check the On box to activate the real-time sun in your product.

Color

Click on the Color box to open the color chooser and pick the color to assign to the
sun.

Intensity

Enter in this field the value of the desired intensity of the sun. This value must be
positive. Unlike the sun type lightings available in the Shaper module, intensity is
adjusted according to the sun altitude.

Example of sun intensity variation.

NOTE
Real-time sun lighting is added linearly to the existing lightmaps in the
model. If your model has very bright lightmaps, the effects of the sun
will not be as visible.
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Parameter

Description

Shadow
intensity

By default, no light intensity is added to areas which are not sunlit. However, by entering a value in the Shadow intensity field, you can apply an additional light intensity in
these shadow areas. The value entered must be positive. The value 0 corresponds to
a realistic effect.

Example of shadow intensity variation.

Lightmap
modulator

Adding a real-time sun to the lightmap of a product can produce an intensity of a
lightmap that is too strong. If this is the case, you can modify the intensity of the
lightmap. The field Lightmap modulator is used to set a modulation coefficient for the
intensity of the lighting calculated in the Shaper module. The value of this coefficient
must be between 0 and 1. The value 0 assigns a null intensity to the lightmap. The
value 1 corresponds to the assignment of the lightmap as it is calculated in the
Shaper module.

Specular

Tick this check box to display the sun’s specular reflection on your product. Enter its
intensity in the corresponding field.

Example of a scene without and with the sun’s specular reflection.

Shadow Settings Box
Parameters specific to shadows are included in this box.
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Setting

Description

Shadows in mirrors

Tick this check box to display shadows on reflective surfaces. The activation
of this option extends the rendering time.

Shadow quality

Select the quality of shadows to display from the drop-down menu. The higher
the selected quality is, the longer the rendering time will be.

Shadow
smoothness

Select the width for the blur effect on shadow edges from this drop-down
menu. The more the shadows are smoothed, the longer the rendering time will
be.

Examples of different smoothness in shadows.

North Setting Box
The North Setting box is used to set up the north relative to the reference axis of the database. There
are three ways to set up the north direction:
• By entering a value between 0 and 360° for the angle between the X axis and the North arrow of the
compass,
• By clicking on the compass while holding the left button of the mouse, and dragging it to the desired
position,
• By clicking on the grid to define the orientation of the compass.

Positioning the compass at a 20.2° angle between the x axis and the compass.
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Position Box
The Position box consists of three tabs, one for each sun positioning mode.

Manual Tab
This tab proposes to position the sun by entering a value for the Azimuth and the Altitude, or directly
with the widgets by clicking or moving the sun to the desired position.

The Manual tab.

Azimuth is the angle in the horizontal plane between the sun direction and the north.
Altitude is the angle between the sun direction and its projection onto the horizontal plane.

Date, Time and Location Tab
This tab allows the sun to be located so as to mimic its position in the sky at a given date and time
for a specific location. To do this, select or enter the date and time of your choice in the corresponding
data field. Then provide the time zone with the drop-down menu. Areas of the world in darkness are
updated on the map.
To activate the shift for daylight saving time, check the Daylight savings box and enter the value in
minutes of the desired shift. This is only active on days when daylight saving time is applicable (from
the last Sunday of March to the last Sunday of October).
Next, specify your location of choice:
• By entering values for latitude and longitude in the data fields – the City field then displays User-defined,
• By selecting a city in the City drop-down menu, or
• By clicking directly on a point on the map – the City field also displays User-defined.

Extracted from Environment Tab
Select this tab to position the sun at the point defined in the Environment’s Brightest Point box in the
Product Environment Properties tab of the Product Environments editor. Positioning the sun in the Product
Environments editor is explained in the section Environment’s Brightest Point [164] Box.

Raytracing Box
The features in this box are used to activate the calculation of smooth shadows in the raytracing
computation.
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Check the Use soft shadows box to activate smooth shadows in the raytracing computation. Then,
specify the desired Sun angular diameter and Sample count for the sun. The shadow smoothness
increases with the angular aperture of the sun.

Overlays (Editor)
Available in: Matter: Editors > Overlays

Overlays

is an editor that enables the parameters of the active overlay to be edited.

The interface is divided into four zones:
• Operations bar and name of the active overlay: Displays operations available in the overlay library.
• Global parameters: Field for managing the alpha coefficient, which sets the level of transparency.
• Layers: Manages the appearance, placement and location of images used as an overlay, as well as
any background gradation. You must create at least one layer).

TIP
As with other types of layers in Patchwork 3D, the layers in an overlay can be used to
create configurations. To make overlay layers configurable, drag them from this zone
and drop them in the Configurations editor, where they can be placed either in the target
zone, or in the rules zone to create a basic configuration. For more information, see the
section Configurations (Editor) [155].
• Map: Used for managing the texture file and scale of the texture.
The following operations are available from the operations bar:
Icon

Description
Start point for assigning an overlay by drag-and-drop to a sensor or to a viewpoint.
Picking eyedropper used to choose, activate and edit an overlay used in a viewport.
Apply the overlay currently being edited to the camera sensor in the active viewport.
Create a new overlay.
Duplicate the current overlay.

Overlays also includes functions that simplify editing:
• Clicking on the name of the Map in use leads to the current texture group in the Matter sidebar's
texture library.
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• The Layer visibility icon is automatically selected when a layer is created, rendering the layer visible
by default.

Textures (Editor)
Available in: Matter: Textures Library (right-hand sidebar) > Edit

Textures is an editor that displays a texture in detail. Dragging and dropping a texture onto the interaction zone changes the texture visible in the editor.
Patchwork 3D includes metric dimensional management of textures which allows accurate association
to the metric dimensions of physical materials.
The mapping modes (planar, box, circular etc.) and the Unfolding Workshop define the sets of UV
coordinates on the metric scale. It is therefore necessary to verify the dimensions of the textures so
that they precisely match the surfaces to which they will be assigned.

Layer Visibility (Editor)
Available in: Matter: Editors > Layer Visibility

Layer Visibility is a control panel for the visibility of geometry and lighting layers, as well as lighting
layer colors. These types of layers are managed directly in the Shaper sidebar, without the help of a
dedicated editor. Layer Visibility affords an overview of the hierarchy of layers and provides controls
over their visibility in Matter.
The editor is organized into two tabs: Geometry and Illumination. The layer hierarchy is displayed in the
corresponding tab. Next to each layer's name, an icon indicates the layer's current state:

visible or

hidden. An illumination layer's color sets are indicated as enabled or disabled in the same manner
as in the Shaper sidebar tab.
The visibility of lighting layers is a viewport-level property. When the first viewport is opened, the
visibility state is initialized with the state set in Shaper. From then on, modifications made in Layer
Visibility are applied both to the active viewport and to the visibility state saved in Shaper. When
additional viewports are opened, the last saved state in Shaper is used.

Modifying a Layer's Visibility
Modifying a layer's visibility changes what is shown in the active viewport.
Modify the visibility state of a layer in the Layer Visibility Editor:
• To modify the visibility state of a geometry layer, click on the Geometry tab. Find the layer you would
like to modify, then click on the icon representing that layer's current visibility state.
• To modify the visibility state of a lighting layer, click on the Illumination tab. Find the layer you would
like to modify, then click on the icon representing that layer's current visibility state.
This switches the visibility state. If the layer was hidden, it will now be visible. If it was visible, it will
now be hidden.
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The visibility state icon will change to reflect the new state.

Modifying the Intensity and the Color of an Illumination Layer
Color and intensity of lighting layers are model-level properties. Modifying the intensity or the color of a
lighting layer will have an effect on all of the viewports displaying the model.
In the Illumination tab, find the layer you want to modify. Click on the color or intensity of the illumination layer to change the value.
Modifications are made in real time.
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PLUG-INS
HDR Light Studio Plug-In
Available in: Matter: sidebar environment library >

Create environment with HDR Light Studio

To use HDR Light Studio plug-in, you have to directly purchase the Automotive version of Lightmap
HDR Light Studio from the Lightmap website.
Link to the product: https://www.lightmap.co.uk/

NOTE
Patchwork 3D Design supports HDR Light Studio plug-in from version 5.
When using HDR Light Studio to create an environment, the following features are available in the
Patchwork 3D Product tools toolbar:

•

HDR Light Studio LightPaint Reflection: in Patchwork 3D, click on the point of a surface on which
you want the reflection of the light source selected in HDR Light Studio to be displayed. The light
source is repositioned in the environment so as to be reflected on this point. The angle between the
new light direction and the normal to the surface at the selected point equals the angle between the
observation direction and this same normal.

•

HDR Light Studio LightPaint Illumination: in Patchwork 3D, click on the point of a surface you
want to illuminate. The light selected in HDR Light Studio is repositioned in the environment so as to
illuminate this point. The light is positioned along the normal to the surface at this point in order to
obtain a maximum intensity where desired.

To gain access to the functions of HDR Light Studio, click the
Studio in the sidebar Environments library.

Create environment with HDR Light

Patchwork 3D creates a new HDRI environment of the "live" type as soon as the plug-in is launched.

TIP
To manipulate the HDRI parameters and see the effects in the Patchwork 3D viewport,
simply assign this environment to your scene by a simple drag and drop.
Lights created in HDR Light Studio are instantly visible in viewport.
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Patchwork 3D makes it possible to create several HDR Light Studio environments. To call up the plug-in
window for an environment, simply click the
environments window.

Edit environment with HDR Light Studio button in the

The HDR button at the bottom left of the HDRLS interface is for rendering and saving the HDR image in
high resolution on your hard drive:
When the high-definition environment image is saved, it is automatically sent to Patchwork 3D. To
benefit from the high-definition quality of the saved environment, simply increase the resolution of
the environment for the reflection and/or for the background. These parameters can be accessed by
Product > Environment properties.
The
High-quality environment button in the Matter sidebar's environment library lets you increase
the quality of the HDRI environment sent to Patchwork 3D by the plug-in.
This button calls up the same action as the HDR button at the bottom left of the HDRLS interface. It
lets you save the HDR image in high resolution on the workstation’s hard drive.

TIP
If you edit your existing lighting setup in HDR Light Studio, your HDR is sent to Patchwork 3D as a low-definition environment. When your environment changes are finished,
remember to save your HDR environment again to your disk (HDR button) so that it will be
sent to Patchwork 3D.

NOTE
For additional information concerning HDR Light Studio uses see online help or PDF User
Guide at https://www.lightmap.co.uk/support/.
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IMPORT AND EXPORT
CAD Models
Importing 3D CAD Models
In the Shaper interface, CAD models are imported using the menu Model > Import or File > Import in
a new database. To import a model, select the desired file format, and then select your file using the
browser. A status bar will appear, indicating the progress of this import.

WARNING
The list of recognized formats depends on the software options selected during the
purchase of your Patchwork 3D license.
The following file formats are available:
• FBX (*.fbx)
• DXF (*.dxf)
• Wavefront OBJ (*.obj)
• 3DS (*.3ds)
• STL (*.stl / *.sta)
• Parasolid (*.x_t / *.x_b)
• Parasolid IGES (*.iges / *.igs)
• Solid Edge (Assembly= *.asm ) / (Part= *.par)
• SAT (*.sat / *.sab)
• XML (*.xml)
• STEP (*.step / *.stp)
• Creo, PRO Engineer (*.prt / *.asm)
• Catia V4 (*.model / *.exp)
• Catia V5 (*.CATPart. /*.CATProduct)
• CATProduct V2 (*.CATProduct)
• Wire file
• Wire folder
• NX (*.prt)
• SolidWorks (Assembly= *.sldasm) / (Part=*.sldprt)
• Lumiscaphe P3DXml (*.xml)
The import compatibilities in 2022 X5 are as follows:
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Source

Format

Support in Patchwork 3D

Autocad DXF

.dxf

Through 2022

Siemens NX

.prt

Through NX1953

SolidWorks

.sldasm, .sldprt

From 98 through 2021

Autodesk Maya

.fbx

Through 2020.2.1

Autodesk 3ds Max

.fbx

Through 2020.2.1

Acis

.sat

Through 2021.1.0.2

Parasolid

.x_t, .x_b

Through 34.0.1

Alias

.Wire

Through 2022 - 1.0.0

SolidEdge

.asm, .par, .psm, .x_t

Through ST11 (with Parasolid export)

Creo Pro/Engineer

.asm, .prt

Through Creo 7.0

Catia V4

.model, .exp

4.1.9 through 4.2.4

Catia V5

.CATPart, .CATProduct

V5R8 through V5-6R2021

Catia V6

.CATPart (v5), .CATProduct (v5)

Through V6 R2021x

OBJ

.obj

All versions

STL

.stl

All versions

3DS

.3ds

All versions

Step

.stp

203, 214, 242 versions

IGES

.iges, .igs

All versions

Based on the format of the file you would like to import, it is recommended to use the first possible line
in the following table:
From

To

Importer to Use

Catia, Acis, NX, SolidWorks, Parasolid,
software supporting FBX

Patchwork 3D

Direct interoperability (for example, use the NX importer for NX
files)

software supporting STEP

Patchwork 3D

STEP

software supporting IGES

Patchwork 3D

IGES

software supporting OBJ

Patchwork 3D

OBJ

any other software

Patchwork 3D

DXF, STL

Patchwork 3D uses two 3D modeling engines to import file formats storing geometry elements as
NURBS:
• ACIS
• Parasolid
Formats imported using these powerful geometry engines will allow users to work directly with the
surface topology. Tessellation and assembly options are available for surfaces imported in these
formats.
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Autocad DXF, Wavefront OBJ, Ksc formats store the models as lattice mesh geometry. Tessellation and
assembly options are not available for surfaces imported in these formats.
Patchwork 3D works on a metric scale. Certain CAD formats specify the scale used for the design
of models. In this case, Patchwork 3D interprets this information and converts the dimensions of the
model from the original scale to the metric scale. When the scale information is not available in the
CAD file, Patchwork 3D uses the default scale specified for each format in the general preferences of
the software.
To open the window used to set the application’s importers default units, navigate to the File menu >
Settings > Geometry tab > Define default units button.

Import User Interface
The import parameters are accessible from Shaper > Model > Import a CAD model and from File > Import
in a new database.

Import Parameters dialog box for a CATPart file
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Depending on the FBX file you wish to import the following options will be available:

General
If the Save while importing checkbox is ticked, Patchwork 3D will first ask you:
• to save your CAD model import in a P3D file format that can be interpreted by Patchwork 3D,
• whether or not to save the rendering cache (for more details please refer to the following chapter:
P3D Database [38]).

NOTE
Save while importing allows you to save the P3D file at regular intervals to avoid saturating the memory when the CAD model being imported is large. Please note that this option
has an impact on the import time.
If the After importing, display Lighting and Environment Creation options checkbox has been ticked, at
the end of the import the Scene parameters window is displayed, so that you can select the elements
constituting the creation of a scene, that is to say its lighting and its environment. Details of the
available options can be found below in the section Automatic scene preparation [222]

Automatic scene preparation

NOTICE
New Features in Patchwork 3D 2022 X5
If the box After the import, display the lighting and environment creation options has been checked, at the
end of the import, the following window is displayed.

Check the desired options and Patchwork 3D takes care of the rest to create the scene with its lighting
and environment.
222

Patchwork 3D Enterprise 2022 X5

The option Create an environment with a hemisphere is particularly useful if you want your model to be
quickly staged in a very realistic environment. Patchwork 3D will take care of creating for you a hemisphere, an environment and a environment material [303]. The latter will be automatically assigned
to the surface of the hemisphere. The HDRI environment files recognized by Patchwork 3D are HDR
and EXR. You can also add a plane with the shadow of the imported model to your scene (cf. Matte
material [305] ).

TIP
If you do not select an HDRI environment, Patchwork 3D will automatically apply the
Studio environment on the surface of the hemisphere.

Import Options
The table below lists the available options (✔) depending on the import formats.

Options

Data

Importer

Format

Save
while
importing

Import
Colors

Import
Materials

ACIS

Acis
xml

✔

✔

Acis
sat

✔

Catia
V4

Parasolid

Import
UV

Groups
Import
Hierarchy

Stitch

Merge

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

Catia
V5

✔

✔

✔

✔

✔

✔

IGES

✔

✔

✔

✔

✔

✔

NX

✔

✔

✔

✔

✔

✔

Pro/E

✔

✔

✔

✔

✔

✔

SolidWorks

✔

✔

✔

✔

✔

✔

Step

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

Solid
Edge
asm

✔

✔

Solid
Edge
prt

✔
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Options
Importer

Parasolid (*)

Data

Format

Save
while
importing

3ds

✔

Obj

✔

STL

✔

FBX

✔

DXF

✔

LWO

✔

Wire

✔

Import
Colors

Import
Materials

Import
UV

Groups
Import
Cameras

Import
Hierarchy

ACIS

Merge

Merge
unamed

✔

✔

Options
Importer

Stitch

✔

Advanced Options

Format

Scene Orientation

Tessellation

Log

P3D Xml
Settings

Specific
Options

Acis xml

✔

✔

✔

Acis sat

✔

✔

✔

Catia V4

✔

✔

✔

✔

✔

Catia V5

✔

✔

✔

✔

✔

IGES

✔

✔

✔

✔

✔

NX

✔

✔

✔

✔

✔

Pro/E

✔

✔

✔

✔

✔

SolidWorks

✔

✔

✔

✔

✔

Step

✔

✔

✔

✔

✔

✔

✔

✔

✔

Parasolid

✔
Solid Edge asm

✔

Solid Edge prt

✔

3ds

✔

Obj

✔

✔

STL
FBX

✔

DXF
LWO
Parasolid (*)

Wire

✔
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Exporting CAD models
In Shaper, CAD models are exported using the menu option Model > Export or File menu > Export. To
export a model, select the desired file format, then enter the filename you would like to save the model
under.
The following file formats are available:
• Lumiscaphe Ksc (*.ksc) (optional, based on your license)
• Wavefront OBJ (*.obj)
• Lumiscaphe P3DXml (*.xml)
• FBX (*.fbx)
The following table gives the version compatibilities:
Format

Compatible versions

OBJ

All versions

P3DXml

P3D software suite 2022 X5

FBX

Autodesk Maya / Autodesk 3ds Max from 2013

P3DXml Format
This format is for exporting and importing P3D data in XML format via the Shaper module of Patchwork
3D.
It is used mainly for merging several elements from different P3D databases (e.g. vehicle interior and
exterior).
List of transferred elements:
• Layers,
• Surfaces and their geometries (nurbs, meshes),
• UV coordinates,
• Lighting effects,
• Kinematic hierarchy (All of the work done to prepare a synchronized animation of surfaces is preserved during the export.),
• Configurations,
• Materials,
• Environments, including alternate background textures,
• Timelines,
• Camera hierarchy,
• Sensors.
The P3DXml format is an open format and facilitates the creation of customized gateways between
Patchwork 3D and the other software.
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FBX Import
The FBX import allows information related to surfaces and surface parameterization, textures, camera
animation paths, and materials to be imported. Furthermore, Patchwork 3D supports FBX files up to
version 2012 included.

Import Parameters dialog box for an FBX file

During the import process of one or more FBX files, a log window displays its progression. The log
window shows events, warnings (printed in orange), and errors (printed in red).

Imported FBX Data
Surfaces
The Patchwork 3D FBX importer only supports FBX mesh surfaces. If the FBX surface contains quadrangles or polygons which have more than four vertices, they are triangulated.
If the FBX file contains NURBS or Patch nodes, the importer carries out a preprocessing step in order
to triangulate these geometries using the FBX SDK. After this preprocessing step, these surfaces are
imported as Shaper mesh surfaces. The FBX importer does not try to stitch surfaces automatically.
If the surface contains more than one material, it is split into sub-surfaces. Each sub-surface corresponds to the restriction of the original surface to one material. In this case, a null surface is created
and serves as a parent for the sub-surfaces.

Point cache
If references to point cache files containing information for vertex displacement are found in the FBX
file, the animation of the meshes are imported at the same time as the surfaces.
Point cache files are exported from Autodesk Maya or Autodesk 3ds Max during the FBX export. This
plugin is included in both Autodesk Maya 2017 and Autodesk 3ds Max 2017.The Geometry Cache File(s)
option (Autodesk Maya) or the Point Cache File(s) option (Autodesk 3ds Max) must be selected.
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The MC (XML) format is preferred. Point cache files in pc2 or MC (XML) format are supported.
Example: exporting from Autodesk 3ds Max 2017
1.

Create an object with a mesh animation.

2.

Select the menu option Edit > Manage Selection Sets. The named selection set management window will open.

3.

Select the object with a mesh animation, then create a new selection set. This new set contains
the animated mesh.

4.

Select the option from the main menu > Export > Export. Choose the FBX export and confirm. You
will need to provide a filename and a location to save the export.

5.

An options window opens. Expand the Animation section. Check the box beside the Animation
option.

6.

Expand the Cache Point File section. Check the box beside the Cache Point File(s) option. Then, in
the drop-down list, choose the selection set you created for the animated mesh.

7.

Validate. This operation will create an FBX file with the vertex displacement information. It also
creates a folder with the same name and the _FPC suffix, containing an MC file and an XML file.
These are the point cache.

If you prefer, you can modify the type of point cache file to be created:
1.

Create an object with a mesh animation.

2.

In the sidebar, select the Modify group.

3.

Select the mesh.

4.

Add a modifier by selecting Point Cache from the List of Modifiers.

5.

In the Parameters zone, click on New. At this point, you can select the file format: XML (the default
format) or PC2. Validate your choice.

When exporting an FBX file with point cache files as described above, the selected point cache format
will be respected.
For additional information on creating animated meshes and their properties, refer to the Autodesk
Maya documentation under the Geometry Cache section, or to the Autodesk 3ds Max documentation
under the sections Modifiers, Point Cache Modifier (Object Space) or Point Cache Files.

Surface Parameterization
The Patchwork 3D FBX importer supports the import of the FBX UV sets, which are copied automatically into the fields uvw:0, uvw:1… of the Patchwork 3D surfaces. For each of these UV sets, the surface
mapping type is set to Extract.

Materials
The Patchwork 3D FBX importer also imports some of the materials used on mesh surfaces. The
imported materials are assigned to the imported surfaces.
Lambert and Phong materials can be imported. The imported properties are the following:
• Diffuse color,
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• Ambient color,
• Opacity modulator,
• Reflection Factor (for Phong materials),
• Specular color and factor (for Phong materials).
The following figure shows the expected behavior when importing a FBX file created using Maya
software (note: the lighting is different between the two screenshots).

Maya shading (left) and Matter shading (right) for an imported FBX file.

Textures
If a texture file is found on the diffuse, bump or specular layer of a Lambert or Phong material, it is
imported provided the FBX importer is able to retrieve it. Only the first texture file on each layer can be
imported. If more than one texture file is found on a given layer of a FBX material, all files starting from
the second one are ignored. In such cases, a warning is inserted in the log file.
The Patchwork 3D FBX importer looks for texture files as follows: it tries to retrieve the file using the
absolute file name found in the FBX file first, and then using the relative file name generated by the FBX
export module. Lastly, it tries to retrieve the file in the FBX file directory using only the texture file name.
The texture is assigned to the corresponding layer of the material, and is also visible in the Texture tab
of Matter.

Camera Animation Path
The Patchwork 3D FBX importer imports camera paths as follows: each key frame is imported as a
tuple (from, to, up, fov) written in a Patchwork 3D Kam file. Thus, baking the animation at the desired
frame rate while exporting a FBX file is necessary as intermediate positions cannot be rebuilt from Kam
files.
The FBX importer creates one Kam file per camera. The Kam file name is built as follows:
"fbx_file_name> FBX import – camera_name>".
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Animation
Transformations of the scene graph saved in FBX format are imported as a timeline containing channel
animations. Each channel animation corresponds to the animation of a node in the FBX scene graph
and is placed at the correct time in the timeline.
As channel animations, these elements appear in the Channel Animations library in the Timelines editor
and can be reused in other timelines. Channel animations created by the FBX importer are not editable.
The FBX importer creates the following elements:
• A timeline with the name of the imported FBX file. This timeline is shared with imported animated
meshes.
• One channel animation per node animation, each with the name of the corresponding node.

Other FBX Nodes
Any other FBX nodes are imported as null surfaces. The null surface name in Patchwork 3D is the node
name read in the FBX file.

Visibility Layer Hierarchy
The FBX importer first creates a layer with the time stamp and the path to the directory used to store
the temporary files generated during the import process. Then, it creates a layer for each imported file
using the file name as layer name.
For each file, the FBX importer builds a layer hierarchy corresponding to the FBX file node hierarchy.

Layer hierarchy from data in the FBX format in Maya (left) and Patchwork 3D (right).

Kinematic Hierarchy
The FBX importer also builds a kinematic hierarchy that follows the FBX node hierarchy.
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Example of kinematic hierarchy in Shaper built according to a FBX node hierarchy.

Wire Import
Importing Files in the Wire Format
Geometry Data
The different types of geometry data interpreted are:
• Groups,
• Meshes,
• Polysets,
• Shells,
• Surfaces.
Existing parameterizations are not interpreted. As a result, imported surfaces are given the default
parameterization (type BOX).

Material Data
The material data interpreted are:
• "File" type textures,
• RGB color parameters,
• Some parameters from the Phong and Lambert models.
For each Surface or Shell, the first shader only is retrieved. A Matter material is created from this
shader and assigned to the corresponding object.
A standard Matter material is created by retrieving color data. Furthermore:
• For "Phong" materials, intensity and specular roughness data, along with the diffuse intensity, specular filter and transparency, are retrieved,
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• If it is a "Lambert" type material, the diffuse intensity is recovered.
"File" textures in the original material are added to the texture library, and the first one is assigned to
the diffuse color map of the material.

Wire File Format Import Options
All options for importing Wire files or folders are gathered in a dedicated dialog box. This dialog box is
accessed from Shaper either by selecting Model > Advanced > Wire folder, or from the Model tab.

Surfaces
This dialog box contains the options for importing surfaces.
Visual quality : the tessellation size may be set using either the slider or the field linked to it. By default,
the tessellation is generated with a Tolerance of 0.5 mm between the triangulated surface and the
NURBS surface.
Grouping surfaces: three options are available for grouping surfaces.
• By Layer: A Shaper layer is created for each Wire layer. Groups of imported surfaces are assigned to
the Shaper layer associated to their initial Wire layer. The groups are made up as follows: for a given
Wire group containing at least one Shell or Surface, a Shaper group is created with the surfaces it
contains. This option is activated by default.
• By shader: A Shaper visibility layer is created for each Wire shader. The groups are created similarly to
when using the By Layer option.
• By Layer Hierarchy: A Shaper visibility layer hierarchy that reproduces the Wire layer/group hierarchy is
created.
Transformation: this option is for defining how surfaces with symmetry are imported.
• No symmetry: no symmetry is imported.
• Use layer symmetry: the symmetry defined in the layers of the Wire file is used (the plane of symmetry
is retrieved). This option is activated by default.
• No symmetry on shaders with suffix: a symmetry with the default plane (equation z = 0) is used for all
surfaces whose shader does not have a name including the specified suffix.
Kinematics: this option allows importing object graphs as kinematics graphs. A null surface is attached
for each group of the Wire data tree. The null surfaces are attached to a visibility layer named Wire
Import Kinematics and the kinematics hierarchy is accessible in the dedicated tab. This option is
enabled by default.
Topology: these options control the sewing process and grouping the surfaces.
• If Use topology is activated, then an attempt at converting Shells into Parasolid surfaces is made.
Shells may be imported as meshes if the option Convert to mesh in the Topology conversion failures
box is enabled. These meshes are built using the Alias tessellation engine.
• Autostitch is for controlling the attempts at sewing imported surfaces. If Autostitch is enabled, then
an attempt is made to:
• sew the surfaces of a Shell together,
• sew the surfaces of a group of objects with the same shader,
231

Patchwork 3D Enterprise 2022 X5

• sew the various parts in a list of Shells.
The options Use topology and Autostitch are enabled by default.

Camera
This option imports the file’s cameras as cameras. These cameras are saved in a group of cameras
named wire import – filename. This option is activated by default.

Shaders
The options for importing textures and materials are contained in this box.
Import textures: this option allows you to import textures of the "file" type, possibly specifying a
maximum size. It is activated by default.
Reuse shader information: if a material with the same name already exists in Matter library, then it is
used. Otherwise, this option allows the material library to:
• Create a new material systematically (No),
• Create a new material only if there is no material with the same name in the default library (Use
default library),
• Create a new material if there is no material with the same name in the specified library (Use specified
library).

Topology Conversion Failures
This box is for defining the actions to perform in case of a topology conversion failure.
Save failed objects: this option is for saving Shells that could not be imported as files, using Alias file
format. It is disabled by default.
Convert to mesh: this option converts Shells whose import failed using Alias tessellation engine into
meshes. It is disabled by default.

Log
A log file can be specified using this option. This file may be deleted if no problem occurred during the
import by selecting Delete if everything went OK. No default file is specified.

Update Mode
Update current model with imported file: when this option is enabled, the Shaperexisting surfaces of
the current model with the same name as surfaces of the imported file are updated. The geometry,
comment, symmetry and material are updated. If a group of surfaces with the same name exists, its
color and material are updated, and the new surfaces attached to it.
The group name is defined as follows:
• For a Shell, it is the name of the Wire Shell node,
• For a list of Shells, it is the name of the Group and the shader name linked with #.
Keep textures: when this option is enabled, updates of a surface or a group of surfaces do not take the
material into account.
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Exporting Matter Products
Matter products can be exported via the menu Product > Export.

Export KDR
Accessible in: Matter: Product > Export

In order to be used with the Lumiscaphe software suite of 3D visualization tools, the raw authoring
data must be exported as a Digital Aspect Mockup (DAM) in the format KDR. This format contains only
the data required by the rendering engine in order to display the product variants and configurations
created in Patchwork 3D. The image underlying the relief in texture is no longer present; only the
resulting calculations needed to display a material using that texture are conserved. Consequently,
authoring is not supported in this format. The KDR is optimized to load more quickly: unlike the .p3d
format, in which the displayed images must be calculated when the file is opened, the data in the KDR
can be transmitted directly to the graphics card without further treatment.
The Digital Aspect Mockup may then be used as-is in any of the Lumiscaphe visualization solutions.
Depending on the case, the addition of new features in Patchwork 3D has an impact on the data to be
exported in KDR format. To clearly identify which KDR format works with the version of Patchwork 3D,
X i has been added in the software naming.
• If adding the features in Patchwork 3D do not modify the KDR format, we could have the following
examples: Patchwork 3D 8.3 X2, Patchwork 3D 8.4 X2, Patchwork 3D 8.5 X2 , and so on.
• However, if adding the features in Patchwork 3D modify the KDR format, we could have the following
examples: Patchwork 3D 8.3 X2, Patchwork 3D 8.4 X3, Patchwork 3D 8.5 X4 , and so on.
When exporting a product in KDR format you will have the ability to export:
• The current version of KDR> KDR. In the Export to KDR Xi window that appears, type the name of the
file under which you want to save it.
• The previous version of the KDR > KDR (previous version). In the Export to KDR window that shows up,
select the version of the KDR you want to export from the drop-down menu. Then type the name of
the file under which you want to save it.

NOTICE
A lower version means better compatibility with other software, but fewer features supported. A higher version means more features supported, but the compatibility with other
software might be broken.
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The table below lists the supported format(s) according to software versions.
KDR

Version

Description

X1

From v8.0 to v8.2

"Software Suite v8.0"

X2

v8.3

U or V repetition for stickers and textures.
Repetition for labels and textures in mirror.

X3

2019.1

Using the roughness map.

X4

From 2019.2 to 2020.2

AxF CarPaint (CPA2) materials.
Choice of units for overlays and post-processes.

X5

2021.1 and later versions

Recolouring of AxF CarPaint (CPA2) materials.
SSAO
Cameras exposure property addition in configurators.

Export FBX
Accessible two different ways from:
• Matter : Product > Export
• File > Export > FBX

To export an FBX product, select the FBX file format, an FBX Export Options window shows up, select
the desired settings and click on Export button and then type the name of the file under which you want
to save it.
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If your product has kinematics you can choose to export the Kinematic tree (the option is enabled by default). Otherwise, only the
option to export the Geometry layer tree will be available.
If your product does not have kinematics, the Geometry layer tree option will be enabled by default.

The following file format is available:
Format

Compatible versions

FBX

FBX 2013
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MODELS
The highest-level object handled by Shaper is the model. A model is a collection of geometric and null
objects and their properties.
Several related models can be stored in the same database. Shaper functions as a model explorer: you
select the model on which you wish to work, by means of the model selector.

Operations on Models
Operations concerning models can be found in the Shaper Model menu or in the Shaper Geometry
sidebar tab:
Icon

Function
Create a new model.
Duplicate a model.
During the duplication of a model, Patchwork 3D shares the geometrical elements constituting the surfaces of the model between the original and the duplicate models. This
means that duplicating a model uses very little memory.
Rename a model.
Import a model.
Export a model.
Delete a model.

A 3D model can occupy a large amount of memory. A Shaper model is loaded into the memory only
when it is to be edited. All the models loaded during your work session are held in the memory and are
instantly available by means of a system of tabs located just below the top toolbar.
On the right, in the same bar as the tabs, the button
can be used to close the current model. You can
also clear a mode from the memory by closing it by means of the Model > Close menu option.
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SURFACES
The surfaces are the 3D geometrical elements used to construct the models. The surfaces are directly
derived from importing the CAD models into Patchwork 3D. The surfaces are represented by a lattice of
triangles (a mesh).
A surface may contain several non-contiguous geometrical elements. Dressing models in Matter is
performed surface by surface.
The same surface, whether it consists of one or more geometrical elements, can receive only one
material. It is therefore important to split surface elements in your CAD tool before importing them into
Patchwork 3D.

Left image: the seat on the left has several distinct surfaces. Right image: the seat on the left has a single surface made up of several
geometric elements.

Operations on Surfaces
The operations associated with surfaces can be found in the menu Surface of Shaper or in the tab
Geometries from the sidebar of Shaper :
Icon

Operation

Description

Duplicate

Makes a copy of the selected surfaces in the active layer. The original surfaces are unselected and the duplicate surfaces are selected
instead.

Move

Moves all the selected surfaces into the active layer.

Properties

Opens the Surface Properties (Shaper Editor) [195].

Randomize
Surface Color

Changes randomly the color of the highlighted surface(s).

Delete

For example, this allows the surfaces of geometry to stand out with
different colors when you have imported a CAD file into Patchwork 3D.
Deletes the selected surfaces.

Certain operations are available only from the Surface menu:
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Icon

Operation

Description

Duplicate
with Symmetry

Duplicates a surface using a symmetry function. The duplicated surface
is fully independent of the original, unlike the surface symmetry property, which can be activated in the Surface Properties.
The surfaces duplicated in symmetry are highlighted.

Copy

Copies the selected surfaces to the clipboard.

Cut

Cuts the selected surfaces to the clipboard.

Paste

Pastes the contents of the clipboard in the active layer.

XY symmetrical duplication.

Surface Optimization
The optimization of surfaces is carried out in Shaper.
Surface optimization adds, corrects or perfects surface information after importing.

Triangulation
When a surface is derived from a parametric definition (for example, a NURBS), it is possible to modify
its degree of tessellation, that is, the resolution of the triangular mesh that makes up the surface. This
allows you to optimize the ratio of the rendering quality relative to the number of triangles generated.
Patchwork 3D will also tessellate groups of surfaces. Interactive tessellation is possible for the applicable surface, no matter what types of surfaces make up the mixed selection.

WARNING
Modifying triangulation requires particular license options. These functions are automatically available when a CAD import option is present.
Surface tessellation can be modified in Shaper using the toolbar buttons or the options in the Surface >
Triangulation submenu:
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Icon

Function

Description

Increase Triangulation

Increases the tessellation of a surface by one degree (refine the surface by increasing the number of triangles).

Decrease Triangulation

Reduces the tessellation of a surface by one degree.

Set Triangulation

Sets and imposes a specific level of tessellation.

Set Advanced Triangulation

Gives access to the advanced triangulation settings.

Modification of the tessellation parameter on a parametric surface.

Convert to Mesh: deletes the parametric representation of the selected surfaces. The current
tessellation is permanently affected to the surface. This reduces the space taken up by surfaces in the
database.

Stitch and Split Functions
In the menu Surface > Surface Topology:
Icon

Function

Description

Stitch

Allows you to join (&quot;stitch&quot;) or &quot;weld&quot; several selected surfaces.

Split

Disassembles a surface composed of several geometric elements. Each
geometric element becomes a surface in its own right.

Orientation: Front and Back Faces
A surface is an oriented geometric element with a front side and a rear side. By default, the back side
of surfaces is not rendered. This procedure is called "backface culling". In Shaper, the rear sides not
rendered are displayed in red.
Two visualization options are available in the Viewport menu:
Icon

Function
Track culling

Description
Renders culled backfaces in red, making it possible to tell which faces
aren't displayed. This option is enabled by default.
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Icon

Function
Backface
culling

Description
Optimizes rendering by not calculating the back of surfaces, substantially accelerates the calculation of interactive 3D images. This option
is enabled by default.

To use the backface culling correctly, the front face of the surfaces needs to be oriented to the visible
side of the delimited volume. You can modify the orientation of the surface front and back faces from
the Surface menu:
Reverse: reverses the orientation of the selected surfaces.

The incorrectly oriented surfaces are selected...

... and then inverted.

Surface Auto-Orientation
Three automatic orientation modes are available in the toolbar and from the Surface > Auto-Orientation
menu:
Icon

Function
Auto-orient visible surfaces
Auto-orient selected surfaces
Auto-orient surfaces towards interior

Visible Surfaces: automatically orients all surfaces visible from the current point of view. In order
to determine if the front or the rear face of a surface is visible from this point of view, a rendering is
performed. The number of red pixels is compared to the number of pixels of another color among the
visible pixels of the surface (i.e. pixels not occluded by another surface). If most pixels are red, the
surface is considered to be inside out and its orientation is flipped.
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Example of the auto-orientation of visible surfaces function. Initially, some of the seat’s surfaces are inside out (left). With the door
closed (middle), some of these surfaces are not visible. The auto-orientation function for visible surfaces is used (right): the inside
out, non-visible surface retains its original orientation.

Selected Surfaces: automatically orients a selection of surfaces. When a set of surfaces is selected, the function determines the corresponding bounding volume. Fourteen renderings of the selected
surfaces are performed for camera positions spread around the bounding volume. If more red pixels
than pixels of another color are visible for a given surface, this surface is considered to be inside out
and its orientation is flipped.

WARNING
Only visible pixels are taken into account. If a surface is completely occluded by another
surface in the selection, it will never be reversed.
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Example of the auto-orientation of selected surfaces function. Initially, some of the seat’s surfaces are inside out (top left). All the
surfaces of the seat are selected (top right), and the door closed (bottom left). The auto-orientation function for selected surfaces is
used in order to orient the surface properly (bottom right).
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The fourteen intermediate renderings of the selected surfaces performed for the example presented in the previous figure.

Surface towards Interior: automatically orients surfaces towards an interior volume. Six renderings
taking all the surfaces in the scene into account are performed from the current camera position in
the following directions: forward, backward, up, down, left and right. If more red pixels than pixels
of another color are visible for a given surface, this surface is considered to be inside out and its
orientation is flipped.

WARNING
As for the auto-orientation function for Selected Surfaces, only visible pixels are taken into
account. If a surface is completely occluded by another in the selection, it will never be
reversed.
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Example of the auto-orientation function for surface interiors on the 3D scene in the left image: the surfaces identified as inside out
have been reversed in the right image.

Renderings performed to identify the orientation of each surface with the auto-orientation function for surface interiors. Top: forward
and backward. Middle: up and down. Bottom: left and right.

Positioning Surfaces
In Shaper, the gizmos [65] allow surfaces to be positioned using the mouse directly in the 3D interface:

•

Translation: movement along the X, Y and Z axes.
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•

Rotation: rotation around the X, Y and Z axes.

Surface translation along the Y axis; Surface rotation around the X axis.

Surfaces can also be positioned by providing numerical values [68] for the desired orientation and
position.

Recalculating Normals
Normals may have to be recomputed when they are either missing or incorrectly imported.

TIP
Display the normals for a selected surface by ticking the Normals option in the Display box
of the Mapping sidebar tab.

Reverse Normals: reverses the normals for the selected surface.
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Results of applying the Recompute normals function with a
threshold angle of 85° on a box.

Results of applying the Recompute normals function with a
threshold angle of 95° on a box.

Surface States
Surfaces can be hidden or frozen.
• A hidden surface is not visible in any viewport. This includes Matter viewports.
• A frozen surface cannot be selected or modified.
In Shaper, a surface's state is listed:
• As icons in the Surfaces box of the Geometry sidebar tab,
• By checkbox in the tab Geometry from the editor Surface properties (keyboard shortcut: P).
In Matter, a surface's frozen state has no meaning. Its visibility state is listed:
• As a check-box in the Surface Properties editor (right-click on the surface in a viewport and choose
Edit properties).
You can use interaction modes to set the state of several surfaces by clicking on them. These are
available from the Shaper > Mode menu or from the toolbar:
Icon

Description
Click to Hide
Click to Freeze
Click to Unfreeze

You can set which surfaces are visible from the Shaper > Visualization menu:
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Icon

Function

Description

Hide Selected

The selected surfaces are hidden.

Hide Unselected

The unselected surfaces are hidden.

Hide Frozen

The frozen surfaces are hidden.

Show All

All hidden surfaces are made visible.

TIP
Show All is also available from the context menu
that appears when you right-click in a Matter viewport.

You can set surface states from the viewport context menu that appears when you right-click on a
surface in a Shaper viewport.

Surface groupings
Merge and unmerge surfaces
Icon

Function

Description

Merge surfaces

Allows you to create a single surface from the selected surfaces.
This function share UV unfolding and lightmaps in particular.

Unmerge surfaces

Retrieves initial surfaces from Merge Surfaces function.

WARNING
UV unfolding and lightmaps are lost with the functions below:
• Merge surfaces
• Unmerge surfaces

Create and delete a saved selection
Icon

Function

Description

Create a saved selection

Creates a group of objects in which all of the selected objects will keep their initial states. This is called creating a
saved selection.

Delete a saved selection

Deletes a saved selection.
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NOTE
• Create a saved selection saves the selection in the Selection editor. Cf. Selections
(Editor) [204].
• Doing an operation on a saved selection it amounts to doing an operation on each
selection of the set.
• Clicking on a surface of a set selects all objects.
• Unlike the merge of surfaces this feature keeps all the properties of the surfaces.
• Compared to a multiple selection, this feature adds the ability to assign a material to a
saved selection.
Below are the shortcuts for creating and deleting a set of objects.
Function

Shortcut

Create a saved selection

Ctrl + G

Delete a saved selection

Ctrl + Shift + G

NOTE
A surface can belong to several sets. In this case a contextual menu appears to specify
which saved selection to select.
Saved selections can then contain kinematic objects, Bézier paths and mergers of surfaces.

Visual representation

A multiple selection of surfaces
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With the Merge surfaces feature, the different geometries
form only one surface and therefore have the same color.

With the Create a saved selection feature all the objects keep
their own color.

The selection box is white.

The selection box is pink.

Geometric Primitives
Patchwork 3D can be used to create simple geometric primitives: plane, cube, sphere, hemisphere and
cylinder. These primitives can be created under the Model > Create Primitive menu of Shaper.

Plane Primitive
Available parameters:
• Name,
• Steps: number of tessellated divisions per axis,
• Width: X axis dimensions,
• Depth: Z axis dimensions.

Box Primitive
Available parameters:
• Name,
• Side steps: number of tessellated divisions per box face,
• Width: dimension on the X axis;
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• Height: dimension on the Y axis;
• Depth: dimension on the Z axis;
• Laid on grid: positions the base of the box on the XZ plane usually used for defining the ground of the
3D scene.

Sphere Primitive
Available parameters:
• Name,
• Number of meridians: number of tessellated divisions running from pole to pole. The poles are aligned
to the Y axis.
• Number of parallels: number of tessellated divisions wrapping around the sphere. These are parallel to
the XZ plane.
• Radius,
• Laid on grid: positions the base of the sphere on the XZ plane usually used for defining the ground of
the 3D scene.

Hemisphere Primitive
Available parameters:
• Name,
• Number of meridians: number of tessellated divisions running from pole to pole. The poles are aligned
to the Y axis.
• Number of parallels: number of tessellated divisions wrapping around the sphere. These are parallel to
the XZ plane.
• Main radius: radius of the corresponding sphere. Consequently, this is also the height of the hemisphere.
• Edge radius: radius of the bottom edge of the hemisphere. This dimension must be smaller than
the main radius. This creates a rounded bottom edge, which improves visual quality when the
hemisphere is used as a skydome.
A hemisphere is always automatically positioned on the XZ plane usually used for defining the ground
of the 3D scene.

Cylinder Primitive
Available parameters:
• Name,
• Circle steps: number of tessellated divisions around the edge of the circular cap of the cylinder,
• Height steps: number of tessellated divisions along the vertical edge of the cylinder,
• Radius,
• Height ,
• Axis: sets the axis along which the height of the cylinder is aligned,
• Laid on grid: positions the base of the cylinder on the XZ plane usually used for defining the ground of
the 3D scene.
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Edit Primitive
It is possible to edit the dimension of primitive by interactively modifying its parameters, either in
Shaper or in Matter.
There are two choices for editing a primitive:
• When creating a primitive in Shaper from the menu by choosing Model > Create Primitive. With the
Primitive editor that opens you can set the parameters for the selected primitive type. See the
parameters above.
• After creating a primitive, in Shaper and Matter you can also change the dimensions of the selected
primitive by right-clicking on it and choosing Edit Primitive.

WARNING
Changing the dimensions of a primitive is only available with primitives that have been
created in Patchwork 3D versions 2020.1 and higher. Primitives created in earlier versions
are not editable.

Kinematic Primitives
Kinematic primitives are used to parent surfaces and create kinematic, animatable groups. They have
no creation parameters but can be edited from the Kinematics sidebar tab. These objects are not
surfaces; they are invisible in finished products and cannot receive materials.
Three kinematic primitives are available:
• Axis,
• Null object,
• Vector.
For more information, see the section Animation Utility Objects [392].
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PIVOTS
Each surface has a local tab known as a Pivot. A pivot is a surface's attachment point. It is generally
positioned at the origin of the surface's local axes and it indicates the orientation of the axes. Local
axes are used when you wish to group surfaces and move the group together, or when you are
preparing an animation.
If the

Pivot tab is active in Shaper, the pivot of a surface is visible when the surface is selected.

A pivot of a surface.

Operations on Pivots
The operations in the
Pivot tab in the Shaper sidebar make it possible to move the pivot without
modifying the position of the surface in the environment (the relative position of the surface to its pivot
is thus modified in consequence).
The operations for translating the pivot are the following:
Translation option

Description

Center on Surface

Centers the pivot on the surface.

Center on Selection

Centers the pivot on a group of surfaces.

Center to Selection Leader

Centers the pivot on the surface designated as the leader of the
selection.

Center in World

Places the pivot point at the origin, at the intersection of the world
axes.

Reset

Returns the pivot to its original position.

The orientation of the pivot can also be modified:
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Orientation option

Description

Align to World

Orients the pivot along the environment origin.

Reset

Returns the pivot to its original orientation.

The transformation function Reset Position Relative to Pivot moves the surface to the center it at the
location of the pivot.
The other transformations that can be performed on the pivot (translation, rotation, constraints on
axes [65], etc.) are the same as those that may be performed on the surfaces.
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UV MAPPING
Mapping is an operation that consists of drawing a regular grid directly on the surface. The materials
that will be applied to the surfaces in Matter are cut along and positioned in accordance with the grid. If
the grid is deformed, the material applied to the surface will present the same deformation.
Most materials are not deformable or support only slight deformations. Consequently, the mapping
grids must be regular and only slightly deformed.

Before mapping.

The Dressing tab
surfaces.

After mapping.

Mapping assignment.

in the Shaper sidebar contains a panel that shows the tools used for mapping

By default, surfaces created in Shaper contain no mapping information. Surfaces without mapping
cannot receive material and appear grayed out in Matter.

Assigning Mapping
To assign mapping to the surfaces, Shaper has two methods: the extraction of mapping predefined
in the CAD tool before importing into Patchwork 3D, and the creation of mapping by projecting a
geometric grid onto the surface.
Several types of projection may be used: planar projection, spherical projection, cylindrical projection,
etc. The appropriate choice of the projection method makes it possible to obtain a regular or almost
regular grid on the majority of surfaces and thus to minimize the deformation of the materials that will
be applied in Matter.
Adjusting the projection parameters is facilitated by using gizmos. A gizmo is the symbolic representation of a projection in a 3D view. They are in the form of simplified 3D objects attached to surfaces.
Each is positioned in space relative to the pivot of the surface to which it is attached. The relative
position of a gizmo with respect to its surface is therefore not modified when you move the surface.
A certain number of parameters influence the projection: by modifying the position, the orientation, the
length, the height and the width of the gizmo, you can squash or stretch the mapping grid along the
main projection axes.
To assign mapping to a surface, select the surface and choose a mapping function in Type drop-down
menu of the Mapping box.
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The gizmo represents the two main axes U and V of the projected grid. The U axis corresponds by
default to the horizontal line of the materials, and the V axis to the vertical line. Certain gizmos project
several grids onto the surface and locally select the most suitable one.

Mapping Operators
Shaper offers eight different functions for defining the mapping of a surface:
• Extraction for the unfolding workshop,
• Planar projection,
• Box projection,
• Open box projection,
• Spherical projection,
• Cylindrical projection,
• Closed Cylindrical projection,
• Torus operator.
The choice of mapping operator is made by means of a selector in the Mapping panel of the Shaper
interface. By default, no mapping operator is assigned to a surface.

Extraction

Certain 3D modeling tools can attach UV mapping information to the surfaces. When importing models,
Patchwork 3D attempts to conserve this information, which remains attached to the surfaces. This is
the case, for example, for the importation of Autodesk 3DS Max models.
Extract mapping operator allows you to apply, depending on the selected UV set, the unfolding made in
the unfolding workshop. Cf. Unfolding & Stitch Workshop [96]
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Planar Projection

The planar projection projects a grid perpendicular to a plane. The effect obtained is similar to the
projection of a transparency slide onto the surface. This type of projection is suitable for flat, sparingly
deformed surfaces. The gizmo represents the plane containing the grid.

Box Projection

The box projection is the simplest projection to use and the one that is the most multi-purpose. The
gizmo takes the form of a box that surrounds the surface. Each face of the box corresponds to a planar
projection.
You can use this projection operator in most situations, since the resulting mapping grid is sparingly
deformed, irrespective of the geometry of the surface.
On the other hand, the material can be cut into several pieces to cover the surface.
This mapping operator is ideal when you use uniform materials bearing no pattern.

Open Box Projection
This projection operator is similar to the Box Projection. The gizmo takes the form of a four-sided box
with no base and no lid.
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Spherical Projection

The spherical projection projects the grid as polar coordinates. The gizmo takes the form of a sphere.
The longitude and latitude correspond, respectively, to the U and V axes of the grid.

Cylindrical Projection

The cylindrical projection projects the grid as cylindrical coordinates. The gizmo takes the form of a
cylinder. The longitude and the height in the cylinder correspond, respectively, to the U and V axes of
the grid.

Cylindrical with Cap Projection

The cylindrical with cap projection is similar to the cylindrical projection. The gizmo takes the form of a
cylinder that is capped at both ends.
The two faces at the ends of the cylinder behave like planar projections. The orientation of the surface
is used to determine which grid should be used.
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Transforming Mapping Gizmos
In Mapping mode, activated by clicking on the Mapping sidebar tab in Shaper, you can modify the
position of a gizmo with the translation and orientation tools. The dimensions of a gizmo can be edited
from the Mapping sidebar tab.

UV mapping scaling
Scaling surfaces using dedicated gizmo [67] affects UV mapping.
• You have the possibility to scale the UV mapping according to the resizing of the surfaces with the
option Apply the geometry scaling to UV available in the tab Mapping tab of Shaper at box level Area.
This will keep the scale of the UV mapping. This option is activated by default.
• On the contrary, you can also choose not to scale the UV mapping according to the modifications of
the surfaces by unchecking the option.

UV mapping WITH geometry scaling

UV mapping WITHOUT geometry scaling

Repetition on the U and U Axis
The repetition factors enable the grid to be expanded in the U or V direction. The orientation of the U
and V axes can be inverted by specifying negative values or by directly using the commands Flip U and
Flip V in the Tiling zone of the Mapping sidebar tab.

Automatic Alignment
Several tools in the Alignment box in the sidebar facilitate the alignment of the gizmo on the surface:
Tool

Description

Fit to Size

Adjusts the size and position of the gizmo so that it bounds the surface.

Center

Positions the center of the gizmo on the center of the box bounding the
surface.

Align XY

Aligns the gizmo on the XY plane.
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Tool

Description

Align YZ

Aligns the gizmo on the YZ plane.

Align ZX

Aligns the gizmo on the XZ plane.

Fit Size to Selection

Aligns the gizmo on the plane of the 3D active view.

Center on Selection

Positions the center of the gizmo at the center of the box bounding the
selection.

Viewing the Mapping Information
You can view the surface mapping directly in the solid 3D views by enabling one of the options in
the Reference Texture option box. A setting texture appears on the surface and gives a preview of the
position of the mapping grid on the surface. Two reference textures are available: a checkerboard and a
coordinate texture showing the corners and the center of the grid.
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KINEMATICS
The Kinematics

tab in Shaper has two functions.

First, it allows a functional hierarchy of moving parts to be developed. Each movement is represented
by a null object: a null, an axis of rotation, or a translation vector. Axes of rotation and translation vectors
create a single type of movement: an axis of rotation is only animated in a rotation around its axis, and
a translation vector is only animated along the direction it defines.
Secondly, the Kinematics tab also allows parts to be associated with groups of objects. During an
animation, these objects move together following the movement of the part to which they are attached.
Because the kinematics system is a hierarchy, rather than a list, the parts being translated or rotated
are linked to their parent and child parts. A right-click on an element in the hierarchy opens a context
menu that offers the following options:
• Delete part,
•

Insert Axis Child,

•

Insert Null child part,

•

Insert Vector child part.

Clicking on one of the creation options adds a new part to the kinematic hierarchical tree and selects
this new part.
When a part is selected, the Part panel in the sidebar will show the options for editing the part’s
properties. The rotation axis or the translation vector is also presented in the 3D viewport. They
allow the animation to be manipulated manually. They are visible only when the Surfaces tab or the
Kinematics tab is selected. The representations for null objects, rotation axes, and translation vectors
each have their own Shaper colors. When they are selected, they behave like other Shaper objects such
as surfaces: they are highlighted in white when selected, or in green when they are part of a selection
but not the selection leader.

Modifying the Hierarchy
Drag and drop parts within the sidebar to change their position in the hierarchy. When you move a part,
all of its child objects are moved with it.
Additional options are available in the context menu. Bring this menu up by right-clicking on the part
you would like to modify.
Hierarchy parts are all Shaper objects. This means that you can modify their properties in the Properties
editor. For easy access, the Properties are also available from the context menu that appears when you
right-click on a part.
You can rename the object directly by choosing the Rename option in the same context menu.
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Saving the Hierarchy
The kinematic hierarchy can be saved by exporting it.
Use the

button to export the hierarchy.

This action saves the hierarchy of nulls, vectors, and axes as a KKI file. The parenting of surfaces to the
hierarchy parts is not saved.
KKI files can be reimported into this database, or imported into any other P3D database using the
button.
When a kinematic hierarchic file is imported, its nodes are added to the current kinematic hierarchy. If
you wish to replace the current kinematic hierarchy with a saved hierarchy, delete the current hierarchy
parts before importing.

Kinematic Properties of Hierarchy Parts
Properties of Rotating Parts
The Endpoints zones set the world coordinates of the endpoints of the axis around which the part
pivots. The Pick
buttons allow you to set the position of an endpoint of the axis with a click in
the 3D view. Clicking on this button opens a menu that defines the picking behavior. You can choose
whether the endpoint should be placed:
• At the location of your click,
• At the center of the clicked surface,
• At the pivot of the clicked surface.
button switches the position of the endpoints. This can be useful to reverse the direction of
The
rotation around the axis.
The Min and Max angle fields set the limits between which the part can be animated.
The Show in Animation Slider Editor option is checked by default. This allows the animation of this part
to be played manually using the Animation Slider Editor in Matter.

Properties of Translatable Parts
The Vector zone allows the endpoints of the translation vector to be provided in world coordinates. The
buttons allow you to set the position of an endpoint of the vector with a click in the 3D view.
Pick
Clicking on this button opens a menu that defines the picking behavior. You can choose whether the
endpoint should be placed:
• At the location of your click,
• At the center of the clicked surface,
• At the pivot of the clicked surface.
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The

button switches the position of the endpoints.

The min and max distance fields limit the distance over which the part can be animated.
The Show in Animation Slider Editor option is checked by default. This allows the animation of this part
to be played manually using the Animation Slider Editor in Matter.

Properties of Freely Transformable Parts
button
In the Settings zone, you can provide the world coordinates of a null’s position. The Pick
allows you to set the position of the null with a click in the 3D view. Clicking on this button opens a
menu that defines the picking behavior. You can choose whether the null should be placed:
• At the location of your click,
• At the center of the clicked surface,
• At the pivot of the clicked surface.

List of Objects Belonging to Parts
The objects belonging to the part, whether other parts or surfaces, appear listed as children under the
part node. These objects will be moved when the part is animated.
If the Sync with selection box is checked, selecting an object in the list also selects it in the 3D viewport
and vice-versa. This helps you locate objects easily in the viewport.

Assigning Objects to a Parent Part
NOTE
Objects to be assigned to parent parts must not be frozen.
Surfaces cannot be used as parent parts.
Icon

Assignment action
This is the assignment shortcut. In the viewport, select the objects you want to assign as
children. Drag and drop this icon onto the kinematic hierarchy node to be used as their
parent.
The Pick parent of selected objects tool assigns a parent to the selected objects. First,
select the desired child objects. Click the button, then click on the representation of the
parent in the viewport.
The Unparent selected objects tool removes the parent-child links from the selected objects. Select the objects to be unparented in the kinematic hierarchy or in the viewport,
then click the button.

You can also right-click on an object or a group of objects listed in the kinematic hierarchy in the
sidebar. This will bring up a context menu offering several operations that can be performed on this
object.
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Assignment Modes
The kinematic function proposes two modes for associating objects with a parent. One keeps the
objects' positions relative to the origin, or center, of the 3D scene; the other orients their positions
relative to the parent's position.

Keeps Child's World Position
This mode conserves the position of the surface as a function of the scene origin.
No change in position will occur, but the child object will be listed under the parent node in the
kinematic hierarchy.
1.

Select the child object.

2.

Select the keeps child's world position option in the Parenting an object zone.

3.

Click on the Pick parent button located in the Operations on selection zone.

Aligns to Parent-Relative Position
This mode conserves the position of the child objects relative to that of the parent part.
1.

Choose the aligns to parent-relative position option in the Parenting an object zone.

2.

Click on the Pick the Parent button.

NOTE
The child objects derived from the relationship appear highlighted and position themselves relative to the parent, and also relative to the reference in the 3D space.
If no change appears on the screen once the parent relationship has been established, zoom out to
obtain a wider field of view and observe the transformations.

Repositioning Parts and Their Associated Objects
The mode
, enabled by default, allows objects such as surfaces to be transformed when their
parents are transformed. Deselect this mode in order to reposition objects that are already part of a
parent-child relationship. This will prevent objects such as surfaces associated with a part from being
moved when you reposition the representation of the null, axis, or vector.

You can reposition all objects by using the translation gizmos
the Shaper toolbar.

and rotation

located in

Animation Constraints
Animation constraints define how certain Shaper objects move in relation to others. This relationship is
defined by the object to be constrained, its target, and the type of constraint. Constraints can affect the
position of an object, the orientation of an object, or both at the same time.
Animation constraints are defined in the Kinematics tab of the Shaper sidebar:
1.

Select the objects to be constrained.
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2.

Click on the

button to add a constraint to the selected objects.

3.

A context menu appears. Select the type of constraint that will be created.

4.

An eyedropper appears. Use this tool to select the target in the viewport. For example, if the
selected null should follow a Bézier path, use the eyedropper to select the Bézier path.

Managing the List of Constraints
The list of constraints in the Kinematics tab shows the constraints applied to the selected object or
objects in the Shaper viewports. To view all of the constraints for a model, select all Shaper objects.
Constraints are taken into account in the order that they are listed. The position and the orientation of
an object are evaluated separately and assigned to the first constraint in the list that applies to them.
Constraints further down the list will have no effect on an object's orientation or an object's position if
it has already been constrained.
Constraints cannot create circular reasoning. When a new constraint would create circular reasoning,
an error will appear indicating the object of the constraint causing the conflict. If you really want to
create the new constraint, you must first delete the conflicting constraint from the list.
button to activate an eyedropper,
To modify an existing constraint, select it in the list. Use the
then select a new target in the viewport. The new target will replace the old target in the selected
constraint.
Use the

button to delete the selected constraint from the list.

Position Constraints
Position constraints assign the target's position to the object. If the target is a moving part, the object
will also be affected by the changes to the target's position.
To avoid having two objects that occupy the same position in the 3D world, assign an offset to the
constrained object. An offset is defined below the list of constraints using the XYZ coordinates to
express the difference between the target's position and the object's position. When the target is
repositioned, the object will also be repositioned and the offset distance will be maintained.

Orientation Constraints
Orientation constraints assign the target's orientation to the object. If the target is a moving part, the
object will also be affected by changes to the target's orientation.
The object's orientation and the target's orientation are defined by their pivots, which set their local
coordinates. The rotational transformation that is applied to the target's pivot will be applied to the
object’s pivot.
Two methods exist for setting different orientations for the object and the target with an orientation
constraint:
• Modify the orientation of the local pivot for either the object, the target, or both.
• Set an orientation offset below the list of constraints. The offset should be provided in X, Y, and Z
angles. It will be applied to the object's pivot.
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Look At Constraints
Look At constraints use the position of the target to set the orientation of the object. If the target is a
moving part, when the target is repositioned in the 3D world, the object will rotate in order to face it.
The object’s face is defined by its pivot and by the settings below the list of constraints:
Setting

Default

Description

Aim axis

local X axis

Defines the local axis of the object's pivot that is oriented towards
the target.

Up vector

local Y axis

Defines the local axis of the object's pivot that points upwards.

To make fine adjustments the alignment of the object's face, adjust the object's pivot.

Follow Path Constraints
Follow Path constraints allow an object to use a target Bézier curve as a path. When the Bézier curve's
path constraint is animated as a channel animation, this affects the object's position. If the option Align
to path is checked, it also affects the object's orientation.
The object follows the Bézier path starting from the path's start point and progressing in the same
sense as the path. You can change the start point by:
• Right-clicking on the Bézier path where the start point should be placed and selecting Place start
here.
• Modifying the Position along path setting below the list of constraints. Provide location along the
Bézier curve by entering a percentage of the curve.
If the option Align to path is checked, the object will rotate so that its face is always oriented in the
direction of travel along the Bézier path. Below the list of constraints, you can define:
Setting

Default

Description

Aim axis

local X axis

Defines the local axis of the object's pivot that is oriented towards
the direction of travel along the Bézier path.

Up vector

local Y axis

Defines the local axis of the object's pivot that points upwards.
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LIGHTING
Illumination in Patchwork 3D is provided by light sources. These light sources can be any of various
types: sky, spot, omni, sun or area. Light sources of all types are grouped into lighting layers, which
can be combined to create complex illumination set-ups. The set of visible layers and their coverage
provides a total illumination set-up which is used to calculate lightmaps.
Lighting is managed in the
Lighting tab of the Shaper sidebar. At each level — light sources,
lighting layers, and full illumination set-up — settings are available to adjust the lighting properties.

TIP
To be able to render lighting, the lighting engine must be enabled in the application
settings [47].
You may also find the following information helpful:
• Lighting Layers [354],
• Distributed illumination calculation [280].
This chapter covers:

Type of illumination rendering
The render configuration settings apply to the entire illumination set-up. They take into account all of
the lights and layers, and their properties, including visibility and activation.
In the Rendering zone, you can set the type of lighting:
Type of
lighting

Description

Environment

The Environment mode is the type of lighting established by default. In this mode,
none of the existing light sources are taken into account. Sufficient light is assumed to be generated by the model's environment. The model is not affected by
the illumination configuration.

Lightmap

The Lightmap mode allows you to apply calculated lighting on the model.

Preview

The Preview mode provides an interactive rendering of the shadow regions. This
allows you to evaluate the placement and orientation of the light sources relative to
the objects and camera viewpoint. Only the active lighting layer is visible in Preview
mode.

The type of rendering that is chosen will also be applied in Matter, except in the case of Preview mode,
which will be replaced with Environment in Matter.
Type-specific settings are available below the Type of lighting list for the chosen lighting type.

Preview Mode
When the Preview mode is selected, the following options can be enabled or disabled:
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Option

Description

Interactive degradation

When enabled, this option pauses the calculation when the object is being
manipulated in the Ctrl+right mouse button and middle mouse button operating modes.

Restrict to shadow integrity

When enabled, this option restricts the calculation of Preview illumination
depending upon the selected shadow integrity mode.

Preview color

When enabled, the preview takes the light sources' colors into account. When
disabled, the preview is shown in grayscale.

Preview bounded
attenuation

When enabled, the attenuation gizmo indicates the full effect and falloff distances. The surface parts illuminated without light attenuation are displayed
in red. The surface parts illuminated with light attenuation are displayed in
pink.

The default shadowmap size provided in the application settings [47] is used for the preview mode.

Calculating Lightmaps
When at least one of the visible lighting layers is a lightmap, the lightmap must be calculated before
the illumination will be visible.

TIP
The lighting resolution and the shadow size are each set by default at 2048 and 1024
pixels, respectively. In the settings [51], you can increase the lighting or shadow definition
for greater fineness when working on an object. Keep in mind, however, that the calculation will be slower as a result of more intensive image information processing.
Select the Lightmap mode. Choose the layers and the surfaces for which lightmaps should be calculated, then use the rendering buttons to render the lightmaps.

Filtering Layers
The Layers filter specifies which layer or layers to take into account when calculating lightmaps.
Filter

Description

All

Lightmaps will be calculated for all of the layers.

Visible

Only the lightmaps for the layers that are visible in the current configuration will be
calculated.

Active

The lightmap for the active layer will be calculated, even if this lighting is not visible.
The active layer is the layer that is currently selected. If multiple layers are selected, the
active layer is the layer bordered by a dotted line in the Layers list.

Filtering Surfaces
The Surfaces filter allows you to restrict the surfaces for which lightmaps will be calculated.
Filter
All

Description
Lightmaps will be rendered for all surfaces.
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Filter

Description

Selected

Select surfaces directly in the 3D product view from the Lighting tab of Shaper. Direct
surface selection saves time as it is not necessary to switch to the Surface tab to
select a surface requiring a lightmap computation. The selected surfaces for which
lightmaps will be calculated will be highlighted in green.

Unlit

Lightmaps will be rendered only for surfaces for which no lightmap has been calculated yet.

Setting the Render Quality
A slider allows you to determine the speed at which lightmaps are calculated by setting the balance
between speed and precision. The default slider position (50) sets an advantageous rendering speed
that preserves global lightmap quality in most contexts.
You can modify this setting by moving the slider towards one of the extremes:
Rendering quality

Description

Faster

Rendering speed is increased. The precision of the lightmaps created by this
calculation is decreased.

More accurate

Priority is given to the precision of the lightmaps being calculated. This
calculation takes longer to carry out.

Launching a Lightmap Render
Two render calculation modes exist:
Mode

Description

Start Local Rendering

Use this option to calculate lightmaps using your computer's resources.

Start Distributed
Rendering

Use this option to calculate lightmaps using the resources of a network
of computers running Patchwork Lightmap Render. More information on
distributed rendering can be found in the chapter Distributed Lightmap Rendering [280].

The option Show while rendering allows you to visualize the result of the calculation before the calculation has been completed. When this option is enabled, as soon as the lightmap for a surface is
calculated, it is shown in the viewport. Surfaces for which the lightmap has not yet been calculated are
displayed in red.
If you are calculating lightmaps for multiple layers, the display will switch to the layer for which lighting
is being calculated if Show while rendering is checked.

TIP
When no lightmap has been calculated for a given surface, it is displayed in red in both
Shaper and Matter.

268

Patchwork 3D Enterprise 2022 X5

Options for Existing Lightmaps
NOTE
Surface and layer filters for lightmap calculation are also applied to the following functions.
Once a lightmap has been calculated, you can:
Operation

Description

Update

Update the lightmap to view the lightmap in a different lightmap format [356].

Export

Export the lightmap as a series of image files.

Remove

Remove the lightmap. This deletes the lightmap completely. A deleted lightmap can
be recalculated from scratch but cannot be restored.

Light Sources
Lighting is organized into lighting layers [354]. Each layer contains at least one light source.
Select a layer by clicking on it in order to add, delete, or modify the light sources in that layer. In the
Lights zone, the light sources in the current layer are listed.
As soon as you create a light, you have a near-immediate view of the result in Patchwork 3D's material
render mode. This interactive mode is useful for fine-tuning your lighting, placing your light sources and
for adjusting their intensity.
Icon

Description
New light group.
New light source.
Duplicate the light source.
Delete the light source.
Align the main light source with the camera.
Align the camera with the main light source.
Position the lights at a point to be selected.
Orient the lights towards a point to be selected.
Show Light Gizmos shows or hides the representation of the lights in the viewports.
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To create a new light source, click on the New light

icon.

The first light created in a layer is always of the type sky . The following are of types spot, sun, omni or
area.
Once the light source has been created, the type of source can be modified at any time.
Right-click on a selection of sources in the list. This opens a context menu that can be used to create a
copy of the selected light sources in another lighting layer.
To delete a light source, select the light source to delete in the lights list, then click on the Delete light
icon.

TIP
To be able to delete a light source, you must have more than one source.

Light Source Groups
Light sources can be grouped together to help organize the list of light sources. Light source groups
also allow you to enable or disable all of the light sources within the group with a single click by
clicking on the Enabled column next to the group in the list of light sources.
Create a new group by clicking on the

New group button.

To place a new light inside this group, click on the group on the list, then click on the New light
button.
To place an existing light inside this group, select the light you want to move by clicking on it in the list.
Drag and drop it on the group where you would like to place it.
Groups of light sources may also contain other groups.

Properties common to all types of source
To modify the properties of a light source, click on it to select it in the list of lights or in the viewport.
When selected, a light source's representation in the viewport is highlighted in yellow.
The Light Source zone lists the properties of the selected light source.

Applying the Light to Surfaces
Check the box beside the light's name to enable the light source. A disabled light is visible in the 3D
view in black, but casts no light.
The light source's name is displayed in the text field beside the activation checkbox. Type a new name
to modify it. Validate your changes with the Enter key.
The Type drop-down list allows you to change the type of light source.
The Filter Surfaces button beside this drop-down list allows you to set up a list of surfaces to include or
to exclude for the selected light source. This button opens a new window in which you can select the
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Type of list (surfaces to Include or to Exclude) and the mode, which allows you to apply the inclusion or
exclusion to shadows only, to illumination only, or to both. Below the filter type choices are two columns
listing all surfaces of the model on the left and the list of surfaces to include or exclude on the right.
Select surfaces by clicking on them in the list. Then, use the buttons between the lists to move the
selected surfaces from one list to the other.

Adjusting the Light Source's Properties
• Color: Click on the colored square to open the color chooser and select a different color.

Color change visible in the instant preview of Shaper.

• Intensity: Modify the intensity by entering a value in the input field and pressing Enter. Decimal values
greater than or equal to 0 are accepted. The default value is 1.
• IES: Light sources of type Spot, Omni, and Area can accept an IES profile. The IES profile describes
the physical properties of a light source. Select an IES profile from your computer and activate the
application of the profile by ticking the check-box.
Attenuation: The attenuation for light sources of type Spot, Omni, and Area can be modified. To improve
performance, the contribution of a light can be canceled at a certain distance from the light source. The
parameters Ramp, Full Effect and Falloff are used for setting this distance.
The list Type determines the rate at which the intensity of the light changes. Fast and slow options
are available for linear and quadratic rates. You can also choose None or Physical, which provides a
physically realistic rate.
The Lighting tab attenuation settings interface has been redesigned. The light attenuation type Bounded
is selected by checking a checkbox. The Ramp type (linear or quadratic) is selected from the drop-down
list.

Attenuation box of the Lighting tab.

Full Effect: distance from the source for which the surfaces are illuminated without light attenuation.
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Attenuation: this is the distance to light beyond which the surfaces are no longer illuminated.
Ramp: type of attenuation model applied between the Full effect and the Falloff distances.
In Preview mode, the attenuation gizmo indicates the full effect and falloff distances. It is activated
by checking the Preview Bounded Attenuation check box. The surface parts illuminated without light
attenuation are displayed in red. The surface parts illuminated with light attenuation are displayed in
pink.

Attenuation gizmo. The sphere parts represent the full effect distance and the falloff distances.

• Shadow: Shadows are cast by default by light from a light source. Unchecking the Cast checkbox
disables shadows for the selected source. If shadows are enabled, the intensity and integrity of
shadows can be adjusted:
• Intensity: The higher the value, the lighter and more attenuated the shadows will be. The intensity
must be a decimal value greater than or equal to zero. Use the Enter key to validate any changes.
• Integrity: Choose an integrity from the drop-down list. Integrity values range from Weak to Max.
Higher values increase shadow quality and shadow calculation time.

Positioning Light Sources
Light sources can be positioned individually or in groups.

Translating a Light Source
1.

Select the light.

2.

Enable the Translation gizmo

3.

For a manual modification: hover over the gizmo to make the pointer change to four white arrows.
Then, move the light source by dragging the mouse while holding down the left button.

4.

To modify according to exact values: enter relative
box.

.
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Modifying the Orientation of the Source
1.

Select the light.

2.

Enable the Rotation gizmo

3.

For a manual modification: hover over the gizmo to make the pointer change to a white rotating
arrow. Then, orient the light source by dragging the mouse while holding down the left button.

4.

To obtain a modification according to exact values, enter relative
nates in the dialog box.

.

or absolute

coordi-

Making the Anchor Point of the Light Source Coincide with the Viewport
1.

Select the light.

2.

Orient the viewpoint of the 3D window so that the viewport would be looking directly into the light
in its desired position.

3.

Click on the Align the light on the camera

icon. The light is aligned to point to the camera.

Positioning a Selection of Multiple Light Sources
Two modes exist for applying transformations to a selection of lights:
Icon

Function

Description

Transform selected surfaces using the pivot of the leader selection

The transformation is applied to all selected lights
relative to the pivot of the selection leader (whose
gizmo is displayed in white).

Transform selected surfaces using their own pivot

The transformation is applied to all lights in the selection relative to their own pivot.

A selection of two lights. The light selection leader’s gizmo is displayed in white.
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A rotation is applied to a light selection relative to the selection leader’s pivot (left) or relative to the lights’ individual pivots (right).

Properties of Sky Sources

Parameters specific to the sky light source:
• A Sky angle top: value between 0 and 90 degrees.
• Sky angle bottom: value between 0 and 90 degrees.
• HDR environment: allows an HDR image to be loaded, which will tint the lighting color generated by
the sky.

Properties of Spot Sources

Parameters specific to the spot light source:
• Attenuation: angle of aperture of the spot, value between 0 and 175 degrees.
• Aperture: angle of aperture of the intensity zone, value between 0 and 175 degrees.
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• Choose one of the items from the attenuation type list: Slow linear attenuation , Rapid linear attenuation , Slow quadratic attenuation, Rapid quadratic attenuation, Physical attenuation.

Gizmos for Aperture and Attenuation Cones
The spot light gizmo involves a target point. This target point is located on the symmetry axis of
Aperture and light Attenuation cones.
The target point of the spot has its own translation and rotation gizmos, which simplifies its positioning. The spot light source orientation is updated during the movement when the translation and
rotation gizmos are used.
Translation gizmo: a normal translation gizmo is attached to the target point.
Rotation gizmo: manipulating the rotation gizmo of the target point moves this point the same way
manipulating the rotation gizmo of the light source would.
Positioning a spot light directly using its own gizmos is still possible.

Moving the target point of the spot light using the translation gizmo.

Moving the target point of the spot light using the rotation gizmo.

It is also possible to move a source and a target simultaneously by clicking on the blue part of the
gizmo.
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Properties of Sun Sources

A Sun type light source is a light with infinite directions, whose beams are parallel.
1.

Fill in all the input fields.

2.

Choose one of the Attenuation type list items.

Properties of Omni Sources

An Omni type light source is omnidirectional, which illuminates all around itself.
1.

Fill in all the input fields.

2.

Choose one of the Attenuation type list items.

Properties of Area Sources
In the case of area light sources, light is emitted from any surface chosen by the user. Since pre-existing meshes can be used, lighting creation becomes intuitive. Moreover, even if no dedicated meshes
are present in a scene, specific primitives that can be modified on the fly are provided to simplify
lighting creation.
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Example of render involving area lights.

To add a surface light to your scene, create a new light and select Area in the Type drop-down list.

Selection of the Area light type.

The surface geometry to use as a light source is specified in the area lights parameters box of the
Lighting tab using two methods.
• If a dedicated mesh already exists, it is set as a light source geometry by first selecting Mesh as an
area light type (default), then by enabling the function Pick Surface
directly.

before selecting the surface

The name of the surface linked to the areal light is then displayed in the areal light parameters box.
• If no dedicated mesh exists, specific predefined primitives (planes and cylinders) whose dimensions
can be updated on the fly can be used.
The translation and rotation gizmos and the Align Leader Light to Camera function
move and orient these primitives.

can be used to

In both cases, the light is emitted according to the surface normals.

Lighting Planner
The Lighting Planner provides an advanced method for baking the illumination of a scene when using
lightmaps. In the simple baking scenario, the layers and the surfaces to light can be selected, but
lighting is calculated in a single step. Using the Lighting Planner, lighting can be calculated in as many
steps as necessary.
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The advantage of multiple-step calculation is the variety of lighting scenarios that can be calculated,
which makes it possible to use lightmaps to light scenes containing animations or multiple geometry
positions.

Planning a Lighting Sequence
To access the lighting planner, make sure you are in the Lighting tab in the Shaper interface.
1.

Set the rendering Mode to Lightmap.

2.

Modify the Baking scenario by choosing the Advanced option.

3.

Click on the button

.

Once a sequence has been defined, close the Lighting Planner and calculate the lightmaps normally.

Lighting Layer
Create a step by selecting the lighting layer:
1.

Click the Add Step button.

2.

Select the lighting layer you want to use from the context menu that appears.

You can add as many steps as necessary. You can also:
• Delete steps that you do not want to keep,
• Rename steps.
Steps will be calculated one by one starting at the top of the list.
It is possible to modify the layer targeted by a step at a later moment:
1.

Select a step in the list.

2.

Modify the selected layer in the Target layer drop-down list.

Configuration
For the selected step, assign a set of configuration parameters. Lighting, geometry, and position layers
will have an influence on the lightmaps that will be calculated.
Button

Description

Acquire

Apply the configuration that is visible in the active viewport to the active step in the
Lighting Planner.

Set

Apply the configuration for the active step in the Lighting Planner to the active viewport. This is one way to verify that the chosen configuration parameters correspond to
the desired model configuration.

Part Animator
For the selected step, assign a position to the moving parts of the kinematics hierarchy. The sliders
available in the Animation Sliders editor are available within the Lightmap Planner. Move the sliders to
set kinematics positions.
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Button

Description

Acquire

Apply the kinematics positions that are visible in the active viewport to the active step
in the Lighting Planner.

Set

Apply the kinematics positions for the active step in the Lighting Planner to the active
viewport. This is one way to verify that the chosen kinematics positions correspond to
the desired model state.

Selected Surfaces
For the selected step, choose the surfaces that should be lit.
Button

Description

Acquire

Apply the surface selection that is visible in the active viewport to the active step in the
Lighting Planner.

Set

Select the surfaces the list in the Lighting Planner in the active viewport. This is one
way to verify that the correct surfaces have been selected for this step.

Clear

Clear the list of selected surfaces.
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DISTRIBUTED LIGHTMAP RENDERING
Depending on the hardware configuration in use, lightmap rendering can be performed either locally
or on a networked set of computers. Distributing the rendering to a networked set of computers will
significantly reduce the time required for rendering lightmaps.
The lightmap rendering mode is selected in the Lighting Tab in the Shaper sidebar. The Tools box is
displayed when the selected Lighting Type is set to Lightmap.
Start Local Rendering is used to render the lightmaps locally. Local lightmap rendering is based on the
use of the processor and graphic cards of the computer on which Patchwork 3D is executed.
Start Distributed Rendering is used to render the lightmaps on the rendering machines running Patchwork Lightmap Render.

Patchwork Lightmap Render
Installing Patchwork Lightmap Render
Install the Patchwork Lightmap Render software on the computers you wish to use for distributed
rendering.
This application must be run manually in order to provide the distributed rendering service. If you
restart Windows on one of the computers functioning with Patchwork Lightmap Render, you must also
restart the Patchwork Lightmap Render application.

WARNING
If you have installed Patchwork Lightmap Render on computers that are listening for a
render task, but which aren't found by Patchwork 3D in the unit discovery window, verify
that no network agents are set to block discovery broadcast packets.
If you do not have access to the network configuration in order to disable broadcast
filtering, you can manually enter the name or the IP address of the Patchwork Lightmap
Render machines.

How Patchwork Lightmap Render Machines Work ?
Should the Patchwork Lightmap Render application crash, it will restart itself automatically.
A Patchwork Lightmap Render machine can only participate in a single rendering session at a time.
If another instance of Patchwork 3D sends a request for the computer's availability while it is already
participating in a render session, the Patchwork Lightmap Render machine will send back the status
"Busy." Patchwork 3D will continue to attempt to open a session at regular intervals until a session is
opened or the rendering is completed on the available machines.

Distributed Lightmap Rendering Mode in Patchwork 3D
The distributed lightmap rendering mode uses resources from several computers running Patchwork
Lightmap Render. The Patchwork Lightmap Render software must be set up and run on the computers
you want to use. The same applies to the computer on which Patchwork 3D is installed if you wish to
use it for distributed rendering.
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Setting up the Distributed Rendering
The port used for finding the Patchwork Lightmap Render computers is specified in the Settings.
Browse to File > Settings > Lighting tab > Distributed lightmap rendering box.

NOTE
The default UDP port for finding Lightmap Render Units is 4242. Enter another value if
required.

TIP
In order for a rendering unit to be discovered by Patchwork 3D, the port number used for
discovery must be the same as that of Patchwork 3D.
Clicking on Start Distributed Rendering displays the Distributed lightmap rendering configuration window,
dedicated to management of Patchwork Lightmap Render machines.

Distributed Lightmap Rendering Configuration window.

If your network infrastructure allows it, Patchwork Lightmap Render machines are automatically found
by broadcast. They appear directly in the list of known Patchwork Lightmap Render machines.
The following data is displayed for each of the known Patchwork Lightmap Render machines:
• The name of the host computer on which the Patchwork Lightmap Render software is running,
• The IP address of this computer,
• The status of the Patchwork Lightmap Render machine – the various statuses are detailed thereafter,
• A checkbox specifying whether a Patchwork Lightmap Render machine is selected for the rendering.
The various statuses of the Patchwork Lightmap Render machines are the following:
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Status

Description

Available

The computer is ready to perform a rendering.

Busy

The computer is being used by the Patchwork 3D software on the
specified computer.

Disconnected: connection denied

The Patchwork Lightmap Render program is not currently running on
the machine.

Disconnected: host not
found

The host computer cannot be found on the network – the rendering
machine might not be turned on.

Disconnected: incompatible protocol version

The version of the Patchwork Lightmap Render software is not compatible with the Patchwork 3D version used. Patchwork Lightmap Render must be updated.

Some network infrastructures do not allow automated discovery of Patchwork Lightmap Render machines. In that case, the units need to be added to the list manually. In order to do this, click on Add
unit. Next, enter the name of the computer you want to use. The computer is now displayed in the list.
The asterisk added to the name of the computer specifies that this machine has been added manually.
The Patchwork Lightmap Render software must already be installed on any computer you wish to add
manually as a Patchwork Lightmap Render machine.
The list of available machines is updated with the Refresh button.
The buttons Use all and Use none allow the user to select all or none of the units, respectively.
To delete a machine added manually from the list, select it and click on Remove unit.
Exiting the Distributed Lightmap Rendering Configuration window is possible at any time by clicking the
Cancel button. The list of manually added machines and their state of use during the latest rendering
are saved on exit.

Starting a Distributed Rendering
Once the Patchwork Lightmap Render machines have been set up, start the lightmap rendering by
clicking the Ok button.
At the start of a distributed rendering, allowing the connection with the Patchwork Lightmap Render
machines through the firewall of your Windows OS may be required.
The lightmap rendering progression window displays a progress bar, the estimated remaining time, the
elapsed time since the beginning of the rendering, the count of surfaces for which the rendering has
been completed, and the status of the rendering.
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Lightmap rendering progress monitoring window.

The status of each rendering machine is also displayed. Several statuses are possible:
Status

Description

Transferring data

Transferring data to the rendering machine.

Initialization

Initialization of the rendering machine.

Computing

Lightmap rendering in progress.

The window closes automatically when the rendering is over if the Close this window when finished
checkbox is checked.

Stopping Distributed Rendering
The rendering in progress can be stopped at any time by clicking the Stop button. A window opens to
offer you the choice of how to proceed:
Option

Description

Continue

Restart the calculation of the illumination for the remaining surfaces. Data may be
transferred to the rendering machine.

Keep

Abandon the calculation for the remaining surfaces, but display the illumination that
has already been calculated.

Discard

Abandon the calculation for the remaining surfaces and do not display the illumination that has already been calculated. This option will restore the previous illumination.

During the rendering, the model’s surfaces whose lightmap is being rendered are displayed in white
and in wireframe mode. Surfaces whose lightmap has not been rendered yet are displayed in red. Once
rendered, a lightmap is displayed on the model.

Resources Consumed
A Patchwork Lightmap Render machine listening for requests for rendering consumes no system
resources.
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During a render session, a rendering machine calculates lightmaps from the geometric information
concerning all of the visible surfaces. In order to optimize the render speed, all of the surfaces are
stored in the GPU. Then, the lightmaps are calculated one by one at Patchwork 3D's request.
The resources of a rendering machine that can be used by Patchwork 3D are only limited by the
hardware configuration of the machine.
For a standard Patchwork 3D model, containing between 3 and 5 million triangles for 300-500 surfaces,
the GPU consumption is about 2 GB. The consumption of RAM resources is approximately identical to
the GPU consumption.

Network events between Patchwork 3D and a Patchwork Lightmap Render machine.

For a standard Patchwork 3D model, the following illustration represents a typical resource consumption:
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Behavior Following Loss of Connection
Loss of Network Connection
Patchwork 3D and the Patchwork Lightmap Render machines will automatically detect the loss of a
network connection.
Patchwork 3D will redistribute the render calculations left to perform to the rendering machines that
are still connected. Patchwork 3D will continue to attempt to reconnect with the rendering machines
that were disconnected.
If no machines are connected, Patchwork 3D will continue to try to reconnect with the Patchwork
Lightmap Render machines at regular intervals. During this time, the rendering is paused. You may
choose to cancel the rendering at this point. You may either save or dismiss the results for the surfaces
for which lighting has already been calculated.
A rendering machine that has lost its connection to Patchwork 3D becomes available on the network.
It will accept the first session request that it receives from an instance of Patchwork 3D looking for a
machine running Patchwork Lightmap Render.

Patchwork 3D Crash
A crash of the Patchwork 3D application will break the connection with the Patchwork Lightmap
Render machines.
A rendering machine that has lost its connection to Patchwork 3D becomes available on the network.
It will accept the first session request that it receives from an instance of Patchwork 3D looking for a
machine running Patchwork Lightmap Render.
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PRODUCTS
A product is a geometrical model that is or can be dressed. Once dressed, a product is used in
producing synthetic images for design purposes. Its general appearance is obtained by assigning
a photorealistic material (wood, leather, gold, plastic, etc.), by inserting it into a complex lighting
environment (photo studio, forest, industrial environment, desert, etc.), and by adding effects such as
backgrounds, post-processing, and overlays.
Products are managed from the tab

Products from the sidebar of Matter.

Product Library
For this library, organization by model is mandatory. Models are created in Shaper . The Create and
Duplicate operations for models are not available in Matter.
Some product thumbnails may appear with an
icon. This indicator means that the image shown
in the thumbnail no longer corresponds to the current representation of the product. The thumbnail will
be recalculated and the indicator will disappear the next time you finish editing the product. Thumbnail
images are updated either at the time the file is saved, or as a background task in order to maintain the
smoothness of movement needed for correct functioning of the Matter module.

NOTE
Patchwork 3D allows you to memorize 4 favorite cameras [388] per product. If favorite
camera 1 is defined, it is then used as the viewpoint for calculating the thumbnail. Otherwise, the thumbnail will be calculated when you close the last viewport or viewport tab in
which the product was active, using the camera viewpoint from that viewport.

Product Properties
Surface Visibility
This property defines the strategy used to obtain the visibility of surfaces in a product. The inactive
box indicates that a surface visible in Shaper is visible in Matter. The enabling this option breaks this
dependency, and each surface will have its own visibility attribute. This property can be edited in the
product properties.

Environment
This property allows you to define the environment used to place the product in a setting (photo
studio, exterior scene, etc.). If the value of this property is not initialized the environment used for the
rendering is a neutral environment (default behavior). It is recommended to create new materials using
this environment, as it does not influence the perceived color.
Assigning an environment is accomplished with a drag-and-drop from the sidebar environment library
to the interactive zone of the viewport. To return to the default environment, open the menu item Editors
> Product Environment, then select the environment in the Environments box and apply the operation,
Remove the environment.
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Background
Standard Assignment
You can use several types of backgrounds to simulate an environment in which your product is placed.
Backgrounds are applied to camera sensors.

From left to right: None – Gradient – Environment.

The type of background can be selected under the menu Camera > Background.
The assignment of a background is performed by:
• Drag-and-drop from the Matter sidebar's background library to the Sensors editor or to the interaction
zone of the viewport,
• Drag-and-drop from the Backgrounds editor to the Sensors editor or to the interaction zone of the
viewport.
An operation for removing the background from a camera's sensor is available from Camera > Background > Remove Background.
For more information on backgrounds, see Backgrounds [329].

Background and Environment on Product Selection
This function enables you to assign a background to a product in the designated viewport or to several
products save considerable time.
This command offers you three modes of product selection:
• All the products in viewports,
• All the products of the model,
• All the products of all models.
This operation is performed by dragging and dropping the background from the Matter sidebar's background library into the active viewport while holding down the Ctrl key.

TIP
The information line located at the bottom of the active view indicates the function of
this command: [Ctrl ="Product selection dialog"] Set background to XXXXXXXX.
These assignment modes can only be performed on environments and overlays.
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MATERIALS
A digital material, like a physical material, is the source of a surface's visual aspect. The materials in
your database reproduce the visual properties of the physical materials that they represent.
Each surface is assigned a material. In some cases, a surface can be dressed with multiple materials.
This is the case when you apply stickers or when you make use of aspect layers.
Patchwork 3D allows you to change the aspect of your product in real-time by assigning new materials
to a surface. No calculation is carried out, but the product is updated instantly while you continue
navigating around it in the 3D world.
Seven types of material exist. A type is defined by the function of the surface to which the material is
assigned:
Material
type

Use

Standard

The default material can duplicate most types of physical materials using two
layers, a diffuse layer and a reflective layer.

Environment

This material represents the environment of a scenario. It is used to dress a skydome, which is a hemisphere surrounding a product.

Matte

This material only shows the shadow of a product. When assigned to a plane on
which your product is placed, it increases the realism of the scene when your
scenario consists of a simple 2D background.

Mirror

This material is used to dress surfaces in which the reflection of other surfaces in
the scene are visible.

Multilayer

This material is designed for the advanced user. Its precision is useful for creating
complex and detailed materials.

Seam

This material is used to represent the particularities of a sewn seam.

Sticker

All standard materials can be assigned as stickers, but this type of material is
designed specifically for that use. It can therefore be employed with another material on a single surface, or even assigned several times to the same surface.
This can be useful in the case of certain patterns such as stickers, printed marks,
engravings, stamps, or other marks that aren't part of the aspect of the physical
material itself.

The Patchwork 3D materials are managed from the Matter sidebar's material library.
Their settings, including their colors, can be modified via Materials (Editor) [174].
The Positioning and Orienting Materials [315] describes the two manipulation modes used to interactively position and orient materials.

Material Library
In the Matter sidebar's
library tab, the
the materials available in your database.

material library manages the groups of materials and
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Groups of materials are listed in the upper part of the library:
Icon

Description
Create a new group.
Duplicate the selected group.
Rename the selected group.
Delete the selected group.

NOTICE
New Features in Patchwork 3D 2022 X5
Double-clicking on the material thumbnail makes it active and opens the materials editor.

TIP
To quickly locate the material in the library you can use the keyboard shortcut E when the
mouse cursor is over a material. You can also use the shortcut Shift + E to directly open
the materials editor.
The list of materials shows all of the existing materials in the selected group. Using the buttons below
the list, you can:
Icon

Description
Create a new material.
Duplicate the selected material.
Edit the selected material by opening the Materials editor.
Rename the selected material.
Import materials. KMT and AxF formats are supported.KMT format is supported.

NOTE
AxF [291] file import (SVBRDF or CPA2 types) is subject to a license option.
Export selected materials in KMT format or AxF.
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Icon

Description
Delete the selected materials.
Purge materials that have not been used (materials that are not applied to any surface of
any product).
Modify the way in which the list is displayed.

Right-clicking on a material opens a context menu offering the following options:
Icon

Function

Description

Set active

Make the material you have clicked active and shows it in the lower
part of the library.

Edit

Edit the selected material by opening the Materials editor.

Duplicate

Duplicate the selected material.

Convert to
multilayer
material

Convert the selected material(s) into equivalent multilayer materials.

Replace with

Replace the selected material(s) with another material from the material library.

NOTE
This functionality is available if at least two materials
already exist in the material library.
Rename

Rename the selected material.

Usage list

Show a list of all products in which this material has been applied.

Import

Import materials. KMT and AxF formats are supported.KMT format is
supported.

NOTE
Importing the file AxF [291] (SVBRDF or CPA2 type) is
subject to license.
Export

Export the selected materials in KMT or AxF formats.

Delete

Delete the selected materials.
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The active material is shown in the lower part of the library:
Icon

Description

Thumbnail

Double-clicking on the thumbnail opens the Materials editor.
Use the eyedropper to pick a material from a surface in a viewport and render it
active.
Open the Materials editor for the active material.
Select the active material in the list of materials.

AxF Material
AxF is a file format that encodes digital material representations, including those of materials measured using X-Rite material scanning technologies. Patchwork 3D supports version 1.8.1 of AxF files.

NOTE
Please note that AxF CarPaint (CPA2) type files can be exported in AXF format if they are
not modified. If they are modified, only the export in KMT format is supported.

WARNING
Overriding a material with an AXF type file consumes a lot of GPU and RAM memories.
You can change the base color of an AxF (CPA2) material from Matter by right-clicking on the surface
that has an AxF material or from the Materials Library by right-clicking on the AxF material.
The parameters to be adjusted are as follows:
• Hue Shift
• Saturation
• Exposure
• Contrast

NOTE
Please note that these parameters are relative to the original color of the material. A
saturation of 1, for example, corresponds to the original color of the AxF, if you decrease
this value it decreases the saturation and if you increase this value it increases the
saturation. The reasoning is the same for the other parameters.

Standard Material
A Matter standard material allows you to simulate materials such as metal, wood, plastic, stone, paint,
etc.
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A standard material is designed to reproduce the characteristic behavior of a material immersed in a
lighting environment. It is above all a visual simulation, in the field of perception.
The settings of a standard material are take into account the elements that define of the matter, i.e.
the color and pattern, capacity to reflect or tint the environment, surface texture, transparency, and
behavior during rendering by raytracing.
A standard material is broken down into a Diffuse coat, or layer, over which a Reflection layer is applied,
each of which may be textured. The interaction between the two layers allows most materials to be
simulated realistically.
The Matter module offers standard materials belonging to the following classes:
• Diffuse only: The material has color, pattern, and texture attributes, but does not reflect the environment. The reflection settings are not available.
• Diffuse and Reflection: The material has color, pattern, and texture attributes, and it reflects or tints
the environment.
• Transparent Filter, or reflection layer only: The color of the material serves as a transparent filter. The
material can be textured and reflects or tints the environment. The diffuse settings are not available.

Basic Principles
In order to give you an idea of the characteristic features of a standard material and to introduce the
parameters associated in Matter, here is the breakdown of a slightly reflective fabric.
To replicate the appearance of a photorealistic material, the Matter module proceeds by layer:
• Diffuse: When created, a new material is slightly gray and has the appearance of perfectly smooth
rubber.
• Color and pattern: The Color Map field is used to apply a pattern mimicking fabric fibers.
• Texture: In the Bump tab, the Bump Map zone encodes the surface texture used to simulate the
unevenness of woven fabric. The depth of this unevenness is modulated by the Diffuse Depth
setting.
• Reflection: The overlay of a reflection (type Diffuse and Reflection) without taking into account the
unevenness of the texture on the reflective layer simulates a thin film of plastic on the fabric.
• Color: A reflective layer has a tendency to lighten the material.
• Texture: Final, to finish the material, enable and set the Reflection Depth in the Bump tab.

Diffuse layer

Diffuse layer + color
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Diffuse layer + diffuse texture

Diffuse layer + color and pattern + diffuse texture

Diffuse layer + color and pattern + diffuse texture + reflection

Diffuse layer + color and pattern + diffuse texture + reflection
+ reflection texture

Diffuse
Light does not pass through a diffuse layer. Light is either absorbed, or returned to the eye of the
observer. The Diffuse tab groups the settings related to this diffuse layer.

Diffuse Color
The color of the diffuse layer is influenced by several settings: the color Filter, the lighting environment
conditions, the ambient color, and the illumination color, among others.
The color Filter setting corresponds to the color perceived when the material is lit by white light. As the
material reacts like a filter, it reflects part of the light it receives. The perceived color of an object is thus
greatly influenced by the lighting environment. If we consider that white light is made up in equal parts
of green, red and blue (empirical computer model), then a black body absorbs all these components, a
white body reflects them without alteration, a red body absorbs the green and blue, etc.

Influence of the lighting environment conditions on the color of a material.

The creation of a new material should thus imperatively be performed in a neutral light environment, for
example, the default environment in the Matter module.
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The Intensity parameter allows you to amplify by a multiplication factor the effect of the lighting
environment on the material.
The Ambient color parameter allows you to add a constant color. It is common practice to add a light
gray to lighten a material. However, we would advise you to limit the amount of ambient light since a
material of relatively dull appearance originates from a relatively dull environment.

The effect of an ambient color on the appearance of a yellow material. Left: gray ambient color. Right: red ambient color.

The effect of an illumination color on the appearance of a yellow material. Left: ambient gray color + blue illumination color. Right:
ambient color red + illumination color blue.

Color Map
Some materials have a pattern or motif that is created by repeating an image across the surfaces to
which the material is assigned. The Color Map settings are used to assign, resize, and position the first
instance of such an image.
Color maps are image or video textures. To use a texture as a color map, drag it from the sidebar
texture library and drop it in the color map zone. To be shown, the color map must also be enabled by
ticking the checkbox next to the color map zone.
The texture dimensions are used by default for an image texture.
For a video texture, the longest edge of the format is scaled to one meter by default. The format's
aspect ratio is respected.
Any texture used as a color map will repeat.
You will find in the accordion menu named Mapping the following parameters Allow repeat in U and
Allow repeat in V that allow you to choose to repeat the texture in U and/or V.
By checking the Mirrored checkbox you can reflect the texture in U and/or V.
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Transparency of the Diffuse Layer
The transparency of a standard material of the Diffuse or Diffuse and Reflection classes can be adjusted
directly fromthe Materials Editor using the Opacity modulator:

The Transparency accordion menu lets you use a texture for controlling the transparency of the material. The alpha layer contained in the images (PNG format) is used to define the transparency of the
texture.
If the texture used as image alpha does not have an alpha layer (JPG image), it is the luminosity of the
image that is used as the alpha layer. In this case, check Use color map transparency. The darkest colors
correspond to the most transparent areas:

You will find in the accordion menu named Mapping the following parameters Allow repeat in U and
Allow repeat in V that allow you to choose to repeat the texture in U and/or V.
By checking the Mirrored checkbox you can reflect the texture in U and/or V.

Filter According to View Angle
Some materials have a color that changes according to the angle of observation. This effect is implemented using a gradient ramp. Click on the Gradient [166] Editor button from the accordion menu
called Advanced in order to modify the gradient that is used.
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Reflection
The reflection layer is an additive layer. This layer can be used in two ways. When combined with a
diffuse layer (Diffuse and Reflection class standard materials), it helps to simulate materials that reflect
the light of the environment such as metals, varnished woods, smooth or metallic paints, or opaque
plastics.
This layer can also be used alone (Transparent Filter class standard materials) in order to simulate
transparent materials. This transparency is obtained by removing the diffuse layer that blocks the light
from passing through the material.

Diffuse+Reflection (left) - Diffuse (center) = Transparent Filter (right)

Intensity
The Intensity setting allows you to adjust the amount of reflection emitted by the material. The Intensity
value varies in principle between 0 and 1, but a higher value makes it possible to counterbalance a
rather dull lighting environment.
A perfect mirror appearance is obtained with the value 1. Even though the color filter parameter enables
you to attenuate the reflection, we would recommend modifying the Intensity value, since it gives
access to a more precise adjustment without any risk of coloration.

Variation in the attenuation of the reflection using the Intensity setting, set to values from 1 to 0.005.

Color Filter
The color Filter setting in the Reflection Color zone is used to tint the reflection. This coloration reproduces the behavior of metals and of certain paints. This parameter may optionally serve to gradually
attenuate the effect of the reflection by selecting a filter ranging from white to black.
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Variation in the Filter parameter.

The Fresnel is an optical effect. The greater the oblique angle at which a glossy surface is observed,
the less visible will be the color of the surface, which forms a white reflection.
In the case of a glossy transparent material, the Fresnel will make the surface increasingly opaque the
more the viewing angle is reduced.
The calculation of the Fresnel effect in Patchwork 3D is based on the physical formulation of the
Fresnel factor to accentuate the photorealistic quality of the rendering.
If no changes appear in the rendering, return to Shaper in the lighting module, check that none of the
boxes in the illumination cube dialog box are checked.
To produce a material of motor vehicle bodywork paint type, it is necessary to enable the Fresnel effect.

Without the Fresnel Effect: no colorless reflection appears when the product is viewed at a sharp angle.

With the Fresnel Effect (refraction index = 1.518).

Preset parameters let you allocate the refraction index and extinction coefficient values corresponding to
common materials such as aluminum, silver, chrome, copper, gold, etc. Custom presets can be added to
this list from the User Presets tab in the Patchwork 3D Settings.
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The extinction coefficient is a feature specific to the metals; this parameter can be left at 0 in the other
cases.
The Fresnel also applies to transparent materials.

Specular Map
You can also restrict per pixel the intensity of the specular reflection of a material by using specular
texture modulation (STM). This gray scale texture encodes the attenuation factor for each pixel the
attenuation factor to be applied to the reflection (reflection = STM * specular).
A value of 255 encodes a maximum reflection and 1 encodes a virtual absence of reflection. This
approach makes it possible, for example, to simply simulate embroidered fabrics. The value 255 is
attributed to the pixels corresponding to the embroidery pattern, and the value 1 to the fabric.

Reflection filtering without a specular map. From left to right: diffuse layer, reflection layer without a modulation image, and result
with a lightening effect.

Reflection filtering with a modulation image. From left to right: diffuse layer, reflection layer with a specular map, and result with a
filtered lightening effect.

You will find in the accordion menu named Mapping the following parameters Allow repeat in U and
Allow repeat in V that allow you to choose to repeat the texture in U and/or V.
By checking the Mirrored checkbox you can reflect the texture in U and/or V.

Roughness
The reflection of a frosted or brushed material is always hazy and coarse, the details disappear, and
the reflection runs and spreads over the surface of the material. Only the silhouettes of the reflected
objects are still apparent. This diffusion of the reflection on the surface of the material is due to a very
perturbed surface state. The Roughness parameter replicates this behavior.
298

Patchwork 3D Enterprise 2022 X5

Variation of the Roughness of the reflection, set to values from 0 to 6.

The roughness describes the surface irregularities that cause differentiated diffusion of light. The
reflected light varies randomly depending on the roughness of the surface. This change the direction of
the light without affecting its intensity because it remains constant. The rougher surface have a larger
and variable highlights than smooth surfaces that have concentrated specular reflections. Smooth
surfaces may look brighter with the same amount of reflected light.
The Roughness map is a grayscale texture where the black corresponds to a roughness of 0 (smooth)
and white corresponds to a roughness value of the material.
In the Roughness map accordion section check Enable and then click on the None button to load the
texture that will serve for the roughness or glossiness of the material.
On the other hand, the Gloss map is a grayscale texture where the black corresponds to ta value of the
material roughness and the white corresponds to a roughness of 0 (smooth).

Gloss map example

Rendering without a gloss map

Rendering with a gloss map

You will find in the accordion menu named Mapping the following parameters Allow repeat in U and
Allow repeat in V that allow you to choose to repeat the texture in U and/or V.
By checking the Mirrored checkbox you can reflect the texture in U and/or V.
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Diffuse Filter
In the case of a standard material of the Diffuse and Reflection class, the additive aspect of the
reflection layer tends to lighten the material when the reflection layer is superimposed.
This standard material class has a Diffuse filter to compensate for this lightening while conserving the
original color.
A diffuse-free material (chromium, gold, steel, aluminum, etc.) is obtained by using the black filter.

Correcting lightening of a Diffuse and Reflection class standard material. From left to right: diffuse layer; diffuse layer + reflection
layer without a filter (white filter); diffuse layer + reflection layer with a gray filter.

Transparent Filter
A standard material of the Transparent Filter class has a Trans. Filter setting, which plays the role of the
transparent filter. This corresponds to the color of the transparent material.

Variation in the Trans. Filter setting of a Transparent Filter class standard material.

Bump
In the Bump tab, the parameter Diffuse depth adjusts the depth of the unevenness encoded in the
Bumpmap. It is a surface state roughness, i.e. not very deep. From a geometrical viewpoint, the surface
is not altered, and remains perfectly smooth.
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Variation in the Diffuse Depth setting with values from 0 to 6.

The parameter Reflection depth adjusts the depth of the hollows and bumps encoded in the Bumpmap.
The grain levels of the diffuse and reflection coats have been dissociated to produce thin reflective
films.

Variation in the Reflection Depth setting with values from 0 to 3.

Enhanced Relief

Variation in the Relief depth setting with values from 0 to 10.

Standard materials using a height map can be rendered with textural relief that is even more realistic.
This option offers an enhanced perception of depth thanks to the way it handles parallax.
The use of enhanced relief is best suited to contexts where a standard material uses a texture that
requires more visual depth than that which can be rendered using diffuse depth and reflection depth.
The relief setting provides a rendering which, while robustly real-time, requires more time to calculate. It
is therefore recommended to use this option where appropriate, without overloading a scene.
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Enabling Enhanced Relief

NOTE
The enhanced relief is not compatible with the use of the diffuse depth or the reflection
depth. Enabling enhanced relief will disable the diffuse depth and the reflection depth, if
they were previously enabled, and vice versa.
Follow these steps to enable enhanced relief for a standard material:
1.

Click on the Bump tab from the Materials editor:

2.

Drag and drop a texture from the texture library to the field None making sure it is a bump map.

3.

Tick the Parallax Bump Mapping checkbox in the Depth section and provide a value for the depth.

Disabling one of these elements will also disable the enhanced relief.

Settings
The settings for enhanced relief are found in the Bump tab of the Materials editor:
Setting
Parallax
Bump Mapping Depth

Description
The depth defines the distance between the white and the black zones of the
height map. The white zones are aligned on the mesh of the surface.
Because the perceived depth of the map's black zones is set using this parameter,
the height map should make use of the full range of elevation available, from white
to black. When this is not possible, make sure that the map's maximum elevation
will be aligned with the modeled surface, that is, that it is represented in white on
the height map.
A negative value will invert the depth of the texture: depth is rendered as rising
from the surface instead of as incisions carved into the surface. While possible,
this rendering is not optimal and is not recommended.

TIP
Values between 0 and 10 are usually sufficient. Using values that are
too high can create visual deformations when viewing surfaces at
low angles or when viewing curved surfaces.
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Setting
Bump map

Description
A height map is required. This map is a black and white texture that is assigned to
the material as a bump map.
The texture to be used as a height map can be square or rectangular. The height
and the width of the texture in pixels must both be powers of two.

TIP
Although Patchwork 3D will resize height maps whose dimensions
are not useable, choosing textures with dimensions that are powers
of two is highly recommended in order to preserve the particularities
of the height map.
Enhanced relief is not compatible with bump maps used as normal maps.
Dimensions
and Transformation
of the
bump map

These settings are modifiable as normal to adjust the dimensions, the orientation,
and the position of the height map on the surface.

You will find in the accordion menu named Mapping the following parameters Allow repeat in U and
Allow repeat in V that allow you to choose to repeat the texture in U and/or V.
By checking the Mirrored checkbox you can reflect the texture in U and/or V.

Sticker
The sticker Properties apply when a material is used as a sticker [312].
You will find in the accordion menu named Mapping the following parameters Allow repeat in U and
Allow repeat in V that allow you to choose to repeat the texture in U and/or V.
By checking the Mirrored checkbox you can reflect the texture in U and/or V.

Raytracing
Each material behaves differently during a rendering by raytracing. The Raytracing tab gives you control
over the settings for this behavior.

Environment Material
The environment material is generally applied to a hemisphere modeled about your object. The HDRI
environment will be visible on this hemisphere. Your object will be integrated in this environment, the
advantage of this method being that the environment changes interactively when you are zoom and
pan around the scene.
After you have applied this material to your hemisphere, it is often useful to edit your environment and
to change its altitude. You will thus obtain a better sense of scale and realism.
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Using an Alternate Background Texture as an Environment Material
In order to reduce the resources used by the graphics card as well as the size of .kdr files, a highdynamic range, average resolution (typically 1024×512 pixels) environment may be coupled with a
low-dynamic range, high-resolution (4096×2048 pixels) texture instead of using a high-dynamic range,
high-resolution environment.
This modification applies to an environmental material. The most common use of this material is to
create in Shaper a Hemisphere primitive enveloping the whole scene (typically with a diameter of 5 to 10
meters), and applying the environment material on it in Matter.
To couple a high-dynamic range, average-resolution environment to a low-dynamic range, high-resolution texture, the following steps must be performed:
1.

In Matter, import an HDR or EXR file of reasonable resolution (1024×512 or 2048×1024) and apply it
to the product.

2.

Open the Environment Properties Editor for this environment. The Background box indicates that no
alternate background texture has been defined.

3.

Select a texture with a higher resolution in a low dynamic range format (JPG, PNG…) and couple
it with the active environment by drag-and-drop onto the None button in the Alternative Background
Map box. The texture is automatically applied to the environment material. The filename replaces
the mention None.

TIP
The environment and the texture chosen must be in the same format, which means they
must use the same projection (Longitude-Latitude, Angular or Vertical cross). In general,
the most appropriate texture is a version of the environment on which a tone mapping is
applied and used as an omnidirectional plate.
The Alternative Background Map has the following functions:
• The button

is for deleting the active alternative background texture.
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• Clicking on the button tagged None or the name of the file defined as an alternative background
texture opens the Matter sidebar's texture library and selects the texture associated with the background chosen.

Matte Material
The matte material in Matter makes it possible to view only the shadow of an object. It is generally
applied to a plane placed under your object. It will allow you to compose your 3D object on a 2D
background; it will help to "set" this object in the scene.

Mirror Material
The mirror material is most often applied to a plane. It will allow you to simulate a mirror or a pane of
glass in which the other surfaces in the scene will be reflected.
You can filter the surfaces that will be reflected using the Tag for Reflected Surfaces option. This option
uses the tags assigned to surfaces in Shaper to limit the surfaces that are reflected. In a complex
scene, this can significantly improve rendering time.
For more information on tags, see Tag Manager [165].
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Multilayer Materials
Multilayer materials allow you to combine effects which previously required the use of stickers. Thus
you can easily create metallic and pearlescent paints, carbon fiber, varnished wood, perforated leather,
etc., which can be assigned directly as a single material.
The technique to assign a multilayer material on a surface is identical to that of a single material.
Layers are created one after another in the upper part of the Materials editor.
When a layer is created, using the New Layer button, you have the choice of three different types: diffuse
layer, specular layer, illumination layer, flakes layer.
The order of the layers is important: if a completely opaque layer is on top, it will mask all layers
beneath it. You can move a layer in the list by clicking and dragging.
Each type of layer is represented by a different icon: a top-lit ball for a diffuse layer, a luminous ball for
an illumination layer, and a mirror-finish ball for a reflective layer.

Types of Layers: Diffuse Layer
In general, this is the first layer created, the one giving the basic color. For a standard material, the
parameters are given under the diffuse tab. The same semi-transparency options as those for the
standard materials apply.
In fact, there are only two differences: the illumination parameter has disappeared (an illumination layer
must now be created) and the diffuse grain is incorporated directly.
The diffuse layer parameters operate in the same way as those of the diffuse tab for the standard
material.
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Mixing the diffuse layer is standard: if the diffuse layer uses a see-through image, the layer underneath
is shown in proportion through it.
Diffuse layers can accept a video texture as a Color Map.

Types of Layers: Specular Layer
In the same way that a diffuse layer incorporates its own diffuse grain, a specular layer incorporates its
own specular grain. This approach provides better hierarchy of the layer parameters and provides more
options. The specular layer is parameterized in the same way as the parameters under the reflection tab
for the standard material.
A specular layer operates in additive mode: the reflection is added to the combination of lower layers,
but provides overall filtering of the lower layers and variable attenuation according to the Fresnel
reflection. If the Transmission attenuation option is ticked, then some of the reflected light on the
surface is not transmitted to the lower layers, making the light behave realistically.
You will find in the accordion menu Roughness the Roughness map parameter and Gloss map only after
enabling the roughness and then dragging and dropping a texture from the texture library on the None
field.
• The Roughness map is a grayscale texture where the black corresponds to a roughness of 0 (smooth)
and white corresponds to a roughness value of the material.
• On the other hand, the Gloss map is a grayscale texture where the black corresponds to ta value of
the material roughness and the white corresponds to a roughness of 0 (smooth).
You will find in the accordion menu named Mapping the following parameters Allow repeat in U and
Allow repeat in V that allow you to choose to repeat the texture in U and/or V.
By checking the Mirrored checkbox you can reflect the texture in U and/or V.

Types of Layers: Illumination Layer
The illumination color is found in the standard material under the diffuse tab and allows a certain
luminosity to be generally added to the material. The brightness may be greater than 1.
The velvet effect in the standard material is found under the reflection tab, but also acts as a light
addition, this time depending on the viewing angle on the surface. The added luminosity is given by a
gradient ramp multiplied by a specifiable factor, which may be greater than 1.
If a modulation image is activated, it filters the modulation color on the surface. If the velvet effect
is used, ticking the Use modulation image box modulates the effect so as to provide a more realistic
appearance.
Note that an illumination layer includes a grain, which affects only the velvet effect if activated. The
grain reinforces the realism, especially of fabrics.
An illumination layer operates in additive mode: its contribution is added to the lower layers.

TIP
Most standard materials may be recreated in the form of multilayer materials with a
single diffuse layer and a single specular layer.
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For more complex materials, nothing prevents you from using several layers of the same type. For
example, a 3D open mesh fabric may use one diffuse layer for the lower textile and another diffuse
layer, made visible using the transparency effect, for the top layer. If the underside is glossy, then the
latter diffuse layer will be on the specular layer of the lower layer. The organization of the material
would thus be:
• Specular layer, upper textile
• Diffuse layer, upper textile
• Specular layer, lower textile
• Diffuse layer, lower textile
If you also want to use the velvet effect because the surface of the fabric is partly soft or textured,
inserting an illumination at the right place will do the job:
• Specular layer, upper textile
• Illumination layer, upper textile
• Diffuse layer, upper textile
• Specular layer, lower textile
• Diffuse layer, lower textile

NOTE
The number of layers that can be used is limited only by the capacity of your graphics
card. If you want to go further, the system will still operate but at a cost of slowing down
the display.

Flakes layer
The flakes layer is particularly useful when you want to reproduce, for example, the effect of glittering
paint of car paint type like on a car body.
The car paint type material is a multilayer material (diffuse, specular and flakes). The flakes layer is
generated using the Flakes Layer Editor. To add a flakes layer, click Add Flakes Layer.
All flakes can have the same color, or follow a distribution given by a color palette available in the
Flakes Color Editor [396]
. See the Multiple Colors parameter. Random variations of the same color
are possible between the flakes via the L +/- (Luminance) or a +/- or b +/- (chrominance) parameters
which define a standard deviation according to the Normal distribution.
Flakes can also vary in size thanks to the Size parameter. The Orientation is expressed in degree with
variations via the standard deviation +/- of the Normal distribution.
The visibility of the flakes can be dimmed according to their angle which is defined by the combination
of a depth value and the texture of the Normal distribution.
The Sides parameter defines the number of sides of a flake (from 3 to 8 sides): eg. triangle, square,
octagon.
The Texture Size parameter sets the size of the texture in pixels.
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• The higher the texture size, the better the definition with longer generation time and more data to
store.
• The smaller the texture size, the less good is the definition with a short build time and less data to
store. The greater the probability of seeing pattern repetitions of textures.
The Seed parameter is used to generate a different texture from the same parameters. To avoid the
redundancy of a texture the Seed parameter randomly generates a new texture according to a value.
You have the option to generate a texture with glitter randomly distributed on the texture Flakes
Distribution > Random or evenly distributed Flakes Distribution > Even. Choose the flakes distribution
according to the result you want. For a more realistic rendering of the generated texture, the random
distribution of flakes is recommended for a texture composed of a lot of flakes.
If you enable the Automatically update textures parameter, after each change to the flake texture settings, the layer will automatically update. If instead the box has not been checked, which is the case by
default, it is necessary to click on this icon

after each modification of the texture parameters.

The features available in the Reflexion Color [296], Fresnel [296], and Roughness [298] accordion menus
are described in their dedicated section.
The features in the Advanced accordion menu are explained in the specular layer [307] section above in
this chapter.

Enhanced Relief
Multilayer materials using a height map can be rendered with textural relief that is even more realistic.
This option offers an enhanced perception of depth thanks to the way it handles parallax.
The use of enhanced relief is best suited to contexts where a standard material uses a texture that
requires more visual depth than that which can be rendered using bump maps in diffuse and specular
layers.
The Parallax Bump Mapping tab gives access to settings that provide a rendering which, while robustly
real-time, requires more time to calculate. It is therefore recommended to use this option where appropriate, without overloading a scene.

Enabling Enhanced Relief
NOTE
Enhanced relief is not compatible with the use of bumpmaps to create the impression of
relief. Enabling enhanced relief for a layer will disable the bump for that layer, if it was
enabled, and vice-versa.
Enhanced relief must be enabled:
• globally for the material in the Parallax Bump Mapping tab,
• then for the required layers in the Layers tab. By default, it is disabled in all layers.
Enable enhanced relief in the Parallax Bump Mapping tab of the Materials editor for a standard material:
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1.

Drag and drop a texture from the texture library to the field None making sure it is a bump map.
Switch to the Layers tab:

2.

For the layer or layers that should use enhanced relief, tick the Use Parallax Bump Mapping checkbox in the Bump zone.

Disabling one of these elements will also disable the enhanced relief.

Settings
The settings for enhanced relief are found in the Parallax Bump Mapping tab of the Materials editor:
Setting
Depth

Description
The depth defines the distance between the white and the black zones of the height
map. The white zones are aligned on the mesh of the surface.
Because the perceived depth of the map's black zones is set using this parameter,
the height map should make use of the full range of elevation available, from white
to black. When this is not possible, make sure that the map's maximum elevation
will be aligned with the modeled surface, that is, that it is represented in white on
the height map.
A negative value will invert the depth of the texture: depth is rendered as rising
from the surface instead of as incisions carved into the surface. While possible, this
rendering is not optimal and is not recommended.

TIP
Values between 0 and 10 are usually sufficient. Using values that are
too high can create visual deformations when viewing surfaces at low
angles or when viewing curved surfaces.
Height
Map

A height map is required. This map is a black and white texture that is assigned to
the material as a Bump map.
The texture to be used as a height map can be square or rectangular. The height
and the width of the texture in pixels must both be powers of two.

TIP
Although Patchwork 3D will resize height maps whose dimensions
are not useable, choosing textures with dimensions that are powers
of two is highly recommended in order to preserve the particularities
of the height map.
Dimensions and
Transformation of
the bump
map

These settings are modifiable as normal to adjust the dimensions, the orientation,
and the position of the height map on the surface.
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Seam Material
The Seam material simulates lines of stitching. The Seam material is transparent, except where the
threads are visible. This material is generally applied to a thin, straight surface that has been superimposed over the main surface.

Lines of stitching created with a seam material.

The structure of this material is similar to that of the standard material. It is composed of two layers, a
diffuse layer and a reflection layer, and it has texture properties.

Diffuse
The diffuse parts of the seam material represent the thread.
The Diffuse Color, which is principally given by the Filter color, is the thread color.
The Color Map gives the pattern of stitches. It is generally the same as the image used for the Seam
Map in the Bump tab.

Reflection
Based on the type of thread used, the stitches can appear more or less shiny. As for a standard
material, the Reflection Color as an additive value, the roughness, and the diffuse filter can be adjusted.

Bump
The realism of the stitching’s appearance is due, in part, to the bump texture.
The texture of this type of material is assembled from two different image maps: a Pleat Map and a
Seam Map.
The Seam map gives the pattern for the individual stitches. Without this map, the material would be
entirely transparent. The color of the diffuse filter will fill in the lighter areas of this image. The zones
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with an alpha background will remain transparent, showing the material assigned to the surface below
the seam surface.

Example of a seam map. The checkered zones represent an alpha background.

If the material is gathered or pleated under the stitching, use the Pleat map settings to impose the
texture.

Sticker Material
A sticker is a material pattern that can be applied to a surface and oriented, similarly to a physical
sticker.
The surfaces of Matter may receive an unlimited number of stickers. These stickers are used to
position product graphical elements such as a logo, documentation, a mark, iconography, and so on,
interactively on model surfaces.
Any standard, multilayer, seam or environment material can be applied in sticker mode. In fact, the
sticker material is a standard material for which the sticker mode (Always use as a sticker) is imposed
by default. In this mode, the textures defining the material are no longer repeated on the surface. The
stickers are overlaid in successive coats according to their order of creation on the surface. This order
can, however, be modified later in the Surface Properties Editor.

Successive layers of stickers.

Furthermore, if the alpha coat of the diffuse texture is present, it defines the transparency zones of the
sticker. A value of zero in the alpha coat encodes a transparent pixel.
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Left: with alpha zones. Right: without alpha zones (RGB only).

Managing Applied Stickers
You have access to the list of stickers of a surface, of which you can modify the order, the transformation, and the name.
This function is available via the contextual menu of the selected surface. Right-click on the surface
then select surface, Edit the properties, and then select the sticker tag.

TIP
To click on a surface, the surface must be visible. Display all surfaces by right-clicking
within the viewport and choosing the option, Show All (Ctrl+Shift+R)
The sticker placed at the top of the list in the Stickers manager is the one perceived in the foreground in
the active view.
The up and down arrows
allow you to change the layer order of the stickers. Select the
sticker and click on the arrows according to the desired arrangement.
You have the possibility of renaming the stickers by entering a new name in the input field located at
the bottom of the Stickers zone.
The U and V Offset and the Rotation parameters of the Transformation zone allow the sticker to be
placed more precisely by entering numerical values directly or by using the keyboard cursor arrows.

Assigning a Material to a Surface
To assign a material to a surface, you can:
• Drag and drop from the editor Materials,
• Drag and drop from active element in the Matter sidebar's material library,
• Drag and drop from a selected element in the Matter sidebar's material library.
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The use of the key modifies, Ctrl, Alt, and Shift, can optimize the assignment of materials to one or
several surfaces of the active model.

From right to left: Starting scene; CTRL = replace on all surfaces with the same material; MAJ = apply as sticker.

Ctrl: The Ctrl modifier replaces a given material with a new material on all of the product surfaces to
which the first material was assigned. The new material will thus be identically assigned to all of the
same surfaces as the previous material had been.
Alt: The Alt modifier resets the position of a material in the scene. This reset is carried out according
to the surface mapping that was calculated in Shaper. If you have transformed the surface by the
rotation or translation operating modes, using the Alt modifier will recalculate its original position. This
command can also be combined with the Shift modifier to position a material according to an absolute
grid determined by the surface mapping.
Ctrl+Shift: Combining the Ctrl+Shift modifiers gives access to the context menu containing advanced
assignment options:
• Apply the material to:
• this surface, in the visible aspect layer,
• this surface, in the active aspect layer,
• all of the surfaces that are currently using the same material as this surface,
• all of the surfaces that have the same tags as this surface.
• Apply as a sticker on active aspect layer to:
• this surface, with the choice among the mappings calculated for this surface,
• all of the surfaces using the same material on the same mapping,
• Replace a sticker applied to this surface,
• Replace a sticker applied to this surface and to all of the visible surfaces where that sticker is also
used.

Assigning Materials as Stickers
Shift: The Shift modifier assigns a material as a sticker. To assign a sticker to a surface, you can:
• Shift + drag and drop from the Materials editor,
• Shift+drag and drop from the active element in the Matter sidebar's material library. If multiple UV
mapping have been assigned to the surface targeted by your cursor, a drop-down menu will appear
allowing you to select the UV channel.
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• Shift+drag and drop from a selected element in the Matter sidebar's material library.
The center of the sticker is placed exactly at the location where you drop the material. Precise
positioning of the sticker on the surface is accomplished using the two interactive modes.

Positioning and Orienting Materials
When a material positioning mode is enabled, it applies to all viewports. The interactive positioning
begins when you click to begin to drag a material or a sticker.
The mode:
• Translate a material
• Rotate a material

moves the material or the sticker on the surface in an intuitive way.
pivots the material or the sticker around the point where you have clicked.
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LIGHTING ENVIRONMENTS
A lighting environment is an omnidirectional image (360 x 360 degrees) that memorizes the incident
lighting at a particular point in space.
Patchwork 3D supports the light probe, latitude-longitude, and vertical cross formats of HDR images for
use as environments.

HDR Environment formats: light probe, lat-long, and vertical cross.

Patchwork 3D environments are HDR environments (High Dynamic Range). The data stored in an
environment are encoded in order to maintain the full range of light dynamics, at multiple orders of
magnitude.
The measured physical quantities of the lighting allow image details to be maintained, even within a
single image, in the full range of lighting dynamics, from very dark areas to very bright ones.
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With the aid of an environment, the Matter module computes the diffuse global lighting environment
that serves to render the lighting on the surfaces and generates visible reflections in the reflection coat
of the materials.

Manipulating the Environment
In addition to the standard operations provided in the Matter sidebar's environment library, the Matter
interface provides other actions, such Environmental orientation, Link diffuse environment rotation, or
Initialize environment orientation in the environment in the Environment Properties editor.
• Environment orientation: Found in the Mode menu. This tool allows you to move the environment
about the product. Since the environment enables lighting of the product, it can thus be positioned
so as to bring out the areas of interest, for example.
• Diffuse environment rotation: this operation is available from the Product > Environment menu. It
allows the lighting to be rotated at the same time as the environment.

Manipulating the Environment from Editors
The editors Surface Properties (in Matter), Product Environments, and Environment Properties allow the
orientation of the environment to be specified as a modification along the three axes X, Y, and Z.

Examples of Environments with a Product
We present here an object lit by two different environments, a studio environment, and an illuminated
environment. Notice that even though the same geometry is represented, the environment plays a
major role in the lighting of the model.
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Studio type environment.

An illuminated street type environment.

It is also possible to set up a background environment. To do this, activate the Camera menu >
Background > Environment. By default, the active environment is chosen.

TIP
To use an environment as a background, a sensor must be assigned to the camera in the
viewport in which you want to use the environment as a background. If this is not the
case, you will first need to create a sensor and drop it on the viewport.

Local Environments
Patchwork 3D supports local environments so that materials used by certain geometries can reflect
their immediate, or local, surroundings.
The button Create a local environment
list of available environments.

allows an environment of the Local Environment type to the

To assign this local environment to a group of surfaces, just hold the Shift key down and drag-and-drop
the local environment onto the desired surfaces (see section Multiple Environments).

NOTE
By default, the local environment initializes at scene coordinate 0,0,0 and captures its
immediate environment.
Depending on the scene, a plane or a surface can hide the environment nearest to the
initial point of capture, in which case the local environment will appear dark and very few
elements will be discernible.
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Setting Local Environment Parameters
To show the environment around a gear lever knob in the reflection of chromed material, parameters
have to be set for the local environment.
To do this, open the Environment Properties by double-clicking on the Active Environment thumbnail.
1.

Select the Pick the capture origin tool
origin of the capture point.

then click on a point on the gear knob to position the

2.

The Display and move the capture box tool
allows the capture box to be displayed and moved,
showing the zones from which the local environment images are going to be captured.

It is possible to adjust the size of the capture box by changing the value of the Radius parameter.
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TIP
Capture of the environment must be consistent with the object to which the local
environment is assigned.
It is therefore necessary to exclude from the capture the surfaces relating to the
object:
• either by using the tool for exclusion of surfaces and entering the name of the
surface.
• or by ensuring that the box is larger than object in question.

3.

The Refresh environment button
allows the environment to be updated by recalculating the
images captured by the local environment box.
The environment thumbnail then displays the captured environment.

The chromed material applied to the gear lever knob reflects this new environment.
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4.

The reflection of the environment on the material can be adjusted with precision by manipulating
the value of the adjustment parameters in the General properties zone.

Multiple Environments
It is possible to simulate separate environments on different surfaces. To do this, drag and drop
environments of your choice onto a surface while holding down the Caps Lock key.

Environment Library
In the Matter sidebar's
library tab, the
environment library manages the groups of environments and the environments available in your database.
Groups of environments are listed in the upper part of the library:
Icon

Description
Create a new group.
Duplicate the selected group.
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Icon

Description
Rename the selected group.
Delete the selected group.

NOTICE
New Features in Patchwork 3D 2022 X5
Double-clicking on the texture thumbnail makes it active and opens the texture editor.
The list of environments shows all of the existing environments in the selected group. Using the
buttons below the list, you can:
Icon

Description
Create a new environment using the HDR Light Studio Live plug-in. For more information
on this plug-in, see HDR Light Studio Plug-In [217].
Open the HDR Light Studio Live plug-in to edit the selected environment.
Get an HQ environment for the selected environment.
Create a new local environment.
Refresh all visible local environments.
Open the Environment properties of the selected environment.
Open the Textures editor to view the selected environment as a texture.
Rename the selected environment.
Refresh the selected environment.
Import environments that you have previously saved.
Export the selected environments. You can then choose the folder where the environments will be saved, the type of file to save (Patchwork 3D Environment, Radiance HDR or
OpenEXR Bitmap) and the desired environment format (Longitude-Latitude, Vertical Cross
or Light Probe).
Duplicate the selected environment.
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Icon

Description
Delete the selected environments.
Purge environments that have not been used (environments that are not applied to any
surface of any product).
Modify the way in which the list is displayed.

Right-clicking on an environment opens a context menu offering the following options:
Icon

Function

Description

Edit

Edit the selected environment by opening the HDR Light Studio Live
plug-in.

Refresh

Refresh the selected environment.

High Quality
Environment

Switch to a high quality environment.

Set active

Makes the environment you have clicked active and shows it in the
lower part of the library.

View

View the environment as a texture in the Textures editor.

Edit

Edit the selected environment by opening the Environment Properties.

Replace with

Replace the selected environment(s) with another environment from the
environment library.

TIP
This functionality is available if at least two materials already exist in the environment library.
Duplicate

Duplicate the selected environment.

Rename

Rename the selected environment.

Usage list

Show a list of all sensors to which this post-processing has been assigned.

Export

Export the selected environment. Then choose the folder where the
environment will be saved, the type of file to save (Patchwork 3D Environment, HDR radiance or OpenEXR Bitmap) and the desired format (Longitude latitude, Vertical cross or Light Probe).

Delete

Delete the selected environment.

323

Patchwork 3D Enterprise 2022 X5

The active environment is shown in the lower part of the library:
Icon

Description

Thumbnail

Double-clicking on the thumbnail opens the Environment Properties editor.
Use the eyedropper to grab an environment in a view and activate it.
Open them Environment Properties for the active environment.
Select the active environment in the list of environments.
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TEXTURES
A texture is an image or video file used to provide a visual pattern in many different contexts.
The following image formats are supported:
• *.ktx
• *.png
• *.jpg
• *.tif
• *.bmp
• *.tga
• *.xpm
• *.hdr
• *.exr
Video files under 1GB in the following formats are supported:
• *.avi
• *.mkv
• *.mpg, *.mpeg

Use text as texture
A series of characters of text can be used in all of the same contexts as an image, thanks to the
internal editor that generates an image based on the text provided.
For additional information on using this function, please refer to the following sections:
• Text Image (Editor) [172]
• Texture Library [325]

Using Video Textures
Video textures can be integrated as the image used by background [94], the diffuse color map in
standard type materials [291], or as the color map of a diffuse layer in multilayer materials [306].
To view the playback of video textures, the texture must be present in a background being used or in a
material applied to a surface of a product. The texture must then be added to a Textures [122] track in a
timeline. When a timeline containing texture clips is played, the corresponding videos are animated for
the background and for all materials using those textures that are present in the active viewport.

Texture Library
library tab, the
In the Matter sidebar's
textures available in your database.

texture library manages the groups of textures and the
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Groups of textures are listed in the upper part of the library.
Icon

Description
Create a new group.
Rename the selected group.
Delete the selected group.

NOTICE
New Features in Patchwork 3D 2022 X5
Double-clicking on the texture thumbnail makes it active and opens the texture editor.
The list of textures shows all of the existing textures in the selected group. Using the buttons below the
list, you can:
Icon

Description
Import textures (images or videos saved on your hard drive or on your network).
Please find below the list of the files formats that you can import into the Texture Library:
• *.ktx (Patchwork 3D texture)
• *.png
• *.tif
• *.bmp
• *.tga
• *.webp
• *.xpm
• *.hdr
• *.exr
• *.avi
• *.mkv
• *.mpg
• *.mpeg
• *.mov
• *.mp4
Create a new text texture by opening the Text Image editor.
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Icon

Description
Duplicate the selected text texture.
Edit the selected texture by opening the Textures editor or the Text Image editor, depending on the type of texture selected.
Rename the selected texture.
Update the selected texture.
Export the selected textures.
Please find below the list of the files that you can export into the Texture Library:
• *.ktx (Patchwork 3D texture)
• *.png
• *.tif
• *.bmp
• *.tga
• *.webp
• *.xpm
• *.hdr
• *.exr
Delete the selected textures.
Purge textures that are not currently in use.
Modify the way in which the list is displayed.

TIP
To add a texture to material just drag and drop a texture from the Texture Library to
the Materials Editor in the dedicated field to a texture. For example Color map, Bump,
Transparency, Gradient map. If a field already has a texture, Patchwork 3D allows you to
adjust the texture size with Absolute or Relative to previous texture parameters when
replacing it.

Right-clicking on a texture opens a context menu offering the following options:
Icon

Function
Edit

Description
Edit the selected texture by opening the Textures editor or the Text Image
editor, depending on the type of texture selected.
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Icon

Function

Description

Refresh

Update the selected texture.

Rename

Rename the selected texture.

Usage list

Show a list of all resources, such as textures and backgrounds, that use
the selected texture.

Replace with

Replace the selected texture(s) with another texture from the texture
library.

TIP
This functionality is available if at least two texture already exist in the texture library.
Import

Import textures from your hard drive or from a network location.

Export

Export the selected textures.

Delete

Delete the selected textures.
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BACKGROUNDS
A background is a 2D visual placed behind the objects in the 3D world. It does not move when you
navigate in the 3D world, but remains stationary with regard to the screen.
Backgrounds are associated with camera sensors. For more information on how backgrounds are
created and applied, see Backgrounds (Editor) [94] and Sensors [347].
In Matter, two types of backgrounds are available:
• Environment type: displays the lighting environment used to calculate the reflections and the diffuse
lighting of the materials.
• Gradient type: replaces the uniform background of a view with a color gradient or with an image. The
gradient is defined by a Start color and an End color, which are respectively associated with the top
and bottom edges of the viewing zone.

Left: Gradient type background - Right: Environment type background

Assignment
To assign a Gradient-type background, you can:
• Drag and drop it from the start zone

in the Backgrounds editor.

• Drag and drop it from the active background at the bottom of the Matter sidebar's background library.
• Drag and drop it from the selected item of the Matter sidebar's background library.

Background Library
In the Matter sidebar's
library tab, the
background library manages the groups of backgrounds and the backgrounds available in your database.
Groups of backgrounds are listed in the upper part of the library:
329

Patchwork 3D Enterprise 2022 X5

Icon

Description
Create a new group.
Duplicate the selected group.
Rename the selected group.
Delete the selected group.

NOTICE
New Features in Patchwork 3D 2022 X5
Double-clicking on the background thumbnail makes it active and opens the backgrounds editor.
The list of backgrounds shows all of the existing backgrounds in the selected group. Using the buttons
below the list, you can:
Icon

Description
Create a new background.
Duplicate the selected background.
Edit the selected background by opening the Backgrounds editor.
Rename the selected background.
Import backgrounds that you have previously saved.
Export the selected backgrounds.
Delete the selected backgrounds.
Purge backgrounds that have not been used (backgrounds that are not assigned to any
camera sensor).
Modify the way in which the list is displayed.

Right-clicking on a background opens a context menu offering additional the following options:
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Icon

Function

Description

Set active

Make the background you have clicked active and shows it in the lower
part of the library.

Edit

Edit the selected background by opening the Backgrounds editor.

Duplicate

Duplicate the selected background.

Rename

Rename the selected background.

Replace with

Replace the selected background(s) with another background from the
background library.

TIP
This functionality is available if at least two materials already exist in the background library.
Usage list

Show a list of all sensors to which this background has been assigned.

Import

Import backgrounds that you have previously saved.

Export

Export the selected backgrounds.

Delete

Delete the selected backgrounds.

The active background is shown in the lower part of the library:
Icon
Thumbnail

Description
Double-clicking on the thumbnail opens the Backgrounds editor.
Use the eyedropper to pick a background from a viewport and render it active.
Open the Backgrounds editor for the active sensor.
Select the active background in the list of sensors.
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OVERLAYS
An overlay is a 2D image (often a logo) that is displayed in front of the objects in the 3D world. It does
not move when you navigate in the 3D world, but remains stationary with regard to the screen.
Overlays are associated with camera sensors. For more information on how overlays are created and
applied, see Overlays (Editor) [214] and Sensors [347].
Overlays are managed in the Matter sidebar's overlay library.

Enabling Overlays
Overlays are enabled by default. They can be disabled and re-enabled using the button in the toolbar at
the top of the Matter module.

•

: Enable or disable overlay display.

Overlays in Configurations
The layers of each overlay can be used in configurations in the same manner of other types of layers in
Patchwork 3D.
Configuration rules accept one or more overlay layers as targets. When a user chooses such a configuration, the configuration rule is met and the layers that are targets of the rule are displayed. The other
configurable layers of the overlay are hidden.
For the effects of overlay configuration to be visible, the overlay containing the configurable layers
must be assigned to an active camera sensor and overlay display must be enabled.
For more information, see the following sections:
• Product configurations [362]
• Configurations (Editor) [155]

Overlays in Animations
Overlay display can be handled in a timeline animation by using channel animations.
Configurations containing layers of an overlay can also be animated. To do so, use configuration keys
positioned in the Configurations track of a timeline.
For more information, see the following sections:
• Timelines [393]
• Timelines (Editor) [115]
• Channels (Editor) [132]
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Overlay Library
library tab, the
In the Matter sidebar's
the overlays available in your database.

overlay library manages the groups of overlays and

Groups of overlays are listed in the upper part of the library.
Icon

Description
Create a new group.
Duplicate the selected group.
Rename the selected group.
Delete the selected group.

NOTICE
New Features in Patchwork 3D 2022 X5
Double-clicking on the overlay thumbnail makes it active and opens the overlays editor.
The list of overlays shows all of the existing overlays in the selected group. Using the buttons below
the list, you can:
Icon

Description
Create a new overlay.
Duplicate the selected overlay.
Edit the selected overlay by opening the Overlays editor.
Rename the selected overlay.
Import overlays that you have previously saved.
Export the selected overlays.
Delete the selected overlays.
Purge overlays that have not been used (overlays that are not assigned to any camera
sensors).
333

Patchwork 3D Enterprise 2022 X5

Icon

Description
Modify the way in which the list is displayed.

Right-clicking on a overlay opens a context menu offering the following options:
Icon

Function

Description

Set active

Make the overlay you have clicked active and shows it in the lower part
of the library.

Edit

Edit the selected overlay by opening the Overlays editor.

Duplicate

Duplicate the selected overlay.

Rename

Rename the selected overlay.

Usage list

Show a list of all sensors to which this overlay has been assigned.

Replace with

Replace the selected overlay(s) with another overlay from the overlay
library.

TIP
This functionality is available if at least two materials already exist in the overlay library.
Import

Import overlays that you have previously saved.

Export

Export the selected overlays.

Delete

Delete the selected overlays.

The active material is shown in the lower part of the library:
Icon
Thumbnail

Description
Double-clicking on the thumbnail opens the Overlays editor.
Use the eyedropper to pick an overlay from a viewport and render it active.
Open editor Overlays for active overlay.
Select the active overlay in the list of overlays.
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How to Make an Overlay
To create an overlay, you must have previously created a texture image (for example, in Photoshop) of
the logo or the text you wish to display.

Begin by opening the Overlays

editor from the Matter editor toolbar.

Next, create a new layer and adjust the position of your overlay. This is managed in the Transformation
zone, which allows you to indicate the horizontal and vertical position, and the overlay offset.

TIP
The offset of the overlay on X, Y axis can be expressed in different units and relative to
the size of the image with the following parameters % width, % height and % default. %
default uses height or width depending on the default orientation of the active camera.
You can also add a background color by adjusting the parameters of the Gradient field.
Finally, apply the texture image by drag-and-drop to the part of the Map field.
The overlay is now created, and by dragging and dropping it from the sidebar library to the viewport,
you can add the overlay to the product.
There are three actions in the Camera > Overlay menu that allow you to hide (or display) the overlay, to
edit it or to remove it from the camera sensor, namely: Overlay visibility, Edit overlay and Delete overlay.

Examples
Here are a few examples of overlays prepared with the same texture image, in this case the Lumiscaphe logo.
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Different styles of overlay.

NOTE
For the last example, we have varied the Alpha parameter (transparency) for each color It
is also possible to adjust it at the start in the Global Parameters. In this case, the same
Alpha parameter value is applied to both the background colors.
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POST-PROCESSING
Post-processing filters an image to produce a certain look or effect. Patchwork 3D has a powerful
2D post-processing tool for creating, combining and inventing spectacular rendering effects. Because
Patchwork 3D's post-processing is real-time, you can continue navigating in the viewport; the filter will
remain in place and navigation will still be fluid.
Post-processing is managed in the Matter sidebar's post-processing library.

Enabling Post-Processing
Applied post-processing is displayed by default. This setting can be disabled and re-enabled using the
button in the toolbar at the top of the Matter module.

: Enable or disable the display of 2D post-processing blends.

Post-Processing Effects
Patchwork 3D offers 17 basic effects as well as three types of tone mapping. Each has programmable
properties. Effects can be added one after the other or blended together using the options in the
Advanced sub-menu to produce a unique result.
The different basic effects are:
• Gaussian blur.
• Film grain.
• Hand drawing.
• Negative.
• Black and white.
• Sepia.
• Grayscale.
• Color filter.
• Adjust color.
• Bloom.
• Sharpen.
• Edge detector.
• Erode.
• Dilate.
• Vignetting.
• Camera response.
You will find examples of the main effects below.
337

Patchwork 3D Enterprise 2022 X5

Initial image.

Gaussian blur.

Film grain.

Hand drawing.

Negative.

Black and white.
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Sepia.

Grayscale.

Color filter.

Adjust color.

Bloom.

Sharpen.
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Edge detector.

Erode.

Dilate.

Tone Mapping
A tone mapping operator is a tool for displaying a High Dynamic Range image (with no intensity limitation) on a Low Dynamic Range screen (with an intensity limited to 1) which is unable to manage the
range of light intensities present in the image. Using a tone mapping operator to display HDR images
can reveal details otherwise invisible. However, tone mapping operators can change the appearance of
the colors, shadows and lights.
The three tone mapping effects are detailed below.
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Automatic tone mapping.

Reinhard Tone Mapping
Two parameters may be set for the Reinhard Tone Mapping: these are Saturation level and Brightness
factor.
Saturation level is the input intensity level that will be brought back to 1. Setting this parameter to a
high value preserves high-intensity lights.
Brightness factor enables the user to control brightness after processing. Setting this parameter to a
high value leads to a light final image.
In order to use Sub-pixel correction, the corresponding box must be ticked. The Sub-pixel correction
option limits aliasing phenomena in the HDR images.

Options for the Reinhard Tone Mapping effect.

The following images show the effect of Reinhard Tone Mapping for different saturation levels and
brightness factors.

A Patchwork 3D scene with no tone mapping applied.
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Reinhard tone mapping with a saturation level of 0.6 and a brightness of 0.6.

Reinhard tone mapping with a saturation level of 1.5 and a brightness of 0.8.

Drago Tone Mapping
The following parameters can be set for the Drago Tone Mapping effect: Average Luminance, Bias and
Maximum Input Luminance. The user may also choose to use Sub-pixel correction by ticking the corresponding box.
Average Luminance is for controlling the average intensity of the original image. Setting this parameter
to low values leads to an overexposure of the final image.
Bias parameter enables users to control the final image contrast.
Maximum Input Luminance parameter is for controlling the maximal intensity in the original image.

Options for the Drago Tone Mapping effect.
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The following images show the effects of Drago Tone Mapping for different average luminance, bias
and maximum input luminance levels.

A Patchwork 3D scene with no tone mapping applied.

Drago tone mapping with an average luminance of 0.5, a bias of 0.6 and a maximum input luminance of 10.

Drago tone mapping with an average luminance of 0.5, a bias of 0.6 and a maximum input luminance of 1.
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Drago tone mapping with an average luminance of 0.5, a bias of 0.2 and a maximum input luminance of 10.

Post-Processing Library
In the Matter sidebar's
library tab, the
post-processing library manages all post-processing
effects. From this sidebar library, you can create, duplicate, save, import and delete the post-processes
you have generated.
Post-Processing Groups: Find below the available actions.
Icon

Description
Create a new group.
Duplicate the selected group.
Rename the selected group.
Delete the selected group.

NOTICE
New Features in Patchwork 3D 2022 X5
Double-clicking on the post-processing thumbnail makes it active and opens the post-processing
editor.
Post-Processing is the list of the available post-processing blends. Using the buttons below the list, you
can:
Icon

Description
Create a new post-processing blend.
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Icon

Description
Duplicate the selected post-processing blend.
Edit the selected post-processing blend by opening the Post-processing editor.
Rename the selected post-processing blend.
Import post-processing blends that you have previously saved.
Export the selected post-processing blends.
Delete the selected post-processing blends.
Purge post-processing blends that have not been used (post-processing blends that are
not assigned to any camera sensor).
Modify the way in which the list is displayed.

The active post-processing blend is shown in the lower part of the library:
Icon

Description

Thumbnail

Double-clicking on the thumbnail opens the Post-processing editor.
Use the eyedropper to pick a post-processing blend from a camera sensor used in a
viewport and render it active.
Edit the selected post-processing by opening the Post-processing editor.
Select the active post-processing blend in the list of sensors.

Right-clicking on a post-process opens a context menu offering the following options:
Icon

Function

Description

Set active

Make the post-processing you have clicked active and shows it in the
lower part of the library.

Edit

Edit the selected post-processing by opening the Post-processing editor.

Duplicate

Duplicate the selected post-processing blend.

Rename

Rename the selected group.

Usage list

Show a list of all sensors to which this post-processing has been assigned.
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Icon

Function
Replace with

Description
Replace the selected post-processing with another post-processing
from the post-processing library.

TIP
This functionality is available if at least two materials already exist in the post-processing library.
Import

Import post-processing blends that you have previously saved.

Export

Export the selected post-processing blends.

Delete

Delete the selected post-processing blends.
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SENSORS
A sensor is one of the basic resources in Matter that allow you to dress a product. Sensors are used
to specify view-related information, such as the aspect ratio and type of projection, and to group 2D
elements applied to a rendering.
To use a sensor, you must assign it to a camera or to a viewport. Assigning a sensor to a viewport
assigns it to the viewport's free camera. You can assign a sensor to as many cameras as you would
like.

Sensors are managed in the Matter sidebar's

sensor library.

Default Values
When no sensor is assigned, a camera, including the free camera in a viewport, uses sensor default
values.
The default values include an aspect ratio of 3:2, equivalent to the full-frame sensor in physical
cameras measuring 24x36mm, and the use of a perspective projection. No backgrounds, overlays, or
post-processing effects are used.

Attributing a New Sensor to a Viewport’s Free Camera
You can attribute a different sensor to any viewport’s free camera. This will replace the default sensor
values in that viewport until the sensor is deleted or the viewport is closed. Remember that all viewports are closed when you close your database.
Drag the sensor that you want to use from the Matter sidebar's sensor library and drop it onto the view
in which you would like to use it.

Sensor Library
library tab, the
In the Matter sidebar's
sensors available in your database.

sensor library manages the groups of sensors and the

Groups of sensors are listed in the upper part of the library.
Icon

Description
Create a new group.
Duplicate the selected group.
Rename the selected group.
Delete the selected group.
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NOTICE
New Features in Patchwork 3D 2022 X5
Double-clicking on the sensor makes it active and opens the sensor editor.
The list of sensors shows all of the existing sensors in the selected group. Using the buttons below the
list, you can:
Icon

Description
Create a new sensor.
Duplicate the selected sensor.
Edit the selected sensor by opening the Sensors editor.
Rename the selected sensor.
Import sensors that you have previously saved.
Export the selected sensors.
Delete the selected sensors.
Purge sensors that have not been used (sensors that are not associated with an open
viewport or with a camera).
Modify the way in which the list is displayed.

Right-clicking on a sensor opens a context menu offering the following options:
Icon

Function

Description

Set active

Make the sensor you have clicked active and shows it in the lower part
of the library.

Edit

Edit the selected sensor by opening the Sensors editor.

Duplicate

Duplicate the selected sensor.

Rename

Rename the selected sensor.

Usage list

Show a list of all cameras using the selected sensor.
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Icon

Function
Replace with

Description
Replace the selected sensor(s) with another sensor from the sensor
library.

TIP
This functionality is available if at least two materials already exist in the sensor library.
Import

Import sensors that you have previously saved.

Export

Export the selected sensors.

Delete

Delete the selected sensors.

The active sensor is shown in the lower part of the library.
Icon
Thumbnail

Description
Double-clicking on the thumbnail opens the Sensors editor.
Use the eyedropper to pick a sensor from a viewport and render it active.
Open editor Sensors for the active sensor.
Select the active sensor in the list of sensors.

Using Sensors
Opening a Database from an Older Version
When you open a database created with a Patchwork 3D version prior to v6.0, sensors will be created
automatically in order to conserve the settings applied to your products. The sensors created by this
conversion include information for:
• Any applied post-processing and the visibility of post-processing blends,
• Any applied overlays and the visibility of overlays,
• The background mode and any applied background texture,
• The depth policy,
• The viewport policy.

Assigning a Sensor to a Camera
A sensor can be assigned to a camera or to multiple individual cameras.
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In the Camera Editor, switch to Edit current camera mode for the camera to which the sensor should be
assigned. Drag the sensor from the Matter sidebar's sensor library and drop it onto the Sensor field in
the Camera Editor.

Assigning a Sensor to a Viewport
A sensor can be assigned to the free cameras in individual viewports. Assign a sensor to the free
camera by dragging it from the Matter sidebar's material library and dropping it onto the viewport while
the free camera is active. Because the free camera for each viewport functions independently, only the
sensor for the free camera in the chosen viewport will be replaced.
You can verify the sensor assigned to the active viewport at any time. If a sensor has been assigned
to the active camera in a viewport, it is displayed in the upper right-hand corner with the name of the
camera. This information is also available in the Camera Editor. When a camera is active, its information
is displayed on the right-hand side of the editor. The sensor used by the active camera is shown in the
Sensor field. Click on this field to locate the sensor in the Matter sidebar's material library.

Modifying the Sensor Used in a Viewport
The sensor assigned to the camera that is active in a viewport can be modified without opening the
Sensor Editor. To replace the sensor’s current post-processes, overlays, and environments with new
ones, drag and drop the new effects onto the viewport.
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GEOMETRY LAYERS
Geometry layers enable the surfaces of a model to be grouped and organized in a hierarchical structure. This facilitates editing. Geometry layers can also be used with the configuration system to hide or
display surfaces in a given layer.
The
Surface tab in the Shaper sidebar contains each of the surfaces contained in the layer you are
editing.
Each layer is represented by a zone containing its name and its properties. All the operations that
modify the state of a layer are applied by default to the active model that is shown highlighted.
Initially, a model has only one layer. You can create new layers via the Layer > New menu. You can then
distribute the surfaces into the various layers to form logical assemblies of surfaces.

Operations on Geometry Layers
Each geometry layer is listed with several status indicators:
Indicator

Description
Visible layer.
Hidden layer.
Unfrozen layer.
Frozen layer.
Layer that contains the active layer.
Active layer.
Select all surfaces in this layer in a single click.

Operations on the layers can be carried out using the buttons below the list of layers:
Icon

Description
New layer.
New layer within the selected layer.
Duplicate the selected layer.
Rename the selected layer.
Find and select the surfaces in the selected layer.
Delete the selected layer.
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Each layer has properties that directly affect the surfaces it contains. These operations are available
via a right-click on the name of the layer.
The most commonly used operations are the following:
Operation
Show
these layers

Description
Modifies the visibility of the active layer. The surfaces in an invisible layer do not
appear in the geometry of the model and cannot be modified in Shaper.
You can use the visibility of the layers to momentarily hide the surfaces on which
you are not working and to simplify accessing the other surfaces. You can also vary
the visibility of the layers to test the geometrical variations of a model.

Freeze
these layers

Modifies the editable state of the active layer. The frozen layers are still included
in the geometry of the model, but can no longer be modified in Shaper. The frozen
surfaces appear differently in the 3D view of Shaper: they are shaded. You should
only freeze a layer when the surfaces of the layer no longer need to be edited.

Duplicate

Duplicates the active layer and also all of the surfaces it contains. If the active layer
is not the only layer in the model, you can delete it by right clicking on the layer and
choosing Delete.

The principal operations on layers are also available via right-click on a geometry layer in the sidebar.
The right-click context menu also provides access to the following operations, among others:
Icon

Operation
Duplicate layer
with symmetry

Description
Creates a duplicate of the selected layer but reflects all of its
surfaces over a given plane: YX, XZ or YZ.
A window will open and you will be asked to choose the plane of
symmetry.

Show child layers

Modifies the visibility state of all child layers in order to make
them visible.
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POSITION LAYERS
Definition
Position layers allow Shaper objects to have multiple positions, one in each layer. Position layers can
then be used in the configuration system to create variants of a model or a product in which the
position or the presence of certain objects is not the same.

Displaying Position Layers
Surfaces using position layers are displayed taking the layer hierarchy into account. Position layers
indicated as visible are analyzed in the same order as they are listed in the Position Layers editor. For
each surface, the first position assignment found is displayed.
For more information on creating position layers, see Position Layers (Editor) [127].

353

Patchwork 3D Enterprise 2022 X5

LIGHTING LAYERS
A lighting layer is a grouping of light information that contains multiple lights.
The lighting that is visible on a model is the result of an analysis of the stack of lighting layers. Each
surface is lit based on the first visible layer in which an lighting is assigned to the surface.
Lighting layers can be used just like other layers, as targets of configuration rules. This allows, for
example, indicator lights, LEDs and other lights to be turned on or off when a configuration symbol is
enabled in the configuration browser, or according to the position of configuration keys in an animation
timeline.
In the Illumination
tab in the Shaper sidebar, the Illumination Layer zone provides the tools to create,
adjust, and delete layers.

Operations on Lighting Layers
TIP
There is a maximum limit to the number of lighting layers. The total number of layers
must not exceed 32. Once you have reached this limit, no additional layers can be created.

TIP
To change the position of a layer in the list, drag and drop it on a new position.
The main buttons are available below the list of layers:
Icon

Description
New lighting layer.
Duplicate lighting layer.
Add new lighting color to the layer.
Rename lighting layer.
Import lighting layer.
Export lighting layer.
Delete lighting layer.
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The buttons to rename, duplicate, export or delete a layer affect only the selected layer. When multiple
layers are selected, these buttons only affect the leader of the selection. The leader layer has a dotted
border and is highlighted in light gray.
Each lighting layer has its own set of active values for modulation color, intensity, visibility, and configuration use. The active set of color values is marked with a check in the visibility column in the Layers
list. When more than one layer is visible, the active values for each layer are combined.
The columns to the right of the name of the layer display the value of each of these properties. To
change the value, click on its representation in the corresponding column.
Property

Description

Modulation
color

The color of the lightmap is multiplied by the color of the layer. This color is
always white by default. Click on the colored rectangle to open the color chooser
and modify the color.

Intensity

The intensity of the lighting can be modified. You can set it to 0 or to any positive
decimal value. By default, the intensity is set to 1, which represents a normal
lighting.

Visibility

Illumination layers can be visible or hidden. During the analysis of the stack of
layers, hidden layers are skipped. New layers are visible by default. Lights in a
visible layer are shown in blue in the viewport. Lights in an invisible layer produce
no effect and are displayed in red in the viewport.

Configuration

If the layer is used as a target of a configuration rule, the icon displayed.
Clicking on this icon will select the corresponding rule in the Configuration Editor.

You can also right-click on a lighting layer in order to copy its lightmaps to another layer in the list.

TIP
When you open a database created with a version of Patchwork 3D prior to version 6.0,
each lighting set is converted to a lighting layer. To maintain the original settings, the
layer that corresponds to the active lighting set is visible; all of the other layers are
hidden.

TIP
When a new lightmap is first calculated for a surface, the other lightmaps for this surface
may also need to be recalculated if they were generated with a version of Patchwork 3D
prior to version 6.0.

Using Lighting Layers
Illumination layers can require significant computing power. To limit this, lighting layers have been
optimized for certain uses.

Substitution
Use a lighting layer when you have multiple geometric versions of your model. For example, you might
be working on a seat that can be marketed with or without a headrest. Without a lighting layer, you
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must calculate the lightmap for the whole model. When you view the version with no headrest, however,
the zone where the headrest would have been remains black: no lightmap was calculated for this zone.
To correct this, use a lighting layer.

Configuration
Use a lighting layer when your light sources need to be animated or configurable.
Put only the lights that must be turned on or off together in a separate layer.
The activation of layers is configurable. As with other types of layers, lighting layers can be dropped
onto the Configurations editor.
The set of color and intensity values of each layer is also configurable. The lighting color set can also
be dropped onto the Configurations editor.

Recommendations
To improve performance, follow these recommendations:
• Put all related lights in the same layer.
• Make sure that it isn't possible to have multiple layers containing sky lights active at the same time.
• Use the minimum number of layers that you can.
• Avoid using multiple sky lights to create the effect of an exterior environment. This effect can be
created in Matter with a lighting environment [316] and a real-time sun [209].

Settings for a Lighting Layer
Select a lighting layer by clicking on it. The light sources in this layer are now shown in white in the
viewport. They are also listed below in the Lighting Settings zone.
In addition to the lights contained in the layer, layers also contain additional settings that determine
the aspect of their illumination. These settings are found in the Lighting Settings zone. They apply to all
lights in the layer.
• Exposure
• Gamma
• Lightmap format:
• Color: To obtain shadow rendering that takes the lighting colors into account, choose the Color
format.
• Luminance (8 Bits): Use the Luminance (8 bits) format to obtain a relatively rapid rendering.
• Luminance HQ (16 bits)
• Luminance HDR (16 bits): The Luminance HDR (16 bits) lightmap texture format is designed for the
shadow rendering of HDR images and manages light sources significantly more intense than the
Luminance (8 bits) and Luminance HQ (16 bits) formats.
• The
lighting settings:
• The resolution ot the textures to be produced,
• The size of shadowmaps,
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• The choice to render the unlit surfaces using Environment-type lighting.

357

Patchwork 3D Enterprise 2022 X5

ENVIRONMENT LAYERS
Environment layers allow for the creation of several product variants with different environments and
can be used in configurations.
You may be interested in learning more about:
• Product Environments (Editor) [161]
• Lighting environments [316]

Using Environment Layers
The principle of using environment layers is best illustrated through an example.
First, a layer named "Dock Layer" is created in which a global environment is allocated to all surfaces.
A second layer named "Warehouse Layer" is created, in which a global environment is allocated to all
surfaces.
Finally, we create a layer "Body Layer" containing an environment assignment specific to the body.
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From top to bottom, the Dock Layer, Warehouse Layer and Body Layer.

We now activate the visibility of the three layers. We note that the global environment of the &quot;Layer Docks&quot;, located higher than the &quot;Layer Hangar&quot; in the hierarchy, is displayed in the
product. The specific assignment of the environment to the bodywork of the &quot;Body Layer&quot; is
also displayed: this is the highest specific environment assignment in the hierarchy.

Result of the environment layers stack evaluation.

In the Products Environments editor, for "Warehouse Layer", surfaces to which the higher-ranking global
environment is affected are displayed in italics and crossed out. Similarly, the listing for the body
surface in "Dock Layer" is also in italics and crossed out.
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ASPECT LAYERS
Aspect layers allow different materials and their UV mapping projections to be assigned to the same
surface in different layers.
Using aspect layers will allow you to create configurations for the materials used to dress your product.
This approach makes it easy to create many variants and derived versions of products.
You may be interested in learning more about:
• Aspect Layers (Editor) [123]

Accessing All Aspect Layers with Assignments
Once a surface is selected, it is possible to obtain the list of aspect layers in which there’s a material or
one or more labels assigned to it.
This list may be reviewed in the Surface Properties accessed by right-clicking on a surface and selecting
Edit properties.
For each aspect layer in the list, the following attributes are displayed:
• The aspect layer’s name,
• The mention hidden if the layer is not visible,
• The number of material assignments for the selected surface in the layer if relevant,
• The number of sticker assignments for the selected surface in the layer if relevant.
Selecting an aspect layer in the list displays the corresponding assignments in the Layer Assignments
box.

Moving Material and Sticker Assignments
Material and sticker assignments may be moved from one aspect layer to another.
Moving a material or sticker assignment is performed by selecting the source aspect layer in the Layer
drop-down list of the Surface Properties accessed by right-clicking on a surface and selecting Edit
properties.
Material and sticker assignments defined in the selected layer are displayed in the Layer Assignments
box. The assignment to be moved must then be selected and the destination aspect layer chosen from
the list opened by clicking the Move Assignment button
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LIVE MODE
Available in: Matter: main toolbar >

Live Mode

NOTICE
New Features in Patchwork 3D 2022 X5
The Live Mode is a visualization and presentation mode that allows you to interact with digital aspect
mockups and explore different product configurations.
In this mode you will be able to:
• View your products.
Patchwork 3D has different views allowing you to interactively inspect the design of a product.
• Compare different 3D products or different configurations of a single product.
Several view configurations (Viewport menu) are available to view products side by side. This approach allows the simultaneous comparison of several elements of a product line. The links between
views [76] are provided to facilitate this 3D comparison.
• Interact with elements of your products using animation triggers.

TIP
It is necessary to have previously created at least one clip or a timeline in the Timelines
editor to be able to create triggers.
Please refer to the chapter on Live Mode (Editor) [175] for how to create triggers.

TIP
To exit the Live Mode, click the button

in the main toolbar of Matter.
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PRODUCT CONFIGURATIONS
The product configuration system in Patchwork 3D is designed to offer the possibility of displaying
product variants in real time. The configuration tools allow you to elaborate a complete product range.
This range can then be used directly by our configuration exploration software programs, such as
Patchwork Explorer and Web Render.
The configuration system requires the use of geometry, aspect, position, environment, illumination, or
lighting color layers. A minimum level of knowledge is necessary to be able to manipulate and use the
configuration features of Patchwork 3D to the best effect.
In order to obtain a configuration system, you will build geometry [351], illumination [354], lighting
color [356], aspect [123], position [127], overlay [214], and environment [161] layers and create combination rules by dividing a model into several layer groups, that is to say, by partitioning it. Product variants
are combinations of these layers.

Definitions used in Configurations
• Partition: A partition is an element or aspect of a product that can have several alternatives. A
partition includes all of the possible states, either "enabled" or "disabled," or a user-defined list of
states.

The truck’s bin color is a partition with three states: red, gray, and blue.

• Symbol: A symbol is a variable that represents a selection state in the Configuration Browser [178].
Symbols are not created directly; they are automatically extracted from rules.
• Defining a symbol: The Configuration Browser [178] allows a set of symbols to be chosen via
checkboxes and drop-down lists. Only one symbol per partition can be "defined" (selected) at a
given time.
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Two defined symbols in the Configuration Browser: Bin.Blue and Ground.

• Rule: A rule is a logical expression that links user selections in the Configuration Browser [178] to the
visibility state—displayed or hidden—of layers. Rules are conditions that depend on a set of symbols
being defined (selected in the Configuration Browser [178]). When the condition is fulfilled, the layers
associated with the rule are visible. If one or more symbols needed to validate the rule are not
defined, the layers will not be visible.
• Simple rule: A rule is called "simple" when a single symbol is necessary to validate it and the only
operator used is "defined".
Ground (defined "Ground")
• Complex rule: A rule is called "complex" when its validation depends on the analysis of a Boolean
operation.
This rule is validated when "Ground" is defined, that is, when it is selected by the user in the
Configuration Browser [178].
Roof_Rails(and (defined "Roof_Accessories")(not (defined "Convertible")))
This rule is validated when "Roof_Accessories" is defined, that is, selected in the Configuration
Browser [178], and "Convertible" is not.

Preparing a Model
A configuration, or product variant, consists of a set of layers.
Creating a variant can be thought of as defining which layers among those you have prepared will be
visible and which will be hidden. Consequently, creating configurations depends on having prepared
product layers before you define the configuration rules.
In this section, the chapters Understanding Partitions [363] and Using Meaningful Layer Names [364]
will help you think about layers used in configurations, and how to name and group layers in order to
create configurations.
If you need more information on creating layers, documentation dedicated to aspect, position and
environment layers is available.

Understanding Partitions

A partition with three possible states.

To create a configurable model, begin by identifying the partitions within which several alternatives
are possible. In the above image, the truck’s bin can exist in multiple colors. The bin color is an
example of a partition. Partitions can be related to model surface geometry, aspect or position, or to the
environment of the model. In this example, for ease of understanding, aspects and colors are used to
illustrate the principles of configurations.
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There are two types of partitions. Some can be enabled or disabled, while others require an element to
be chosen from a list of multiple alternatives. Partitions are listed in the Configuration Browser, where
you or your end user can select their state:
Next, the partitions must be associated with rules.
In the above image, the partition "stickers" can be enabled or disabled. By ticking the checkbox "stickers" (on the left in the image), you define the corresponding symbol. The associated rule, "stickers" (on
the right), states that when the symbol "stickers" is defined, the aspect layer containing the stickers is
visible.
In this image, the partition "paint" refers to the color of the paint, which can be any one of several
options: red, blue, yellow, black… By making a selection in the drop-down list (on the left of the image),
you define one of the symbols "paint.red", "paint.blue", "paint.yellow", "paint.black" in accordance with
your choice. The associated rules (on the right), "paint.red", "paint.blue", "paint.yellow", "paint.black," state
that if the corresponding symbol is defined, the layer with the right color is visible.
This example, therefore, contains a total of five symbols and five rules (one for the stickers and four for
the paint), but only two partitions ("stickers", and "paint").

Using Meaningful Layer Names
It is highly recommended that you give your geometry, position, illumination, aspect, overlay, and
environment layers meaningful names. A meaningful name expresses the layer’s function clearly. This
will greatly simplify the procedure of creating target layers for the rules governing your configurations.
Where configurations are concerned, using meaningful names does not only mean using names that
allow you to remember what the layer is and does. It also means using names that allow you to make
the connection between the layers themselves and eventual configuration symbols and partitions that
you will create.
Name your layers according to the partition they will belong to.
Give the same prefix to all layers referring to the same configurable element, or partition. If the layer
is part of a group of options in a single partition, like the paint partition in the example in the chapter
Understanding Partitions [363], we recommend using a multi-part name constructed as follows:
• use the partition name as a prefix,
• followed by a point (.),
• followed by a meaningful descriptor.
This will lead to layer names such as "paint.red" for an aspect layer with red paint, or "lever.raised" for a
position layer in which a lever is in the up position.
When you create configurations rules, you will be able to use meaningful layer names to automatically
generate simple rules [366] and their symbols in the appropriate format.

NOTICE
New Features in Patchwork 3D 2022 X5
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If you wish to rename an aspect layer, Patchwork 3D will then suggest that you rename the configuration rules and the linked symbols for you. Patchwork 3D will also offer to rename the symbols when a
configuration rule changes its name.

Configuration Rules
The configuration system is based on user-defined rules. These rules establish the visibility of the
layers that they are associated with. These associated layers are called target layers. Consequently,
your model must be organized into meaningful layers [363] before you set up your configuration rules.

Definition of a Rule
Configuration rules are the expressions that determine which options to display, and under which
conditions to display them.
Configuration rules are expressed as Boolean expressions. A rule consists of:
• The definition of one or more symbols in the form "partition" or "partition.value_n". Each symbol
represents a condition that can be true or false based on selections made by the end user.
• Optionally, the logical operators (AND, OR, NOT, XOR) that express relations between the symbols.
• The assignment of target layers.
Rules are evaluated logically. This evaluation leads to one of two values: true or false. When a rule is
true, the rule’s target layers are visible. Otherwise, they are hidden.
Using the Configuration Browser in this software and other display software, you or your end user can
select the options to display. This selection determines which simple rules are defined, and which are
not defined. The evaluation of complex rules is carried out based on these user-indicated definitions.
You can create as many rules as necessary in order to create a complete range from a base product.

Understanding Functional Principles of Symbols
All symbols follow one of two functional principles:
• Activation/Deactivation Principle
These symbols take the form "partition". They are activated or deactivated individually.
• Exclusion Principle
These symbols take the form "partition.value_n". They are grouped by their prefix "partition.". Activating a symbol in the same group excludes of all other symbols.
When creating a rule, you determine which principle is will be followed by giving the appropriate format
to the symbol used in the rule.

Activation/Deactivation Principle: "partition" Symbols
All "partition" symbols follow the activation/deactivation principle.
They represent partitions that can be activated or deactivated. You might have symbols armrests and
headrest and footrest for a seat product. Any, all, or none may be selected at a given time: your product
variants could include a seat with both a footrest and a headrest without causing a conflict.
Each "partition" symbol may be either defined (true) or undefined (false) independently from other
"partition" symbols, unless restricted by a complex rule. Many "partition" symbols may be defined, or
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selected, at the same time. The visibility of the target for each of the rules is activated or deactivated
separately.
Once your simple rules for defining "partition" symbols are set up, the Configuration Browser will present
you with a sticker "partition" and a check box to activate or deactivate the symbol for each rule of this
type.

Checkbox for a "partition" sticker in the Configuration Browser

Exclusion Principle: "partition.value_n" Symbols
All "partition.value_n" symbols follow the exclusion principle.
They represent partitions that can have many values, such as the color of paint or the position of
a moving part. You might have paint symbols paint.red, paint.blue, paint.yellow or position symbols
position.up, position.middle, position.down.
Only one of these symbols can be selected at a given time: the paint cannot be both red and yellow at
the same time; the part cannot be in both its up position and its middle position at the same time. Only
one "partition.value_n" symbol can be defined, or selected, at a time.
The Configuration Browser will group these symbols by their "partition." prefix. For each prefix, it will
present you with a sticker "partition" and a choice from a drop-down list for all of the corresponding
".value_n" rules. You may choose only one "value_n" to activate at a time.

A drop-down list of "value_n" values in the Configuration Browser.

Creating Simple Rules
A simple rule is a rule that is evaluated as true when the symbol it uses is selected by the user. If the
simple rule is evaluated as true, its target layers are displayed.
Simple rules contain only one symbol. They do not contain logical operators or relationships between
symbols.

Creating Simples Rules by Dragging and Dropping
Creating "partition" Rules by Dragging and Dropping
To create a "partition" rule with a symbol that follows the activation/deactivation principle, drag and
drop a single target layer onto the rule list in the Configuration Editor. It will follow the activation/deactivation principle [365] by default.

1.

Open the Configuration Editor. Go to the Editors menu > Create configurations
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2.

Select a layer that you want to use as a target layer from any of the following:
• Shaper: the model’s Geometry Layers list in the sidebar,
• Shaper: the model’s Illumination Layers and their colors from the list in the sidebar,
• Shaper / Matter: Position Layers editor,
• Matter: Aspect Layers editor,
• Matter: Environment Layers list in the Product Environments editor.
• Matter: Overlay Layers list in the Overlays editor,

3.

Drag the selected layer onto the Rules box in the Configurations editor. The Simple Rules editor will
appear.

Dragging and dropping an aspect layer into the Rules zone makes the Simple Rules editor appear.

4.

In the Simple Rules editor, you can rename the symbol that will be automatically added to the
Configuration Browser. The name of the layer is proposed by default. You can also rename the rule
itself by unticking the checkbox Use defined symbol as rule’s name. Even if you rename the rule or
the symbol, the name of the layer itself will remain unchanged.

NOTE
This method creates a single simple rule for a "partition" symbol that will follow the
activation/deactivation principle.
It is not possible to create multiple simple rules for multiple "partition" symbols at the
same time. Dragging and dropping a selection of layers will create a group of rules for
"partition.value_n" symbols that follow the exclusion principle.
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Creating "partition.value_n" Rules by Dragging and Dropping
To create a set of simple rules for "partition.value_n" symbols that follow the exclusion principle, drag
and drop multiple target layers together onto the rule list in the Configurations editor. This will create
multiple rules simultaneously. They will follow the exclusion principle [366] by default.
1.

Open the Configuration editor. Go to the Editors menu > Create configurations.

2.

Select a group of layers that you want to use as target layers from any of the following:
• Shaper: the model’s Geometry Layers list in the sidebar,
• Shaper: the model’s Illumination Layers and their colors from the list in the sidebar,
• Shaper / Matter: Position Layers editor,
• Matter: Aspect Layers editor,
• Matter: Environment Layers list in the Product Environments editor.
• Matter: Overlay Layers list in the Overlays editor,

3.

Drag the selected layer onto the Rules box in the Configurations editor. The Parameters editor will
appear.

Dragging and dropping a selection of aspect layers into the Rules zone makes the Parameter Editor appear.

4.

If the layer names are not in " partition.value_n " format, the Parameters editor requires that you
provide the prefix "partition" to use for the set of symbols generated from these layers.

NOTE
This method creates a single partition with a single "partition." prefix for the set of
layers being dragged and dropped.
It is not possible to create sets of "partition.value_n" symbols with different prefixes
simultaneously.
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5.

Provide value labels for each individual rule. If your layer names were already in "partition.value_n"
format, the Parameters editor will propose the "value_n" value for each layer as the value label. The
names of the layers themselves will remain unchanged.

Renaming a value label.

Creating "partition.value_n" Rules by Dragging and Dropping a group of layers
To create a set of simple rules for "partition.value_n" symbols that follow the exclusion principle, drag
and drop multiple target layers together onto the rule list in the Configurations editor. This will create
multiple rules simultaneously. They will follow the exclusion principle [366] by default.

1.

Open the Configuration editor. Go to the Editors menu > Create configurations

2.

Select a group of layers that you want to use as target layers from Matter: Aspect Layers editor.

3.

Drag the selected layer onto the Rules box in the Configurations editor. The Parameters editor will
appear.

.

Dragging and dropping a selection of aspect layers into the Rules zone makes the Parameter Editor appear.

TIP
Drag and drop into the box Rules create a single partition with a single prefix " partition."
for all appearance layers for groups and subgroups.
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Adding Targets to Existing Rules by Dragging and Dropping
TIP
Aspect and environment layers are stored at the product level. This means that a given
aspect or environment level only affects the product with which it is associated. To apply
the rule to several products, add the appropriate target layers for each additional product.

TIP
To ensure visibility of configurations with overlay layers, the overlay in question must be
assigned to a sensor used in the viewport camera. Overlay display must be enabled.
Once a rule is created, you can also add additional target layers:
1.

In the rule list of the Configurations editor, select the rule you want to add target layers to.

2.

Drag and drop the additional target layers onto the Target list.

WARNING
You cannot use a given layer as the target for two different rules.
To express the condition set up in the following case:
• If the symbol " partition.value1" is defined, display layer A.
• If the symbol "partition.value2 " is defined, display layer A.
Use a single complex rule:
• If the symbol "partition.value1" or the symbol " partition.value2" is defined, show layer A.

Creating Simple Rules Manually
To create a simple rule, use the New Simple Rule button in the Configurations editor.

1.

Open the Configuration editor. Go to the Editors menu > Create configurations

.

2.

Click on the

3.

In the Defined Symbol text zone, enter the name of the symbol you want to create.
• Use the format "partition" to create a symbol that will follow the activation/deactivation [365]
principle. This will create a partition and add a checkbox in the Configuration Browser.

New Simple Rule button. The Simple Rule editor will appear.

• Use the format " partition.value_n " to create a symbol that will follow the exclusion principle [366]. Create multiple rules with symbols that share the same " partition." prefix to add them
to the same partition and populate the same drop-down list in the Configuration Browser.
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Defining a "partition" type simple rule.

4.

The name of the symbol is used by default as the name of the rule. To change the name of the rule,
uncheck the option Use the defined symbol as the name of the rule. Provide a new name in the Rule
text zone.

Renaming a simple rule.

5.

Confirm by clicking on OK.

Your rule has been created, but you still need to assign target layers to it:
1.

Return to the Configurations editor. In the rules list, select the rule you have just created.

2.

Drag and drop your desired target layers onto the Target list. You can drag layers from any of the
following:
• Shaper: the model’s Geometry Layers list in the sidebar,
• Shaper: the model’s Illumination Layers and their colors from the list in the sidebar,
• Shaper / Matter: Position Layers editor,
• Matter: Aspect Layers editor,
• Matter: Environment Layers list in the Product Environments editor.
• Matter: Overlay Layers list in the Overlays editor,
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WARNING
You cannot use a given layer as the target for two different rules.
To express the condition set up in the following case:
• If the symbol " partition.value1" is defined, display layer A.
• If the symbol &quot; partition.value2 &quot;is defined, display layer A.
Use a single complex rule:
• If the symbol "partition.value1" or the symbol " partition.value2" is defined, show layer A.

Creating Complex Rules
A complex rule establishes the relationships between defined symbols using the logical operators
"and", "or", "not" and "xor". If the conditions are met, the rule is evaluated as true and the target layers
are displayed.
Complex rules are created manually by typing the desired expressions. To create a complex rule, use
the New Complex Rule button in the Configurations editor.
1.

Open the Configuration editor. Go to the Editors menu > Create configurations

2.

Click on the button

3.

In the first text box, the editor will suggest a default name for your rule. Replace " Rule" by an
explicit name which clearly expresses the function of the rule.

.

New complex rule. The editor Complex rules will be displayed.
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Replacing "Rule" with a meaningful rule name.

4.

In the Expression text box, type out the Boolean expression. Refer to the chapter on Rule Syntax [374] for more information on expression syntax.

5.

You can use the Insert Tool to insert simple rule expression within your complex rule:
• Select the desired existing symbol from the drop-down list.
• Click "defined" to insert the expression at the current cursor location in the Expression text box.

Using the Insert Tool to insert the simple expression "(define "paint.black")" in a complex expression.

6.

Click OK to validate your rule. If the rule cannot be validated, the validation problems will be listed
in the Compiler Output box. These problems must be corrected before you can validate your rule.

Compiler output error for missing final parenthesis.

TIP
The tools found in the Inspection [157] tab are particularly helpful to analyze the evaluation of complex rules.
Your rule has been created, but you still need to assign target layers to it:
1.

Return to the Configurations editor. In the rules list, select the rule you have just created.

2.

Drag and drop your desired target layers onto the Target list. You can drag layers from any of the
following:
• Shaper: the model’s Geometry Layers list in the sidebar,
• Shaper: the model’s Illumination Layers and their colors from the list in the sidebar,
• Shaper / Matter: Position Layers editor,
• Matter: Aspect Layers editor,
• Matter: Environment Layers list in the Product Environments editor.
• Matter: Overlay Layers list in the Overlays editor,

TIP
Aspect and environment layers are stored at the product level. This means that a given
aspect or environment level only affects the product with which it is associated. To apply
the rule to several products, add the appropriate target layers for each additional product.
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TIP
To ensure the visibility of configurations with overlay layers, the overlay in question
must be assigned to a sensor used in the viewport camera. The overlay display must be
enabled.

WARNING
You cannot use a given layer as the target for two different rules.

Rule Syntax
Rule syntax is based on the following principles:
• All rules have names.
• All expressions are enclosed in parentheses.
• All rules begin with an operator, followed by an operand.

Simple Rules
Simple rules are expressions using the "defined" operator only. This operator takes a single argument, a
user-defined symbol, which follows it. The symbol is set off by a space and must be set inside double
quotes.
Simple rules are written as:
• Rule (defined "symbol")
• A symbol can take the form "partition" or "partition.value_n". In the case of " partition.value_n " forms,
multiple rules will have the same "partition." prefix.
Rule1(defined "partition1")
Rule2(defined "partition2")
Rule3(defined "partition3.value_1")
Rule4 (defined "partition3.value_2")
Rule5(defined "partition3.value_3")

Complex Rules
Complex rules are Boolean expressions. They can call on several of the operators available: the operator &quot;defined&quot; and the logical operators "and", "or", "not", "xor".
Each logical operator takes two arguments in any order. The arguments of the logical operators are expressions enclosed in parentheses and can be either the expression of a simple rule or the expression
of another complex rule.
Operators are placed before operands in the Boolean expression. Nested parentheses indicate the
grouping of expressions and their order of evaluation.
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• This rule is true if symbol_p and symbol_q are defined.
Rule(and (defined "symbol_p") (defined "symbol_q"))
• This rule is true if symbol_p or symbol_q is defined.
Rule(or (defined "symbol_p") (defined "symbol_q"))
• This rule is true if symbol_p or symbol_q is defined ("or" is evaluated first), and if symbol_r is also
defined.
Rule(and (or (defined "symbol_p") (defined "symbol_q")) (defined "symbol_r"))

Example: Creating Configuration Rules
NOTE
This example of configuration rule creation for the color of a truck cabin is based on
database toy_truck_tuto.p3d. You can obtain this database by emailing our support team
@ support@lumiscaphe.com.
First, aspect layers need to be created for the configurable elements.

1.

In Matter, open the Aspect Layers window by clicking on this icon

2.

Select the Split by picked material tool.

3.

Click on an element linked to the configuration to create an aspect layer.

4.

Rename the aspect layer created by following the naming principle: "partition.value" (for example:
Cabin.Blue).
The use of this naming system lets you automatically create configuration rules (see next paragraph). Using it therefore saves considerable time.
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5.

Click on the Duplicate the Aspect Layer button to create a variant of the element linked to the
configuration.

6.

Drag-and-drop a new material on the element in order to assign to the aspect layer the new value
taken by the element linked to the configuration.

7.

Rename the aspect layer according to the newly assigned value (in our example: Cabin.Yellow).
• Create as many variants as necessary by repeating steps 5 to 7.
• Create new configurable elements by repeating steps 2 to 4, and then create their derivatives by
repeating steps 5 to 7.

NOTE
Patchwork 3D also lets you create product derivatives relating to geometry.
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Aspect layers Cabin.Yellow, Cabin.Red and Cabin.Blue.

Click on this icon
to show dialog Configurations. In the Browser tab, select Yellow in the dropdown list. Name all layers using the same prefix "Cabin.", then drag and drop the layer selection into the
Rules tab of the Configurations editor. The interface builds the following rules:
Cabin.Yellow (defined "Cabin.Yellow")
Cabin.Red (defined "Cabin.Red")
Cabin.Blue (defined "Cabin.Blue")
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Rule Cabin.Blue determines the visibility of aspect layer Model/Product/Cabin.Blue.

This set of rules follows the principle of exclusion: only one of them is evaluated as true at a time. We
check that each of these new rules targets an aspect layer.
This rule set follows the exclusion principle: only one of them is evaluated as true at a time. Each of
these new rules targets one aspect layer. Symbols Cabin.Yellow, Cabin.Red and Cabin.Blue are added
automatically as a drop-down list to the available symbols in the Configurations Browser. Selecting
Yellow means defining the symbol Cabin.Yellow. Since only one of these symbols can be defined at a
time, only one of the new rules is evaluated as true. A partition corresponding to the color of the cabin
was created.
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Drop-down list generated automatically from the symbols involved in the new rules.

In the Browser tab, select Yellow from the drop-down menu. In the Inspection tab, the Cabin.Yellow rule
appears in green because it is true. The aspect layer Model/Product/Cabin.Yellow is then visible. The
Cabin.Red and Cabin.Blue rules appear in red because they are false. The target layers of these rules are
hidden.

Inspection tab shows the result of rules evaluation.
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Create a configuration rule for enabling or disabling the displaying of material on the ground in the
same manner. First, create the aspect layer Model/Product/Ground corresponding to material assignment on the ground. Generate the rule Ground by dragging and dropping the layer from the Aspect
Layers editor to the Configurations editor: the Simple Rule editor pops up, allowing for specifying the rule
name and the symbol involved.

Rule Ground creation using the Simple Rules editor.

The rule "Ground" follows the activation/deactivation principle and is written:
Ground (defined "Ground")
A partition corresponding to the ground was created and a check-box for defining the symbol Ground
added automatically to the list of available symbols in the Browser tab in dialog Configurations. Ticking
the check-box defines the symbol.

Check-box for defining symbol Ground.
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Configuration Annex: Auto-Partitioning
The Concept of Auto-Partitioning Aspect Layers
The geometry, lighting, and position layers belong to the model, whereas the aspect layers belong to
the products. As a consequence, aspect partitions defined through configuration also belong to each
product and not to the model. They cannot be transferred from one product to another product created
from the same model directly.
You might find yourself in this situation if you are working on a multi-product database.

Auto partitioning operating principle.

In order to access all product partitions inside a single product, auto-partitioning is required. Auto-partitioning gathers all product partitions related to aspect layers and assigns them to a single product.
To auto-partition a product, use automated functions available in the Aspect Layers editor.
1.

From the Matter module, create a new, blank product.

2.

Open the Aspect Layers editor. Click on the Editors menu > Aspect Layers.

3.

Click Import Aspect layers

4.

Select all of the imported layers. Click on Expand Selected Layers Selection by Assignment
This creates partitions.

. This imports all aspect layers into a product.

TIP
It is best to rename the aspect layers at this point. To simplify this task, you can use the
Replace String function

in the Aspect Layers editor.
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An example of how to implement auto-partitioning is included below.

Example: Creating a Configured Product with Auto-Partitioning
NOTE
This example of configuration rule creation for the color of a truck cabin is based on
database toy_truck_tuto.p3d. You can obtain this database by emailing our support team
@ support@lumiscaphe.com.
This example uses the database toy_truck_versions.p3d. It contains several product versions including
a single aspect layer each. The following tutorial explains how to gather all the versions into a single
configurable product to create a complete product range.
The product versions available in the database show different colors for the cabin on the one hand and
the bin and rims on the other hand. The configured product will then require two configuration rules.

The six product versions created from the same model.

Step 1: Creation of a Blank Product and Layers Import from All Product Versions
Create a new product called Configured Product.
Aspect layers belong to the product versions and not to the model. The product created only has
a blank base aspect layer. In order to create the configuration system, the aspect layers of the different product versions must be imported in this product. Use the function Import Aspect layers
accessed through the Aspect Layers editor to import aspect layers into the new product. The imported
layers are displayed in the Aspect Layers editor of the Configured Product in addition to the base layer.
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Importing existing aspect layers into the blank product.

Step 2: Auto-Partitioning
Select all imported layers in order to split them by assignment. This operation is performed by using
the Expand Selected Layer Selection by Assignment function
partitions obtained are presented below.

Partitions obtained by expanding the layers by assignment.
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The partitions obtained are listed in Aspect Layers in addition to the base layer of the "Configured Product".

Step 3: Renaming the Layers
Now that partitions have been obtained, configuration rules may be created for the cabin color in one
instance and the bin and rims color in the other.

Renaming the layers.

First, rename the layers according to the "partition.value_n" format using the Replace String function
of the Aspect Layers editor. In this example, rename layers Partition0, Partition1 and Partition2 into
BinRims.0, BinRims.1 and BinRims.2. In order to work with explicit names, rename these layers into BinRims.Blue, BinRims.Red and BinRims.Silver. In the same manner, rename layers Partition3 and Partition4
into Cabin.Yellow and Cabin.Silver. Layer Partition5 is renamed into Base. The material assignments in
this layer don’t require a configuration rule.
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Renamed appearance layers of the product "Configured product".

Step 4: Rule Creation
Create the rules by drag-and-drop of the selection Cabin.Yellow and Cabin.Silver layers on the one hand,
and BinRims.Silver, BinRims.Blue and BinRims.Red on the other hand. The rules created are displayed in
the Configurations editor. The Configuration Browser was also updated.

Configuration editor and browser after creating the rules.

TIP
• The different product versions can be deleted.
• In the Aspect Layers [123] editor, these product versions are accessible as bookmarks.
• It is possible to create a configuration for each of the corresponding variants in the
Library of the Configurations editor, so that you can easily call it up again for future
reference.
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CAMERAS
A camera is a set of several elements:
• a sensor: a set of information concerning the rendering that is applied when the camera is used for
viewing. Its modifiable settings include:
• Sensor size / Aspect ratio,
• Type of render (post-process, overlays, backgrounds),
• Type of projection : isometric/perspective ,
• a lens: information linked to the position of the object viewed in relation to the camera:
• Focal distance / Field of view angle (FOVX or FOVY),
• Depth of field (aperture, focal point distance),
• a camera position: the position and the orientation of the camera.
Cameras are used to prepare rendering by setting up a particular view of a product in a viewport. This
view can then be saved, recalled, or used to create films and images.

Identifying the Camera Used in a Viewport
The name of the camera that is active in a given viewport is indicated in the upper left corner of that
viewport, followed by the name of its sensor, if one is used. In the case of the free camera, if a preset is
used, the name of the preset mode is indicated: top, bottom, left, right, front, or back.

Identifying the Camera Used in a Viewport.

Recalling a Camera's Settings in a Viewport
A camera's settings can be recalled in a viewport. This replaces the current settings of the active
camera in that viewport with the settings being recalled. Any of the following actions will recall a
camera's settings in the current viewport:
• Double-clicking on an entry in the list of cameras in the Cameras editor to load the selected camera's
settings,
• Selecting one of the cameras via the viewport context menu. Right-click on the active camera name
to open this menu.
386

Patchwork 3D Enterprise 2022 X5

• Clicking on one of the four favorite camera buttons [388] in the toolbar or using their keyboard
shortcuts, if you have assigned favorite cameras for the product in the current viewport.
The position, orientation, sensor effects, and lens properties change instantaneously.

Modifying a Camera's Settings
It is possible to modify the settings of a camera directly from the viewport in Shaper or Matter or edit
them from the editor of cameras.

By directly selecting a camera in the viewport
Assuming that your database has at least one camera in the scene, select it directly in the viewport of
Matter or from Shaper to modify its location in the scene using the translation or rotation gizmos. You
can also adjust the camera target in the same way.

NOTE
By default the cameras are hidden in the scene, you can, however, display them from
the Cameras editor by clicking on this icon or lock them in the viewport from the
Cameras Editor [128]. Refer to the Cameras [386] chapter for more details on the overall
operation of the cameras.

Edit a camera directly in the viewport from Shaper (image on the left) or from Matter (image on the right) without using the Cameras
editor.

By selecting a camera from the Cameras list
To modify a camera's settings, the Edit current camera mode must be enabled. Enable this mode for the
selected camera in the Cameras editor by clicking on the Edit current camera
button. You can also
enable this mode by choosing Edit camera from the context menu that opens when you right-click on
the camera in the Camera List.
The settings shown in the Cameras editor are the settings for the active camera in the current viewport.
When the camera's settings are displayed on the right of the Cameras editor, the viewport shows
what is seen by the camera. The name of the camera is indicated in the upper left-hand corner of the
viewport.
As you navigate in the world, you modify the camera's position and orientation. To explore the 3D world,
you can use the various navigational modes, Pan, Zoom, Orbit, Fly, Walk, and Head, as well as the mouse
and keyboard shortcuts assigned to them.
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To return to the free camera, disable the Edit current camera mode.

Default Camera: the Free Camera
Viewport Free Camera
The free camera exists only in its viewport and is deleted when the viewport is closed. If you have
marked a camera as the favorite camera 1 for a product, that camera's settings will be used to initialize
the viewport's free camera when the product is loaded.
The free camera's settings can be modified in the Cameras editor. They are also edited as you navigate
in the viewport.
You can change the sensor used by the free camera by dragging and dropping a new sensor onto the
viewport or onto the Sensor field in the Cameras editor.

Viewport Camera Presets
Each viewport has a series of camera presets: top, bottom, left, right, front and back views.
You can change the preset at any time. Right-click on the name of the active camera, which appears in
the top left corner of the viewport. In the contextual menu that appears, select View, then choose the
camera preset that you would like to activate.
It is not possible to modify these camera presets.

Product Favorite Cameras

Four favorite cameras per product are available via shortcuts in the toolbar.
To mark a camera as a favorite:
• Use the keyboard shortcuts from the active viewport:
• Select the favorite camera on which you want to assign the current camera settings from the
Cameras menu > Set Favorite Camera
• In the Cameras editor, select the camera to use as a favorite and click on the corresponding favorite
button at the bottom of the editor just below the Camera list box.
Shortcut

Function

Ctrl + F9

Use the current camera settings as favorite camera 1.

Ctrl + F10

Use the current camera settings as favorite camera 2.

Ctrl + F11

Use the current camera settings as favorite camera 3.

Ctrl + F12

Use the current camera settings as favorite camera 4.

This creates favorite cameras for the product in the active viewport.
To restore the favorite cameras of a product in a viewport:
• From the main interface of Matter, click on the button corresponding to the favorite camera you
would like to restore.
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• Select the favorite camera to be restored from the menu Camera > Restore Favorite Camera.
• Use the keyboard shortcuts:
Shortcut

Function

F9

Restore the favorite camera 1 in the viewport.

F10

Restore the favorite camera 2 in the viewport.

F11

Restore the favorite camera 3 in the viewport.

F12

Restore the favorite camera 4 in the viewport.

Generating Bookmarks from a Kam File
Available in: Matter : Editors menu > Cameras
The frames in a *.kam file can be converted to cameras by the Cameras editor. To do this, at least
one .kam file must already be loaded before you generate bookmarks.

To load a *.kam file:
1.

Open Timelines under Matter > Editors menu > Timelines.

2.

On the right-hand side of the editor, click on the Camera Animations library tab. Create a new
camera animation using the New button below the Camera Animations list.

3.

In the dialogue box that appears, choose the type Kam File. Validate this step.

4.

Double-click on the name of the animation you have just created. The Camera Animations editor will
open.

5.

In the Kam Files zone, click on

6.

You can import several .kam files. You will be able to choose later on which of the open files you
want to use to generate bookmarks.

Import a Kam File. Select your .kam file and validate.

To generate the bookmarks:
1.

Open the Cameras editor: go to the Editors menu > Cameras.

2.

to open a .kam file.
Select the option
The Import Cameras window will open. In the first drop-down list, choose Import from kam file.

3.

In the second drop-down list, choose the group in which the cameras will be placed. By default, the
cameras that will be created will be placed at the root of the camera hierarchy. You can choose
from among any of the existing camera groups.
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4.

In the drop-down Kam file list, choose the file to use. If you have opened several .kam files, they will
all be shown in the drop-down list.

Choosing the .kam file to use.

5.

The editor will provide a name for each new camera in the format <prefix_number>. By default, it
proposes the .kam file name as the prefix. You can change the prefix in the Camera Prefix text zone.

6.

Camera count is the number of cameras to be generated. Each frame of your .kam file can be used
to provide a view for a camera. Consequently, you can generate, at most, one camera for each
frame. You will manage the offset of the first camera and the frame spacing between cameras in
the next steps.

7.

By default, the first camera is created from the first frame of the .kam file. If you prefer to change
this, use the sliding bar to offset the first camera.

Modifying the offset of the first camera.

NOTE
• 0 offset: the first frame will be used to generate the first camera.
• N offset: the frame N+1 will be used to generate the first camera.
8.

Use the Current camera preview slider to check each camera to be created. If you are not satisfied
with the automatically calculated spacing, you can adjust the frame that will be used to generate
each individual camera. Use the Camera adjustment tool to move each camera forwards or backwards in the frame sequence.

Adjusting a camera within the frame sequence.

9.

Once all the settings have been adjusted, click Import to begin generating the cameras.
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ANIMATION
Animating Geometries
Geometries of models can be animated in Patchwork 3D using the kinematics hierarchy available in
Shaper.
Nodes, or parts, in the hierarchy are animated in one of three ways: freely (by rotation or translation
along any of the three principal axes), by rotation along an axis, or by translation along a vector. As part
of a hierarchy, child nodes are animated with their parent nodes. This allows you to create functional
hierarchies and complex moving parts.
For example, a car door part might rotate along an axis running through its hinges. The range of
its rotation is delimited by the angles of its open and closed positions. You might also have a child
part for the car window, which is a constituent part of the door but which can also be raised and
lowered independently of the door's position. In this example, when the door is opened, the entire
door, including the window at its current position, moves. This hierarchical configuration allows you to
animate both parts of your model distinctly and simultaneously, though the position and orientation of
one has an influence on the position and orientation of the other.
Each part in the hierarchy consists of two elements:
• A null object, a translation vector or a rotation axis for which animation parameters are defined.
• A group of Shaper objects associated with the part, to be animated according to the animation
parameters of the null, the vector or the axis with which they are associated.
Animating the geometry of your model begins in Shaper:
1. To animate the geometry of your model, you will first need to define a functional kinematics
hierarchy of parts for your model. This can be accomplished in the Kinematics [260] tab of the
Shaper sidebar. At this stage, you will indicate what type of motion is necessary for each functional
part: will it be freely transformed, will it rotate around an axis or will it move along a vector?
2. For each part, you will need to set the properties that define how it is supposed to behave when
animated [392]. You define the degrees of rotation and the translation distance for each part. You
also have precise control over the position and orientation of the null object, the axis of rotation, or
the translation vector along which the part will be animated.
3. A group of surfaces must be selected and assigned to the part [262] as children.
It is also possible to link animated changes to the position and orientation of a part or a surface to
those of another part or surface using the animation constraints [263] available in the Kinematics [260]
tab.
Once the animation has been added in Shaper, the Matter tools allowing you to visualize this animation
on a product will be available. You can:
• Review moving parts using Animation Sliders [154]

,

• Add moving parts to a timeline [121] using channel animations for real-time playback, use in
Live [400] mode, or for generating videos.
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Animation Utility Objects
The movement of an animated group of surfaces is defined using one of the three utility objects: nulls,
rotation axes, or translation vectors.
Nulls, rotation axes and translation vectors possess representations to help you to visualize them and
to position them in the 3D space.

NOTE
The mode
, enabled by default, allows objects such as surfaces to be transformed
when their parents are transformed. Deselect this mode in order to reposition objects that
are already part of a parent-child relationship. This will prevent objects such as surfaces
associated with a part from being moved when you reposition the representation of the
null, axis, or vector.

Null
A null, is an empty object, invisible in the final rendering, that groups together object that can be
affected by a free transformation. A free transformation is one that is not limited to a single type of
transformation (rotation or translation), nor is the transformation limited to a single axis or direction in
the 3D world.
In the Shaper interface, a null is represented by an intersection of axes.
A null object can be selected by clicking on it. The rotation and translation gizmos position and orient it
in the world.

Rotation Axis
The rotation axis is a visual representation of the axis around which an animated group of surfaces will
turn. To modify the position and orientation of this axis, you will manipulate the representation.
The rotation axis can be selected at one of three points that allow it to be manipulated: its center, and
its two endpoints. When it is selected at an endpoint, only that endpoint is moved during a translation
to position the axis. This will change the orientation of the axis. If it is selected at its central point, both
endpoints are moved during a translation. As a result, the entire axis is repositioned.
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Before (left) and after (right) adjusting the placement of a rotation axis. The top diagram illustrates selection at an endpoint; the bottom
diagram illustrates selection at the central point.

Translation Vector
The translation vector is a visual representation of the line along which an animated group of surfaces
will move. To modify the position and orientation of this line, you will manipulate the representation.
The translation vector can be selected at one of three points that allow it to be manipulated: its center,
and its endpoints. When it is selected at an endpoint, only that endpoint will be repositioned, which will
change the direction of the vector. If it is selected at its central point, both endpoints are moved when
the position is modified. This results in the entire vector being moved.

Timelines

A timeline is a set of animation tracks. Every new timeline is initialized with tracks for Products,
Cameras, Configurations, Channels, and Textures. Each track accepts a given type of animation keys
or clips, which are available in the libraries on the right-hand side of the editor. You will find more
information about the editor in the corresponding chapter: Timelines (Editor) [115].
Tracks accepting channel animation clips and video textures are added below the existing tracks. To
simplify creating and deleting additional tracks, the following strategy is applied:
• There will always be one empty track of each kind: if a clip is inserted into the last empty track, a new
one is created at the bottom of the list of tracks.
• Only one track of each type is empty: if a track no longer contains any clips, and if another empty
track already exists, the newly empty track is deleted.
A slider allows you to scroll through the tracks if the window is not big enough to display them all.

Items in Tracks: Clips and Keys

Add clips and keys to the timeline by dragging them from their library tab and dropping them onto their
corresponding track.
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• Keys impose an instantaneous state change. They are positioned at a given point in time. Drop them
at the time at which the change should occur.
To help you identify the elements you have loaded, the stretch of time during which the key is active
is assigned a solid color and the name of the key is shown. Each key is activated at its position in
time and continues to be active until it is replaced by a different key.

NOTE
In a key track, the absence of a key at the beginning of the timeline range is handled
differently depending on the type of key.
See the sections on the types of keys (Product Keys [119] and Configuration
Keys [120]) for more information.
• Clips are sequences of changes over a defined period of time. Drop them at the time when the
sequence should begin.
To help you identify the animations you have loaded, each clip is assigned a striped color, and the
name of the animation is shown within the clip on the timeline. The length of the clip is a visual
representation of the time required to play it. If your clips overlap, the clip that begins first will play until
the beginning of the next clip, which will then play instead. The clip that begins last will always have
priority.
Some clips contain keys that mark points within the clip. This is the case with bookmarks in a camera
animation clip and key frames in channel animation clips. You can reposition a key within a clip. First,
select the clip. Then, click on the key and drag it to a new position within the clip.
Once added to a timeline track, items can be:
• Selected,
• Repositioned,
• Removed: Pressing the Delete key removes the selection from the timeline.

Selecting Individual Items
Select a single item in any track by clicking on it.
If only one item is selected, its information will be shown and can be edited if the corresponding editor
is already open.
To clear a selection, click on an empty area in the tracks.

Selecting Multiple Items
Select multiple items by holding down the left mouse button and dragging to create a selection zone.
This zone will select the keys whose central point lies within the zone as well as the clips that are
entirely enclosed by the zone.
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Using a selection zone to select multiple items.

You can also select multiple items by holding down the Ctrl key and clicking on the items in the tracks
that you wish to include in your selection.
While the Ctrl key is held down:
• Dragging to create a selection zone will add items in that zone to the current selection,
• Clicking on an item that is already part of your selection will remove it from the selection.
To clear a selection, click on an empty area in the tracks.

Repositioning Items
To reposition an item or group of items already in a timeline track, begin by selecting the item or group.
Then:
• enter the start time in the Item field,
• drag and drop the selection within its track or, in the case of channel animation clips, onto another
channel track.
In the case of a multi-item selection, entering a value on the Item time zone will align the activation of
all of the selected items at the new time value.
A magnet effect allows you snap both keys and clips to the beginning and the end of the timeline
range. This magnetism also helps you to position clips one after another with no pause in between.
Additionally, you can use it to align the activation times of elements in one track with elements in other
tracks.

Resizing Clips
To change the duration of a clip, position the mouse over the left or the right end of the clip. Click and
drag the end; this will change the length of the clip.
Resizing a texture clip has no effect on its playback speed. The video will be stopped before its end, or
its playback will be looped in order to fit the length of time established by the size of the clip.
You cannot resize selections of multiple clips at once.

Loop, Reverse, and Delete Elements
A right-click on a selected timeline key or clip in a track, or on a selection containing one or more
elements, opens a menu from which the following actions are accessible:
•

Erase the selection (keys and clips) from the track,

•

Reverse the playback (clips only, excluding texture clips),

TIP
The background chevron shading indicates the playback direction of a clip. The chevrons
point to the right when the clip is played forwards. When the playback direction is reversed, the chevrons point to the left.
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• Loop the playback of the selected clips (excluding texture clips) by selecting the type of loop:

•

Repeat: This mode repeats individual clips an infinite number of times. At the beginning
of each repetition, the values that have been modified are reset to their initial value, and the
animation is replayed identically. A clip that rotates an object five degrees will be returned to its
initial position and will then move the object the same five degrees again.

•

Increment: This mode repeats individual clips an infinite number of times. It is available only
for channel animations. Any values that have been modified retain their modification, and each
new repetition of the clip adds the new modification to the previous one. A clip that rotates an
object five degrees will move it from zero to five degrees on the first repetition, from five to ten on
the second, from ten to fifteen on the third, and so on.

• Disable: This option removes looped playback for the selected clips.

Bézier Curve Primitives
Available in: Matter or Shaper via the toolbar:
• Create Bézier path
• Show Bézier Paths Editor

Patchwork 3D Bézier curves are supports for camera and camera target paths in animations. The
camera, its target, or both can be animated along any existing curve in your product.
The simplest form of a Bézier curve is a curve calculated between two control points. The shape of the
curve is manipulated by modifying the position of the tangents running through these control points.
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The Bézier curves in Patchwork 3D consist of two or more points, with a curve passing through each
pair of points. This chain may have two endpoints (an open curve) or the two ends may meet and join
together (a closed curve).
When creating a Bézier curve, you provide the following information:
• The name of the curve being created.
• The number of points to position along the curve. You can also add or delete points later.
• Whether the curve will be an open or a closed shape. Select Closed Path to create a closed curve.
This property may be modified later on.
The curve that is created is placed on the grid. An open curve will be placed aligned on the X axis. A
closed curve is placed so that its points are positioned equidistantly on an invisible circle centered on
the origin in the 3D world.

Modifying a Bézier Curve
You can Display
visible by default.

or Hide

Bézier curves using the toolbar toggle button. Bézier curves are

Modifying a Bézier Curve via the contextual menu
A single click selects the curve. When the curve is selected, the various points and tangents along the
curve are displayed.
Right-click on a curve to open the curve's context menu. From this menu you can:
Icon

Function
Show/Hide Bézier Path

Description
Hides or shows a Bézier path in the 3D Viewport.

TIP
Process to change simultaneously the state of several
Bézier paths. From Bézier Paths Editor, right click on
the selection and then click Show/Hide
Freeze/Unfreeze
Bézier Path

Freezes or unfreezes the selected Bézier Path from editing.

TIP
Process to change simultaneously the state of several
Bézier paths. From Bézier Paths Editor, right click on
the selection and then click Freeze/Unfreeze
Insert point

Insert a point on the curve at the location you right-clicked.

Delete the curve

Deletes Bézier Path(s).

Close/Open a
path

Change the path's shape by deciding to Close path or Open path.
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Icon

Function

Description

Place start here

Set the start point for animations along this curve.

Reverse path direction

Reverse the direction of animations on this curve.

A point can also be added to the curve by Alt+clicking on the place on the curve where you wish to add
a new vertex. An existing point can be deleted by right-clicking on it and choosing
from the context menu.

Delete point

Modifying a Bézier Curve via the editor
From the Bézier Paths Editor, you can:
Icon

Function
Show Bézier Path

Action
Freezes or unfreezes the selected Bézier Path from editing.

TIP
Process to change simultaneously the state of several Bézier paths. From Bézier Paths Editor, right
click on the selection and then click Show/Hide
Hide Bézier Path
Freeze Bézier Path

Freezes or unfreezes the selected Bézier Path.

TIP
Process to change simultaneously the state of several Bézier paths. From Bézier Paths Editor, right
click on the selection and then click Freeze/Unfreeze
Unfreeze Bézier
Path
Add a path

Adds a path a Bézier path into the 3D Viewport.

Hide/Show Bézier
Paths

Hides or shows Bézier paths in the 3D Viewport.

Import Bézier
Path(s)

Imports one or multiple Bézier paths from the hard drive of your
computer.

Export Bézier
Path(s)

Exports one or multiple Bézier paths into the hard drive of your
computer.

Rename Bézier
Path

Renames a Bézier path.

Delete Bézier
Path(s)

Deletes one or multiple Bézier paths.
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Bézier Curve Position and Orientation
The position and orientation of the curve, as well as those of its points and tangents, can be modified
using the translation and rotation gizmos.
• Use the translation or rotation gizmos to manipulate the entire curve if no specific point or tangent is
selected.
• When a point is selected, the translation gizmo moves the point in the 3D space; the rotation gizmo
changes the orientation of its tangent.
When a tangent's endpoint is selected, the translation gizmo moves the endpoint in the 3D space; the
rotation gizmo has no effect.

TIP
By holding down the Ctrl key of the keyboard you can move the direction point (end of the tangent) regardless of the other direction point.

TIP
By holding down the Ctrl + Shift keys of the keyboard you can change the length of one
side of the tangent while keeping the same axis for both sides.

NOTE
Multiple points on a single curve can be selected and repositioned at the same time.
However, only one curve or only one tangent endpoint may be selected and repositioned
at a time.
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Live Mode
Live mode is an interactive mode in which you have access both to the navigation modes that allow you
to explore your product and its animations and configurations. Animations and configurations can be
activated by using triggers, that is, a keystroke or click on a predefined surface.
To make an animation available in Live mode, assign it a trigger in the Live mode [175] editor, then
switch to Live mode.
When Live mode is active, the menus and buttons in the interface are no longer available.
• To leave the Live mode, press the Esc key.
• Navigate within your scene using the navigation shortcuts.
• Play animations by using the triggers you have defined.
A trigger can be used multiple times while the animation is playing. The playback behavior will depend
on the trigger's play mode [177].
Triggers can also be created to cycle through configuration values when a trigger surface is clicked. To
create configuration triggers, use the Tag Manager [165] in Shaper.
Live mode can be viewed in full screen. To do so, switch the active viewport to full screen (keyboard
shortcut: Y) before switching to Live mode from the editor.

Animating Channels with Advanced Configuration
The advanced mode in the Channels (Editor) [132] can be used for precise control over one or more
channels of animation.
Creating an animation curve using the advanced mode follows these main steps:
1. To the left of the graph, select the curve you wish to edit.
2. Place the time cursor at the time position where you would like to make a change by adding a new
key frame.
3. In the active viewport or in the editors associated with the selected channels, make the changes
you would like to see at this point in time.
4. Click on
Capture current values. This will add a key point in each selected channel, using the
values set in the editors and the active view. The new key points are aligned with the time cursor.
You can also add key points by hand: activate the New key frame
mode and click on curves on the
graph where you would like to place new key frames. Once the key frame has been added, enable one of
,
, or
) to reposition your key frames interactively by dragging
the repositioning modes (
the point with the mouse. If one of these modes is already enabled, you can place a key frame without
changing modes by using the function Alt + click.
1.

By default, the curve which is drawn between two points is of the type Curve
. In this case, the
change in the channel value in this interval of time does not occur at a constant speed. The speed
of change of this value on either side of the key point is represented by the angle of tangents to the
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curve to the left and to the right of the key point. To modify the speed of change, you will need to
reposition the tangents. To do so, set the mouse to one of the repositioning modes (

,

, or

) and click on any key frame to show its left and right tangents.
2.

By default, the tangents are horizontal. Clicking and dragging a tangent's end-point modifies the
tangent used to calculate the curve. The tangents to the left andR to the right of the key frame are
modified independently of one another.

3.

To modify the type of progression used between two key frames, open Key Frames
. Clicking
on the option shown next to Left or Right allows you to modify the progression mode for the curves
to the left and to the right of the point, respectively. This opens a list of choices:
• Select Linear
to impose a constant (linear) change from the initial value to the final value
over the time available between the two points. This appears as a straight line on the curve.
to impose an instantaneous change of value at the key frame's time. This
• Select Step
appears as a step (horizontal and vertical lines) on the curve.
• Leave the Curve
form to add ease to the animation slope. Tangents are available at each key
frame that has been set to Curve. Use them to adjust the shape of the curve.
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CLIPPING PLANES
Clipping planes can cut through a model to reveal cross-sections, internal structures, or other details
that are usually hidden by outer pieces.
Three customizable clipping planes are available. They can be placed and modified manually, or automated during an animation using a channel animation.
You may be interested in the following topics:
• Clipping Planes (Editor) [185]
• Channels (Editor) [132]

Animating Clipping Planes
Three types of animation channels exist for clipping planes. These allow you to:
• Enable/Disable the clipping plane
• Position the clipping plane along the X, Y and Z axes
• Orient the normals for the X, Y and Z axes

NOTE
It is strongly recommended that you use all three position or all three normal channels
together in the same clip when animating clipping planes.
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REAL-TIME SUN
In contrast to the lighting defined in Shaper, the real-time sun available in Matter provides light that
is calculated on a product in real-time. The real-time sun provides light similar to that projected by a
sun type light source. The source is not visible. Its beams are infinite and parallel to one another. The
source can be positioned in terms that are used to describe the real sun: angle above the horizon,
position on a compass, etc.
Data related to the real-time sun is included in databases exported in KDR format.
The real-time sun can be animated using a channel animation.
You may be interested in the following topics:
• Lighting [266]
• Real-Time Sun (Editor) [209]
• Channels (Editor) [132]
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IRAY
WARNING
This feature requires a specific license option and may not be available in your software
version.
Patchwork 3D includes Iray, a physically realistic raytracing engine designed to work with Nvidia
graphics cards. Iray provides an interactive rendering with progressive refinement, which approximates
the physically realistic behavior of light and its interaction with materials. Among other advantages,
this allows for the use of effects such as global illumination.
In Patchwork 3D, modifications to Iray-specific settings are saved in the database. If an Iray database
is later opened by an equivalent version of Patchwork 3D that does not include the Iray module, the Iray
settings will be ignored, but will be preserved.

Conversion of a Patchwork 3D scene for Iray
The various elements in a Patchwork 3D are converted for rendering with Iray, with certain limitations.
The following elements are not converted, or are only partially converted:
• Stickers in Add and Multiply modes
• Video textures: supported in video snapshots only
• Overlays
• Post-processing produced by Patchwork 3D

Rendering with Iray
To start a render using Iray, enable Iray rendering with the
active viewport.

button. Rendering will begin in the

To increase interactivity, you may choose to keep the Patchwork 3D rendering in the active viewport
and to send the Iray rendering to a remote window. To do so:

1.

Open the Iray settings editor

2.

Enable the rendering in a remote window with the button

3.

If the remote window is hidden, show it by clicking on the button

During refinement, the number of passes and the current rendering time are displayed at the top of the
Iray settings editor and at the top of the remote Iray rendering window, if the remote window is enabled.
A message is also displayed in the Patchwork 3D status bar when refinement has finished.
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Activation and viewing controls
In the interface of Matter:
Icon

Function
Enable Iray rendering
Pause refinement
Show the Iray settings editor

In the Iray settings editor:
Icon

Function
Enable Iray rendering in a remote window
Show / hide the remote rendering window
Synchronize the aspect ratio of the remote rendering window with that of the active
viewport
Show the remote rendering window in full screen. To quit the full screen mode, press the
Esc key
Show the rendering log
Access connections to remote rendering servers

Scene
Iray Rendering Modes
Iray Photoreal: This is the photo- and physically realistic mode in Iray, which uses complex global
illumination effects. This mode offers a maximum quality but takes longer to calculate the refinement
of the image.
Iray Interactive: This raytracing mode uses progressive rendering that allows you to take advantage of
the effects of a raytracer without giving up interaction and editing capabilities. This mode does not
provide physically realistic rendering.
Blend: Render convergence begins in Interactive mode and then switches to Photoreal mode after
a certain level of refinement is achieved. In high-interactivity situations, this mode allows for more
fluid interaction while still aiming for increased realism once the interaction has ended. Because both
rendering modes are used, this mode consumes more memory resources during the conversion of the
scene.
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Refinement stop criteria
Multiple criteria are available to define the end of the refinement phase. The rendering will stop as soon
as the first limit is reached.
Max samples per pixel: the higher the limit, the better the quality and the longer the rendering time
Max quality: expressed as the rate of convergence per pixel, from 0 to 1, where 1 represents an infinite
convergence
Max time: maximum duration of the calculation in hours, minutes and seconds before stopping the
refinement
Max path length: in number of bounces

Render Settings
The optimization settings favor certain phenomenons or characteristics that are physically present in
the scene in order to make the final convergence for these elements visible earlier during the rendering.
Caustic sampler: uses a sampling strategy to favor the calculation of caustics
Architecture sampler: allows earlier appearance of the light in interior spaces
Enable Environment Material support allows you to view an environment material in the viewport of
Matter.

WARNING
For closed decors (such as a hemisphere) on which the material Environment is applied,
matte material or Iray ground is not compatible with the above parameter. This parameter
can be deactivated (unchecked) to instead show up the Iray environment that supports
matte material and Iray ground.
A rendering difference may appear between Iray and OpenGL, that's why you can use the Use alternative
texture parameter to prevent blurring when the HDR or EXR file applied to the background texture of the
environment is in low resolution. Patchwork 3D will instead load an alternative non-HDR texture which
results in an alteration of information related to the intensity of the light. You will find additional information related to the Environment material in the following chapter: Using an Alternate Background
Texture as an Environment Material [304].

TIP
The best option to have a similar rendering between Iray and OpenGL is instead to use a
high resolution wide dynamic range HDR as the environment texture and uncheck the Use
the alternative texture parameter.
In the event that the Environment material is not used, Set the background mode to environment parameter is required to display the Iray environment. This is to apply the background mode Environment to
the sensor in use. You will find additional information on how a sensor works in the following chapter:
Sensors (Editor) [138].
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Ground
The ground, when enabled, simulates an infinite plane, covered in the equivalent of a matte material. In
background mode, it includes the reflections of and influence of the product's environment.
Altitude: height of the ground along the Y axis
Shadow intensity
Scale: adjusts the scale of the environment
Glossiness: glossiness of the ground
Reflectivity: reflection color for the ground

Filtering Settings
Filters reduce certain artifacts associated with the non-convergence of pixels. Filters can impose an
additional calculation load, which can taken up, in part, by the CPU.
Fireflies: filters bright points
Degrain filtering: produces a smoothing of the rendering. Five modes are available:
• Pixel clipping
• Smart median
• Smart average
• Limited blur
• Limited auto blur
In ascending order, the Pixel clipping produces a soft smoothing while the Limited auto blur produces a
strong smoothing.

NOTE
Modes 4 and 5 of degrain filtering are not physically realistic.

Denoise filtering
The Patchwork 3D rendering engine supports the new algorithms for intelligent noise reduction by
NVIDIA Iray. During progressive refinement it is now possible to obtain a noise-free rendering from a
threshold defined in advance.
From the user-defined threshold of the Minimum iterations, intelligent noise reduction algorithms perform a process to make the image look sharper.
• The higher the threshold, the more intelligent noise reduction occurs late in rendering.
• The lower the threshold, the more intelligent noise reduction occurs early in rendering.

Tone Mapping
Tone mapping is disabled by default in order to insure a continuity in the colorimetric and the rendering
between the real-time OpenGL engine in Patchwork 3D and the Iray raytracer.
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Exposure: compensation for the exposure of light in the scene
Burn highlights
Crush shadows
Saturation
White balance: can be set via a choice of standard values, a personalized Kelvin value, or with the color
chooser
Photographic tone mapping: replaces the exposure value with photographic exposure settings. These
settings include the Cm2 factor, the sensor sensitivity ISO, the F-number of the aperture, and the shutter
speed.
The reset button restores the default tone mapping settings.

Camera effects
These camera effects are specific to Iray and are fully independent with respect to their equivalents in
Patchwork 3D.
Bloom: when enabled, the radius, threshold, and brightness scale can be set
Vignetting: provide a value and press Enter. Increasing the value increases the effect.

TIP
Vignetting is only available when Tone Mapping is enabled.

NOTE
Depth of field, for which the setting are available in the camera editor, is also taken into
account.

Materials
A digital material, like a physical material, is the source of a surface's visual aspect. The materials in
your database reproduce the visual properties of the physical materials that they represent.
Each surface is assigned a material. In some cases, a surface can be dressed with multiple materials.
This is the case when you apply stickers or when you make use of aspect layers.
Patchwork 3D allows you to change the aspect of your product in real-time by assigning new materials
to a surface. No calculation is carried out, but the product is updated instantly while you continue
navigating around it in the 3D world.
Seven types of material exist. A type is defined by the function of the surface to which the material is
assigned:
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Material
type

Use

Standard

The default material can duplicate most types of physical materials using two
layers, a diffuse layer and a reflective layer.

Environment

This material represents the environment of a scenario. It is used to dress a skydome, which is a hemisphere surrounding a product.

Matte

This material only shows the shadow of a product. When assigned to a plane on
which your product is placed, it increases the realism of the scene when your
scenario consists of a simple 2D background.

Mirror

This material is used to dress surfaces in which the reflection of other surfaces in
the scene are visible.

Multilayer

This material is designed for the advanced user. Its precision is useful for creating
complex and detailed materials.

Seam

This material is used to represent the particularities of a sewn seam.

Sticker

All standard materials can be assigned as stickers, but this type of material is
designed specifically for that use. It can therefore be employed with another material on a single surface, or even assigned several times to the same surface.
This can be useful in the case of certain patterns such as stickers, printed marks,
engravings, stamps, or other marks that aren't part of the aspect of the physical
material itself.

The Patchwork 3D materials are managed from the Matter sidebar's material library.
Their settings, including their colors, can be modified via Materials (Editor) [174].
The Positioning and Orienting Materials [315] describes the two manipulation modes used to interactively position and orient materials.

Surfaces as light sources
It is possible to use a surface as a light source by selecting a material to be used as a source and
assigning that material to the surface.
All of the standard and multi-layer materials in the Matter material library can be selected as light
sources. This selection is made from the Iray settings editor.
Materials are selected simultaneously in the Iray settings editor and in the Matter library; you can
therefore select the material in whichever interface is more convenient.
To function as a light source, the emitting materials must have an illumination intensity greater than 1.
For a multilayer material, this is the illumination of the illumination layer. This parameter can be set in
the Materials editor.

NOTE
The renders of materials used as light sources can be noticeably different between
Patchwork 3D and Iray.
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NOTE
MultiLayer Materials: Iray does not support infinite layers. Materials conflicting with the
Iray limit will appear in orange in the list, and a warning is printed in the log. During
rendering, Iray will automatically simplify the conflicting material.

Override Patchwork 3D material
Certain material settings can be overridden by Iray-specific settings. The available settings vary with
the type of material.
To enable the override settings in Iray, click the Materials tab from the Iray settings editor and select
among the following parameters:
• Any Patchwork 3D material can be used by Iray as a matte material.
• Iray accepts an AXF file (with refractive or non-refractive clear coats) or a MDL file imported from the
hard drive of your computer.
• You can also override the selected material with other materials from the Material Library of the
database.

Lighting
All active lights in Shaper have an effect on the Iray rendering. You can override certain settings of
these lights.
In the Iray settings editor, select a light to enable the setting override. When a light source uses Iray's
settings instead of Patchwork 3D's, a check mark appears in the Iray settings editor next to the name of
the light.
You can override:
• The intensity
• The use of intensity as radiant existence
For spot type lights, it is also possible to modify the exponent.
For area lights in the form of rectangles and cylinders, the option use as portal light is available. A portal
designates a zone, defined in this case by the surface, that allows exterior light to reach and enclosed
area. This option produces an effect only when the caustic sampler optimization is enabled.

Snapshot layers
The Iray engine is available for image, video, VR object and VR panorama snapshots. In the corresponding Snapshot editor, select Iray as the render engine.
When the snapshot will be saved in a format that supports layers (PSD or PSB), Iray can split the image
into different layers.
Render direct and indirect contribution separately: renders separate layers for the direct illumination (light
sources) and indirect illumination (global illumination).
Available layers:
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• Diffuse layer
• Specular layer
• Glossy layer
• Emission layer
• Alpha layer
• Depth layer
• Normal layer
The calculation of layers does not include transmission.

Sun and Sky
WARNING
The Patchwork 3D real-time sun cannot be used at the same time as the Iray sun and sky.
If both lights are enabled simultaneously, only the sun and sky in Iray will be used.
Iray offers a simulation of the light of the sun and the sky.
When the Sun and sky option is enabled, a sun type illumination is added, an infinite plane is used as
the ground, and an environment representing the sky is displayed.
The Multiplication value adjusts the environment's luminosity.
The sun settings include:
• The solar disk intensity
• The solar disk scale
• The solar glow intensity
• The sun's position, which can be set in the Position of the Real-time Sun editor

The sky settings include:
• The night color
• The haze level
• The red- or blueshift. Positive values will produce a redshift, while negative values produce a blueshift.
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The ground settings include:
• The ground color
• The horizon height
• The horizon blur

NOTICE
New Features in Patchwork 3D 2022 X5
Soft shadow settings include:
• the use of OpenGL parameters, cf. Use OpenGL parameters
This setting ensures that the OpenGL visualization of your model in the viewport is similar to the
Iray rendering. You can then change the Shadow smoothness parameter from the Real-Time sun [211]
editor to get soft shadows in Iray.
OR
• the use of custom parameters, cf. Use custom parameters
• The Distance from the sun to the scene.
• The Sun radius.
• The Intensity factor .
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Choice of graphics card
WARNING
This information is specific to each session and each machine. Changes to settings in
this section are saved on your machine but are not saved in the model database.
Iray can use multiple graphics cards at a time.
All cards available on the machine being used are listed.
Iray can also use CPU threads. This option is disabled by default to prevent Iray from monopolizing the
computer's processing power. This is an option provided by Iray that was designed to be used only on a
machine used as a rendering server.

Access connections to remote rendering servers
WARNING
This information is specific to each session and each machine. Changes to settings in
this section are saved on your machine but are not saved in the model database.
You can use a machine on your network or an Nvidia VCA to process rendering remotely.
Set up a remote rendering server by clicking on the

button in the Iray settings editor.

A check mark indicates an active connection.
Remember to disconnect at the end of a session: in certain cases, including the use of VCAs, other
users cannot access the remote service while you are connected.
If a connection is underway when Patchwork 3D is closed, the connection will be automatically disconnected. See the following sections to configure each type of server.

Iray Server
NOTE
The software Nvidia Iray Server is available from Nvidia.
The Iray server is any machine on your network on which the software Nvidia Iray Server is installed.
You will need the IP address and the connection port for the server. You will also be asked to provide
the ID and password.
A button is added to the snapshot editors: Add to queue. This sends a deferred render request to the
Iray server. You will then need to manually run the rendering of the queue on the server. This can be
done after the Patchwork 3D session has been closed and does not require either Patchwork 3D or
access to the original computer that requested the render.
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It is not possible to encode a video from the Iray server render queue. When a render request for a video
is made, each frame will be rendered separately and the output will be made available as an archive file
containing all frames.

NOTE
The preparation for sending a of a video render request to the server may take a few
moments. The Rendering window will open while the timeline is evaluated and each video
frame is prepared.

NOTE
For more information about Iray Server, see details in Iray documentation that came with
the purchase of this product.

VCA
A VCA is a calculation device for network use for graphic purposes, notably for use with Iray. VCAs offer
a multiplication of the strength of Nvidia GPUs. You must have access to a VCA. An ID and password
will be requested.
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ANTIALIASING
Patchwork 3D includes an antialiasing function for real-time rendering.
Real-time antialiasing can be set up in the Render Presets available from the context menu of the 3D
viewport.
The effect of the antialiasing is particularly effective in the case of sharp borders and strong contrast
between the start and end colors of gradients.
When the point of view changes, artifacts due to high intensities may occur in specular reflections.
These artifacts consist in white dots due to highly-localized reflections. Consequently, filtering is
deactivated by default during and at the end of interactive phases.
However, as the software antialiasing eliminates the artifacts efficiently and the filtering removes a
light blur from the specular reflections, the anisotropic filtering is automatically enabled when the
software antialiasing kicks in.
The anisotropic filtering may be set separately for interactive rendering phases, for the end of these
phases, and for idle phases. To do so, activate a custom preset in the Render Quality Settings of the
Render Presets submenu of the viewport context menu. Use the Specular anisotropic filtering slider to
set the level of filtering.
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ENHANCED TRANSPARENCY
Enhanced transparency provides improved rendering for transparent surfaces. Rather than using surfaces' bounding boxes to determine their distance from the viewpoint, enhanced transparency utilizes
pixel-by-pixel analysis to determine the order in which the surfaces must be rendered.
Using enhanced transparency increases the consumption of GPU memory and reduces the number of
images per second. This option is disabled by default.

NOTE
The option Enhanced transparency is not compatible with the use of transparent mirrors.
When enhanced transparency is enabled, transparent mirrors are treated as simple transparent surfaces.

Enabling Enhanced Transparency
Use the

button in the Matter toolbar to enable or disable enhanced transparency.

Standard versus Enhanced Transparency
This technique for calculating transparency can be costly. In order to improve the rendering of transparency without resorting to enhanced transparency, avoid grouping transparent surfaces together
in Shaper. A group is treated as a single surface, which can prevent Patchwork 3D from correctly
analyzing which geometric elements should be visible through a transparent surface.
Standard Transparency
Affected
materials

Enhanced Transparency

• Standard materials with alpha,

• Standard materials with alpha,

• Standard materials of the
transparent filter class,

• Standard materials of the transparent filter
class,

• Multi-layer materials with no
diffuse layer,

• Multi-layer materials with no diffuse layer,
• Mirror materials with transparency (treated
as standard materials of the transparent filter class).

• Mirror materials with transparency.
Calculation
method

Handled surface-by-surface, using the position of the bounding
box to determine the order of
surfaces from a given point of
view.

Handled pixel-by-pixel, analyzing all of the surfaces present at each pixel from a given point
of view.

Advantages

Renders quickly and is suited to
most uses of transparency.

Prevents situations where the position of the
bounding box is not enough to determine the
order of surfaces from the point of view. This
can occur with complex transparent surfaces,
intersecting transparent surfaces, transparent
surfaces that surround other surfaces...
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Intersecting transparent surfaces rendered with standard transparency (left) and enhanced transparency (right).
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RAYTRACING
The raytracing engine is directly accessible from Patchwork 3D , which makes it particularly easy to
use. Each rendered view can be saved in the database, making further operations like applying a
post-process easier.
The raytracing engine uses the Patchwork 3D materials from the current product. The render of the
materials with the raytracing engine remains true to the one calculated with the Patchwork 3D OpenGL
rendering engine. Product views are prepared with the tools available in the Patchwork 3D Matter
interface. The default environment can be replaced by any environment.
Multicore architectures are supported and recommended. A minimum of 16 GB of memory is required
and 24 GB are suggested for heavy scenes.

Raytracing a View
Raytracing Part or All of the Active View
Raytrace rendering may be costly in calculation time. Therefore, the raytracing engine gives you the
ability to render either a part or all of the active view.
To render the entire active view, use the function Raytrace active viewport
. This function is
available in the Visualization toolbar located in the upper part of Patchwork 3D user interface.
To render a part of the active view, use Select raytracing area
in the Visualization toolbar and draw
the rectangular region you want rendered in the active view. As long as this mode is active, raytracing
rendering is limited to this defined region. The rest of the view is rendered with the OpenGL rendering
engine.

Raytracing rendering limited to a region of the view.
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For additional information, see:
• Raytracing Settings (Editor) [182]

Creating Snapshots Using the Raytracing Engine
The following types of snapshots may be created using the raytracing engine:
• Image snapshots,
• Video snapshots,
• Cubic VR panorama snapshots,
• VR object captures.

The Rendering Engine box of the Video editors.

When you create a snapshot, select the proper engine in the Rendering Engine box of the snapshot
editor. Rendering is started by clicking the Render button at the bottom of the editor. Alternatively, it can
be postponed for later with the Snapshot Batcher. In that case, use the Add to Snapshot Batcher button
to save the view and its associated parameters to the Snapshot Batcher. You can also replace the
current snapshot in the Snapshot Batcher with the new view and its associated parameters by clicking
on the Replace Current Snapshot Batcher Item button.
For additional information, see:
• Snapshots (Editors) [139]
• Snapshot Batcher [179]

Creating Snapshot Using Remote Raytracing Engine
Patchwork 3D allows you to configure and use remote CPU from units (cluster) to generate a snapshot
with raytracing rendering engine.

Raytracing cluster unit 2022 X5 release 1 step by step setup guide
1.

Install Patchwork 3D Raytracing cluster unit 2022 X5 release 1 application on each remote unit
(PC).

2.

Click Next when Raytracing cluster unit application pops up.

3.

Check to accept the license agreements.

4.

Click on Next.

5.

In the next window you can choose to install the application in a different location.

6.

Click on Install.

7.

Click on Finish.
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8.

Start the application by double clicking on the shortcut desktop icon.

9.

Accept Windows Firewall warning by clicking on Allow access button.

10. The software will open a port to communicate with remote units.
11. Start Patchwork 3D on main PC and load a p3d database.

TIP
If you restart Windows on one of rendering unit calculating remote raytracing, you have
to relaunch Raytracing cluster unit application. You can add it to Windows startup programs.
• For Windows 8 & 10 users: Copy-paste the Raytracing cluster unit shortcut located
on Windows desktop in this following folder: C:\ProgramData\Microsoft\Windows\Start
Menu\Programs\Startup
• For Windows 7: Drag and drop the application to the following location Start > All
Programs > Startup

Cluster configuration in Patchwork 3D
1. On the main PC, in the Editor toolbar (at the bottom left) of Patchwork 3D Design, click on this icon
to configure the raytracing.
2. Click on the Remote tab
3. Check Use remote raytracing
4. Click on the

button to add unit using its IP address (use copy/paste to set IP address faster).

5. Click OK to add a unit.
You can also use this icon

to import a list of units using a text file.

Syntax is:
192.168.10.134
192.168.10.133
192.168.10.132
//192.168.10.12 ignore this IP address.
Use the icon

to remove the unit from the cluster.

Creating Snapshot
In the Snapshot menu, select Snapshot image, in the Renderering Engine select the Raytracing radio
button as rendering engine.
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Patchwork informs the user once the image is calculated. It takes times first to upload the data to all
the render units. Progress bar shows how the cluster is working.
For more information, see Raytracing Settings (Editor) [182]
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RENDERING SNAPSHOTS, VIDEOS, AND 3D ENVIRONMENTS
Snapshot Menu
The Snapshot menu provides access to the functions that allow you to export the rendering in the
active viewport as media content: videos, images, or 3D virtual reality objects or panoramas. It contains
the following menu items:
Icon

Tool

Description

Snapshot Image

Opens the Snapshot Images editor to access the settings and render a
view of a product that will be saved as an image file. See: Snapshots
(Editors) [139].

Snapshot Video

Opens the Videos editor. This editor generates animations or sequences of images based on an initial point of view and a predefined animation. See: Snapshots (Editors) [139].

Snapshot
Panorama

Opens the Panoramas editor to modify the settings and generate a
panoramic 360-degree video. See: Snapshots (Editors) [139].

Snapshot VR
Object

Opens the VR Objects editor to modify the settings and generate a VR
object. See: Snapshots (Editors) [139].

Snapshot Cubic VR Panorama

Opens the Cubic VR Panoramas editor to modify the settings and generate a cubic VR panorama. See: Snapshots (Editors) [139].

Quick Snapshot

Creates snapshot of the current active viewport. The snapshot is generated by the editor that was most recently used, and the settings
of the last snapshot rendered are applied. If no snapshot has been
created before, the Snapshot Images editor and its default settings are
used.

Show Info

Enables or disables the Show Info option in any of the snapshot editors. This option displays, along the bottom of the active viewport, a
summary of the snapshot dimension settings.

Snapshot
Batcher

Opens the Snapshot Batcher. Use this tool to group snapshots and
render them as a batch at the time of your choosing. See: Snapshot
Batcher [179].
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PRINTING
Printing Patchwork 3D's printing functionality is used to print the image displayed in a Matter viewport
on paper or to a digital file. It is available only if a default printer is defined on the computer.

General Print Window
To print the image displayed in the active viewport, open the print menu
Print or with the keyboard shortcut Ctrl + P.

accessible from File >

The general print window is for selecting the printer to use and adding new printers, as well as defining
the Settings for the printer and the pages to print.
The Print in a file function is for saving the image in PDF format. When printing as a PDF a new window
will automatically open.

Printing to a File
The Configure Printers button recalls the general print window.
When Print file information is enabled, the file information in the box is added under images in the *.pdf
file generated.
The image position on the page is selected by using options Center, Top Left and Custom, for which the
margins’ width is entered in the fields.

Print in a file window.

The Dimensions box contains the image dimension options:
• Fit Page,
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• Specification of image Width and Height in the fields and unit selection. The images printed from the
Matter viewport are considered vector images and will be rendered with the ideal resolution for the
required printing dimensions. The renders with raytracing are fixed and will be resized for printing.
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SCRIPTING
Available in: Shaper or Matter: Scripting

Scripting allows you to automate repetitive tasks or to extend the functionalities of Patchwork 3D.
Three operating modes are available:
• The Console mode to execute commands interactively. For assistance click the Documentation button.

TIP
At any time you can Interrupt Execution of the command by clicking on the dedicated
button and restart the Python interpreter.
• The Execute script mode to execute a .py script stored on your computer.
• The Start scripting server mode to launch a server allowing an external Python interpreter to execute
commands in Patchwork 3D. The Local connections only parameter disallow remote connections. The
Port allows you to choose the communication port between the server and the interpreter.
Examples of scripts (see the Scripts library) were created to help you use Python scripting with Patchwork 3D. Use these examples to familiarize yourself and create new ones.

TIP
At any time you can see the scripting documentation in Matter or Shaper by clicking the
Scripting menu > Scripting Help...

Workspaces
Thanks to the workspaces you can reorder the Patchwork 3D user interface toolbars according to your
use. Workspaces use Python scripting, so please read the scripting documentation for more details.
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